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CHAPTER 1

Preparing to Work with 
Effects

Your Avid editing system offers many effects that you can apply to 
your sequences. This chapter describes some of the concepts with 
which you must become familiar before you begin creating and 
editing effects into sequences.

• About Effect Types

• About Horizontal, Vertical, and Nested Effects

• Effects Creation Tools

• About Real-Time and Downstream Key Effects

• About Effects in 24p or 25p Projects

• Using the Effect Palette

• Using Third-Party Plug-in Effects

• Changing Timeline View Settings for Effects

• Adjusting Trim Settings for Effects
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About Effect Types

Much overlapping occurs between the various types of effects you can 
create, as well as the methods used to create them. Roughly speaking, 
there are four basic types of effects:

• Transition effects (dissolves, wipes, and so forth) are applied at 
the cut point between two video clips that are on the same video 
track (that is, the same video layer). 

Chapter 2 and Chapter 3 describe techniques for creating 
transition effects.

• Segment effects (both single-layer and multilayer) are applied to 
an entire clip or group of clips. There are two types of segment 
effects:

- A single-layer segment effect, such as the Mask effect, is 
applied to a segment on one video track. Single-layer segment 
effects use one stream of video. 

Chapter 2 and Chapter 3 describe techniques for creating 
single-layer segment effects.

- A multilayer segment effect, such as the Picture-in-Picture 
(PIP) effect, is applied to the top layer or a middle layer of 
segments that contain two or more video tracks that will be 
played simultaneously. 

Chapter 4 describes techniques for creating multilayer effects.

• Title effects are created with the Title tool and edited onto their 
own layers in a sequence. 

Chapter 6 and Chapter 7 describe techniques for creating and 
editing title effects.

• Motion effects (freeze frame, variable speed, and strobe) are 
created by manipulating the playback characteristics of a clip of 
footage. 

Chapter 2 describes techniques for creating motion effects.
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A number of effects have both 2D (two-dimensional) and 3D 
(three-dimensional) versions on systems equipped with the 3D Effects 
option. Chapter 5 describes techniques for creating 3D effects.

n For a complete list of effects, with information on the capabilities of each 
effect, see the release notes for your Avid editing system.

About Horizontal, Vertical, and Nested Effects

You can break down effect designs into two different types: horizontal 
and vertical.

Horizontal refers to effects that you apply across an individual video 
track. Horizontal effects include: 

• Transition effects between two video clips (dissolves, wipes)

• Segment effects and motion effects that modify the appearance of 
a single clip (color effects, flops)

Vertical refers to effects that you apply by adding video elements on 
more than one track to create a composite. They are called vertical 
effects because you add elements by creating additional video tracks 
that appear vertically above existing tracks. Vertical effects include 
picture-in-pictures, titles, and superimpositions. Individual elements 
in a vertical effect can also contain horizontal effects.

You might need to change a single element in a vertical effect 
sequence. For example, you might want to apply a color effect within 
an existing Picture-in-Picture effect. To do this, you can nest an effect 
inside another effect. Instead of one video layer being physically above 
another video layer, a nested effect is contained within another effect 
on the same video layer. For more information about nested effects, 
see “Nesting Effects” on page 206.
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Effects Creation Tools

The following chart presents the basic tools used to create effects.

Sources of effects:

Effects editing: 

Effects adjustment 
in Effect mode:

Effect Palette Title tool
Motion Effect dialog box

Effect Editor:
Allows you to 
adjust effect 
parameters.

Effect Preview monitor:
Allows you to preview 
an effect, manipulate 
keyframes, and manip-
ulate wire-frame repre-
sentations of the 
effect.

Apply transition 
and segment effects 
directly to tracks.

Title and motion 
effects appear first 
as clips in the bin.Edit effect clips 

into the Timeline.
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About Real-Time and Downstream Key Effects

Many effects are real time, which means you do not have to render 
them before you play them. You can preview effects that are not real 
time before rendering. In addition, titles and graphic elements 
imported with an alpha channel display as downstream key (DSK) 
effects.

- Playback Capabilities for Two-Stream Video

- Playback Capabilities for Single-Stream Uncompressed Video

About Downstream Key Effects

By default, all titles are created using your Avid editing system’s DSK 
capabilities. Graphic elements imported with an alpha channel are 
also created as DSK clips. 

Downstream keying allows you to add uncompressed titles or 
graphics over multiple streams of compressed media and continue to 
play the sequence in real time. The real benefits of downstream keying 
are seen during editing of Title Effect clips into sequences. 

n For information about editing with DSK titles, including descriptions of 
various restrictions and playback capabilities, see Chapter 7.

About Real-Time Effects

A real-time effect is an effect that you can apply to a sequence and play 
without having to render it first (rendering takes time and drive 
space). A real-time effect has a small orange dot within the effect icon 
in the Timeline. Effects that must be rendered have a small blue dot 
within the effect icon in the Timeline. Effects that might need to be 
rendered have a small green dot within the effect icon in the Timeline. 
For more information, see “Understanding the Color Coding” on 
page 42.
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n Your Avid editing system has a mix of real-time and non-real-time effects. For 
a complete list of effects and their real-time status, see the release notes for 
your system.

Playing Real-Time Effects

You can create a sequence that has any number of real-time and 
non-real-time effects. However, the maximum real-time playback 
capabilities of your Avid editing system depend on whether you are 
working with two streams of video (compressed resolutions or the 
two-stream uncompressed option) or with the single-stream 
uncompressed video option.

Playback Capabilities for Two-Stream Video

If you are working with compressed video resolutions or with the 
two-stream uncompressed option, your Avid editing system can play 
two video streams in real time. The following are the maximum 
real-time playback capabilities for two streams of video:

• You can play up to a maximum of two real-time segment effects at 
a time.

• You can add a maximum of one additional DSK title or graphic. 
The DSK Title effect can be either a rolling title, a static title, or a 
graphic.

The following sequence shows one example of the maximum 
real-time playback capabilities of your Avid editing system. The 
system can successfully play the Color Effect, the Mask effect, and 
the DSK Title effect at the same time. At any point in the sequence, 
your Avid editing system is using one video stream for the Color 
Effect, a second video stream for the Mask effect, and is applying 
the DSK Title effect downstream.
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• You can add a Dissolve effect between adjacent segments 
containing real-time segment effects, and the track will continue to 
play in real time. However, if another segment effect is on another 
track, your Avid editing system can no longer play the sequence in 
real time, since it cannot process three video streams 
simultaneously.

In the following illustration, a Dissolve effect is placed between 
the two Color Effects on track V1. This prevents the sequence from 
playing in real time. Your Avid editing system would exceed its 
limits since it would require one video stream for the outgoing 
part of the Dissolve effect, a second stream for the incoming part 
of the Dissolve effect, and a third for the nested Mask effect. In this 
instance, the Dissolve effect appears with a green dot and must be 
rendered.

DSK title or graphic 
(rolling title)
Segment effect 
(nested mask)
Segment effects 
(Color Effects)

DSK title or graphic 
(rolling title)

Segment effect 
(nested mask)

Segment effects 
(Color Effects)

Dissolve effect appears with a green 
dot. It must be rendered for this 
sequence to play in real time.
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Playback Capabilities for Single-Stream Uncompressed Video

If your system includes the single-stream uncompressed (1:1) video 
option and you are working with uncompressed video, your system 
can play only one video stream in real time. The following are the 
maximum real-time playback capabilities for single-stream 
uncompressed video.

• You can play effects that use only one video stream, for example 
color effects or resizes. These effects will appear with an orange 
dot in the Timeline.

• You can add a DSK title or graphic to a sequence that plays in real 
time, and the sequence will continue to play in real time. For more 
information on the playback capabilities of titles and graphics 
when working with uncompressed video, see Chapter 7.

• You cannot play effects that require more than one video stream, 
for example, dissolves and Picture-in-Picture effects, in real time. 
This includes all transition effects and all multilayer segment 
effects. These effects will appear with a green dot in the Timeline.

Additional Suggestions for Playback

You can play back any number of effects beyond the real-time 
playback capabilities by using one or more of the following additional 
techniques:

• Render some or all of the effects. You can use ExpertRender™ to 
identify those effects in a sequence that must be rendered in order 
to achieve successful playback. For more information, see 
“Rendering Effects” on page 140.

n In general, consider rendering transition effects such as the Dissolve effect or 
wipe effects first, because they take less time to render than titles or segment 
effects.

• Use the Submaster effect to reduce the amount of rendering. For 
more information, see “Submaster Editing” on page 213.
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• Perform a mixdown of video tracks. For more information, see 
“Performing a Video Mixdown” on page 218.

Hardware Limitations for Real-Time Effects

If you have multiple short clips with multiple real-time effects or 
images with a high level of complexity, you may exceed the capacity of 
the hardware to play these in real time, resulting in Video Underrun 
error messages. In this case, render some of the intermediate effects 
before playing the sequence.

Combined Rendering of Real-Time and Non-Real-Time Effects

The combination of real-time and non-real-time effects on the same 
video track can show different results, depending on when you render 
the non-real-time effects:

• If you render non-real-time segment effects after you apply a 
real-time transition effect, the sequence will play in real time.

• If you render non-real-time segment effects and then apply a 
real-time transition effect, the transition effect will play as a cut.

Displaying Effects On-the-Fly

The Render On-the-Fly option allows you to play back real-time 
effects and preview non-real-time effects frame by frame, immediately 
after applying them.
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To display effects immediately during effects editing:

t Choose Render On-the-Fly from the Special menu.

n A separate setting for Render On-the-Fly exists for Trim mode. See 
“Adjusting Trim Settings for Effects” on page 59.

Interrupting Render On-the-Fly

Using Render On-the-Fly can slow down your editing of a sequence. If 
you are compositing and then change the frame you are monitoring, 
you must wait for the Avid system to render the single frame.

Instead of waiting for the Avid system to finish rendering, you can 
interrupt Render On-the-Fly. Interrupting Render On-the-Fly 
interrupts the rendering of only non-real-time effects.

To interrupt Render On-the-Fly do one of the following:

t Drag the position indicator in the Timeline.

While you are dragging, the sequence appears in the Record 
monitor as it would if Render On-the-Fly were not selected in the 
Special menu.

t If you click in the Timeline and the Avid system begins to render, 
quickly move to another location in the Timeline. This cancels the 
rendering process.

About Effects in 24p or 25p Projects

Since effects in 24p or 25p projects are frame based rather than field 
based, their normal behavior is slightly different from effects in 
interlaced projects. In particular, temporal artifacts might appear in 
some effects under certain circumstances. This section explains when 
temporal artifacts might appear and suggests ways to create effects 
that do not show perceptible temporal artifacts.
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Effects that do not involve any movement across the screen — for 
example, masks, Color Effects, and dissolves — look the same in 24p 
or 25p projects as in interlaced projects.

Effects that involve movement across the screen — for example, wipes, 
3D shapes, or moving titles — might look different from their 
equivalents in interlaced projects for the following reasons:

• Since the effect is created using 24 or 25 progressive frames per 
second (24p or 25p), motion across the screen is interpolated in 24 
or 25 increments per second. (Contrast the 50 increments per 
second for a PAL interlaced project or the 60 increments per 
second for an NTSC interlaced project.) For example, the edge of a 
one-second Horizontal Edge Wipe effect will appear in 24 or 25 
different positions across the screen. For effects of short duration 
in particular, this difference might be perceptible to the viewer.

• When the 24p or 25p media is output (to the interlaced Client 
monitor or as a digital cut), it is re-interlaced and pulldown is 
inserted to achieve 60 fields per second (NTSC). Your Avid system 
inserts pulldown by duplicating some of the existing frames to 
create the correct number of fields per second. Temporal artifacts 
created by this duplication process might be perceptible to the 
viewer. This behavior is a normal result of the pulldown insertion 
process and is often perceptible in conventional transfers of films 
to video formats.

n PAL output with pulldown also duplicates certain frames but is less likely to 
exhibit perceptible temporal artifacts since fewer frames require duplication.

Motion effects created in 24p or 25p projects, such as Variable Speed 
effects, might also look different from motion effects created in 
interlaced projects. For more information on 24p or 25p motion effects, 
see “About Motion Effects in 24p or 25p Projects” on page 88.

n For more information on how your system handles 24p or 25p material, see 
the Avid Media Composer and Film Composer Input and Output Guide.
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If an effect in a 24p or 25p project does not look completely smooth, do 
one or more of the following:

• Slow down the effect. For example, a two-second Horizontal Edge 
Wipe effect, while it is still performing at the same rate (24 
increments per second), moves across the screen in 48 steps. These 
smaller movements make the wipe appear smoother to the viewer.

• Soften the edges of the effect. The more the edges of the effect are 
blurred, the less noticeable the movements between the 
increments of the effect will be.

• When working with moving titles, avoid small font sizes and 
sharp edges. In a moving title such as a roll, lines of small text 
might move less smoothly than lines of larger text.

Using the Effect Palette

The Effect Palette is a window that lists all the effects available on your 
Avid system. The effects that are available on your system depend on 
the model and options that you purchased and on what third-party 
plug-ins you might have installed. For the list of effects available for 
your model, see the release notes for your system.

You select transition and segment effects from the Effect Palette. The 
effects in the Effect Palette are grouped by category:

• Blend

• Box Wipe

• Conceal

• Edge Wipe

• Film

• Image

• Key

• L-Conceal



40

• Matrix Wipe

• Peel

• Push

• Sawtooth Wipe

• Shape Wipe

• Spin

• Squeeze

• Xpress 3D Effect

n If you have effect templates saved in an open bin, or if you have third-party 
plug-in effects installed on your system, additional effect categories appear in 
the Effect Palette.

Each of these effect categories contains multiple effects. Use the 
following procedure to display the Effect Palette.

Displaying the Effect Palette

To display the Effect Palette:

1. Choose Effect Palette from the Tools menu.

You can also display the Effect Palette by pressing Ctrl+8 
(Windows) or k+8 (Macintosh) on your keyboard.

The Effect Palette appears.
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The left side of the Effect Palette displays a scrollable list of effect 
categories. The right side shows the various effects that are 
available for the currently selected effect category.

2. Click an effect category to select it and display effects in the 
category.

n Some effects are available only on certain models. For example, the 3D Warp 
effect is available only on models equipped with 3D effects capability. 

Resizing the Effect Palette

You can resize the Effect Palette to display more effects when a 
particular category includes a long list of icons.

To resize the Effect Palette:

t Click the lower right corner of the palette, drag the palette to the 
size you want, and release the mouse button.

Scrollable list of 
effect categories

Blend effect 
choices
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Understanding the Color Coding

Effect icons in the Effect Palette and in the Timeline display 
color-coded dots to help you determine whether an effect is real-time 
or non-real-time. After opening the Effect Palette, you will notice that:

• Real-time effects are preceded by an orange dot. These effects take 
advantage of fast rendering.

• Real-time effects that might not be playable in real time due to their 
position in a sequence or the options available on your system are 
preceded by a green dot. These effects take advantage of fast 
rendering.

n The Submaster effect has a green dot in the Effect Palette. Other effects might 
show a green dot in the Timeline, based on the complexity of the sequence.

• Non-real-time effects have no dot in the Effect Palette. In the 
Timeline, the effect icon contains a blue dot until the effect is 
rendered.
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n When you edit a non-real-time effect into a sequence, the effect icon appears 
with a blue dot in the Timeline, which indicates that you must render the 
effect to play it in real time. After you render the effect, the effect icon appears 
in the Timeline without a dot.

All color-coded dots disappear in the Timeline when you render 
effects.

A real-time effect might not be playable in real time for a variety of 
reasons involving the complexity of the sequence and the real-time 
effects capabilities of the Avid editing system. For more information, 
see “About Real-Time and Downstream Key Effects” on page 32.

n For a complete listing of all effects and their real-time playback capabilities, 
see the release notes for your system.

Orange dot 
indicates a 
real-time 
effect.

Green dot 
indicates a 
real-time effect 
that might not 
be playable in 
real time.

No dot (as in Paint Effect above) indicates a non-real-time 
effect; in the Timeline, the effect icon contains a blue dot 
until the effect is rendered.
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Displaying Effect Templates

Effect templates allow you to save the parameters of an effect to a bin 
and use them again to create or modify other effects. See “Using an 
Effect Template” on page 136 to learn more about applying templates.

In addition to allowing you to view all the standard effects, the Effect 
Palette allows you to view and access effect templates that are stored 
in open bins. The names of open bins containing effects appear in a list 
below the effect categories. 

To view the effect template:

1. Open the bin containing the effect templates.

Effect templates
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2. Choose Effect Palette from the Tools menu.

The Effect Palette opens.

3. Click the bin name below the effect category list to view the effect 
templates in the bin. 

For example, in the illustration in step 1, the bin named Effects 
contains a series of effect templates using the Picture-in-Picture, 
Mask, and Superimpose effects.

n In the previous illustration, notice that the Effect Palette also displays other 
effect files, such as titles and matte key clips.

Whenever you open or close a bin or drop an effect into a bin, your 
Avid system automatically updates both lists. Once a template appears 
on the right side of the Effect Palette, you can apply it as you would 
any other effect. 

Effect category 
list

Bin name containing 
effect templates

Effect templates
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Using Third-Party Plug-in Effects

You can use third-party plug-in effects to add new effects to your Avid 
system or to update existing effects. Third-party plug-in effects are 
compatible with the Avid Visual Extensions (AVX™) standard. AVX is 
a cross-platform software architecture designed to allow software 
effect modules to be dynamically linked with a host application such 
as an Avid editing system.

You can purchase these plug-ins directly from a third-party vendor. 
Two of the current AVX plug-in vendors are:

• Ultimatte Corporation (Ultimatte®) 

www.ultimatte.com

• Artel Software (Boris FX™) 

www.borisfx.com or www.artelsoft.com

For a complete, up to date list of AVX plug-in vendors and other 
information on AVX, visit the AVX Web site:

www.avid.com/3rdparty/avx/index.html

After you install third-party plug-ins, the effects appear in the Effect 
Palette in their own category (usually the name of the plug-in vendor). 
Individual effects all have a plug icon. The plug icon also appears in 
the Timeline when you have applied a third-party plug-in effect. After 
you create an effect, you can save it as an effect template and reapply 
the template to other transitions or segments in your sequence. Effect 
templates also appear in a special section at the bottom of the Effect 
Palette.
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n Your Avid system also supports Digidesign® AudioSuite plug-ins. These 
plug-ins apply only to audio clips and do not appear in the Effect Palette. For 
more information, see the chapter “Working with Audio ” in the Avid Media 
Composer and Film Composer Editing Guide.

n If you are transferring from another system a project that includes sequences 
with AVX plug-in effects, you must install matching AVX plug-ins in order 
to see the effects.

AVX Plug-Ins and Memory Usage

Each time you apply an AVX plug-in to a sequence, your Avid system 
keeps the effect resident in memory. When you close the bin 
containing the sequence, the system also closes the AVX plug-ins, 
freeing the memory. If you have applied many plug-ins and you find 
your Avid system running out of memory, use the following 
procedure to free the memory being used by the plug-ins.

To close all the AVX plug-ins:

1. Choose Console from the Tools menu.

2. Type the command closeallavxplugins and press Enter 
(Windows) or Return (Macintosh).

The Avid system closes all open AVX plug-ins. The AVX plug-ins 
will automatically open again as needed.

Installing Photoshop-Compatible Plug-in Effects (Macintosh)

Avid Media Composer and Film Composer for the Macintosh 
operating system can use many plug-in effects that are compatible 
with Adobe Photoshop Version 2.5. You purchase these plug-ins 
directly from a third-party vendor.
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To install Photoshop-compatible plug-ins:

1. Exit the Avid application.

c Do not add or remove plug-ins while the Avid application is 
running.

2. Copy the plug-in files from the software vendor’s folder to the 3rd 
Party Plug-Ins folder located on your Avid drive.

The following illustration shows the location of the 3rd Party 
Plug-Ins folder within the Avid file structure.

3. Restart the Avid application and open the Effect Palette. The 
plug-in effects will appear in the Effect Palette, usually in their 
own effect category.

c You must place the plug-ins directly in the 3rd Party Plug-Ins folder. 
They cannot be inside another folder within this folder or elsewhere 
on the Avid system. If they are, the system will not recognize them.
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Installing AVX Plug-Ins

AVX plug-ins usually come complete with any necessary 
documentation. This section describes how to install the plug-ins and 
how to access them from your Avid system.

Most AVX plug-ins have their own installation program. This program 
locates the AVX_Plug-Ins folder and installs the plug-ins 
automatically when you follow the installation instructions.

c If an AVX plug-in has an installation program, you should always 
use the program to install the plug-ins. For more information, see 
the documentation for the plug-in.

Some AVX plug-ins do not have an installation program and must be 
installed manually.

To install AVX plug-ins manually:

1. Exit the Avid application.

c Do not add or remove plug-ins while the Avid application is 
running.

2. Copy the plug-in files from the software vendor’s folder to the 
AVX_Plug-Ins folder located on your Avid system.

c You must place the plug-ins directly in the AVX_Plug-Ins folder. 
They cannot be inside another folder within this folder or elsewhere 
on the Avid system. If they are, the system will not recognize them.

t (Windows) The default location for the AVX_Plug-Ins folder 
is:

C:\Program Files\Avid\AVX_Plug-Ins

However, the AVX_Plug-Ins folder might be in a different 
location on your system.
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n If the AVX_Plug-Ins folder does not appear in the default location and you do 
not know where it is located, you can locate the folder by using the Regedit 
application that comes with your Windows NT® system. For more 
information, see “Locating the AVX_Plug-Ins Folder (Windows)” on 
page 51.

t (Macintosh) The following illustration shows the location of 
the AVX_Plug-Ins folder within the Avid file structure.

3. Restart the Avid application and open the Effect Palette. 

The AVX plug-in effects will appear in the Effect Palette, usually in 
their own category under the name of the vendor.

n (Windows only) If the plug-in effects do not appear in the Effect Palette after 
installation, see “Troubleshooting AVX Plug-Ins” on page 56.
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Locating the AVX_Plug-Ins Folder (Windows)

When the Avid application is first installed, the system asks the 
administrator to choose a location for the AVX_Plug-Ins folder. The 
default path is:

C:\Program Files\Avid\AVX_Plug-Ins

If the administrator accepts the default location for the AVX_Plug-Ins 
folder, you can install AVX plug-ins here.

If the AVX_Plug-Ins folder is not in the default location, or if the effects 
are not appearing in the Effect Palette after you install them, you can 
use the Regedit application that comes with your Windows NT system 
to locate the AVX_Plug-Ins folder.

c Use the following procedure only to obtain information on the 
location of the AVX_Plug-Ins folder. Do not change any of the 
information in the Windows® Registry. Changing values in the 
Windows Registry might affect the performance of your system.

To locate the AVX_Plug-Ins folder by using Regedit:

1. Click the Start button, and then click Run.

2. Type regedit in the command line and click OK.

The Registry Editor window opens.

3. In the left pane of the window, navigate to the following path:

HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\AVX Plug-Ins

4. Click the AVX Plug-Ins folder in the left pane, and then check the 
entry for “Directory” in the right pane.

The value of this entry is the path that contains the AVX_Plug-Ins 
folder. For example, if the AVX_Plug-Ins folder is in its default 
location, the Directory entry will be “C:\Program Files\Avid.” If 
you navigate to C:\Program Files\Avid by using My Computer or 
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the Windows NT Explorer, you will find the AVX_Plug-Ins folder 
in that location.

n Remember that AVX plug-ins must be installed in the AVX_Plug-Ins folder 
itself, not elsewhere in the path that contains that folder. If AVX plug-ins are 
not in the folder, the system will not recognize them.

Upgrading AVX Plug-ins and Effects

You can upgrade an AVX plug-in simply by de-installing the old 
version of the plug-in and installing the new version in your 
AVX_Plug-Ins folder.

Once you have installed a new version of an AVX plug-in, your Avid 
system upgrades existing effects in sequences to be compatible with 
the new version. The existing parameter values for the effect appear in 
the Effect Editor or in the plug-in’s own user interface.

HKEY_LOCAL_MACHINE\SOFTWARE\
Avid Technology\AVX Plug-Ins

Directory entry. The path listed here is the path 
that contains the AVX_Plug-Ins folder.
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If the new version of the plug-in has new or redesigned parameter 
controls, your Avid system sets these controls to their default settings 
for existing effects. Controls that are unchanged from the older version 
of the plug-in retain the values previously set by the user when the 
system upgrades existing effects.

c Once a plug-in effect or transition has been upgraded, you should 
not reinstall the older version of the plug-in. The Avid editing 
system cannot use an older version of a plug-in to process effects 
that have been created with a newer version. Similarly, if you 
transfer projects between systems, an effect created with a newer 
version of a plug-in will not work on a system that has an older 
version installed.

Assigning Multiple Tracks in Plug-in Effects

Some plug-in effects take an arbitrary number of tracks as input. Your 
system allows you to choose the number of video inputs from the AVX 
Optional Inputs dialog box.

n For more information on the multiple track capabilities of a plug-in, 
see the documentation for that plug-in.

To assign multiple tracks to a plug-in effect by using the AVX 
Optional Inputs dialog box:

1. Drag the plug-in icon to the Timeline.

2. If the AVX Optional Inputs dialog box appears, select the number 
of video inputs you want from the Number of Tracks pop-up 
menu, and then click OK.
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For more information on nested effects, see “Nesting Effects” on 
page 206.

Using AVX Plug-in Controls

This section provides general guidance for controlling and adjusting 
AVX plug-in effects. For more information on the adjustments 
available for a specific effect, see the documentation for the plug-in.

AVX plug-ins use a variety of interfaces that give you control over the 
effects. Plug-in vendors have the following styles for controls:

• The Avid system-style Effect Editor only. The Effect Editor for a 
specific plug-in might include only Avid standard buttons and 
parameter controls, or it might include additional custom controls.

• Custom dialog box only. In this case, when you click the Effect 
Mode button, the Effect Editor is empty except for the Other 
Options button in the upper left corner. Click the Other Options 
button to see the additional dialog box.

• Direct manipulation controls in the Effect Preview monitor. In this 
case, when you click the Outline/Path button in the Effect Editor, 
custom controls appear over the image in the monitor.
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Accessing an AVX Custom Interface

If an AVX plug-in has a custom interface, you access that interface 
from the Effect Editor.

To access an AVX plug-in’s custom interface:

t Click the Other Options button in the Effect Editor.

The AVX plug-in’s custom interface appears.

n Dialog boxes that appear as part of an AVX plug-in’s custom interface are 
modal dialog boxes. If you move one of these dialog boxes, the screen behind 
the dialog box will not redraw. To restore your screen, close the dialog box.

Custom AVX Controls in the Effect Editor

This section introduces some of the custom controls that might appear 
in the Effect Editor for an AVX plug-in effect. For more information on 
using these controls, and other controls specific to individual effects, 
see the documentation for the plug-in.

Some plug-in effects allow you to adjust an image by using controls 
that appear as overlays, such as handles and wire frames, in the Effect 
Preview monitor. You access these overlays by clicking the 
Outline/Path button at the bottom of the Effect Editor. In some cases, 
you can then access further controls by clicking buttons on the right 
side of the Effect Editor that are similar to the buttons available in 
standard Avid 3D effects. 

The following Effect Editor parameters, which are not available in 
standard Avid effects, are available to some AVX plug-in effects:

• The Treadmill is a slider that provides a window on a wide range 
of values and allows precise control over increments. 
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• The Angle allows you to manipulate an effect’s angle or direction 
by dragging within a graphic representation of a circle to alter the 
angle or direction value. Values can be positive or negative and are 
not limited to a single 360º rotation.

Troubleshooting AVX Plug-Ins

This section describes problems that you may encounter with AVX 
plug-ins and suggests possible solutions or sources for more 
information. 

Contact the plug-in vendor if a plug-in does not work as expected and 
these suggestions do not solve the problem.

• Plug-in does not appear in the Effect Palette

AVX plug-ins have a plug icon in the Effect Palette and in the 
Timeline. If the plug icon does not appear in the Effect Palette after 
installation, the plug-in may be in the wrong folder. See “Locating 
the AVX_Plug-Ins Folder (Windows)” on page 51 for help.

• Plug-in does not load

AVX plug-ins might not load correctly for a variety of reasons. In 
particular, even though it is located correctly in the AVX_Plug-Ins 
folder, a plug-in might require supporting files — for example .dll 
files — that are missing from your system or are installed in the 
wrong location.

If a correctly located plug-in does not load, check the plug-in 
documentation for information on required supporting files.



57

• The Avid system cannot render the plug-in

If the Avid system cannot render the plug-in, the plug-in might 
have expired or the plug-in’s system application key (dongle) 
might be missing or damaged.

Check the Console window if you have problems rendering a 
plug-in effect. Some plug-ins write more information about the 
failure to the Console window. Also, some plug-ins might report 
the problem as a message in the Bin or Edit monitor. 

• Blank effect icons in the Timeline

AVX plug-ins have a plug icon in the Effect Palette and in the 
Timeline. If the effect icon in the Timeline is blank, the Avid 
system could not find the plug-in.

To identify the plug-in that is missing or misplaced, open the 
Console window (choose Console from the Tools menu) and look 
for the message “Can’t find effect.” The message will identify the 
plug-in that cannot be located. You can then reinstall the plug-in in 
your AVX_Plug-Ins folder and restart the Avid application.

• Missing effect categories in the Effect Palette

If plug-in effect categories are not visible in the Effect Palette, 
either they are not installed correctly or you might have an 
incorrect version of the AVXLibrary. Check the Console window 
for a message that states that AVX was disabled. 

- If AVX was not disabled, quit the Avid application, reinstall 
the plug-ins, and restart the application. 

- If AVX was disabled, call Avid Customer Support to 
determine whether you need a new version of the 
AVXLibrary.

• The Avid system is running out of free memory

Each time you apply an AVX plug-in to a sequence, your Avid 
system keeps the effect resident in memory. When you close the 
bin containing the sequence, the system also closes the AVX 
plug-ins, freeing the memory. To close the AVX plug-ins, see “AVX 
Plug-Ins and Memory Usage” on page 47.
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Changing Timeline View Settings for Effects

All effect icons are displayed in the Timeline by default. You can 
change the Timeline settings to display all effect icons, all effect icons 
except Dissolve Effect icons, or no effect icons. If you have changed the 
setting to display no effect icons, you have to reset it before you begin 
applying effects. The fewer effect icons you display, the faster your 
Avid system refreshes the screen.

To change the Timeline settings:

t Click the Fast Menu button in the Timeline window.

The Timeline Settings Fast menu appears.

• To display all effect icons in the Timeline, choose Effect Icons.

• To display all effect icons except Dissolve icons, choose Effect 
Icons and deselect Dissolve Icons.

• To display no effect icons, deselect Effect Icons. Dissolve Icons 
appears dimmed and is now unavailable.

• To save your Timeline settings, click the Timeline View Name 
button, select Save As, and type a view name.
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Adjusting Trim Settings for Effects

When you are in Trim mode, you can control whether or not the effects 
you apply are computed immediately on the screen (that is, on-the-fly) 
or appear later when you render them. For example, viewing 
transitions as cuts (without rendering on-the-fly) can facilitate the 
trimming process. This setting is defined in the Trim Settings dialog 
box.

To change the Trim settings for render on-the-fly:

1. Double-click Trim in the Settings scroll list of the Project window.

The Trim Settings dialog box appears.

2. Click the Features tab, and then select or deselect Render 
On-The-Fly.

Timeline View Name button
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n For information on changing the Trim settings, see “Working in Trim Mode” 
in the Avid Media Composer and Film Composer Editing Guide.

Use Render On-the-Fly to 
determine when the Avid 
system computes effects.
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CHAPTER 2

Basics of Effects Editing

This chapter explains how to create basic transition and single-layer 
segment effects, including motion effects.

• Deconstructing Effects

• Applying Effects to a Sequence

• About Deleting Effects in a Sequence

• Using the Fade Effect Button

• Working with Transition Effects

• Creating Motion Effects

Deconstructing Effects

One good way to understand how effects are built in your Avid 
editing system is to break down existing effects into their basic 
elements. By learning how the various pieces fit together, and how the 
system allows you to manipulate them, you can begin to construct 
new effects from these building blocks.

The sequence depicted in the following screen image contains a series 
of effects that cover all the basic techniques — from simple dissolves to 
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3D nested layers — described throughout Chapters 2, 3, 4, and 5 of this 
guide.

n You can double-click the image below to view the entire sequence in the .pdf 
version of this guide, available on the Avid Media Composer and Film 
Composer Online Publications CD-ROM.

The Timeline for this sequence, shown below, includes both transition 
and segment effects applied horizontally, vertically, and nested within 
video tracks. The callouts summarize deconstructed elements and list 
the sections of this guide that describe them in more detail.

Imported title elements 
set in motion with a 3D 
wipe effect

Layered background 
elements

Layered foreground 
elements
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Dissolve sequence forms the foreground on V2:
See “Applying an Effect to Multiple Transitions” on page 66
and “Working with Transition Effects” on page 72 .

Nested segments 
add more layers 
to the foreground 
track:
See “Nesting 
Effects” on 
page 206 .

Submaster segment, created from collapsed 
layers, forms the background on V1:
See “Submaster Editing” on page 213 .

Title graphics imported as Matte Key effects:
See “Working with Imported Graphics and Anima -
tion” on page 182 .

Effect template applied repeatedly to crop 
and position foreground images on V2:
See “Creating a Cropped Foreground 
Effect” on page 247 .

Keyed titles are faded in and out:
See “Using the Fade Effect Button” on page 71 .

Various effect parameters are adjusted throughout 
to soften, distort, or position images:
See “Using the Effect Editor” on page 117 .

Deconstructing an effects sequence

Imported graphic promoted to a 3D Slat Wipe:
See “Using Matte Keys with 3D Effects” on page 225 .

Titles “stamped” in place with 3D Warp:
See “Creating a Stamp” on page 253 .
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Applying Effects to a Sequence

This section explains how to apply an effect to a sequence in the 
Timeline. You can apply an effect to:

• One transition or segment on a single video layer

• Multiple transitions or segments on a single video layer

• Multiple transitions or segments on multiple video layers

The effect type (transition or segment) determines where you can 
place the effect in the sequence. For an explanation of the effect types, 
see “About Effect Types” on page 29.

After you apply an effect, the next step is to adjust the effect’s 
parameters. To understand how to adjust the effect parameters, see 
“Changing a Parameter” on page 123.

Applying an Effect to a Single Transition or Segment

Use the following procedures to apply an effect to one transition or 
segment on a single video layer.

To apply an effect to a single transition or segment:

For information about 
editing a sequence, see 
the editing guide for 
your Avid system.

1. Create a sequence in the Record monitor by using standard Avid 
editing procedures. 

2. Choose Effect Palette from the Tools menu.

For an explanation of the Effect Palette, see “About Effect Types” 
on page 29.
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3. To apply an effect, do one of the following:

t Click the effect icon in the Effect Palette, drag it to the segment 
or transition in the Timeline, and release the mouse button.

t In Effect mode, click the transition or segment in the Timeline 
where you want to apply the effect, and double-click the 
effect’s icon in the Effect Palette.

The effect icon appears in the Timeline, as shown in the following 
example.

n If the effect is a segment effect, one segment at a time is highlighted as you 
drag the effect within the Timeline. If the effect is a transition effect, one 
transition at a time is highlighted as you drag the effect within the Timeline. 
Some effects can be both a transition and a segment effect; when you drag an 
effect within the Timeline, both transitions and segments are highlighted.
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Applying an Effect to Multiple Transitions

To apply an effect to multiple transitions:

1. Click the Effect Mode button to enter Effect mode.

2. Click the first or last transition to which you would like to apply 
the effect.

3. Click above the Timeline and begin dragging to activate a selection 
box. Continue to drag down and either to the left or right to 
include additional transitions in the selection.

4. Release the mouse button when you have lassoed all the 
transitions you want.

The Avid system highlights the transitions that you selected, and 
the position indicator moves to the first transition.

5. If the transitions where you want to apply the effect are not 
contiguous, Shift+click any transition to deselect it.

Cursor selection box
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6. Open the Effect Palette and double-click the effect’s icon that you 
want to apply to the transitions.

The Avid system applies the effect to the highlighted transitions in 
the Timeline.

If there is not enough incoming or outgoing media to apply the 
transition effect, a dialog box appears. For more information, see 
“Sizing the Effect to Fit the Media” on page 81.

n You can also apply the effects available in the Quick Dissolve dialog box to 
multiple transitions by marking IN and OUT points. For more information, 
see “Using the Add Dissolve Button to Apply Effects to Multiple 
Transitions” on page 78.

Applying an Effect to Multiple Segments

You can apply an effect to multiple segments on the same video layer 
or on multiple video layers in a single step. The following procedure 
describes selecting multiple segments in the same video layer. You can 
also use this procedure to select segments on multiple layers.

To apply an effect to multiple segments on the same video layer:

1. In Source/Record mode or Effect mode, click above the Timeline 
and to the left of the leftmost segment that you want to select and 
begin dragging to the right and down to activate a selection box.

2. Continue to drag the selection box to the right until you lasso the 
rightmost segment that you want to select.
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3. Release the mouse button.

The segments that you selected are highlighted.

4. If the segments where you want to apply the effect are not 
contiguous, Shift+click a segment to deselect it.

5. Open the Effect Palette and double-click the effect’s icon that you 
want to apply to the segments.

The effect is applied to the highlighted segments in the Timeline.

About Deleting Effects in a Sequence

Transition effects can be deleted from a sequence in Source/Record 
mode, Trim mode, or Effect mode. Segment effects can be deleted in 
Source/Record mode or Effect mode. Use the following procedures to 

Cursor selection box
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either delete a single effect from a sequence or delete effects in 
multiple segments.

Deleting a Single Effect

To delete a single effect:

1. Move the position indicator to the Timeline segment containing 
the effect’s icon.

2. If there are multiple tracks that contain effects at the same position 
in the Timeline, select only the track where the effect to be deleted 
resides.

In this example, only track V1 is selected.

c If you are deleting a segment effect and the segment contains a 
transition effect, the transition effect will be deleted also, because 
the transition effect resides “on top of” the segment effect. If 
necessary, you will have to reapply the transition effect.

3. Use one of the following methods to delete the effect:

t If the Effect Editor is not active, click the Remove Effect 
button.

t When the Effect Editor is active, select the effect and press the 
Delete key.

t In Trim mode (for transition effects only), either press the 
Delete key or click the Remove Effect button.

Record Track button



70

n When you delete an effect from a sequence, the associated media file is not 
deleted. In order to delete the effect’s media file, you must manually remove it 
from the drive. Your Avid editing system operates this way so that you will be 
able to undo the deletion of an effect or undo the change you made to an effect. 
To delete an effect’s media file, see “Managing Effect Media Files” on 
page 165.

Deleting Multiple Transition Effects

To delete multiple transition effects:

1. Shift+click each of the transition effects you want to delete. 

2. Click the Remove Effect button, or press the Delete key.

Deleting Multiple Segment Effects

To delete multiple segment effects:

1. Click one of the Segment Mode buttons below the Timeline.

2. Shift+click each segment that contains a segment effect to be 
deleted.

3. Click the Remove Effect button, or press the Delete key.

The effect is removed.
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Using the Fade Effect Button

You can use the Fade Effect button to fade segment effects quickly and 
easily. A dialog box appears that allows you to enter the number of 
frames to fade up and fade down.

The Fade Effect feature automatically creates keyframes for the effect. 
You can access the keyframes in the Effect Editor.

To fade one or more segment effects in a sequence:

1. Select the segment effects in the Timeline:

t To fade a single segment effect, move the position indicator to 
the segment.

t To fade multiple segment effects, click either the 
Extract/Splice-in button or the Lift/Overwrite button below 
the Timeline; then Shift+click the segments.

2. Click the Fade Effect button.

n You can map the Fade Effect button to the Record monitor, the Tool palette, or 
the keyboard. For more information on mapping buttons, see the Avid Media 
Composer and Film Composer Editing Guide.

3. In the Fade Effect dialog box, type the number of frames to fade 
up and fade down, and click OK.
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You can immediately view the Fade effect by playing the segment 
or segments.

Working with Transition Effects

You apply a transition effect to the cut point between two clips on the 
same video track. You can adjust the alignment and duration of a 
transition effect. Depending on the specific effect, other effect 
parameters might also be available.

Types of Transition Effects

Transition effects are included in all effect categories on the Effect 
Palette, except the Image effect category. For an explanation of the 
transition effects in each effect category, see Chapter 9, “2D Effects 
Reference,” and Chapter 10, “3D Effects Reference.”

Applying a Dissolve Effect

One of the most common transition effects is a dissolve. Your Avid 
editing system has three methods you can use to apply the Dissolve 
effect:

• Select the Dissolve effect from the Effect Palette.

• Type a duration in the Transition parameters in Trim mode or in 
the Effect Editor.

• Click the Add Dissolve button.

The following sections describe each of these methods.
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Using the Effect Palette

To apply a Dissolve effect by using the Effect Palette:

1. Create a sequence in the Record monitor by using the standard 
Avid editing procedures. For information about editing a 
sequence, see the Avid Media Composer and Film Composer Editing 
Guide.

2. Choose Effect Palette from the Tools menu.

3. Click the Blend category.

4. Drag the Dissolve Effect icon to the transition in the Timeline, and 
release the mouse button.

The Dissolve Effect icon appears in the Timeline.

When there is not enough incoming or outgoing media to apply a 
transition effect, a dialog box appears. See “Sizing the Effect to Fit the 
Media” on page 81.

Using the Transition Parameters

You can create a Dissolve effect using the Transition parameters 
displayed in Trim mode and in the Effect Editor. Simply enter the 
duration for which the effect will play, and the system adds the 
Dissolve effect to the sequence.

To create a Dissolve effect by using the Transition parameters:

1. Click a transition in the Timeline while in Trim mode or Effect 
mode.

2. In the Transition Effect Duration box in the Effect Editor, type the 
dissolve’s duration. 

n The duration format is determined by the Duration setting above the Record 
monitor — for example, seconds:frames.
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The system adds the Dissolve effect at the transition, and a 
Dissolve Effect icon appears in the Timeline.

3. Click the Transition Effect Alignment button, and select the effect’s 
position relative to the cut point from the pop-up menu.

For an explanation of the Transition Effect Alignment menu 
selections, see “Transition Parameters” on page 511.

Using the Add Dissolve Button

Another way to create a transition effect is to click the Add Dissolve 
button. This button allows you to apply a Dissolve effect or any other 
transition effect listed below without having to access the Effect 
Palette:

• Dissolve

• Film Dissolve (optional on some models)

• Film Fade (optional on some models)

• Fade to Color

• Fade from Color

• Dip to Color

n If you have IN and OUT points marked in your sequence, you can choose to 
add the same Dissolve effect to multiple transitions. When you click the Add 
Dissolve button, the Quick Dissolve dialog box will contain a check box for 
Apply to All Transitions (IN -> OUT). See “Using the Add Dissolve 
Button to Apply Effects to Multiple Transitions” on page 78.

Transition effect alignment but-
ton

Transition effect alignment
pop-up menu

Transition effect duration box
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To create an effect by using the Add Dissolve button:

1. Move the position indicator to the transition in the Timeline.

2. Click the Add Dissolve button in the Tool palette.

The Quick Dissolve dialog box appears.

The dialog box shows a graphic representation of the outgoing 
media (A) and incoming media (B), with the Dissolve Effect icon 
applied to the transition. 

The system scales the graphic to show the relative size of the 
Dissolve effect and the media available for the effect. 

Below the graphic on the left is the number of frames of incoming 
media (B) available before the cut, and on the right is the number 
of frames of outgoing media (A) available after the cut.

3. Customize the effect using either the menu choices or the graphic 
of the Dissolve Effect icon. When you click and drag on the 
Dissolve Effect icon, the cursor changes to a hand and three 
alignment buttons appear below the graphic.

Outgoing media

Frames of incoming 
media available for the 
effect

Incoming media

Frames of out-
going media 
available for the 
effect

Dissolve Effect 
icon
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4. Choose a transition effect from the Add pop-up menu.

For an explanation of individual effects shown in the menu, see 
Chapter 9, “2D Effects Reference.”

n When you save a Dissolve effect template into a bin named Quick Dissolves, 
the effect template appears on the Add pop-up menu. See “Using an Effect 
Template” on page 136.

n When you choose a color transition with Add Dissolve, the default color is 
black. You must enter Effect mode to choose another color. For more 
information, see “Using the Effect Editor” on page 117.

5. Select the transition duration by doing one of the following:

t Type the duration in frames into the Duration text box.

t Click and drag on either the left or right edge of the Dissolve 
Effect icon to change the duration.

Ending at Cut
Centered on Cut

Starting at Cut
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The graphic changes — the size of the effect icon gets smaller or 
larger, and the numbers in the Duration and Start text boxes 
change — to reflect the new duration.

6. Choose the effect’s alignment relative to the cut point in one of the 
following ways:

t Choose an alignment from the Position pop-up menu.

t Click and drag on the inside of the Dissolve Effect icon to 
position the effect with respect to the cut point.

t Click one of the alignment buttons below the graphic.

The system positions the effect.

If you select an alignment for which there is not enough media, the 
system comes as close as it can to the alignment you requested.

7. If you click and drag on the Dissolve Effect icon, the Position 
pop-up menu changes to Custom. Indicate where the effect is to 
start — that is, how many frames before the cut you want to 
include in the Dissolve. Do one of the following:

t Click near the middle of the Dissolve Effect icon and drag to 
dynamically change the number of frames.

t Click one of the buttons below the graphic to specify the effect 
as ending at cut, centered on cut, or starting at cut.

t Type the number of frames in the Start text box.

The graphic changes to show the relative amount of media 
available and the relative position of the effect, and the new 
value appears in the Start text box.
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8. Click Target Drive, and from the pop-up menu choose a drive on 
which to store the effect if you choose to render it.

The Effect Source Drive is the drive where the media on the 
outgoing shot of a transition resides.

9. If you have IN and OUT points marked in your sequence, the 
Quick Dissolve dialog box contains a check box for Apply to All 
Transitions (IN -> OUT). Select this option to apply the same effect 
to all transitions between the IN and OUT points. Deselect this 
option to apply the effect only to the transition at which you have 
placed the position bar.

10. If the effect you selected is real-time, select Skip Real-time Effects 
to prevent real-time effects from being rendered.

11. Do one of the following:

t To add the effect without rendering it, click Add.

t To add the effect and render it, click Add and Render.

Your Avid system adds the effect to the selected transition in the 
sequence, or, if you selected Apply to All Transitions (IN -> OUT), 
the system adds the effect to all transitions between the IN and 
OUT points.

Using the Add Dissolve Button to Apply Effects to Multiple Transitions

You can select multiple transitions by marking IN and OUT points. 
Then apply an effect from the Quick Dissolve dialog box to all the 
selected transitions at once.

To apply an effect to multiple transitions by using the Add Dissolve 
button:

1. Mark IN and OUT points around the transitions to which you 
want to add the effect.

2. Make sure that the Record Track buttons in the Track Selector 
panel are selected for the tracks to which you want to add the 
effect.
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3. Click the Add Dissolve button. 

The Quick Dissolve dialog box appears.

4. Choose a transition effect from the Add pop-up menu.

For an explanation of individual effects shown in the menu, see 
Chapter 9, “2D Effects Reference.”

Apply to All Transitions option
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n When you choose a color transition with Add Dissolve, the default color is 
black. You must enter Effect mode to choose another color. For more 
information, see “Using the Effect Editor” on page 117.

5. Type the duration of the transition effect in frames.

6. Choose the effect’s alignment relative to the cut point from the 
Position pop-up menu.

7. If you select Custom Start, you must indicate where the effect 
should start — that is, how many frames before the cut. Type the 
number of frames in the Start text box.

8. Click Target Drive, and from the pop-menu choose a drive on 
which to store the effect if you choose to render it.

The Effect Source Drive is the drive where the media on the 
outgoing shot of a transition resides.

9. If the effect you selected is real time, select Don’t Render Real-time 
Effects to prevent real-time effects from being rendered.

10. Select Apply to All Transitions (IN -> OUT).

11. Do one of the following:

t To add the effect without rendering it, click Add.

t To add the effect and render it, click Add and Render.

This adds the selected effect to all the transitions between the 
marked IN and OUT points on the selected tracks in the sequence.

If there is not enough incoming or outgoing media material to apply 
the effect to a transition, a dialog box appears. For more information, 
see “Sizing the Effect to Fit the Media” on page 81.
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Sizing the Effect to Fit the Media

When you select a transition effect from the Effect Palette and there is 
not enough source media to apply the effect, a dialog box appears 
describing whether the source that has insufficient material is Media A 
(outgoing footage) or Media B (incoming footage).

To automatically size the effect to fit the media:

t Click Size To Fit in the dialog box.

The system sets the duration of the effect to fit the available media. 
If you have selected an alignment, the system attempts to 
preserve it.

To change the alignment or duration of the transition effect, see 
“Using the Transition Parameters” on page 73.

Trimming a Transition Effect

You can trim a transition effect by using the standard transition trim 
procedures. For more information, see the chapter “Working in Trim 
Mode” of the Avid Media Composer and Film Composer Editing Guide.

Adjusting Transitions in the Timeline

You can change the duration of Dissolve effects just by dragging them 
in the Timeline. You bring up the Transition Corner Display in Trim 
mode to use this feature.

To adjust a transition using the Transition Corner Display:

1. Click the transition in the Timeline.

2. Enter Trim mode.
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3. Click the Transition Corner Display button.

The button changes to bright green, and the display is enabled. As 
you position the cursor over the transition, it changes to look like a 
film clip that has been cut for a splice.

4. Lengthen or shorten the transition effect by clicking and dragging 
to the length you want.

t To shorten a transition, drag toward the transition point.

t To lengthen a transition, drag away from the transition point.

The cursor changes to a hand that moves as you drag. You can 
adjust either the outgoing or the incoming video.

5. To review your edit, click the Play Loop button.

n To customize transition effect parameters, see “Transition Parameters” on 
page 511.

Creating Motion Effects

A motion effect, applied to a clip in the Source monitor, allows you to 
alter the playback characteristics of the clip. Motion effects include 
Freeze Frame, Variable Speed (such as slow motion or fast motion), 
and Strobe Motion effects. You can also combine Variable Speed and 
Strobe Motion effects in a single clip.

Your Avid editing system creates a motion effect by creating a new clip 
in a bin. You then edit the clip into your sequence by using standard 
editing techniques. 
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Playing and Rendering Motion Effects

Some motion effect clips play in real time when edited into a sequence; 
others must be rendered before they can be played.

Playback capabilities for motion effects depend on the type of effect, 
the options you choose when creating the effect, and how you work 
with the effect after you first create it.

Rendering Considerations When Creating Motion Effects 

Motion effects divide into two basic types -- those that play in real time 
and those that require rendering before they will play. When you first 
create a motion effect that requires rendering, you can render it 
immediately or create an unrendered version that you can render later 
in your workflow.

The Avid system creates motion effects using one of four different 
types -- Duplicated Field, Both Fields, Interpolated Field, and 
VTR-Style. Some of these types enable some motion effects to play in 
real time, while other types always require rendering. You choose 
motion effect types based on the quality you need for the final motion 
effect, the rendering time that each type requires, and the media with 
which you are working (some types are useful only when you are 
working with two-field media).

n For more information on motion effect types, including their relative quality 
and their compatibility with different types of media, see “Motion Effect 
Parameters” on page 499.

The system allows you to preview some kinds of unrendered motion 
effects in real time even if they require rendering for final playback. 
The system cannot preview other kinds of unrendered motion effects; 
these effects will play as filler until they are rendered.Table 2-1 
provides a summary of playback capabilities for motion effects.
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Rendering and Rerendering Existing Motion Effects

In certain situations, you might need to render or rerender existing 
motion effects. To do this, follow one of the procedures described in 
“Rendering Effects” on page 140.

Information about the type and render status of motion effects appears 
in the Timeline in the same form as that used for other effects. Each 
motion effect type has a distinct effect icon, as shown in the following 
table.

Table 2-1 Playback Capabilities of Motion Effects

Effect Playback Capability Preview Capability

Freeze Frame (all types) Real-time Real-time

Variable Speed effects — forward slow motion — 
created by using the Duplicate Field or Both Fields 
type. (Use a value between 0 and 100 in the % speed 
text box of the Motion Effects dialog box.)

Real-time Real-time

Variable Speed effects — forward slow motion — 
created by using the Interpolated Field or VTR-Style 
type. (Use a value between 0 and 100 in the % speed 
text box of the Motion Effects dialog box.)

Non-real-time Play in real time as 
Duplicate Field motion 
effects until rendered

Variable Speed effects — fast motion and reverse 
motion (all types). (Use a value over 100 or a 
negative value in the % speed text box of the Motion 
Effects dialog box.)

Non-real-time Play back as filler 
(black image) until 
rendered

Strobe Motion effects (all types) Non-real-time Play back as filler 
(black image) until 
rendered

Strobe Motion effects combined with Variable Speed 
effects (all types)

Non-real-time Play back as filler 
(black image) until 
rendered



85

Color-coded dots appear on Motion Effect icons to indicate whether 
they require rendering. The following illustration shows several 
typical examples of Motion Effect icons in the Timeline.

On systems that include the ExpertRender™ feature, ExpertRender 
correctly identifies motion effects that require rendering.

When you render existing motion effects, The Avid system checks the 
Motion Effects Render Using option in the active Render setting. If the 
Motion Effects Render Using option is set to Original Preference (the 
default setting), the system makes no change to the type of motion 
effects when it renders them. If the Motion Effects Render Using 
option is set to a specific motion effect type, the system changes all 
motion effects to that type when it renders them. This option is 
particularly important for controlling the look of motion effects when 
you are working with two-field media. 

Duplicated Field Motion Effect icon

Both Fields Motion Effect icon

Interpolated Field Motion Effect icon

VTR-Style Motion Effect icon

Rendered 
VTR-style motion 
effect (no dot)

Unrendered Both Fields 
motion effect (orange dot 
— plays in real time)

Unrendered Interpolated Field 
motion effect (blue dot — 
plays as a Duplicated Field 
motion effect until rendered)
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Whenever the system changes the motion effect type during a 
rendering operation, a message appears in the Console, providing 
information about the change. For more information, see “Creating a 
New Render Setting” on page 142 and “Understanding Motion 
Effect Type Changes” on page 87.

The following is a list of the circumstances in which you might need to 
render or rerender motion effects.

• You need to render any motion effect that requires rendering for 
successful playback if you did not render that effect at the time 
you created it. This kind of effect appears with a blue dot in the 
Timeline until it is rendered.

• You might need to render a motion effect so that it will play 
successfully in a complex sequence even if that effect would not 
normally require rendering. (Motion effects that display a green 
dot in the Timeline might not play back in real time under some 
circumstances.) For more information on the overall real-time 
playback capabilities of your system, see “About Real-Time and 
Downstream Key Effects” on page 32.

• You might need to render or rerender motion effects when you 
edit them into a sequence and perform trims or apply transition 
effects. If an effect that was previously rendered (no colored dot in 
the Timeline) or that previously played in real time (orange dot in 
the Timeline) changes in such a way that it requires rendering, it 
will appear with a blue dot in the Timeline. On systems that 
include the Partial Render feature, only those parts of the Motion 
Effect clip that have been changed by your editing require 
rendering. You can see which parts of the motion effect require 
rendering by using the Render Ranges command in the Timeline 
Fast menu. For more information, see “Some Considerations 
When Using ExpertRender” on page 158.

• You need to rerender motion effects when you redigitize media at 
a different resolution. For example, if you edit a sequence by using 
a single-field resolution and then redigitize at a two-field 
resolution, you will need to rerender all motion effects before they 
will play back correctly. In this circumstance, it is important to 
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manage the quality of the finished effects by using the most 
appropriate Render Settings options. For more information, see 
“Creating and Using Render Settings” on page 142 and 
“Understanding Motion Effect Type Changes” on page 87

Understanding Motion Effect Type Changes

Whenever motion effects in the Timeline are rendered or rerendered, 
the system uses the Motion Effects Render Using option in the active 
Render setting to define the motion effect type for the new versions of 
the motion effects. For example, you might start a project using 
single-field media and the Duplicated Field type for motion effects. 
Later, you might redigitize the media at a two-field resolution, set the 
Motion Effects Render Using option in the active Render setting to 
VTR-Style, and submit the whole sequence for rendering. By doing 
this, you create new motion effects that are higher quality and that can 
play with the two-field media.

n Changes to motion effect types are permanent changes to both the Motion 
Effect clip and its associated media. You can only return to the old motion 
effect type only by rerendering. To avoid unnecessary rerendering, make sure 
that the Motion Effects Render Using option in the active Render setting is 
set to the motion effect type you need.

The system writes a message in the Console whenever it changes the 
type of a motion effect during rendering. You can check these 
messages to verify the changes that the system has made to your 
motion effects. Motion Effect icons in the Timeline also change to 
reflect the new motion effect type.
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To display Console information about motion effect type changes in 
the Console:

1. Choose Console from the Tools menu.

The Console opens.

2. Render one or more motion effects by using one of the procedures 
described in “Rendering Effects” on page 140.

For each motion effect whose type is changed by rendering, a 
message appears in the Console.

The following illustration shows a typical message. In this 
example, the Motion Effects Render Using option in the active 
Render settings is set to Interpolated Field.

3. (Option) If the new motion effect type is not the one you want, 
change the Motion Effects Render Using option in the active 
Render settings, and then rerender the motion effects.

About Motion Effects in 24p or 25p Projects

Motion effects created in 24p or 25p projects behave somewhat 
differently from the same effects created in interlaced projects. You 
should be aware of the following issues when you are working with 
motion effects in 24p or 25p projects.

• The system always uses complete progressive frames to create 24p 
or 25p motion effects since there are no fields in 24p or 25p 
material. There are no two-field rendering options available in the 



89

Motion Effect dialog box when you are working in a 24p or 25p 
project.

• The system creates motion effects by duplicating or eliminating 
frames to speed up or slow down the motion. Since 24p or 25p 
motion effects use only 24 frames per second, minor stuttering 
might be noticeable if you use speed ratios that are not integer 
values (because unusual patterns of duplication will occur). 
Choose simple ratios such as 2:1 (50%), 3:1 (33%), or 4:1 (25%).

• 24p or 25p motion effects might look slightly different from 
interlaced motion effects because of the way your system handles 
24p or 25p material. For more information, see “About Effects in 
24p or 25p Projects” on page 37.

Creating a Freeze Frame

A Freeze Frame effect is a still image, based on a chosen frame from a 
clip, that continues to display for the duration that you choose. When 
combined with the original clip, the footage plays and then “freezes” 
and holds on the frame that you specified.

To create a Freeze Frame effect:

1. Load a clip into the Source monitor.

2. Cue the clip to the frame that you want to freeze.

3. Choose Freeze Frame from the Clip menu.

A pop-up menu appears.
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4. If you are using two-field or uncompressed media, choose Freeze 
Frame from the Clip menu and choose an option from the Two 
Field Freeze Frames pop-up menu:

t Using Duplicated Field — The Avid system creates the effect 
using a single field. While this reduces reduces the vertical 
resolution of the image by one-half, it is often the best option if 
the source footage contains rapid motion.

t Using Both Fields — The Avid system uses both fields to 
create the effect. This option is especially useful when there is 
little or no motion in the footage since it preserves all vertical 
resolution.

t Using Interpolated Field — The Avid system creates a second 
field for the effect by combining scan line pairs from the first 
field in the original media. This might result in a slightly softer 
look to the freeze frame.
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n For more information on these options, see “Motion Effect Parameters” on 
page 499.

The chosen option becomes the default until you choose another 
option.

5. Choose Freeze Frame from the Clip menu and choose a duration:

t Choose a preconfigured duration from the list.

t Choose Other and type a custom duration in the dialog box; 
then click OK to enter the new duration.

A dialog box appears, prompting you to choose a target drive for 
the freeze frame media.

6. Choose a drive from the pop-up menu and click OK.

A new clip appears in the Source monitor and in the current bin 
preceded by a Motion Effect icon. The new clip has the original 
clip name followed by the letters FF.

Creating a Rolling Clip That Freezes

One common use for freeze frames is to create a segment that plays 
normally and then freezes, either to superimpose text information or 
to add emphasis to the end of a sequence before fading.
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To create a rolling clip that freezes:

1. Edit the clip into the sequence.

2. Mark an IN point in the sequence at the frame where you want the 
freeze frame to occur.

3. Click the Match Frame button to load and cue the source clip to 
the matching frame.

4. Create the Freeze Frame effect from the source footage as 
described in “Creating a Freeze Frame” on page 89.

5. Click the Splice-in or Overwrite button to edit the freeze frame 
into the sequence at the previously marked IN point.

When you play the sequence, the footage plays full-motion and then 
freezes at the chosen frame.

Creating a Variable Speed Effect

Variable Speed effects involve changing the rate of playback to achieve 
fast-motion or slow-motion effects. The Avid system creates 
slow-motion effects by duplicating frames in the original media. It 
creates fast-motion effects by eliminating frames from the original 
media.

To create a Variable Speed effect:

1. (Option) If you require a fixed duration for the clip based on a 
segment in the sequence, mark the segment in the Timeline with 
IN and OUT points.

2. (Option) If you want to use only part of the source clip for the 
motion effect, mark IN and OUT points in the Source monitor.

3. Click the Motion Effect button.
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n The Motion Effect button does not appear on the interface by default. You can 
map the Motion Effect Button from the Command palette to the button 
palettes on the interface or to the keyboard. For more information, see the 
Avid Media Composer and Film Composer Editing Guide.

The Motion Effect dialog box appears.

4. Select the Variable Speed option.

These options 
are available for 
two-field media in 
interlaced 
projects only.

Variable Speed 
option 
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5. Specify the play speed for the Variable Speed motion effect in one 
of the following ways: 

t Type a number of frames in the frames text box.

t Type a frame rate in the FPS text box. To indicate reverse 
motion, enter a negative number for the play rate.

t Type a percentage of the current play rate in the % speed text 
box. To indicate reverse motion, enter a negative number for 
the percentage.

t Select the Fit To Fill option to automatically set the Variable 
Speed parameters so that the duration of the motion effect will 
match the IN to OUT duration marked in the Record monitor.

When one of these is set, all values change to reflect the specified 
play rate.

6. (Option) If you are using two-field or uncompressed interlaced 
media, select one of the Render 2-Field Motion Effect options:

t Duplicated Field — A single field is displayed in the effect.

t Both Fields — Both fields are displayed in the effect.

t Interpolated Field — A second field is created for the effect by 
combining scan line pairs from the first field in the original 
media. The interpolation causes a slight softening of the final 
image.

t VTR-Style — The Avid system creates a second field for the 
effect by shifting selected video fields of the original media by 
a full scan line. This technique is similar to that used by 
high-quality professional video decks when playing footage at 
less than normal speed.

n For more information on these options, see “Motion Effect Parameters” on 
page 499.
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7. (Option) If you are using two-field media, and a specific motion 
effect type is set as the Motion Effects Render Using option in the 
active Render setting, the system automatically selects that type in 
the Motion Effect dialog box, makes all other types unavailable, 
and displays the Ignore Render Setting checkbox. If you want to 
override the Render setting, click the Ignore Render Setting 
checkbox, and then select one of the four options described in step 
6.

8. Complete the effect by doing one of the following:

t Click Create to create the new clip and close the dialog box. 
Another dialog box asks you to choose the target bin for the 
effect.

t Click Create and Render to render the clip — creating new 
media files — and close the dialog box. Another dialog box 
asks you to choose the target bin for the effect.

n If the effect must be rendered, the Create button is unavailable. Click the 
Create and Render button to create and render the effect.

A new clip is created in the Source monitor and in the current bin. 
The clip has the original clip name followed by the frame rate in 
parentheses. You can then edit this clip into your sequence as you 
would any other clip.
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Creating a Strobe Motion Effect

Strobe motion results in a stuttering effect during playback of a clip. 
You determine the degree of the “stutter” or strobe when you create 
the effect.

n You can also combine the Strobe Motion effect with the Variable Speed effect. 
For more information on the Variable Speed effect, see “Creating a Variable 
Speed Effect” on page 92.

To create a Strobe Motion effect:

1. (Option) If you want to use only part of the source clip for the 
effect, mark IN and OUT points in the Source monitor.

2. Click the Motion Effect button.

n The Motion Effect button does not appear on the interface by default. You can 
map the Motion Effect button from the Command palette to the button 
palettes on the interface or to the keyboard. For more information, see the 
Avid Media Composer and Film Composer Editing Guide.

The Motion Effect dialog box appears. 
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3. Select the Strobe Motion option.

4. Specify the update rate in frames for the Strobe Motion effect. For 
example, a rate of 5 causes every fifth frame to be held for five 
frames before updating in the Strobe Motion effect. 

5. (Option) If you are using two-field or uncompressed interlaced 
media, select one of the Render 2-Field Motion Effect options:

t Duplicated Field — A single field is displayed in the effect.

t Both Fields — Both fields are displayed in the effect.

t Interpolated Field — A second field is created for the effect by 
combining scan line pairs from the first field in the original 

Strobe Motion 
option 

These options 
are available for 
two-field media in 
interlaced 
projects only.
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media. The interpolation causes a slight softening of the final 
image.

t VTR-Style — The Avid system creates a second field for the 
effect by shifting selected video fields of the original media by 
a full scan line. This technique is similar to that used by 
high-quality professional video decks when playing footage at 
less than normal speed.

n For more information on these options, see “Motion Effect Parameters” on 
page 499.

6. (Option) If you are using two-field media, and a specific motion 
effect type is set as the Motion Effects Render Using option in the 
active Render setting, the system automatically selects that type in 
the Motion Effect dialog box, makes all other types unavailable, 
and displays the Ignore Render Setting checkbox. If you want to 
override the Render setting, click the Ignore Render Setting 
checkbox, and then select one of the four options described in 
step 5.

7. Click Create and Render to render the clip and close the dialog 
box.

n You must render a Strobe Motion effect in order to play it back in real time.

A new clip appears in the Source monitor and in the current bin 
preceded by a Motion Effect icon. The new clip has the original 
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clip name followed by the word Strobe and the number of update 
frames in parentheses.
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CHAPTER 3

Customizing Effects in 
Effect Mode

After you have created an effect and applied it to a transition or 
segment in your sequence, you can adjust its appearance and 
operation by changing its effect parameters in Effect mode. This 
chapter explains how to use the Effect Preview monitor and the Effect 
Editor to adjust effect parameters.

• Entering Effect Mode

• Customizing the Effect Mode Display

• Navigating in Effect Mode

• Using the Effect Editor

• Using Keyframes

• Defining a Motion Path

• Using an Effect Template

• Playing an Effect

• Rendering Effects

• Saving a Partially Completed Render
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• ExpertRender

• Managing Effect Media Files

Entering Effect Mode

After you add an effect to a sequence, you must enter Effect mode to 
change the parameters of the effect. Entering Effect mode transforms 
the Record monitor into the Effect Preview monitor and opens the 
Effect Editor. 

To enter Effect mode:

1. Move the position indicator to the effect’s icon in the Timeline.

2. Click the Effect Mode button. 

The Record monitor is transformed into the Effect Preview 
monitor, and the Effect Editor opens. 

Effect Editor

Effect Preview 
Monitor
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Customizing the Effect Mode Display

You can adjust the appearance and functionality of various aspects of 
Effect mode by resizing windows, mapping buttons, displaying 
tracking information, or displaying a variety of grids to provide 
guidelines, as described in this section.

Understanding the Effect Preview Monitor

The Effect Preview monitor displays the selected effect in the sequence 
where the position indicator is located in the Timeline. The effect’s 
position bar, located directly below the Effect Preview monitor, 
represents only the selected effect, not the entire sequence.

Length of effect
Current position in effectPress and hold mouse button

for tracking information.

Effect’s position

Effect’s position
indicator

Effect Preview

bar

monitor

Keyframe

Pop-up scale 
bar for expanding 
the position bar
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n If the effect you expect does not appear in the Effect Preview monitor, make 
sure that you have selected the Record Track Monitor button in the Track 
Selector panel. If a black frame appears in the Effect Preview monitor, the 
position indicator might be at a location in the Timeline where an effect has 
not been applied to the sequence.

About Big Effect Mode (Windows)

Big Effect mode lets you work on an enlarged Effect Preview Monitor.

To leave Big Effect Mode, click the Effect Mode button, located at the 
bottom of the timeline.

Using Big Effect Mode (Windows)

Once you choose the Effect Editor, if you have a high-resolution 
monitor, you can click the Effect Mode button again to bring up Big 
Effect mode, which offers you a larger Effect Preview monitor.

Big Effect mode provides an enlarged window that makes working 
with effects easier. The Source monitor disappears, and the Effect 
Preview monitor transforms into a larger working space that makes it 
easier to create effects and make changes to them.

n You must be using a high-resolution monitor (a monitor capable of 
1024 x 768 pixel display or greater) as the Edit monitor to enter Big Effect 
mode.

Effect Mode button
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To enable Big Effect mode:

1. In Source/Record mode, click the Source/Record window and 
drag it so that it fills the width of your high-resolution Edit 
monitor.

2. Enter Effect mode by clicking the Effect Mode button. 

3. Click the Effect Mode button again.

The Avid system enables Big Effect mode. You can click the Effect 
Editor and drag it to the left of the enlarged Effect Preview 
monitor.

4. To return to normal Effect mode, click the Effect Mode button 
again.

n If you do not return to normal Effect mode, Big Effect mode remains the 
default state when you enter Effect mode in the future.

Mapping User-Selectable Buttons in Effect Mode

You can customize the buttons that are available in Effect mode by 
mapping user-selectable buttons directly from the Command palette 
to the Tool palette or to the area below the Effect Preview monitor.

n When you customize the display of buttons in Effect mode, the new 
configuration appears in Effect mode only. The default editing mode buttons 
reappear when you exit Effect mode.

To remap user-selectable buttons, enter Effect mode and use the 
procedure for mapping buttons from the Command palette described 
in the Avid Media Composer and Film Composer Editing Guide.
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Understanding the Tracking Information

The two boxes above the Effect Preview monitor display the length of 
the effect in seconds and frames and the current position in the effect’s 
position bar. 

If you are working with two-field media, the current position display 
indicates the field that appears in the monitor. The current position 
display ends with .1 for the first field of a frame and with .2 for the 
second field. These boxes replace the name of the sequence that 
appears in this position in the Record monitor. 

n If the position information boxes do not appear above the Effect Preview 
monitor, increase the size of the window.

Displaying the Safe Title and Safe Action Guidelines

Many effects can utilize the outer edges of the viewing screen area. If 
you are editing material that will be viewed on screens with more 
limited viewing areas, such as standard televisions, you can use the 
Safe Title and Safe Action options to provide visual guidelines in the 
Effect Preview monitor that replicate the actual viewable area on a 
standard television screen.

For example, you can use the Safe Title option as a template for the 
area in which you want the effect to operate. In this way, you can 
avoid the appearance of the effect floating off into a nonviewable area 
of a standard television screen.
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To display the Safe Title and Safe Action guidelines in 
Source/Record mode or Effect mode:

t Click the Grid button in the Tool palette or in the Effect Editor.

n You can customize the type of grid displayed by the Grid button. For more 
information, see “Working with the Effect Grid” on page 107.

Two outlined boxes appear in the Effect Preview monitor. The inner 
box is the safe title area. All text and objects should remain within the 
inner box. The outer box is the safe action area for video display.

Safe title area

Safe action area
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Working with the Effect Grid

The Effect Grid provides a variety of ways for you to position effects 
with accuracy and previsualize them in the Effect Preview monitor. 
The grid coordinates can be expressed in traditional fields or X–Y 
pixels in any resolution. The following illustration shows a 12-field 
grid displayed in a video project.

You can use the Effect Grid to:

• Display the aspect ratios for film categories such as standard film, 
Academy, Super 35 mm, and Anamorphic, as well as the 4:3 safety 
area for the 16:9 aspect ratio.

Axis with 
tick marks

Grid points

Safe title area
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• Show coordinate information to track the exact location of an 
effect in the frame.

• Use the snap-to-grid feature to easily position effects.

In film projects, you can also use the Effect Grid to:

• Create position information for the following effects: Paint, 
AniMatte, Blowup. You can include this information in an optical 
list created by using Avid FilmScribe™.

• Create position information for an effect you previsualize by using 
the Previsualization Marker tool. You can include this information 
in an optical list created by using Avid FilmScribe. For more 
information, see “Previsualization Marker Tool for Film 
Projects” on page 408.

Setting the Effect Grid Options

The Grid Settings dialog box allows you to define the grid to use when 
you create effects.

To set the default grid values for your system, do one of the 
following:

t In the Settings scroll list of the Project window, double-click Grid.

t In the Grid parameter category in the Effect Editor, click the Other 
Options button.

The Grid Settings dialog box appears. The following illustration 
shows the two tabs of the Grid Settings dialog box.
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Table 3-1 describes the Grid settings.

Grid Settings dialog box — Coordinates tab Grid Settings dialog box — Display tab
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Table 3-1 Grid Settings Options

Option Tab Description

Scale Mode Coordinates This setting allows you to work with a grid that indicates 
boundaries for a format other than the one in which you 
are working. This is useful when you are creating 
graphics (like titles) that must remain safe in other 
formats. Choose the appropriate option for the current 
and target formats you need. When you do not 
specifically need a grid that represents another format, 
use the Normal option, which is the default.

Increments:

Fields

Coordinates This option determines the number of tick marks along 
the grid axes as well as the number of visible grid points. 
The default value is 12.

Sub Fields Coordinates This option determines the snap-to-grid feature between 
visible grid points. The value determines how many 
jumps are in between each visible point. A value of 1 
snaps only to visible points. A value of 2 splits provides 
1/2 field jumps. A value of 4 (the default value) provides 
1/4 field jumps, and so on. A value of 0 turns off the 
snap-to-grid feature.

Source Scan Size 
(Hor. Size, Vert. Size)

Coordinates For film projects, where an optical house scans film for 
the addition of visual effects. The default values are 720 x 
486 pixels.

Source Grid 
Adjustments (Hor. 
Offest, Vert. Offset)

Coordinates This setting moves the grid on the image. These values 
are intended mainly for film projects.

Inset Coordinates This setting shrinks the grid proportionally.

Type Display This option selects a different grid for each of the 
standard film types. For video projects, use the Square 
grid type. The grid for the Academy option includes a 
safety margin on the left that is used for adding the 
optical soundtrack.

Color Display Choose a color for the grid axes and the grid points.
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Show Safe Title Display When this option is selected, the system displays the safe 
title area. Create video titles within this area to ensure 
that they are viewable on a regular television screen.

Show Safe Action Display When this option is selected, the system displays the safe 
action area for video display. This box is self-adjusting 
for PAL and NTSC projects.

Show 14x9 Zone 
Show 1.66 Aspect 
Show 1.85 Aspect 
Show 1.77 Aspect

Display Choose one or more of these options to display the grid 
you want.

Show Axes Display When this option is selected, the system displays the 
grid axes.

Show Tick Marks Display When this option is selected, the system shows tick 
marks along the axes. Use the Fields parameter to set the 
number of tick marks.

Show Thirds Display When this option is selected, the system divides the 
screen into three sections. This is especially useful if you 
are creating titles for the lower third of the screen.

Show Points Display When this option is selected, the system shows the grid 
points. Use the Fields parameter to set the number of 
grid points.

Table 3-1 Grid Settings Options (Continued)

Option Tab Description
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Displaying the Effect Grid in Effect Mode

As with the Safe Title/Safe Action guidelines, you use the Grid button 
in the Effect Editor to display the Effect Grid.

To display the Effect Grid rather than the Safe Title/Safe Action 
guidelines:

t Press the Alt key (Windows) or Option key (Macintosh) and click 
the Grid button.

To switch between the Effect Grid and the Safe Title/Safe Action 
guidelines:

t Press the Alt key (Windows) or Option key (Macintosh) and click 
the Grid button until the appropriate grid is displayed.

Show Position Info Display When this option is selected, the system displays the 
coordinates of any point in the Effect Preview or Record 
monitor. The Avid system uses compass coordinates and 
X, Y coordinates. For compass coordinates, the point (0, 
0) is the center of the axes. For X, Y coordinates, the point 
(0, 0) is the top left corner of the monitor. X values 
increase to the right, and Y values increase as you move 
down.

To display the coordinates in Source/Record mode, 
move the pointer to the Record monitor, press and hold 
the mouse button, and move the mouse.

To display the coordinates in Effect mode:

1. Deselect all tools in the Grid parameter category 
(including the Arrow tool).

2. Move the pointer to the Effect Preview monitor.

3. Press and hold the mouse button, and move the 
mouse.

Table 3-1 Grid Settings Options (Continued)

Option Tab Description
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To remove the display of either the Effect Grid or the Safe Title/Safe 
Action guidelines:

t Click the Grid button without pressing the Alt key (Windows) or 
Option key (Macintosh).

Displaying Position Coordinates

Your Avid editing system uses compass coordinates and X, Y 
coordinates to describe the position of an effect. To view the 
coordinates, you must select the option Show Position Info in the Grid 
Settings dialog box and enable the Effect Grid. For compass 
coordinates, the point (0, 0) is the center of the axes. For X, Y 
coordinates, the point (0, 0) is the upper left corner of the monitor. X 
values increase to the right, and Y values increase as you move down.

The compass coordinates describe the effect’s position in terms of film 
optical house standards. Each compass coordinate begins with a 
direction (N, S, E, or W, the abbreviations for North, South, East, or 
West) followed by a numerical value. This numerical component 
reflects the Fields and Sub Fields parameters you choose in the Grid 
Settings dialog box or the Grid parameter category. 

The X, Y coordinates describe position in terms of the Source Scan Size 
parameters you choose in the Grid Settings dialog box or the Grid 
parameter category.

To display position coordinates:

t Move the pointer to the Record monitor, press and hold the mouse 
button, and move the mouse.

To display position coordinates in Effect mode:

1. Deselect all tools in the Effect Editor (including the Outline/Path 
button and the Selection tool for Intraframe effects).

2. Press and hold the mouse button, and drag the cursor in the Effect 
Preview monitor.
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Using Local Grid Parameters

The Grid parameter category in the Effect Editor allows you to 
customize the grid display for an individual effect. The Grid 
parameter category appears in the Pan and Scan effect for all projects 
and in other effects for film and 24p or 25p projects. Grid parameters 
set in the Effect Editor apply only to that effect and temporarily 
override the current settings in the Grid Settings dialog box. For more 
information on the parameters available in the Grid parameter 
category, see “Grid” on page 490.

Obtaining Position Information in a Film Project

You can use the Effect Grid to include position information in a cut list 
for the Paint and AniMatte effects on a keyframe-by-keyframe basis. 
Additionally, you can display the position information for the first 
keyframe of a Blowup effect in a cut list.

n You generate film cut lists and change lists with Avid FilmScribe. For general 
information on using Avid FilmScribe, see the Avid FilmScribe User’s 
Guide.

n You can also generate effect information in a cut list by using the 
Previsualization Marker Tool in the Paint Effect. For more information, see 
“Previsualization Marker Tool for Film Projects” on page 408.

Position Information for the Paint and AniMatte Effects

Your system can include both compass coordinate and X, Y coordinate 
information in a cut list for each corner of a Paint or AniMatte effect. 
For example, a rectangle you create with the Paint Effect shows four 
compass and four X, Y coordinates for each keyframe.
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To include coordinate information in a cut list:

1. Enable the Effect Grid before you generate the list.

2. In the Cut List tool within Avid FilmScribe, select the Key Frames 
check box in the Options pane for the optical list.

The following illustration shows the presentation of Paint Effect 
information for a rectangular object in a cut list.

Position Information for the Blowup Effect

The event section of the cut list displays the compass coordinates of 
the effect at the first keyframe in the segment and the Fields parameter 
you have chosen for the effect. You must enable the Effect Grid before 
you generate the cut list to display this information in the list.

The following illustration shows the presentation of Blowup effect 
information in a cut list.

Grid 
information

Keyframe number 
and reference 
numbers

Shape type and 
color information

Compass and (X, Y) coordinate 
information for each corner of 
the rectangle
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Navigating in Effect Mode

The following sections describe helpful techniques for moving 
through footage in Effect mode.

Changing Position

You can change your position in an effect either by dragging the 
position indicator in the effect’s position bar or by typing and entering 
the timecode in the numeric keypad for a location, just as you do in 
Source/Record mode. The type of timecode you enter (master 
timecode or absolute timecode) depends on the top row of tracking 
information you are displaying. 

The position information boxes above the Effect Preview monitor 
update as you change position. For more information on entering 
timecode to change the current position, see the “Viewing and 

Grid information

Keyframe number Field parameter 
value

Compass coordinates
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Marking Footage” chapter in the Avid Media Composer and Film 
Composer Editing Guide.

Using Single-Field Step

When stepping through two-field media such as 2:1 or uncompressed, 
the system displays field 1 of each frame by default. Single-field step 
enables you to view field 1 and field 2 of each frame of video. This 
feature is especially useful when you require field-by-field control 
during Intraframe editing.

n For more information on Intraframe editing, see Chapter 8.

To step through the footage one field at a time:

t Click the Step Forward One Field button or the Step Backward 
One Field button.

n The Step Forward One Field and Step Backward One Field buttons can be 
mapped from the Command palette to the keyboard or the Composer window.

As you step, the number “2” appears in the upper-right corner of the 
Record monitor whenever field 2 of the media is displayed. The 
number disappears during the display of field 1 (the default display 
for the system).

Using the Effect Editor

Use the Effect Editor to adjust the parameters for an effect.

To display an effect’s parameters in the Effect Editor window:

1. Move the position indicator to the effect’s icon in the Timeline.

2. Click the Effect Mode button.
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n If the Effect Editor window is already open and active, you can just select the 
segment or transition effect to display the effect’s parameters in the Effect 
Editor window.

The Effect Editor window opens.

This example shows the Picture-in-Picture effect parameters.

Not all effect parameters apply to all effects. Parameters that do not 
apply to an effect do not appear in the Effect Editor for that effect. To 
determine which parameters pertain to an effect, refer to the effect’s 
description in Chapter 9, “2D Effects Reference,” and Chapter 10, 
“3D Effects Reference.”

n If the position indicator is not on an effect’s icon in the Timeline, or if the 
track that contains the effect is not selected, then the Effect Editor is blank.

A number of parameters are common to many effects, such as 
parameters affecting size, position, or foreground level (transparency). 

Effect name

Triangular

Slider used to adjust
parameter

Effect icon

opener

Parameter category
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You can adjust these parameters once for the entire effect, or you can 
use the Effect Editor along with keyframes to change the effect 
parameter over time. Other parameters can be adjusted only once for 
the entire effect, regardless of keyframe selection.

n For reference information on all effect parameters, see “2D Effects 
Parameters” on page 456 and “3D Effects Parameters” on page 636.

Effect Editor Buttons

This section describes the buttons in the Effect Editor, starting from the 
top left button in the window. Not all buttons apply to each effect. If a 
button is not applicable, it does not appear in the Effect Editor for that 
effect.

Additional buttons appear in the Effect Editor, depending on which 
effect you are using. For example, if you are working with a 3D effect, 
a set of 3D-specific buttons appears along the right side of the Effect 
Editor.

The following buttons appear along the right side of the Effect Editor.

Button Description

Other Options Click to access additional parameters for Matrix effects, Sawtooth Wipe 
effects, third-party plug-in effects, and the Title tool.

Triangular 
opener

Click to display or hide the parameter category. A downward-pointing 
triangle displays the parameter category; a right-pointing triangle displays 
only the parameter name.
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The following buttons appear at the bottom of the Effect Editor.

Button Description

Reduce  Reduces the image in the Effect Preview monitor.

Enlarge Enlarges the image in the Effect Preview monitor.

Dual Split Splits the Effect Preview monitor in half to show the image with and without 
effects applied to it.

Play Loop Plays back a transition or segment effect in a loop.

Play Plays the effect from the current position in the effect’s position bar for most 
2D and 3D effects.

Button Description

Add Keyframe Creates a keyframe at the frame in the effect’s position bar where you place 
the position indicator. Alt+click (Windows) or Option+click (Macintosh) this 
button to delete a keyframe.

The Add Keyframe button on the Command palette is mapped to the double 
quote key (“) on the keyboard. You can map the button from the Command 
palette to another key, or you can map the button to an existing button in the 
Source/Record monitor.

Play Preview Plays back a wire-frame preview of an unrendered effect.

Render Effect Renders the effect.

Outline/Path Displays a wire-frame path to illustrate the movement of an effect from the 
first keyframe through the last keyframe.

Grid Displays the Safe Title and Safe Action guidelines and enables the Effect Grid 
for precise placement of effects.
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For a detailed explanation of the Transition Effect Alignment Menu 
and the Transition Effect Duration box, see “Using the Transition 
Parameters” on page 73.

Moving an Enlarged Image in Effect Mode

When you use the Enlarge button to increase the size of the image in 
the Effect Preview monitor, you cannot view the entire frame all at 
once. When you are creating an effect that requires great detail, you 
can reposition the enlarged frame in the monitor to view the sections 
that need your attention.

n This feature applies only to an enlarged image in the Effect Preview monitor, 
not to a standard-sized or reduced image.

Transition 
Effect 
Alignment 
menu

Use this menu button to select the alignment of a transition effect relative to 
the cut point.

Transition  
Effect Duration box 

Click in this display to type a duration for the transition effect other than the 
duration displayed.

3D Promote Appears when you use a 2D effect on systems with 3D effects options. Click 
the button to promote the 2D effect to a 3D effect. For example, you can 
promote a 2D Picture-in-Picture effect to a 3D effect and make use of the 3D 
effects parameters. 

Before you promote the effect to 3D, save a 2D copy as a template so you can 
go back to it later. For more information, see “Promoting 2D Effects to 3D 
Effects” on page 225.

Button Description
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To move the image within the Effect Preview monitor:

1. Click within the boundaries of the Effect Preview monitor.

2. Press and hold Ctrl+Alt (Windows) or k+Option (Macintosh).

The cursor changes to a hand.

3. Drag the hand in any direction to reposition the image within the 
Effect Preview monitor.

Cursor Zoom ratio
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n Similarly, you can enlarge the frame in the Source monitor when you are 
working in Source/Record mode and move the frame around by pressing and 
holding Ctrl+Alt (Windows) or k+Option (Macintosh). To access the 
Enlarge and Reduce buttons in Source/Record mode, you must map the 
buttons to your keyboard or to the user-selectable palettes. You can also use 
Ctrl+L (Windows) or k+L (Macintosh) to enlarge the frame, and Ctrl+K 
(Windows) or k+K (Macintosh) to reduce the frame.

Selecting a Parameter

Some effects have additional parameters that you select from the 
current parameter’s Fast menu. For example, border types for 3D 
effects are on the same Fast menu.

Changing a Parameter

To change a parameter that has a slider, you must click its slider. When 
a slider is activated, it turns pink. Use the Tab key to move from one 
slider to the next slider. 

Fast Menu button

Pop-up menu 
showing other 
parameters

Parameter’s slider

Parameter’s numeric value
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To change the value of a parameter that has a slider, use any of the 
following methods:

t Move the slider with the mouse.

t Type a new value using the numeric keypad, and, if you entered 
fewer than three digits, press Enter.

t Use the Left Arrow or Right Arrow key to change the value by –1 
or +1.

t Press the Shift key and use the Left Arrow or Right Arrow key to 
change the value by –10 or +10.

Accessing an Effect’s Additional Parameters

Some effects have additional parameters that control their operation. 
For example, the Grid effect has additional parameters in which you 
set the number of columns and rows in the wipe. When an effect has 
additional parameters, the Other Options button appears next to the 
effect name in the Effect Editor. The Other Options button also appears 
in a parameter category in the Effect Editor if the category can access 
additional parameters.

To access an effect’s additional parameters

t Click the Other Options button next to the effect name or in a 
parameter category.

A dialog box appears in which you set the additional parameters.

n You also use the Other Options button to access the parameters for 
third-party plug-in effects and for the Windows Color dialog box or 
Macintosh Color Picker in the Title tool and other effects that allow you to 
change color parameters.
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Adjusting a Color Parameter

You can change a color parameter or select a key color using the 
eyedropper or the Windows Color dialog box or Macintosh Color 
Picker instead of the Hue, Sat (saturation), and Lum (luminance) 
sliders.

Using the Eyedropper

To select a color by using the eyedropper:

1. Position the cursor over the Color Preview window to activate the 
eyedropper.

2. Click the eyedropper, drag it to the Effect Preview monitor, and 
release the mouse button on the color you want to select from the 
video image.

The parameter’s numeric values are updated, and the selected 
color appears in the Color Preview window.

Using the Windows Color Dialog Box

The Windows Color dialog box is a standard service that ships with 
the Windows NT operating system.

To open the Windows Color dialog box:

t Click the Other Options button next to a color parameter.

Other Options button

Color Preview window

Eyedropper
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The Windows Color dialog box appears.

Figure 3-1 Windows Color Dialog Box

To use the Windows Color dialog box:

1. To choose a color from the Basic colors palette, click the color you 
want.

2. To specify a custom color, do one of the following: 

t Click in the color matrix to choose a color, and then drag the 
color slider to adjust the amount of white and black in the 
color.

t Type numerical values for each color component in the color 
selection text boxes.

The new color is displayed on the left side of the Color|Solid box. 
The right side of this box displays the solid color closest to the 

Color
selection
text
boxes

Default choices

Color slider

Color matrix

Custom 
colors 
palette

Currently chosen colorColor|Solid box
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color you have specified. You can choose the displayed solid color 
by double-clicking the right side of the box.

3. When you are satisfied with the color, click Add to Custom Colors 
to add it to the Custom colors palette.

4. To choose a custom color from the Windows Color dialog box, 
click the color you want.

5. Click OK.

The Windows Color dialog box closes, and the Avid editing 
system applies the color to the parameter in the Effect Editor.

Using the Macintosh Color Picker

The Macintosh Color Picker is a standard application that ships with 
Macintosh systems. Its appearance varies, depending on the current 
release of the Macintosh operating system. You can access the 
Macintosh Color Picker through the Other Options button.

To open the Macintosh Color Picker dialog box:

t Click the Other Options button next to a color parameter.

The Macintosh Color Picker dialog box appears.
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The Macintosh Color Picker displays the HSV (hue, saturation, value) 
color wheel by default for Macintosh operating system Version 8.5, as 
shown in the illustration above. You can also select an RGB (red, green, 
blue) slider interface or an HLS (hue, luminance, saturation) interface 
by selecting the appropriate icon on the left side of the Color Picker 
window. For a complete description of how to use the other Macintosh 
Color Picker interfaces, see the documentation that ships with your 
Macintosh.

To use the HSV color wheel:

1. Drag the color selector to select a color.

2. Drag the Value slider to make colors brighter or darker.

You can also enter color values by using the color selection text boxes 
on the right side of the dialog box. The color selector automatically 
changes position in the color wheel as you change values.
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Replacing an Effect with the Effect Editor

While in Effect mode, you can replace an existing effect.

To add a replacement effect:

1. Choose Effect Palette from the Tools menu.

2. Choose an effect category.

3. Use one of the following methods to replace the effect:

t Drag the new effect’s icon to the Timeline. To replace an 
existing effect, move the new effect’s icon on top of the 
existing effect’s icon.

t Drag the new effect’s icon to the Effect Preview monitor.

t Select the effect in the Timeline, and double-click the new 
effect’s icon in the Effect Palette.

4. Set the applicable effect parameters in the Effect Editor.

n Some effects cannot replace other effects. For example, some segment effects, 
such as the Mask effect, cannot replace transition effects. In addition, 
two-track effects, such as wipes, cannot replace three-track effects, such as 
matte keys.

Using Keyframes

A keyframe is a point in the effect at which you can set parameters. 
Modifying an effect’s parameters at various points causes the effect’s 
appearance to vary as it plays. For example, you can add keyframes to 
a Picture-in-Picture effect and change the position parameters for each 
keyframe to add movement to the effect.

Keyframe indicators appear as triangles in the position bar of the 
Effect Preview monitor when an effect is selected and the Effect Editor 
is active. You adjust keyframe parameters by using the Effect Editor.
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By default, your Avid editing system always provides the starting and 
ending keyframes of an effect. These keyframes are selected by 
default, and thus any parameter changes are constant throughout the 
effect. By using techniques for adding, deleting, moving, selecting, 
and deselecting keyframes, you can begin to change the appearance 
and operation of the effect over time by applying parameter changes 
to specific keyframes.

Adding a Keyframe

You can create a keyframe at any point in the effect’s position bar.

To create a keyframe:

1. Click the position in the effect’s position bar below the Effect 
Preview monitor where you want to add the keyframe. The 
position indicator moves to that frame.

2. Do one of the following to add a keyframe:

t Click the Add Keyframe button.

t Manually adjust a parameter in the Effect Preview monitor 
(segment effects only). For example, when you click a handle 
on an effect outline and drag to resize or reposition it, a new 
keyframe is created.

Selecting a Keyframe

You can select a keyframe or multiple keyframes by using the 
following procedures. A keyframe changes to pink when selected.

Ending keyframeStarting keyframe
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To select one keyframe:

t Click the keyframe indicator in the effect’s position bar.

To select multiple keyframes:

t Press and hold the Shift key and click the keyframe indicators that 
you want in the effect’s position bar.

To select all keyframes in the effect’s position bar:

t (Windows) Press Ctrl+A, or press and hold Ctrl+Alt and click one 
keyframe indicator.

t (Macintosh) Pressk+A, or press and hold the k key and click one 
keyframe indicator.

n For a quick way to jump to the previous or next keyframe, you can map the 
Fast Forward and Rewind buttons from the Command palette to your 
keyboard.

Moving a Keyframe

After you have created a keyframe, you can move it to another 
position in the effect’s position bar.

n The starting and ending keyframes cannot be moved.

To move a keyframe:

t Press and hold the Alt key (Windows) or Option key (Macintosh), 
click the keyframe, and drag it to its new position.

n Alternatively, you can select a keyframe and click the Trim Left 1 Frame and 
Trim Right 1 Frame buttons or the Trim Left 10 Frames and Trim Right 10 
Frames buttons.
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Changing a Keyframe’s Parameters

With certain parameter categories, such as Foreground and 
Acceleration, you adjust parameters globally (over all keyframes in the 
effect). You can also change many parameters for individual 
keyframes.

To change a keyframe’s parameters:

1. Click the keyframe indicator in the effect’s position bar. The 
keyframe indicator changes to pink when selected.

2. Adjust any of the applicable parameters in the Effect Editor.

Copying and Pasting Keyframe Parameters

You can copy and paste parameters from one keyframe and apply 
them to another keyframe. You can also copy keyframe parameters 
from one effect to another effect.

To copy and paste keyframe parameters:

1. Click one keyframe indicator in the effect’s position bar whose 
parameters you want to copy.

2. Choose Copy from the Edit menu.

3. Select one or more keyframes: 

t To copy the parameters to one keyframe, click the keyframe.

t To copy the parameters to multiple frames, Ctrl+click 
(Windows) or Shift+click (Macintosh) multiple keyframes.

t To copy the parameters to all keyframes, choose Select All 
from the Edit menu.

4. Choose Paste from the Edit menu.

The parameters that you copied from one keyframe are pasted to 
the keyframe, or frames, you selected.
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Deleting a Keyframe

You can delete any keyframe you create. You cannot delete the starting 
and ending keyframes the system creates.

To delete a keyframe:

1. Click the keyframe indicator in the effect’s position bar. 

The keyframe indicator changes to pink when selected.

2. Press the Delete key.

n Alternatively, you can Alt+click (Windows) or Option+click (Macintosh) the 
Add Keyframe button to delete a keyframe.

Defining a Motion Path

You can define how the foreground image of a multilayer effect will 
move across the background video by building a motion path, or string 
of keyframes. You can define a motion path on multilayer video effects 
such as Picture-in-Picture effects. Use the wire-frame preview feature 
when you want to see the path an image takes on the screen. 

When you are creating a motion path that moves beyond the viewing 
screen, you can use the Reduce button to view an outline of the image 
at a reduced scale. The reduced scale view shows the area outside the 
background image and allows you to extend the motion path into that 
area. The Enlarge button returns the screen to full view.

To define a motion path for the foreground image, use one of the 
following methods:

t Move the image directly and automatically add keyframes.

t Add keyframes and adjust the parameter sliders.
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Moving the Image Directly

You can add a motion path to a multilayer effect using the wire-frame 
feature and keyframes. The Outline/Path button on the Effect Editor 
window places a wire frame around the foreground image in the 
Effect Preview monitor. You can then drag the wire frame to new 
locations and add keyframes at each location to add movement to the 
effect. 

You can also resize the foreground image by clicking the wire-frame 
handles and dragging them to a new location. The top center handle 
adjusts the image’s height and the right center handle adjusts the 
image’s width. You can use the top right corner handle to equally 
change the image’s height and width.

To add a motion path to the foreground image by using the wire 
frame and keyframes:

1. Create a sequence with two video layers (foreground video on 
track V2, background video on track V1). For information about 
creating a sequence, see the Avid Media Composer and Film 
Composer Editing Guide.

2. Apply a multilayer effect to the foreground segment on track V2.

3. Select the foreground effect segment on track V2.

4. Open the Effect Editor window. By default, the wire frame is 
active. The foreground image is outlined, and both the starting 
and ending keyframe indicators are highlighted (pink) in the 
effect’s position bar.
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If the wire frame is not displayed, click the Outline/Path button in 
the Effect Editor window to activate the wire frame.

5. Drag the wire frame to the start point of the motion path you are 
creating. The starting keyframe indicator represents the start 
point.

6. Click the ending keyframe indicator to select it. Make sure the 
ending keyframe indicator is the only indicator selected (pink).

7. Drag the wire frame to the end point of the motion path. A path 
line from the center of the starting position to the center of the 
ending position appears.

8. Drag the position indicator in the effect’s position bar to a new 
location. The wire frame moves with the position indicator; notice 
the path line does not change.

9. Click inside the wire frame and drag or stretch the wire frame to 
add a keyframe at the new location. A handle appears in the 

Starting keyframe indicator Ending keyframe indicator

Effect’s position bar

Wire frame outlining 
foreground image on 
track V2

Background image 
on track V1
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center of the wire frame, indicating the path position of the new 
keyframe.

10. Drag the wire frame to change the effect’s path.

11. Repeat the last three steps to add more variation to the path.

Using an Effect Template

The parameters for an effect are called the effect template. You can 
reuse an effect template in multiple places in a sequence by saving the 
template in a bin and later applying the template to other effects or 
video clips in the sequence.

Wire frame

Center handle

Path line

Effect’s position bar

Selected keyframe
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Saving an Effect Template

You can save the parameters from an effect in the Effect Editor and 
reuse them for another effect.

To save an effect template:

1. Drag the effect icon from the Effect Editor to a bin.

This creates a new effect template in the bin, containing the parameter 
setting information for the effect. The new effect template is identified 
in the bin by its effect icon.

n Effect icons for open bins are also displayed in the Effect Palette.

n You can save a segment effect with its source media, which is useful when you 
want to save an imported PICT file or Matte Key clip for future editing into a 
sequence. Press and hold the Alt key (Windows) or Option key (Macintosh) 
while you drag the effect icon from the Effect Editor to a bin.

2. To rename the template, click the template name below the icon 
and type a new name.

Effect icon

Effect template
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n Title effects are saved with source by default. If you press and hold the Alt key 
(Windows) or Option key (Macintosh) while dragging the icon, you will get a 
keyframe only template. This template will retain the movement of the title 
without the source.

Applying an Effect Template

You can take an effect template that has been saved in a bin and apply 
the template and its parameters to other transitions or segments in 
your sequence. 

You can apply an effect template with all its parameters directly to 
segments or transitions as you would any other effect. You can also 
apply specific parameters from the template. 

To apply a specific parameter from an effect template:

1. Select an effect transition or segment in the Timeline.

2. Choose Effect Editor from the Tools menu.

3. Open the parameter category you want to change. For example, 
the following illustration shows the Position parameter category.

Effect template example:
In this example, a 3D PIP effect template was saved and 
then applied repeatedly to a series of segments to achieve 
the same cropping and positioning of foreground footage.
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4. Click the effect template icon in the bin or in the Effect Palette, and 
drag it to the specific parameter category in the Effect Editor.

The effect template is applied only to the effect parameter category 
you selected.

c Do not drag the effect template through the Timeline because this 
deselects the effect.

Playing an Effect

You can play back an effect in a variety of ways, described in this 
section. Depending on the capabilities of your system, various effects 
might require rendering before you can play them back in real time. 
For more information, see “About Real-Time and Downstream Key 
Effects” on page 32.

Basic Playback

To play an effect:

1. Drag the position indicator to the effect you want to play in the 
Timeline.

2. Click the Play button.

3. To stop playing an effect, click the Play button, or press the space 
bar.

New position parameters
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Playing an Effect in a Continuous Loop

To play the effect in a continuous loop while in Effect mode:

1. Drag the position indicator to the effect you want to play in the 
Timeline.

2. Click the Play Loop button.

3. To stop playing an effect, click the Play Loop button, or press the 
space bar.

Playing a Preview of an Effect

You might want to play an effect or its outline to check its appearance 
and operation. An effect’s outline is a wire-frame representation of the 
effect’s position, scale, and path of motion.

To play an effect’s outline:

1. Click the Play Preview button.

The effect’s outline plays from the current position.

2. Do one of the following to stop playing the effect preview:

t Click the mouse button.

t Press the space bar.

t Click the Play Preview button a second time.

Rendering Effects

You must render a non-real-time effect (an effect whose icon displays a 
blue dot) before it can be played. In addition, you must render some or 
all effects that exceed the real-time playback capabilities of the system 
in order to view them during playback. Occasionally, you might also 
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need to render an effect that displays a green dot in the Timeline, 
depending on the complexity of the sequence.

n For more information on the real-time effects playback capabilities of the 
system, see “Playing Real-Time Effects” on page 33.

When your Avid system renders an effect, the system stores the effect 
and its media file as a precomputed master clip (often referred to as a 
precompute). The system uses the precompute the next time to play 
the effect at its normal speed.

If IN and OUT points are not marked in the Timeline, the Render at 
Position command is available for rendering a single effect or for 
rendering multiple effects at the same position in the Timeline. If IN 
and OUT points are marked in the Timeline, the Render IN to OUT 
command is available for rendering all effects on selected tracks 
between the marked IN and OUT points. 

You can also click the Render Effect button in the Tool palette to render 
effects at position. The Render Effect button ignores any marked IN 
and OUT points and allows you to render the effects at the current 
position in the Timeline.

You can also use ExpertRender to have your system determine which 
effects need to be rendered. If IN and OUT points are not marked in 
the Timeline, the ExpertRender at Position command is available for 
determining which effects at the current position in the Timeline 
require rendering. If IN and OUT points are marked in the Timeline, 
the ExpertRender IN to OUT command is available for determining 
which effects on the selected tracks between the marked IN and OUT 
points require rendering. For more information, see “ExpertRender” 
on page 154.

The key to rendering quickly is to render only those effects that require 
it. With vertical and nested effects, for example, you do not have to 
render every layer to play the effect in real time. If the top track covers 
the entire duration of the tracks below, the system renders the 
composite result of all tracks into the top track. 
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Two useful ways to minimize rendering time are:

• Use the ExpertRender feature to determine which effects to render 
for successful playback. See “ExpertRender” on page 154.

• Use the Submaster effect by applying it to a track above layered 
effects and rendering only the Submaster effect. See “Submaster 
Editing” on page 213.

Creating and Using Render Settings

You can create one or more sets of render parameters and save them as 
a custom Render setting. For example, you can create one setting 
especially for rendering single-field motion effects and another for 
rendering two-field or uncompressed motion effects. You can then 
activate the setting that you need at each stage of your project.

Creating a New Render Setting

To create a new Render setting:

1. Click the Settings button in the Project window.

The Settings scroll list appears.

2. Click Render.

3. Choose Duplicate from the Edit menu.

4. Name the setting by clicking the custom name column (in between 
the setting name and the setting type identifier), typing a name, 
and pressing Enter (Windows) or Return (Macintosh).

5. Adjust the options for the setting as described in the following 
procedure
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Adjusting Render Settings Parameters

To adjust the parameters in the Render Setting dialog box:

1. Double-click a Render setting in the Settings scroll list of the 
Project window. 

The Render Setting dialog box appears.

2. Select the appropriate options based on the descriptions in 
Table 3-2.

3. Click OK to apply the Render settings.

Table 3-2 Render Setting Options

Option Suboption Description

Render Completion Sound Sets a sound for the system to activate once the rendering process is 
complete. This is useful when you are rendering multiple effects.

None Disables the rendering completion sound. This is the default.

System Beep Sets the rendering completion sound to match the sound set for your 
operating system.

Avid Sound Sets the rendering completion sound to a customized Avid sound.
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Motion Effects Render 
Using

Use these render effect parameters to determine the processing 
method when existing motion effects are rendered or rerendered. 

Original Preference Will cause effects to be rendered as whatever type they were when 
originally created.

Duplicated Field A single field is displayed in the effect. For two-field media, this 
reduces the information stored by half because it drops one field of 
the image, resulting in a lower quality image. For single-field media, 
this is usually the best choice because of its speed. (The other options 
do not improve effect quality for single-field media.) 

The effects render in the shortest amount of time using this option.

Both Fields Both fields are displayed in the effect. For example, the first two 
frames of a half-speed (50%) slow motion effect repeat the original 
Frame 1 (both fields) twice. This option is good for shots without 
inter-field motion, NTSC or PAL film-to-tape transfers, and still shots. 
With footage that includes inter-field motion, this method might 
result in minor shifting or bumping of the image because it disturbs 
the original order of fields: a Field 1 will appear both before and after 
the corresponding Field 2. 

The effect renders relatively quickly. For best results, you should use 
evenly divisible frame rates with this option.

Interpolated Field A second field is created for the effect by combining scan line pairs 
from the first field in the original media. This option calculates the 
motion effect at the field level rather than the frame level. Because the 
system considers all fields and does not disturb the original order of 
fields, the smoothest effect results. This method is best for 
video-originated material or film-originated material transferred at 24 
fps. 

Effects created using this option take the longest amount of time to 
render.

Table 3-2 Render Setting Options (Continued)

Option Suboption Description
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Activating a Render Setting

To activate a Render setting:

t Click in the column to the left of the setting name in the Settings 
scroll list of the Project window.

A check mark appears beside the setting that is currently active.

Rendering a Single Effect

After you have adjusted an effect’s parameters, you can render the 
effect.

To render a single effect:

1. Move the position indicator to the effect in the Timeline. Make 
sure the track containing the effect is selected.

2. Click the Render Effect button in the Tool palette, or choose 
Render at Position from the Clip menu.

VTR-Style A second field is created for the effect by shifting selected video fields 
of the original media by a full scan line. This option also creates the 
motion effect at the field level rather than the frame level, but because 
pixels are not filtered, the final image is sharper than that created by 
the Interpolated Field option. The image might display some slight 
jitter at certain speeds. This technique is similar to that used by 
high-quality professional video decks when playing footage at less 
than normal speed.

The time needed to render effects created using this option is longer 
than for effects created using either Duplicated Field or Both Fields, 
but similar to the time needed for Interpolated Field.

Show Intermediate Results Displays the progress of the rendering process on the system monitor.

Table 3-2 Render Setting Options (Continued)

Option Suboption Description
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The RenderEffects dialog box appears.

n To prevent this dialog box from displaying, press and hold the Alt key 
(Windows) or Option key (Macintosh) when you click the Render Effect 
button. The system will use the last drive selected.

3. Select a drive for the rendered media from the pop-up menu.

The Effect Source Drive is the drive where the media on the 
outgoing shot of a transition resides.

4. Click OK.

If there is not enough room on the drive, the system displays a 
message box that gives you the following choices:

• Stop — Stop the rendering process and return to the Render 
Effects dialog box, and then choose another target drive before 
continuing.

• Continue — Attempt to render the effect anyway, in case there 
might be enough room on the drive.

The effect is rendered, and a precompute master clip is stored on 
the drive you selected.

n To display the estimated render time during rendering, press the T key on the 
keyboard. Press the T key again to clear the display. Press the P key to view 
percent rendered.
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Rendering Effects at Position

When you have more than one effect at a particular point in the 
Timeline (for example, effects on several stacked video tracks), you can 
render them as a group.

To render multiple effects at position:

1. Move the position indicator to the effects in the Timeline.

2. Select all tracks that contain effects you want to render.

3. Choose Render at Position from the Clip menu.

The Render Effects dialog box appears.

n To prevent this dialog box from appearing, press and hold the Alt key 
(Windows) or Option key (Macintosh) when you click the Render Effect 
button. The system will use the last drive selected.

4. Select a drive for the rendered media from the pop-up menu.

The Effect Source Drive is the drive where the media on the 
outgoing shot of a transition resides.

5. (Option) If you do not want to render the real-time effects in the 
selected group of effects, select the option Skip Real-Time Effects.

6. Click OK.

If there is not enough room on the drive, the system displays a 
message box that gives you the following choices::
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You have two choices:

• Stop — Stop the rendering process and return to the Render 
Effects dialog box, and then choose another target drive before 
continuing.

• Continue — Attempt to render the effect anyway, in case there 
might be enough room on the drive.

The Avid system renders all effects at the position in the Timeline.

n To display the estimated render time during rendering, press the T key on the 
keyboard. Press the T key again to clear the display. Press the P key to view 
percent rendered.

Rendering Effects Between IN and OUT Points

When you have multiple effects to render for a whole sequence or a 
portion of a sequence, you can render them as a group by marking IN 
and OUT points.

n Save your sequence before you use this feature. Depending on the number, 
type, and complexity of the effects, the batch process can take a long time.

To render multiple effects by using IN and OUT points:

1. Select all tracks that contain effects you want to render.

2. Mark an IN point before the start of the first effect to be rendered 
in your sequence; mark an OUT point after the last effect to be 
rendered.

3. Choose Render In/Out from the Clip menu.

The Render Effects dialog box appears.
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4. Select a drive for the rendered media from the pop-up menu.

The Effect Source Drive is the drive where the media on the 
outgoing shot of a transition resides.

5. (Option) If you do not want to render the real-time effects in the 
selected group of effects, select the option Skip Real-Time Effects.

6. Click OK.

If there is not enough room on the drive, the system displays a 
message box that gives you the following choices::

You have two choices:

• Stop — Stop the rendering process and return to the Render 
Effects dialog box, and then choose another target drive before 
continuing.

• Continue — Attempt to render the effect anyway, in case there 
might be enough room on the drive.

The Avid system renders all effects between the IN and OUT 
points.

n To display the estimated render time during rendering, press the T key on the 
keyboard. Press the T key again to clear the display. Press the P key to view 
percent rendered.

n Another way to speed up rendering is to use the Submaster effect. See 
“Submaster Editing” on page 213.
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Saving a Partially Completed Render

If you interrupt a render that is not complete, the system allows you to 
save the part of the render that has been completed when you 
interrupt. You can then finish the render later by resubmitting the 
effect for rendering. The system will then render only the part of the 
effect that has not been rendered previously and will save that part as 
a separate precompute. This feature is especially useful if you have to 
interrupt a long render of a single effect, such as a Submaster effect.

You can also use the Render Ranges command in the Timeline Fast 
menu to customize the Timeline so that it indicates which parts of an 
effect have been rendered.

Partially Completed Render Example

The following example describes a typical interrupted render process 
for a group of five effects. 

The five effects are submitted for rendering, and the rendering process 
is interrupted while rendering the second effect. Precomputes are 
saved for the fully rendered first effect and for the part of the second 
effect that has been rendered.

Precomputes saved when 
initial render is interrupted. 
The precompute for the 
Flop represents the part of 
that effect that had been 
rendered when the opera-
tion was interrupted.
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When the same group of effects is submitted for rendering again, the 
system:

• Does not rerender the fully rendered first effect

• Renders only that portion of the second effect that has not been 
rendered previously

• Renders the remaining three effects

The result is six precompute files for five effects, since the second effect 
was rendered in two parts at two different times.

Interrupting a Render

To interrupt a render:

1. Press Ctrl+period (Windows) or k+period (Macintosh) to 
interrupt the render.

A message box appears.

Final set of precomputes 
after the second rendering 
operation. The Flop effect 
has two precomputes: one 
for the partial render from 
the first operation and a 
second for the remainder of 
the effect as rendered in the 
second operation.
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2. Do one of the following:

t Click Keep to save the material already rendered.

t Click Discard to end the render without saving the material 
already rendered.

Customizing Render Range Display

To customize the display of render ranges in the Timeline:

1. In the Timeline Fast menu, choose Render Ranges.

2. Choose one of the following:

t None — Turns off the display of render ranges

t Partial Only — Displays a red line on the portion of any 
partially rendered effect that is currently unrendered (but 
does not mark completely unrendered effects)

t All — Displays a red line on the portion of any partially 
rendered effect that is currently unrendered and on all 
completely unrendered effects

The following illustrations show how the Timeline displays render 
range information. The Picture-in-Picture effect on track V2 has been 
partially rendered; effects on track V1 are not rendered.

Timeline with Render Ranges set 
to Partial Only

Unrendered portion of effect on 
track V2 is marked with a red line.
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n Render Ranges indicator lines do not display if Show Effect Contents is 
selected in the Timeline Settings dialog box.

n The red line indicator used by the Render Ranges command is very similar to 
that used by the Dupe Detection command. To avoid confusion, do not use 
Dupe Detection and Render Ranges in the Timeline at the same time.

n The All option of the Render Ranges display provides a simple visual 
indication of which effects are unrendered. It is not an indication of which 
effects might need to be rendered to achieve successful playback.

n In Effect mode, the playback behavior of a partially rendered effect depends on 
the frame at which playback begins. If playback begins at a rendered frame, the 
system attempts to play the entire effect in real time. You see the rendered 
portion in real time but cannot see the unrendered portion. If playback begins 
at a non-rendered frame, the system plays the entire effect using render 
on-the-fly.

Timeline with Render Ranges 
set to All

Unrendered portion of effect on 
track V2 is marked with a red line.

All unrendered effects on track 
V1 are marked with a red line.
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ExpertRender

When you render effects by using Render at Position or 
Render In/Out, the system renders all effects in the selected material 
— all effects on the enabled tracks at the position or all effects on the 
enabled tracks between the marked IN and OUT points. In most cases, 
some effects are rendered that do not require rendering for successful 
playback, resulting in a longer render time than necessary and the 
creation of more precomputes than necessary.

The ExpertRender option helps to solve this problem by analyzing all 
the effects in selected material and determining which ones need to be 
rendered to achieve successful playback. You can then choose to 
render the effects identified by the system or to modify the system’s 
selections before submitting them for rendering.

ExpertRender attempts to generate a minimum set of effects to render 
for successful playback. If you render the effects recommended by 
ExpertRender, your material will always play successfully in real time. 

In most circumstances, ExpertRender enables you to render material 
quickly, easily, and with a high degree of storage efficiency. However, 
experienced Avid users might achieve an even quicker render of a 
complex sequence than that offered by ExpertRender — for example, 
by using Submaster editing. For more information, see “Examples of 
ExpertRender Behavior” on page 159 and “Submaster Editing” on 
page 213.

Rendering Effects by Using ExpertRender

To render effects by using ExpertRender:

1. Select all tracks in the Timeline that contain effects you want 
ExpertRender to analyze.
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2. Do one of the following:

t To render at position, move the position indicator to the effects 
in the Timeline.

t To render between IN and OUT points, mark IN and OUT 
points around the effects.

3. Choose ExpertRender at Position or ExpertRender In/Out from 
the Clip menu.

ExpertRender analyzes the selected effects and highlights the 
effects that require rendering in the Timeline. The following 
illustration, in which four effects are selected for rendering, shows 
how the system highlights both transition and segment effects.

The Render Effects dialog box appears and indicates how many of 
the effects submitted to ExpertRender require rendering.
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4. Do one of the following:

t Click Cancel.

The system removes all ExpertRender highlighting and 
cancels the ExpertRender process without rendering any 
effects.

t Click Modify Selection.

The effects identified for rendering remain highlighted, and 
you can modify the set of effects to render. For more 
information, see “Modifying ExpertRender Results” on 
page 156.

t Click OK.

If there is not enough room on the drive, the system displays a 
message box that gives you the following choices:

• Stop — Stop the rendering process and return to the Render 
Effects dialog box, and then choose another drive before 
continuing.

• Continue — Attempt to render the effects anyway, in case 
there might be enough room on the drive.

The system renders the highlighted effects.

n To display the estimated render time during rendering, press the T key on the 
keyboard. Press the T key again to clear the display. Press the P key to view 
percent rendered.

Modifying ExpertRender Results

To modify the results of an ExpertRender analysis:

1. Perform an ExpertRender by following steps 1 to 3 in “Rendering 
Effects by Using ExpertRender” on page 154.

2. In the Render Effects dialog box, click Modify Selection.
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3. Shift+click effects in the Timeline to add them or remove them 
from the set of effects to render.

Effects currently selected are highlighted.

4. When you are satisfied with your selections, click the Render 
Effect button on the Tool palette.

The Render Effects dialog box appears.

n To prevent this dialog box from appearing, press and hold the Alt key 
(Windows) or Option key (Macintosh) when you click the Render Effect 
button. The system will use the last drive selected.

5. Select a drive for the rendered media from the pop-up menu. 

The Effect Source Drive is the drive where the media on the 
outgoing shot of a transition resides.

6. Click OK.

If there is not enough room on the drive, the system displays a 
message box that gives you the following choices:

• Stop — Stop the rendering process and return to the Render 
Effects dialog box, and then choose another drive before 
continuing.

• Continue — Attempt to render the effects anyway, in case 
there might be enough room on the drive.

The system renders the selected effects.
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n To display the estimated render time during rendering, press the T key on the 
keyboard. Press the T key again to clear the display. Press the P key to view 
percent rendered.

To cancel ExpertRender during the modification process, do one of 
the following:

t Click in the Timecode track to move the position indicator.

t Double-click one of the Segment Mode buttons below the 
Timeline.

t Choose an ExpertRender command from the Clip menu, and then 
click Cancel in the Render Effect dialog box.

The system removes all ExpertRender highlighting and cancels 
the ExpertRender process without rendering any effects.

Some Considerations When Using ExpertRender

When you work with ExpertRender, you should be aware of the 
following aspects of its operation:

• ExpertRender operates on all selected tracks in the Timeline, 
including any enabled tracks that might be above the currently 
monitored track. To view the material that you are submitting to 
ExpertRender accurately in the Record monitor, make sure that 
you are monitoring the topmost selected track in the sequence.

• ExpertRender takes account of all tracks at or below the topmost 
selected track when determining what to render on the selected 
tracks to achieve successful playback. For example, if you have a 
sequence with tracks V1 to V4, and select tracks V3 and V4 when 
using ExpertRender, the system considers tracks V1 and V2 when 
determining playback possibilities but highlights effects to render 
only from tracks V3 and V4.

• If the material you submit to ExpertRender includes an effect in a 
segment that also contains nested effects, ExpertRender always 
renders the effect on the top (outside) track rather than the effect 
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inside the nest. In certain circumstances, this might limit your 
workflow flexibility. For example, you might anticipate the need 
to readjust the parameters of the effect outside the nest and the 
effect would then require rerendering. You can use the procedure 
described in “Modifying ExpertRender Results” on page 156 to 
select the effect within the nest for rendering and deselect the 
effect outside the nest.

Examples of ExpertRender Behavior

The following examples illustrate how ExpertRender behaves in a 
variety of circumstances. The examples will help you to understand 
the value of ExpertRender and alert you to certain situations in which 
you might want to modify the results of an ExpertRender analysis 
before you render a sequence.

n The ExpertRender results in these examples reflect the use of compressed 
video resolutions or uncompressed video resolutions on a two-stream 
uncompressed system. Results will be different when you are working with 
single-stream uncompressed media since real-time playback capabilities are 
different for one stream of video. For more information, see “Playback 
Capabilities for Single-Stream Uncompressed Video” on page 35.

Example 1: Nested Effect with Dissolves

In this example, two segment effects are applied to a segment by 
nesting the effects, and Dissolve effects are applied to the beginning 
and end of the segment. In the Timeline, the Dissolve effects appear 
with green dots.
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Although the Dissolve effects have green dots to indicate that they 
might need to be rendered under some circumstances, this example 
will play successfully in real time without rendering. When the 
sequence is submitted to ExpertRender, the system correctly indicates 
that no effects require rendering.

In this example, ExpertRender saves time for the editor who might 
assume that the sequence cannot play in real time without rendering 
at least the Dissolve effects.

Mask effect on segment appears 
with an orange dot.

Color Effect on segment 
appears inside nest with 
an orange dot. Dissolve effects appear with 

green dots.

Example 1: Timeline

Example 1: ExpertRender Result in 
the Render Effect Dialog Box
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Example 2: Multilayer Sequence with a 3D Effect

In this example, a Mask effect is applied to the segment on track V1, 
and a 3D Picture-in-Picture effect is created by applying the 3D Warp 
effect to the segment on track V2. Dissolves are applied to the 
beginning and end of the segments on both tracks. The final effect has 
masked video in the background and a 3D Picture-in-Picture effect 
using the same footage in the foreground. Additional segments 
containing Mask effects follow the first segment on track V1. The 
sequence has eight effects in all.

In the Timeline, the 3D segment effect and all four transition effects 
appear with a green dot.

Example 2: Timeline Before Rendering

Dissolve effects appear 
with green dots.

3D Warp effect appears 
with a green dot.

Mask effects appear 
with orange dots.
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When this sequence is submitted to ExpertRender, only three effects 
are recommended for rendering — the 3D effect on track V2 and the 
two dissolves on track V1. After you render these three effects, the 
sequence plays successfully in real time.

Example 2: Sample Frame from Sequence

Example 2: ExpertRender Results High-
lighted in Timeline

The 3D segment effect and two Dissolve 
effects are recommended for rendering.
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In this case, ExpertRender saves time for the editor who might assume 
that the sequence cannot play in real time without rendering all five 
green dot effects or even all the effects in the sequence.

Example 3: Titles with a Dissolve Effect

In this example of a situation that is common when working with 
titles, a Dissolve effect is applied between two Title Effect clips. In the 
Timeline, the Dissolve effect appears with a green dot.

Example 2: ExpertRender Results in 
the Render Effect Dialog Box

Example 3: Timeline Before Rendering Dissolve effect appears 
with a green dot.

Title Effect clips appear 
with an orange dot.
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When this sequence is submitted to ExpertRender, the system 
recommends the two Title Effect clips for rendering.

In this case, ExpertRender makes a recommendation for rendering that 
is not ideal. This sequence will play back successfully if the Dissolve 
effect alone is rendered. If you render the two Title Effect clips, they 
will no longer be DSK and the rendering process will take longer than 
the process for rendering the Dissolve effect alone.

Example 3: ExpertRender Results 
Highlighted in Timeline

Both Title Effect clips are 
recommended for rendering.

Example 3: ExpertRender Results in the 
Render Effect Dialog Box
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n This example shows that ExpertRender sometimes recommends the rendering 
of longer segment effects (including Title Effect clips) when a quicker render 
of transition effects is sufficient to enable successful playback. You should 
check for these kinds of recommendations and consider modifying them by 
using the procedures described in “Modifying ExpertRender Results” on 
page 156. Accepting these recommendations might slow down your workflow 
or result in the loss of DSK title capability.

Managing Effect Media Files

Your Avid system allows you to view effect media files and select them 
for deletion. You can quickly find or delete an effect media file from a 
bin, or you can use the Media tool to view all the files that relate to 
your project and select those you want to delete.

For complete information on media management features and on the 
use of the Media tool, see the chapter “Managing Media Files” in the 
editing guide.

n If you are using your Avid editing system in an Avid Unity™ workgroup 
environment, you can use Avid MediaManager to manage your media. For 
information on using the Avid MediaManager application, see the Avid 
MediaManager User’s Guide.

Example 3: Timeline After Ren-
dering of Dissolve Effect

Sequence plays successfully after 
the Dissolve effect is rendered.
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Understanding Effect Media Files

When you render an effect, your Avid system creates two elements: a 
rendered effect clip (also known as a precompute clip). and an 
associated media file. When you create a title or an imported matte 
key clip, your system creates several elements: an effect clip, a 
precompute clip, and associated media files.

Your system overwrites or automatically deletes a media file from 
your drive only if you do both of the following:

• Render an effect two or more times with the Render Effect button

• Close the project before either an Auto Save or a manual save 
occurs

In this case, the system automatically saves the last-rendered effect 
and deletes the earlier, unreferenced versions. This autodeletion 
applies only to effects rendered since the last save or project close.

This prevents you from deleting media that may be necessary to play 
other versions of the sequence. If you want to remove media files from 
your drive to save space, you will have to manually delete the files.

Revealing Effect Media Files

You can reveal the media files that are associated with effect clips 
(titles and matte keys), rendered effect clips (precompute clips), and 
motion effects so that they are visible in their folders on the desktop. 
You can then verify information about the media files, delete them 
directly from the folder, or perform other standard file management 
operations.
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To reveal effect clip, rendered effect clip, or motion effect media 
(Windows):

1. (Option) If you want to reveal effect media for rendered effect 
clips (precompute clips), display those clips in the bin by doing 
the following:

a. Choose Set Bin Display from the Bin menu.

The Set Bin Display dialog box appears.

b. Select Rendered Effects and “Show reference clips,” and then 
click OK.

Any rendered effect clips appear in the bin.

2. Select an effect item in the bin.

In this example, a Title Effect clip is selected.

Rendered 
effect (pre-
compute) 
clips
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n You can reveal media files for only one item in a bin at a time.

3. Choose Reveal File from the File menu.

The system searches all available drives, opens the folder in 
Windows Explorer, and highlights a related media file.

4. (Option) If more than one media file is associated with the clip, the 
system displays a message box prompting you to reveal the next 
file. Do one of the following:

t Click OK to reveal the next file.
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If the Explorer window disappears from view, bring it 
forward by pressing and holding the Alt key and pressing the 
Tab key until you select the Explorer window containing the 
OMFI MediaFiles folder information.

t Click Cancel to end the Reveal File operation.

To reveal effect clip, rendered effect clip, or motion effect media 
(Macintosh):

1. (Option) If you want to reveal effect media for rendered effect 
clips (precompute clips), display those clips in the bin by doing 
the following:

a. Choose Set Bin Display from the Bin menu.

The Set Bin Display dialog box appears.

b. Select Rendered Effects and “Show reference clips,” and then 
click OK.

Any rendered effect clips appear in the bin.

2. Select an effect item in the bin.

In this example, a Title Effect clip is selected.

n You can reveal media files for only one item in a bin at a time.

3. Choose Reveal File from the File menu.

The system searches all available drives, opens the folder, and 
highlights related media files.
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Deleting Effect Media Files from a Bin

You can delete effect media files (for titles, matte key clips, and 
rendered effects) and motion effect media from a bin by using the 
Delete dialog box.

To delete effect media files and motion effect media:

1. (Option) If you want to delete effect media for rendered effect clips 
(precompute clips), display those clips in the bin by doing the 
following:

a. Choose Set Bin Display from the Bin menu.

The Set Bin Display dialog box appears.

b. Select Rendered Effects and “Show reference clips,” and then 
click OK.

Any rendered effect clips appear in the bin.

2. In the bin, select the clip or clips whose media you want to delete.

In this example, two items are selected: a motion effect and a 
rolling title.
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3. Press the Delete key.

The Delete dialog box appears.

4. Select the appropriate check boxes for the material you want to 
delete, and then click OK.

For example, to delete only effect media files, select “delete n 
associated media file(s)” beneath each of the appropriate effect 
clip types and deselect all other check boxes. Make sure that you 
select only those file types you want to delete.
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CHAPTER 4

Creating Layered and 
Nested Effects

This chapter describes how to apply multilayer effects to your 
sequence. Layered effects consist of two or more layers of video built 
up vertically in the Timeline that play back simultaneously with 
effects such as Picture-in-Picture, Superimpose, or Submaster applied 
to the tracks. Nested effects consist of one or more effect layers that are 
contained within another effect on the same video layer.

This chapter also explains how to work with the Reformat effects, 
including Pan and Scan, which are applied to a separate layer in the 
Timeline and which allow you to reformat media to different aspect 
ratios.

The methods and concepts for creating multilayer effects — described 
in the following sections — build on the procedures for creating 
single-layer effects described in Chapter 2.

• Creating Key Effects

• Working with Imported Graphics and Animation

• Using the Reformat Effects and the Pan and Scan Effect

• Nesting Effects

• Submaster Editing
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• Performing a Video Mixdown

Creating Key Effects

Your Avid editing system supports the following key effects:

• Chroma Key — Replaces one part of the video image with another 
video image based on color

• Luma Key — Replaces one part of the video image with another 
video image based on luminance (brightness)

• Matte Key — Replaces one part of the video image with another 
video image or graphic based on the location of a high-contrast 
image known as a matte

Using the Chroma Key Effect and the RGB Keyer

The Chroma Key effectand the RGB Keyer are used most frequently 
with a foreground image shot in front of a highly saturated color 
screen that is keyed against a background image. The following 
sections describe the process of creating these effects.
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Chroma Key Effect

The Chroma Key effect includes several standard digital video effect 
(DVE) parameters such as scaling, position, and crop in addition to 
key control parameters. If your system includes 3D effects capability, 
you can also promote the Chroma Key effect to 3D for additional 
adjustments to various 3D DVE parameters such as skew, perspective, 
and spline-based motion. 

Use the Chroma Key effect when you want to work in real time, or 
when you need to adjust various DVE parameters of the foreground 
chroma key footage. 

RGB Keyer

The RGB Keyer is a non-real-time plug-in effect that includes 
additional parameters for fine-tuning the edges of the key and 
applying post-key color correction (correction applied to the foreground 
image without affecting the key itself) to the foreground elements. You 
cannot promote the RGB Keyer effect to 3D.

This shows a Chroma Key effect that has been promoted to 3D and then repositioned with defo-
cus applied to enhance the effect of perspective between foreground and background.

Chroma Key effect example

AfterBefore
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Use the RGB Keyer when working with full-screen chroma key 
footage that does not require DVE parameter adjustments such as 
repositioning or scaling, or when you need the RGB Keyer’s post-key 
color correction capabilities to better match the foreground to the 
background.

This example shows use of the post-key color correction capabilities of the RGB Keyer to blend 
the foreground and background elements more effectively.

RBG Keyer example: using post-key color correction

AfterBefore
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Creating a Chroma Key Effect

To create a Chroma Key effect:

1. Create a sequence with two video layers. 

2. Edit the background image onto track V1.

3. Edit the foreground image onto track V2.

4. Choose Effect Palette from the Tools menu.

5. Click the Key category.

6. Drag either the RGB Keyer icon or the Chroma Key Effect icon 
from the Effect Palette to the clip on track V2.

The Avid system adds the Chroma Key effect. Ultimatte blue is the 
default key color

7. Move the position indicator to the segment containing the effect in 
the Timeline, and click the Effect Mode button.

The Effect Editor opens and displays parameters for adjusting the 
chroma key.

8. Open the Key Color parameter category (RGB Keyer) or the Key 
parameter category (Chroma Key effect). 

For the Chroma Key effect and the RGB Keyer, Ultimatte blue is 
chosen by default. To match the key color more closely to the color 
of the background screen used in the footage, proceed with the 
following step.

Chroma Key effect applied to V2Background footage on V1Chroma key footage on V2
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9. Click the Color Preview window in the Key parameter category to 
display the eyedropper icon, and then drag the eyedropper to a 
representative region of the blue or green background screen in 
the Record monitor.

The Avid system selects the primary key color, and the key takes 
effect.

10. Fine-tune the key by enabling additional parameter categories and 
adjusting sliders as necessary:

• For more information on specific parameters, see “Key 
Control Parameters” on page 492.

Color Preview window

Select a key color from the chroma background 
with the eyedropper.

The chroma key takes effect.
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• For more information on using post-key color correction with 
the RGB Keyer, see “Using Post-Key Color Correction” on 
page 178.

Using Post-Key Color Correction

You can use the Color Correction parameters in the RGB Keyer effect 
for post-key color correction of the foreground elements in the key.

Because the foreground and background elements of a chroma key are 
often shot at different times and locations, post-key color correction is 
especially useful for maintaining the key while matching the visual 
characteristics of the foreground elements to the background footage.

To perform post-key color correction:

1. Apply and adjust the RGB Keyer effect as described in “Using the 
Chroma Key Effect and the RGB Keyer” on page 173.

2. While in Effect mode, adjust the hue, saturation, and value of the 
foreground elements using the Color Correction parameters in the 
Effect Editor. For more information on the specific parameters, see 
“Color Correction” on page 497.

Creating a Luma Key Effect

Use a Luma Key effect to replace portions of the foreground video 
with the background video based on brightness or luminance. 

To create a Luma Key effect:

1. Create a sequence with two video layers.

2. Edit the background image onto track V1.

3. Edit the foreground image onto track V2.

4. Choose Effect Palette from the Tools menu.

5. Click the Key category.
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6. Drag the Luma Key Effect icon from the Effect Palette to the 
segment on track V2.

7. Use the eyedropper or the Luma Key sliders to select a brightness 
value in the foreground video. 

The Avid system replaces the corresponding portions of the 
foreground video with background video. See “Key: Luma Key” 
on page 564 for an example.

Creating a Matte Key Effect

The Matte Key effect uses three layers of video to create the effect. The 
bottom layer is the background image, the middle layer is the 
foreground image, and the top layer contains the matte or alpha 
channel.

To create a Matte Key effect:

1. Create a sequence with three video layers.

2. Edit the background image onto track V1.

3. Edit the foreground image onto track V2.

4. Load a high-contrast image into the Source monitor, and edit it 
onto track V3. The high-contrast image can be an imported 
graphic or a clip that you adjust within the Avid system.

n If the image is not high enough in contrast, you can adjust the contrast by 
applying the Color Effect and adjusting its parameters in Effect mode. For 
more information, see “Using the Color Effect to Prepare a 
High-Contrast Image” on page 182.

5. Choose Effect Palette from the Tools menu.

6. Click the Key category.

7. Apply the Matte Key effect as follows:



180

t If your high-contrast image was created with the Color Effect, 
press and hold the Alt key (Windows) or Option key 
(Macintosh) and drag the Matte Key Effect icon from the Effect 
Palette onto the segment on track V3 to nest the Color Effect 
within the Matte Key effect.

t If your high-contrast image on track V3 does not include a 
Color Effect, drag the Matte Key Effect icon from the Effect 
Palette onto the segment on track V3.

8. Click the Record Track Monitor button for track V3 in the Track 
Selector panel. You should see tracks V2 and V1 through the 
high-contrast image on track V3.

9. Move the position indicator to the Matte Key effect and render 
the effect.

n For an example of a Matte Key effect, see “Key: Matte Key” on page 565 
and “Using Matte Keys with 3D Effects” on page 225.

About Real-Time Moving Mattes

If you import a moving matte as a 32-bit QuickTime® file or a graphic 
sequence, the Avid system handles the effect in real time. The basic 
procedure for importing a moving matte is described in the Avid Media 
Composer and Film Composer Input and Output Guide.

The Avid system treats a QuickTime file with embedded alpha as a 
moving matte if it has more than one frame. 

To import a QuickTime file as a moving matte:

t Select either Use Existing or Invert Existing in the Alpha category 
on the Image tab of the Import Settings dialog box.
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To import a graphics sequence as a moving matte:

1. Select the first file in the sequence as the file to import.

2. Select Auto Detect Sequential Files in the Image tab of the Import 
Settings dialog box.

The Avid system uses all the files in the sequence to make the 
moving matte. If you import only one graphic file with alpha, it 
becomes a static matte.

The Avid system creates a real-time Matte Key effect with nested alpha 
and video fill. To preserve real-time performance, the system locks the 
alpha track so that you cannot replace it.

These guidelines apply to editing with real-time moving mattes:

• You can promote a real-time Matte Key effect to a 3D Warp effect, 
and use the 3D manipulation parameters.

• If the Matte Key effect is not on the top video track of a 
multilayered composite, it must be rendered before it will play in 
real time.

• If you add a motion effect to the matte and foreground, the effect 
will not play in real time until you render the motion effect.

• Real-time moving mattes cannot be combined with real-time titles 
without rendering the effect.

• Moving mattes in a 24p or 25p project play in real-time in their 
native format only. You must render moving mattes in order to 
output the sequence in alternate formats using the Digital Cut 
tool. For example, a moving matte imported into a 24p NTSC 
project will not play back to the PAL format on output unless you 
render it first.



182

Using the Color Effect to Prepare a High-Contrast Image

This section describes how to enhance high-contrast images for use in 
creating Matte Key effects.

To create a high-contrast image from available footage:

1. Apply the Color Effect to the clip and enter Effect mode.

2. Change the Luma Range to 0 to 255.

3. Drag the Sat (saturation) slider under Chroma Adjust all the way 
down to remove all color saturation from the image.

4. Adjust the Gamma to change the color of the midtones. Note that 
this is the only nonlinear function in the Color Effect.

The high-contrast image can now be used as a matte for the key 
effect, as described in “Creating a Matte Key Effect” on page 179.

Black portions of the high-contrast image will be transparent and 
white portions will be opaque. To switch the order, use the Reverse 
option in the Foreground parameter category of the Matte Key effect.

n You can also import a graphic image with an alpha channel and use it as a 
Matte Key effect. See “Editing with Imported Matte Key Clips” on 
page 183.

Working with Imported Graphics and Animation

This section describes two different approaches to editing with 
imported graphic images, depending upon whether:

• The image was imported as a master clip with no alpha channel 
(an opaque graphic element)

• The image was imported as a Matte Key clip with an alpha 
channel (a keyable graphic element for video overlay)



183

These alternatives apply to both single-frame graphic images and 
animation. In addition, you can edit imported images into sequences 
using standard Avid system effects. These topics are described in this 
section.

n (Windows) AVI files cannot be imported with an alpha channel. To import 
animation with an alpha channel, you must use another supported format. 
For more information on importing graphic and animation clips, see the Avid 
Media Composer and Film Composer Input and Output Guide.

Editing with Imported Matte Key Clips

When an imported clip includes an alpha channel for keying the 
graphic over video, it appears in the bin with a Key Effect icon.

Both single-frame graphic images (such as a single JPEG file) and 
multiple-frame animation sequences (such as a JPEG file sequence) 
appear in the bin in the same form after import, and you use the same 
editing techniques for both. You can edit this type of clip into a 
sequence as a standard matte key overlay.

Graphic master clip 
with no alpha channel

Matte Key clip with 
alpha channel
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n Only single-frame files can be used as real-time keyed graphics. PICT 
sequences, QuickTime® files, PICS animation files, and ERIMovie files 
cannot be used as real-time keyed graphics.

To edit a Matte Key clip into the sequence:

1. Edit the main video sequence.

2. Add a new track above the tracks in the sequence by choosing 
New Video Track from the Clip menu.

n You must edit Matte Key clips onto an upper track to achieve the keying 
effect. If you edit a Matte Key clip onto track V1, for example, the image is 
keyed over black unless track V1 contains nested tracks.

3. Play the sequence, and mark an IN point and an OUT point where 
you want to overlay the graphic.

4. Load a Matte Key clip into the Source monitor. Mark an IN point 
toward the center of the clip if it is a still.

5. In the Track Selector panel, click and drag the V1 Source Track 
button to the Record Track button for the new track to patch the 
video from track V1 of the Source monitor to the track in the 
sequence that will receive the Matte Key clip.

Record Track button

Source Track button

Track Selector panel

Before

Record Track button

Source Track button

After
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6. Click the Overwrite button to edit the matte key into the sequence.

The Avid system keys the graphic over the video on the lower 
tracks.

In the following example, the graphic appears on track V3 above 
the main video sequence edited onto tracks V1 and V2.

7. Adjust effect parameters in the Effect Editor, if necessary, using 
procedures described in “Using the Effect Editor” on page 117.

n If the keyed portions of the images are the reverse of the intended effect, click 
the Invert button in the Foreground parameter category. For more 
information, see “Foreground” on page 489.

8. Use standard effect editing procedures to preview, render, or play 
the Matte Key clip.

n Make sure the Record Track Monitor button for the topmost track is selected 
in the Track Selector panel to see the complete effect.

Key Effect iconMatte key graphic 
keyed over video
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Editing with Imported Master Clips

When an imported clip does not include an alpha channel for keying 
the graphic over video, its icon is the standard master clip icon. This is 
true for both single-image graphics and animation sequences. You can 
edit this type of clip into a sequence as an opaque image or animation 
(in other words, as a single layer) using basic editing techniques 
described in this section.

To edit an imported master clip into the sequence:

1. Load a graphic clip into the Source monitor, and load a sequence 
into the Record monitor.

2. In the Source monitor, mark an IN point at the start of the clip and 
mark an OUT point to specify the duration of the graphic.

3. In the Record monitor, mark an IN point where you want to edit 
the graphic clip into the sequence.

4. Click the Source Track and Record Track buttons.

5. Click the Splice-in or Overwrite button to add the opaque graphic 
to the sequence.

The opaque image appears in the sequence. In the Timeline, the 
graphic looks like a standard video clip edited into the sequence.

6. Play the clip using the standard playback procedures.
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Using the Reformat Effects and the 
Pan and Scan Effect

The Reformat category contains effects for conforming media of 
different aspect ratios. One of these effects, Pan and Scan, available on 
some Avid systems, usually works as a vertical effect that you apply to 
a layer above the rest of your video material and that affects all the 
video material beneath it. 

Reformat effects allow you to reformat media to different aspect ratios, 
for example, when you need to reformat a film aspect ratio for 
television programming. 16:9 Letterbox, 14:9 Letterbox, and 4:3 
Sidebar resize the media to conform to the aspect ratio you select. 

n Reformat works on all tracks below the track to which you apply it. For 
example, if you apply Reformat above a title track, the titles become 
reformatted as well. If you don’t want to reformat the titles, apply Reformat 
below the title track.

Pan and Scan allows you to select a portion of the media to reformat 
and provides other parameters. See “Understanding the Pan and 
Scan Effect” on page 188.

Pan and Scan also supports conversion of 15:9 anamorphic source 
media to 16:9 anamorphic. See “Selecting the Source and Target 
Aspect Ratios” on page 4-192.

Original footage After 16:9 Letterbox effect applied
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n If you use a Reformat effect and the Pan and Scan effect on the same sequence, 
you must render one of the effects before the sequence will play in real time. 

The following sections describe the Pan and Scan effect and explain 
how to use it and the other Reformat effects to change the aspect ratio 
of your media.

Understanding the Pan and Scan Effect

Pan and Scan is a technique for reformatting media to different aspect 
ratios. The most widespread use of this technique is for reformatting 
television programming, for example when 16:9 Anamorphic material 
needs to be converted to the 4:3 aspect ratio.

Merely stretching or shrinking the media to fit a new aspect ratio 
would distort the media. If you do not want to distort the original 
media, you must choose a portion of each frame in your media for 
output. Traditionally, this selection process, known as Pan and Scan, is 
done during the transfer from film to tape in a telecine room. 

The Pan and Scan effect lets you pan across your media and select 
what portion of the media you want to retain for output. If necessary, 
you can insert keyframes into the Pan and Scan effect and adjust the 
effect for each keyframe.
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n You can use Pan and Scan on any type of project (24p or 25p NTSC, 30i 
NTSC, 24p or 25p PAL, or 25i PAL).

About the Reformat Effects

The Reformat category contains three effects, other than Pan and Scan, 
that reformat media to new aspect ratios:

• 16:9 Letterbox — Scales the image vertically to the 16:9 aspect 
ratio within a 4:3 frame. It works on 16:9 anamorphic media.

• 14:9 Letterbox — Reformats media to the 14:9 Letterbox aspect 
ratio with a black band at the top and bottom. First the system 
expands the media horizontally by a fixed amount before scaling 
it down vertically, resulting in a slight horizontal cropping of the 
image. You control what part of the image is cropped with the 
Position slider.

• 4:3 Sidebar — Reformats 4:3 source media to the 16:9 anamorphic 
aspect ratio by scaling down the media horizontally and applying 
a black band to the left and right sides of the image.

Original media with the Pan and Scan wire frame 
(in 16:9 mode)

Results of the Pan and Scan effect 
(in 4:3 mode)
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You would use one of these effects when you need to reformat a film 
aspect ratio for television programming. These effects also make it 
easier to combine 4:3 legacy media into a 16:9 master.

For more information, see “Reformat Effects” on page 597.

Outputting the Media with the Pan and Scan Effect

Media with the Pan and Scan effect can be output in two video 
formats: 4:3 or 16:9 anamorphic. Currently, the Pan and Scan effect 
does not generate data for inclusion in cut lists created with Avid 
FilmScribe. Consequently, if your target is not video, or if your source 
requires excessive scaling, you may visualize the reformatting 
operation but the Pan and Scan effect will not automate a film-to-film 
or a film-to-tape transfer.

Positioning the Pan and Scan Track

When your sequence does not contain titles, the Pan and Scan track 
should typically be the top track. If you use titles, the most effective 
way to work with Pan and Scan and titles is to work with multiformat 
titles, available in any project on a system that includes support for 
24p or 25p projects. For more information on multiformat titles, see 
“Working with Titles on Systems with 24p or 25p Support” on 
page 323.

If you work with multiformat titles, you can place the Pan and Scan 
track under the titles. This placement ensures that both DSK titles and 
the Pan and Scan effect play correctly in real time.

n When you place the Pan and Scan effect under multiformat titles, you might 
not see the titles with the correct Target aspect ratio as you work. For example, 
if you are reformatting from 4:3 to 16:9, titles will appear distorted in the 
Client monitor. When you output the sequence at 16:9 using the Digital Cut 
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tool, select the 16:9 aspect ratio and the titles will be sized correctly during the 
digital cut. For more information, see the chapter “Generating Output” in the 
Avid Media Composer and Film Composer Input and Output Guide.

When not using multiformat titles, you can place the Pan and Scan 
track over a title to properly scale the title along with the video tracks 
beneath it. If you need to pan, however, the pan will apply to the title 
as well as the other video tracks. Since this technique results in the title 
being panned, the results might not be desirable.

If you need to pan your footage and the title aspect ratio is not critical, 
you can move the titles above the Pan and Scan track. If the title target 
ratio is important, you may need to create a new title in your target 
aspect ratio.

Applying the Pan and Scan Effect

Because the Pan and Scan effect controls the aspect ratio of your final 
output, the effect must be applied to your entire sequence. You should 
apply Pan and Scan to its own video track after you finish editing the 
sequence. 

n There may be some situations in which you will want to place a Pan and Scan 
effect directly on a video segment. For more information, see “Combining 
the Pan and Scan Effect with Transition Effects” on page 205.

To apply the Pan and Scan effect:

1. After you finish editing your sequence, press Ctrl+Y to create a 
new video track on the topmost track.

2. Choose Effect Palette from the Tools menu.

The Effect Palette opens.
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3. Click the Reformat category.

4. Drag the Pan and Scan Effect icon from the Effect Palette to the 
new track.

n If you apply the Pan and Scan effect and then add a segment to or remove a 
segment from your sequence, the Pan and Scan effect does not automatically 
adjust to cover the entire segment. Either trim the Pan and Scan effect 
manually, or remove the Pan and Scan effect and insert a fresh effect.

Selecting the Source and Target Aspect Ratios

If you enter Effect mode and select the Pan and Scan effect, you see a 
white wire frame in the Effect Preview monitor. This wire frame lets 
you select the portion of the media that appears in your output. The 
Pan and Scan aspect ratios determine the size and shape of the wire 
frame.

Correctly setting the Pan and Scan aspect ratios is the most important 
part of using Pan and Scan. Whenever you change aspect ratios, you 

Pan and Scan 
wire frame
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must decide which part of an image you will retain for the final output 
and which part you will discard. The Pan and Scan aspect ratios 
specify the size of the incoming image and determine how much of 
that image you can retain for your final output.

You must set two ratios:

• Source ratio: Specifies the aspect ratio of your incoming media

• Target ratio: Specifies the aspect ratio of the final output

To set the Source and Target aspect ratios for a Pan and Scan effect:

1. Apply the Pan and Scan effect to the new video track, following 
the procedure described in “Applying the Pan and Scan Effect” 
on page 191.

2. Enter Effect mode.

The Effect Editor appears.
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3. Select the Pan and Scan effect if it is not already selected.

4. In the Effect Editor, click the triangular opener for the Aspect 
Ratios parameter category.

5. Set the Source aspect ratio to the ratio of your source material.
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6. Set the Target aspect ratio to the ratio of the final output. 

Setting Up Your Monitors for the Pan and Scan Effect

To accurately view the effects of Pan and Scan while you edit, you 
need to set your monitors to display the correct aspect ratios. Your 
Record or Effect Preview monitor can display in 4:3 aspect ratio (the 
default) or 16:9 aspect ratio. Your Client monitor should also be able to 
display these two aspect ratios.

Generally, your monitors should all be set to 4:3. However, if your 
source aspect ratio is 16:9 Anamorphic, you should set the Record or 
Effect Preview monitor to 16:9. If your target aspect ratio is 16:9 
Anamorphic, the Client monitor should be set to 16:9. Use 4:3 aspect 
ratio for all other aspect ratios.
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n If you are working with 16:9 Anamorphic and do not have the monitors set up 
correctly, the media and the wire frame will appear distorted. They will appear 
either elongated or squeezed.

To set the Record or Effect Preview monitor aspect ratio:

1. Right-click in the monitor. 

A shortcut menu appears.

2. Choose 16:9 Video from the shortcut menu to select or deselect 
16:9 display.

Viewing Pan and Scan Media

In Source/Record mode, the Client monitor displays the media inside 
the Pan and Scan wire frame. The portion of the image inside the wire 
frame expands to fill the entire monitor. The Record monitor also 
shows the media inside the wire frame; however, the media will be 
distorted if either the Source or Target aspect ratio is 16:9 Anamorphic.
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In Effect mode, the Effect Preview monitor displays your original 
media and the Pan and Scan wire frame. The Client monitor displays 
the original media. 

Unlike other effects, you do not see the results of the Pan and Scan 
effect on a frame-by-frame basis while in Effect mode. You see the 
entire source image so that you may select a portion of it. To see the 
results of the Pan and Scan effect while in Effect mode, click the Play 
button. In Source/Record mode, you can see the results of the Pan and 
Scan effect on a per-frame basis or by playing the media.

Using the Effect Grid with the Pan and Scan Effect

The Effect Grid displays a variety of positioning guides to help you 
move and position the Pan and Scan wire frame. Displaying the Safe 
Action grid and Thirds can be particularly useful when adjusting Pan 
and Scan compositions. 

The following illustration shows the Effect Grid with Show Safe 
Action, Show Thirds, and Show Axes selected.

In Effect mode, the original media displays in the Effect 
Preview monitor with the Pan and Scan wire frame.

In Source/Record mode, the Record monitor shows 
a distorted view of the results of the Pan and Scan 
effect. The Client monitor shows the accurate view 
of the results. 

Effect Preview monitor in Effect mode Record monitor in Source/Record mode
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n Safe Title/Safe Action and Thirds grid marks are based on the Target aspect 
ratio and are displayed inside the wire frame. Other grid markings are 
displayed as normal across the entire monitor.

You can open the Grid Settings dialog box by clicking the Other 
Options button in the Grid parameter category of the Effect Editor. The 
Grid Settings dialog box controls the size, position, and display of a 
variety of grids. For more information on Grid settings, see “Working 
with the Effect Grid” on page 107.
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In addition to using the options in the Grid Settings dialog box, you 
can use the controls in the Grid parameter category of the Effect Editor 
to change some Grid settings. For more information on these 
parameters, see “Grid” on page 490.

Setting an Origin in the Pan and Scan Effect

Each Target aspect ratio has default position and scaling settings. You 
can return to these default settings at any time by selecting the aspect 
ratio again. 

In addition to using the system’s default values, you can create 
customized default values for each instance of the Pan and Scan effect 
by using Establish Origin. 

n You should establish an origin before subdividing or adjusting individual 
keyframes in your Pan and Scan effect.

Other Options button

Grid button

Grid parameter 
category
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After inserting the Pan and Scan effect, you may want to adjust the 
size and position of the wire frame and save the wire frame’s new 
settings as base settings for the Pan and Scan effect. 

To save wire frame settings for the Pan and Scan effect:

t Click Establish Origin (in the Actions parameter category in the 
Effect Editor). 

Now, whenever you adjust Pan and Scan, you can return to these 
settings by clicking Reset to Origin. Reset to Origin is useful for 
quickly centering the wire frame after you move it.

n If you do not set an origin, clicking Reset to Origin returns to the default 
values for the Target aspect ratio.

Subdividing the Pan and Scan Effect

Because your sequence probably contains a variety of segments with 
different panning requirements, you may need to adjust the position 
of the Pan and Scan effect on a segment-by-segment basis. To make it 
easier to adjust Pan and Scan for individual segments, Pan and Scan 
includes the Subdivide Effect option. Subdivide Effect breaks up the 
Pan and Scan effect based on the segment boundaries of the selected 
video tracks underneath the Pan and Scan track. 
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n You can also subdivide a Pan and Scan effect manually by using add edits.

The following illustrations show the Timeline before and after using 
the Subdivide Effect command.

Breaking up the effect minimizes the number of keyframes you need 
to add and manipulate because, by default, each effect has a keyframe 
at the start and end of the effect. If you want to reposition Pan and 
Scan for an entire segment, you can select the segment and drag the 
Pan and Scan wire frame to a new position. If you need to adjust Pan 
and Scan within the segment, add keyframes to the effect.

n You should subdivide the Pan and Scan effect only after you have finished 
editing your sequence and have selected your Pan and Scan aspect ratios and 
origin. 

To subdivide a Pan and Scan effect:

1. In Effect mode, move the position indicator to the Pan and Scan 
effect.

2. Click the Record Track buttons in the Track Selector panel for the 
video tracks to use as the subdivision guide. 

Subdivide Effect divides Pan and Scan based on the segment 
boundaries of the selected tracks underneath the Pan and Scan 
track.

Pan and Scan effect on a Filler track before subdividing the effect

Pan and Scan effect after subdividing the effect
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3. In the Actions parameter category of the Effect Editor, click 
Subdivide Effect. 

The Avid system divides the Pan and Scan effect into multiple 
effects.

n Subdivide Effect works on the selected Pan and Scan effect, not on the entire 
track.

n Subdivide Effect does not subdivide segments connected by transition effects. 
For information on using Pan and Scan with transition effects, see 
“Combining the Pan and Scan Effect with Transition Effects” on 
page 205. 

Using the Wire Frame in the Pan and Scan Effect

The wire frame displayed in the Record monitor outlines the section of 
media selected for output. The Pan and Scan wire frame behaves 
similarly to the Picture-in-Picture wire frame.

Scaling the Wire Frame

You can resize the wire frame by dragging its handles or by using the 
Scaling sliders; however, you cannot change the wire frame’s shape. 
The wire frame’s initial shape is determined by the Target aspect ratio. 
The system maintains the wire frame’s shape during scaling.

To scale the wire frame do one of the following:

t Click one of the wire frame’s handles, and drag it to the position 
you want.

t Click the triangular opener for the Scaling parameter category in 
the Effect Editor, and use the slider controls to adjust the wire 
frame’s height and width.

Scaling lets you zoom in on your media. When you make the wire 
frame smaller, the image inside the wire frame is enlarged to fit the 
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output monitor. Because making the wire frame very small results in a 
pixelated image, it might not be appropriate to zoom in closely on an 
image when you plan to output directly to video. 

Positioning the Wire Frame

Moving the wire frame and defining a motion path works similarly to 
other multilayer effects; however, there are minor differences. 

Dragging restricts the motion to the most important axis. For example, 
if you go from a wide aspect ratio (16:9) to a narrow aspect ratio (4:3), 
you can drag the wire frame from side to side. If you go from 4:3 to 
16:9, you can drag the wire frame up and down.

To position the wire frame by dragging:

t Click inside the wire frame and drag it to a new position. 

n Pressing and holding the Shift key while dragging the wire frame lets you 
move in all directions. 

You cannot drag the wire frame off the screen because in most 
circumstances you will not need to select empty space outside the 
boundaries of the source image. If you do need to position the edges of 
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the wire frame beyond the screen’s limits, use the Position sliders in 
the Effect Editor.

To position the wire frame by using the position sliders:

t Open the Position parameter category in the Effect Editor and 
adjust the wire frame’s horizontal and vertical Position sliders. 

The Position sliders let you override some limits imposed by 
dragging.

Adjusting the Pan and Scan Effect

You might need to adjust Pan and Scan at different points throughout 
your sequence. The following are some suggestions for adjusting Pan 
and Scan.

If your sequence needs few adjustments:

1. Play the sequence until you see a problem with the panning.

2. Click the Play button, or press the space bar to stop play.

3. Enter Effect mode.

n Mapping the Effect Mode button to a key lets you stop and enter Effect mode 
with one keystroke.

4. Adjust the Pan and Scan effect.

If your sequence needs many adjustments:

1. Enter Effect Mode. You will do all your adjustments in Effect 
mode.

2. Use the Go To Next Edit and Go To Previous Edit buttons to step 
from one Pan and Scan effect to the next.

3. Adjust the Pan and Scan effect.
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Combining the Pan and Scan Effect with Transition Effects

When you subdivide the Pan and Scan effect, the subdivisions are 
based on the segment boundaries of the selected track. However, if 
two segments are connected by a transition effect, Pan and Scan does 
not place a subdivision between those segments. If one or more 
segments are connected by transition effects, Subdivide Effect treats 
this string of segments as one continuous segment.

The following illustration shows this behavior for a typical sequence 
with transition effects.

You can set Pan and Scan parameters for the start and end keyframes 
of the entire segment string and insert additional keyframes wherever 
you need to fine-tune the panning. However, this approach works 
only if the panning does not vary among the segments in the string. 

If panning needs to vary greatly from segment to segment, you may 
need to handle Pan and Scan on a segment-by-segment basis. To work 
on a segment-by-segment basis, you need to combine the Pan and 
Scan effect with the transition effects by placing the Pan and Scan 
effect on your video track. 

Pan and Scan effect above segments 
with transition effects

After subdividing, the Pan and Scan effect above the 
transition effects is not subdivided.

Segment string
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Placing Pan and Scan Effects on the Video Track

To combine Pan and Scan effects with transition effects, you need to 
place the Pan and Scan effects in the segments of the segment string. 

To place Pan and Scan effects in the segments:

1. After subdividing the Pan and Scan effect, select the Pan and Scan 
effect above the segment string.

2. Press the Delete key to remove the Pan and Scan effect.

3. Choose Effect Palette from the Tools menu.

The Effect Palette opens.

4. Click the Image category.

5. Drag the Pan and Scan Effect icon from the Effect Palette to the 
first segment in the segment string in the Timeline

6. Repeat step 5 for each segment in the segment string.

7. Adjust each Pan and Scan effect as needed.

Nesting Effects

You can use your Avid system to place effect tracks inside one another 
to better combine multiple images and digital video effects (DVEs). 
This involves a process known as nesting, which allows you to use the 
Timeline to step into a track, perform a series of editing operations, and 
then step out to view and render the effect as one segment on the track.
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You can edit up to 24 video track layers (8 for offline systems). Into 
each layer of video, you can additionally nest (stack inside) up to 24 
additional video tracks (8 for offline systems). In addition, you can 
step into each video track indefinitely, constrained only by your Avid 
system’s memory.

n Nested effects must be rendered in order to play back correctly.

You can use nesting when you want to create layered effects. In this 
case, the nested layers are treated as one element during the transition. 
Since transition effects, such as dissolves, fades, and wipes, are not 
multilayered, nesting is not applicable to these types of effects; nor are 
nesting effects applicable to audio tracks.

n Some effects do not work well with each other when nested. For example, the 
Box Wipe effect and Edge Wipe effect cannot be used together in a nested 
segment because the two effects are competing to establish the shape of the 
wipe.

Another use of nesting is to constrain one effect using another effect. 
For example, you can use the Circle Shape Wipe effect to constrain an 
image posterization inside a region.

Effects nested 
inside a Sub-
master effect

Additional 
nested layers 
inside the first 
nest
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n Nested effects do not appear in edit decision lists (EDLs) because they are not 
supported by linear tape-based edit controllers.

Stepping Into and Out of Nested Effects

You can step into an existing nested effect for editing. When you step 
into the effect, the full sequence in the Timeline is replaced with just 
the tracks that make up the nested effect. You can then add new tracks, 
monitor individual tracks, edit source material into the tracks, apply 
effects, and adjust effects on the nested tracks. You can step into any 
segment effect in this way.

n You can also expand nested effects while leaving the rest of the sequence 
visible in the Timeline. See “Expanding Nested Effects in the Timeline” 
on page 208.

To step into a nested effect:

t Click the Step In button on the Timeline toolbar.

To step out of a nested effect:

t Click the Step Out button.

Expanding Nested Effects in the Timeline

You can expand an existing nested effect for editing within the 
Timeline. You can then add new tracks, edit source material into the 
tracks, apply effects, and adjust effects on the nested tracks. Any 
segment with a segment effect applied can be expanded in this way.

n You cannot monitor individual tracks when you expand nested tracks in the 
Timeline. To monitor individual tracks within a nested effect, see “Stepping 
Into and Out of Nested Effects” on page 208.
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To expand a nested effect:

t In Effect mode, double-click a nested effect to expand the effect 
within the Timeline.

t In Source/Record mode, click either the Extract/Splice-in button 
or the Lift/Overwrite button, and then double-click the nested 
effect.

The nested tracks appear in the Timeline above the track you 
double-clicked. Editing and patching features are available for 
changing the content of the track’s effect.

When you expand a nested effect, a number appears with the letter N 
in the Timecode button. This number represents the level of nesting 
that you are currently in. For example, N2 indicates that you are two 
levels in from the outermost track level.

Double-click the effect’s icon in the Timeline to step out of the nested 
effect.

Creating a Simple Nested Effect

This example involves nesting a sequence of clips with dissolves 
inside another segment effect.

To create the nest:

1. Create a sequence and add a segment effect.

Nesting level 
indicator
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2. Click either the Extract/Splice-in button or the Lift/Overwrite 
button, and then double-click the segment.

The segment opens to reveal the nested tracks.

3. Edit new footage into the nested tracks, and apply additional 
effects as necessary.

In this example, a series of clips is edited onto nested track 1.2, 
with dissolves applied between the shots. The 3D Picture-in-
Picture effect applies to the entire nested dissolve sequence.

4. Double-click the main track for the nested effect (V2 in this 
example) to close the nested tracks again.
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Nesting a Matte Key Effect

A Matte Key effect uses three layers of video to create the effect.

To nest a Matte Key effect:

1. Create a sequence with the background video on track V1.

2. Load a high-contrast image into the Source monitor and edit it 
onto track V2. 

For an example of a high-contrast image, see “Key: Matte Key” on 
page 565.

3. Choose Effect Palette from the Tools menu.

4. Click the Key category.

5. Drag the Matte Key Effect icon from the Effect Palette to the 
segment on track V2.

6. Click one of the Segment Mode buttons below the Timeline.
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7. Double-click the Matte Key Effect icon in the segment. The 
Timeline expands to display three nested tracks (1.1, 1.2, and 1.3). 

By default, nested track 1.3 contains the same image segment as 
track V2. Nested track 1.2 is empty (foreground filler track). 
Nested track 1.1 (background video) is also empty.

8. Deselect the Segment Mode button so you can edit the tracks.

9. Edit the foreground image onto nested track 1.1.

10. Click one of the Segment Mode buttons, and double-click track V2 
to collapse the nested tracks.

11. Click the Record Track Monitor button for track V2 in the Track 
Selector panel. You should see tracks V1 and nested track 1.1 
through the high-contrast image on track 1.3.
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For an example of a Matte Key effect, see “Key: Matte Key” on 
page 565.

Submaster Editing

The Submaster effect is in the Image category of the Effect Palette. 
When you render this effect, the Avid system creates a single media 
file from several clips or effects in a sequence. The Submaster effect is a 
single-track segment effect.

This saves the new Submaster clip to the drive as a single media file. 
However, each element that makes up the composite is left untouched 
so you can still manipulate any element. 

The Submaster effect is useful when you want to play back 
bandwidth-limited sequences, such as sequences composed of several 
seconds of single-frame clips. It is much faster to use the Submaster 
effect than to use methods such as applying a graphic, 
Picture-in-Picture, Mask, or Resize effect. Normally, Submaster effects 
render at about the same rate as motion effects.

n You can nest up to 24 tracks inside a Submaster effect depending on the model 
of your Avid system.

n An edit decision list (EDL) for a sequence that contains a Submaster effect 
represents the contents of the Submaster as a single cut. To work around this, 
you can create a new sequence with the contents of the Submaster and 
generate a separate EDL for that sequence.

Applying the Submaster Effect to a Multilayered Sequence

You can use the Submaster effect to speed the rendering process by 
applying it to a track above layered or nested effects and then 
rendering only the Submaster. The system renders the composite 
result of all tracks into the top track. 
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n The Submaster effect maintains links to the original media files, so you should 
not delete the original media files. If you want to combine tracks to create a 
sequence that is independent from the original media files, perform a video 
mixdown.

n The Submaster effect does not render each track separately, so you cannot play 
each track individually, and the blue dot remains in the effect icon. In 
addition, if you delete or modify a track below a Submaster effect, the 
Submaster effect becomes unrendered.

To apply the Submaster effect to a multilayered sequence:

1. Choose New Video Track from the Clip menu.

2. On the new video track (V5 in this example), create one add edit 
before and another after the group of clips to be submastered.

3. Choose Effect Palette from the Tools menu.

4. Click the Image category.

5. Drag the Submaster Effect icon to the space between the add edits 
you added on the new track (V5 in this example).

The Avid system applies the effect above the layers.

Add edit marks on new track V5; bracket clips on track V4
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6. Render the Submaster effect, as described in “Rendering Effects” 
on page 140.

Using the Submaster Effect with a Series of Short Clips

The Submaster effect is useful when you want to play back 
bandwidth-limited sequences, such as a sequence composed of a 
series of short clips (a few frames each). You can apply and render the 
Submaster effect above the clips to improve playback.

To apply the Submaster effect to multiple clips:

1. Choose New Video Track from the Clip menu.

2. On the new video track, create one add edit before and another 
after the group of clips.

3. Choose Effect Palette from the Tools menu.

4. Click the Image category.

5. Drag the Submaster Effect icon to the space between the add edits 
you added on the new track.

Submaster effect on track V5
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6. Render the Submaster effect.

n If you alter or move either the Submaster segment or the clips below it, the 
effect becomes unrendered. You must render it again.

Collapsing Layers into One Submaster Effect

You can use the Collapse feature to build a multilayer effect and then 
nest the effect within a single Submaster effect in one step. To use this 
feature, map the Collapse button from the Command palette to your 
keyboard or a user-selectable palette.

The Collapse feature allows you to build your effect at the topmost 
level and when you are finished, collapse the layers automatically into 
one Submaster effect. This feature is useful for simplifying a sequence 
with complex compositing. Once you have collapsed a complex 
composite, you can easily add transition effects to the start and end of 
the newly created Submaster composite effect.

n You can also use the Collapse feature to simplify the deletion of multilayer 
segment effects. After collapsing the effects, you can select the resulting 
segment and press the Delete key twice to delete the effect and all the layers.

After the tracks are collapsed into a Submaster effect, the Avid system 
recognizes a Submaster effect as a multilayer effect instead of a 
single-layer effect. This allows you to add chroma keys and other 
multilayer effects to the nested tracks within a Submaster effect.
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n You can drag “two-channel” effects (such as chroma key) onto Submaster 
effects if the Submaster segment contains two or more nested tracks. This is 
useful after performing a Collapse operation to composite the newly created 
Submaster over another background.

To collapse layers into a submaster effect:

1. Select all the tracks you want to collapse. The tracks must be 
adjacent.

2. Mark an IN point and an OUT point around the area to be 
collapsed.

3. Click the Collapse button.

The Avid system collapses the tracks into a Submaster effect on a 
single track.
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To open the nested tracks again:

1. Click either the Extract/Splice-in button or the Lift/Overwrite 
button.

2. Double-click the Submaster effect.

The following procedure explains an alternate way to use the 
Collapse feature:

1. Click either the Extract/Splice-in button or the Lift/Overwrite 
button below the Timeline.

2. Select the segments you want to collapse.

3. Click the Collapse button.

Performing a Video Mixdown

Video mixdown allows you to combine several tracks into a new 
master clip. You can use video mixdown after you have finished 
building your sequence and want to make it into one piece (for 
example, a standard opening to a program). It can be useful for a 
complex sequence you need to use repeatedly or if you want to add a 
motion effect to an entire sequence. 

Video mixdown is similar to the Collapse feature; the difference is the 
end result. 

• With the Collapse feature, you collapse the tracks into a Submaster 
effect. After you collapse the tracks, you are still able to step in to 
the Submaster and work on the individual elements. 

• With video mixdown, your end result is a new master clip made 
up of all the tracks you built on different layers. Those tracks 
become one clip; you cannot separate the tracks to work on them 
or step into the sequence.
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n You cannot generate an EDL for a sequence that contains a video mixdown. 
To work around this, you can either remove the video mixdown or maintain a 
version of the sequence that does not contain a video mixdown.

To perform a video mixdown:

1. Select the Record Track Monitor button in the Track Selector panel 
for the highest track you want to include in the video mixdown.

2. Mark an IN point and an OUT point around the area to mix down.

3. Choose Video Mixdown from the Special menu.

The Video Mixdown dialog box appears.

4. Choose a target drive for storing the new master clip, and then 
click OK.

A progress indicator appears. When the video mixdown is 
completed, a new clip appears in the bin along with the sequence, 
and a new media file is created on the target drive.
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CHAPTER 5

Working with 3D Effects

This chapter describes procedures for creating and manipulating 3D 
effects on systems with 3D effects capability. For reference information 
on the parameters that apply to 3D effects and all the available 3D 
shapes, see Chapter 10, “3D Effects Reference.”

• About 3D Effects

• Accessing 3D Effects

• Understanding the 3D Effects Interface

• Creating Custom 3D Effects

• Using Avid Xpress 3D Effects

About 3D Effects

The 3D Effects feature delivers a wide range of digital video effects, 
including the following:

• Image effects such as blur (defocus), corner pin, and resize with 
rotation and perspective

• Two-channel segment effects including smooth-motion 
picture-in-picture 

• Shapes, including 3D spheres and four-way page curls
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• Positioning, scaling, skewing, and rotation, with perspective

• Source cropping

• Internal borders including beveled and rounded edges

• Soft borders

• Trails and drop shadows with varying opacity

• Highlights and wipe generator

• Luma keyand chroma key effects

n For information on the hardware requirements for the 3D Effects option, see 
the setup guide for your Avid system.

Turning the 3D Effects Option On and Off

The 3D Effects option is on by default. If for any reason you need to 
disable the 3D Effects option, you can do so by using one of two 
methods.

n While the 3D Effects option is disabled, a limited set of real-time 2D effects is 
available. For example, dissolves, superimpositions, and titles are real-time 
effects.

The methods for disabling the 3D Effects option are:

• You can disable the 3D Effects option during startup by using a 
key sequence. In this case, the 3D Effects option will be reenabled 
automatically the next time you start the system.

• You can disable the 3D Effects option with a Console command. In 
this case, the 3D Effects option will remain disabled until you 
enter another Console command.

c The Console window gives you access to low-level commands that 
can alter the operation of your Avid system. Use only Console 
commands that are documented in Avid Tech Notes or user manuals.
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Turning the 3D Effects Option On and Off at Startup

To turn off the 3D Effects option during startup:

1. Press and hold the F and X keys on the keyboard while starting the 
Avid application.

A dialog box appears, with buttons for enabling or disabling the 
3D Effects option.

2. Click the button for disabling 3D.

The system proceeds to start up with the 3D Effects option 
disabled.

After the application starts, the 3D Effect category is no longer 
available. The next time you restart the application, the 3D Effects 
option will be turned on again unless you press and hold the F and X 
keys.

Turning the 3D Effects Option On and Off in the Console

To turn off the 3D Effects option in the Console:

1. Choose Console from the Tools menu. 

The Console window opens.

2. Type the following command in the command line at the bottom 
of the Console window, and press Enter (Windows) or Return 
(Macintosh):

Disable3D 

A message appears stating that the 3D Effects option is disabled.

3. Quit the Avid application, and restart it.

During startup, a message indicates that 3D effects are disabled. 
To turn on the 3D Effects option again, repeat this procedure and 
type the command Enable3D in the command line at the bottom 
of the Console window.
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c 3D effects play as cuts (unless rendered) while the 3D Effects option 
is disabled. Any effects that are real-time with 3D become 
non-real-time (blue dot) effects (unless rendered).

Accessing 3D Effects

To access 3D effect parameters, do one of the following:

t Apply the 3D Warp effect to a transition or segment. See 
“Applying the 3D Warp Effect” on page 223.

t Promote an existing 2D effect to 3D. See “Promoting 2D Effects to 
3D Effects” on page 225.

Applying the 3D Warp Effect

All the 3D effects features are accessible through the 3D Warp effect in 
the Blend category.

n This procedure assumes that you are familiar with adding effects to a 
sequence. For more information, see “Applying Effects to a Sequence” on 
page 64.

To apply the 3D Warp effect:

1. Create a sequence by using standard Avid system editing 
procedures.

2. Choose Effect Palette from the Tools menu.

3. Click the Blend category.

4. Drag the 3D Warp Effect icon to a transition or a segment in the 
Timeline and release the mouse button. 

The 3D Warp Effect icon appears in the Timeline as shown in the 
following illustration.
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5. In the Timeline, move the position indicator to the 3D Warp effect 
and click the Effect Mode button.

The Effect Editor and the Effect Preview monitor appear. The two 
default keyframe indicators appear under the Effect Preview 
monitor. 

Now you can begin adjusting the 3D Warpparameters to customize 
your effects.
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Promoting 2D Effects to 3D Effects

You can use 2D effects as building blocks for 3D effects. For example, if 
you have a 2D Picture-in-Picture effect, you can add 3D features like 
3D borders, drop shadow, page curls, smooth curve movement, and 
rotation. You can also promote a Title effect created with the Title tool 
to a 3D effect.

The following rules and restrictions apply to promoting effects to 3D:

• Some software-based effects cannot be promoted to 3D.

• You cannot demote a 3D effect to a 2D effect. If you play a 3D 
effect on a system that does not have 3D hardware, the effect plays 
as a cut (unless the effect was rendered on the 3D system). 
However, you can reapply the 2D effect.

• All effects that were real-time in 2D are still real-time when you 
upgrade to 3D.

To promote a 2D effect or title to a 3D effect:

1. Click the Effect Mode button to open the Effect Editor.

2. Click the effect icon in the sequence to select it.

3. Click the 3D Promote button in the Effect Editor.

n For information on creating a 2D Title effect, see Chapter 6.

Using Matte Keys with 3D Effects

A matte key is an effect made up of three components: 

• High-contrast image or matte, also called the key

• Background image (the image that shows through the lightest part 
of the matte)

• Foreground image (the image that shows through the darkest part 
of the matte)
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n For more information on Matte Key clips, see “Creating a Matte Key 
Effect” on page 179. 

You can promote real-time 2D Matte Key effects (graphics imported 
with alpha channel) to 3D effects, called 3D Warp, and apply 
additional parameters, such as Shape Wipe effects, or X, Y, and Z 
positioning.

n You cannot promote matte keys created using the Matte Key effect from the 
2D Effect Palette to a 3D matte key.

To create a matte key for use with 3D effects:

1. Import a graphic file containing an alpha channel. 

The system creates a Matte Key clip when you import the file. In 
this example, the imported graphic is a title created in Adobe® 

Photoshop®.

2. Edit the Matte Key clip into your sequence as an overlay.

Graphic master clip 
with no alpha channel

Matte Key Effect clip 
with alpha channel

2D Matte Key 
title import
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Make sure Render On-the-Fly is enabled (displays a check mark in 
the Special menu) so you can see the matte key as you are working 
with it.

3. Promote the Matte Key clip to a 3D Warp effect as explained in 
“Promoting 2D Effects to 3D Effects” on page 225.

4. Enter Effect mode, and apply changes to additional parameters to 
achieve the effect you want. 

In this example, the effect, promoted to 3D, was repositioned with 
the Position parameters. Then the 3D Slat Wipe effect was chosen 
and adjusted in the Shape category to make the top and bottom 
elements of the title slide across in opposite directions.

Final 3D Matte Key title graphic:
Slat wipe in the Shape category 
was used to make the top and bot-
tom titles slide across in opposite 
directions.
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Understanding the 3D Effects Interface

This section provides basic information for using the 3D effects 
parameters and the Effect Preview monitor and controls.

Moving in 3D Space

You do not need to use a lot of math to create most 3D effects, but you 
do need some basic understanding of degrees of motion and geometry, 
as described in this section.

n Moving objects in 3D space requires an understanding of each of the 3D 
effects parameters and their correct order in the effects parameters hierarchy. 
For more information, see “About 3D Effects Parameters” on page 231.

The 3D Coordinate System

Throughout this chapter, the terms X, Y, and Z refer to the three axes or 
dimensions of the image that can be manipulated in the 3D effect’s 
coordinate space.

• X refers to the image’s left/right direction.

• Y refers to the image’s up/down direction.

• Z refers to the image’s front/back dimension.
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Rotation Axes

The Shape and Rotation parameters allow you to rotate the image 
around the X, Y, and Z axes. Note that you can rotate more than 360 
degrees (from –720 to 720 degrees) between keyframes. The following 
illustration shows how angles of rotation are distributed around a 
circle.

Z Axis

X Axis

Y Axis

X Axis — values increase from left to right

Y Axis — values increase from bottom to top

Z Axis — values increase from back to front

X0, Y0, Z0
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The following illustration shows several rotation examples.

– +

–90 degrees

–45 degrees

–180 degrees
+180 degrees

+135 degrees–135 degrees

0 degrees

+45 degrees

+90 degrees

A

0 degrees

A

+180 degrees
–180 degrees

A

A
+45 degrees

–45 degrees
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About 3D Effects Parameters

The following sections provide a basic introduction to 3D effects 
parameters. For specific information on each of the parameters 
available in the Effect Editor, as well as important information on the 
hierarchy of 3D effects parameters, see Chapter 10, “3D Effects 
Reference.“

n Manipulating 3D effects parameters requires a basic understanding of 
degrees of motion and the system of geometry used in your Avid system’s 
3D effects interface. For more information, see “Moving in 3D Space” on 
page 228.

Accessing 3D Effects Parameters

To access the 3D effects parameters:

1. Move the position indicator to the icon for the 3D Warp effect in 
the Timeline.

2. Click the Effect Mode button.

The Effect Editor window opens and displays the parameters for 
the 3D Warp effect .

n If the Effect Editor window is already open and active, you can just select the 
segment or transition effect to display the effect’s parameters in the Effect 
Editor window.

Manipulating 3D Effects Parameters

As in 2D effects, the 3D Warp parameters are grouped in collapsible 
panes. Each parameter pane represents a specific type of 
manipulation, called a category, that you can apply to an image. You 
can apply category adjustments either individually or in combination.
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Basic manipulation of the parameter categories, sliders, and buttons is 
identical to that of 2D effects parameters. For more information, see 
“Using the Effect Editor” on page 117.

3D Warp parameter 
categories

Effect Editor buttons
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Resetting Default Values

To reset the parameters for a category to their default values:

t Alt+click (Windows) or Option+click (Macintosh) the Enable 
button. 

This operation affects only selected keyframes. 

n This method works only for 3D effects and AVX plug-in effects.

Using Effect Templates

Once you create a 3D effect and adjust parameters, you can save the 
adjustments as a template for later use. This allows you to use the 
same effect parameters in multiple places in a sequence or in different 
sequences.

• You can drag an effect template and drop it into the Effect Preview 
monitor or onto the effect segment in the Timeline to apply all the 
values from the template.

• You can drag an effect template and drop it onto an open 
parameter category to reset the parameters of the category to those 
of the first keyframe of the effect template. This allows you to use 
selected portions of effect templates.

For more information, see “Applying an Effect Template” on 
page 138.

Zooming In or Out on the Effect Preview Monitor

Because you can move the edges of a 3D effect outside the enclosing 
frame, the Avid system lets you view an outline of the image area at a 
reduced scale. Use the Enlarge and Reduce buttons in the Effect Editor.
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Manipulating 3D Effects Directly

You can perform a number of operations on an image by clicking 
buttons in the Effect Editor and dragging handles attached to the 
image in the Effect Preview monitor. This is similar to the procedures 
you use to directly manipulate 2D effects; some additional 
manipulations are possible, however, when working with 3D effects.

For more information on direct manipulation of 2D effects, see 
“Moving the Image Directly” on page 134.

Manipulating 3D Effect Handles

Various 3D effect handle buttons appear along the right side of the 
Effect Editor. You determine the direction and type of manipulation 
performed in the Effect Preview monitor by selecting one of the image 
manipulation buttons on the Effect Editor.

To manipulate a 3D effect handle in the Effect Preview monitor:

1. Click one of the image manipulation buttons on the Effect Editor 
to activate the specific handles.

2. Click the handles and drag them to manipulate the image.

3. Click the image manipulation button a second time to turn off the 
handles.

The following illustration shows the handles for several image 
manipulation buttons.

Z Rotation

X Rotation

XY Position

XZ Position

Axis

Scale

Y Rotation

Crop

Corner Pin
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Using the Motion Path Editor

Use the Outline/Path button when you want to see the path an image 
takes on the screen (for example, moving a Picture-in-Picture effect as 
described in “Defining a Motion Path” on page 133). The motion path 
editor displays the path between keyframes as either a straight line or 
a smooth curve. 

Click the Enable button in the Spline category to switch between a 
straight line and smooth curve. For a description of the Spline 
parameters, see “Spline” on page 665. For an example, see “Using the 
Spline Parameters with 3D Effects” on page 249.

Creating Custom 3D Effects

This section provides examples of some basic 3D effects, including the 
steps and values used to create the effects. You can use them to 
practice creating 3D effects, or you can use them to get ideas for 
building your own effects. Examples of both segment effects and 
transition effects are included.

Scale X and Y 
at same time

Scale X

Scale Y

Rotate around Z AxisRotate around X Axis Rotate around Y Axis

Rotation AxisScale Position
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If you need more information while you are trying to complete the 
examples shown here, refer to the following sources:

• Chapter 2, for basic information on effects editing

• “Understanding the 3D Effects Interface” on page 228 for 
information on the 3D interface and moving in 3D space

• Chapter 10, for reference information on all 3D effects parameters 
and controls

• The user’s guide, for basic information on editing

In addition to re-creating the examples in this chapter, you can 
experiment with the default shape effects. Each shape effect has 
default values for the first and last keyframes. Examples of the default 
shapes are provided in Chapter 10.

Some Tips for Creating 3D Effects

The following tips apply to the examples in this chapter:

• Creating the sequence: Transition effects require only a two-clip 
sequence. Some of the segment effects require at least two tracks.

• Avoiding Insufficient Source errors: Several of these examples 
assume that you are creating a transition effect centered on the cut 
between the incoming and outgoing video. Make sure you leave 
enough material for the overlapping portions of the transition 
when you mark the source material. For example, the following 
illustration shows the Source monitor position bar for the 
outgoing video clip.

Video material used for segment Material left behind for
transition to next clip

Source monitor position bar
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If you get an Insufficient Source message when you apply an effect 
to the transition, you did not leave enough source material behind 
for the system to create the transition.

• Using the Swap Sources button: When you use the 3D Warp 
effect as a transition and click on the effect for the first time, the 
system applies the effect to the incoming video. To apply the effect 
to the outgoing video, click the Swap Sources button in the 
Foregnd (Foreground) parameter category. Click anywhere in the 
effect’s Timeline to view the results.

The following illustration shows the display (in Big Effect mode) for 
“Creating a Page Curl Transition” on page 238 and identifies several 
areas that are referred to throughout the chapter.

Swap Sources button
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Creating a Page Curl Transition

This example uses the Page Curl effect. This effect treats the 
foreground video channel as though it were a sheet of paper being 
rolled up to reveal another page beneath. Page Curl supports two 
highlights on the curl. The following illustrations show the effect 
created in this example.

Effect icon 3D Warp 
parameters list

Effect Preview monitor

Keyframe 
indicators in 
the effect’s 
position bar

3D Warp used as a transition effect 

Incoming 
video

Outgoing 
video

A simple two-clip sequence

Effect name 
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To create the Page Curl effect:

1. Create a sequence and apply the 3D Warp effect as described in 
“Applying the 3D Warp Effect” on page 223.

2. In the 3D Warp parameter list, click the triangular opener for 
Shape, and choose Page Curl from the Shape Fast menu.

The default Page Curl effect appears on the incoming video. To 
apply the effect to the outgoing video, swap the video sources as 
follows:

Page Curl

Incoming videoOutgoing video

Triangular
opener

Category
name

Shape 
Fast menu

Enable
button

Split Fast menu



240

a. Scroll down to display the Foregnd parameter category, and 
click the triangular opener.

b. Click the Swap Sources button.

c. Click anywhere in the Effect Preview monitor’s position bar, 
and the system displays the effect on the outgoing video.

3. Locate the Highlight category, and click the Enable button.

4. Click the first keyframe indicator.

The 3D Warp parameters for the first keyframe are now active. 

5. In the Shape parameter category, set the Curl slider to 0 (no curl).

6. Click the last keyframe indicator.

7. Set the Curl slider to 80. This takes the curl completely off the 
underlying video.

8. Click the Play or Play Loop button to preview the effect.

n You might want to use the Transition parameters to lengthen the effect. See 
“Using the Transition Parameters” on page 73 for more information.

A Simple Variation on the Page Turn Transition

This example describes how to make some simple changes to the Page 
Turn transition to create a dramatically different effect. To create this 
variation, use the example you created in the previous section.

For the previous example, you used the default No Split option on the 
Split Fast menu. This example uses the Quad Split option.

Enable button

First keyframe Last keyframe
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1. Click the first keyframe indicator, and choose Quad Split from the 
Split Fast menu for the Shape parameter.

2. Click the Angle slider, type 135 on the numeric keypad, and press 
Enter to set the Angle for the first keyframe to 135 degrees. 

3. Click the last keyframe and set the Angle to 135. The following 
table shows the values for each keyframe.

Now step through or play the effect. The following illustrations show 
the effect.

Effect Parameter First Keyframe Last Keyframe

Shape
Page Curl

Curl = 0

Radius = 15

Angle = 135

Quad Split

Curl = 80

Radius = 15

Angle = 135

Quad Split

Highlight Enabled Enabled

Page Curl effect 
Quad Split 135 degree angle



242

Creating a Splash Dissolve

This example creates a Splash effect and uses it as a dissolve. Use the 
Opac. (opacity) slider in the Foregnd parameter category to create the 
dissolve. Changing the opacity value from solid to transparent creates 
the same effect as a dissolve.

The following illustrations show the effect and the outgoing and 
incoming video.

Here are some tips for creating this effect:

• Use the Multi Wave shape and increase the radius throughout the 
effect, starting at 0 and ending at 55.

• Add a new keyframe (shown as the second keyframe below) to 
provide a starting point for the dissolve. The complete dissolve 
occurs between the second and last keyframes.

For information on working with keyframes, see “Using Keyframes” 
on page 129.

Splash dissolve Incoming videoOutgoing video

Last keyframeSecond keyframeFirst keyframe
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To create the Splash effect:

1. Create a sequence with two video clips as you did in the Page Curl 
examples, and drag the 3D Warp effect onto the transition point in 
the Timeline.

2. Click the effect in the Timeline and enter Effect mode (click the 
Effect Mode button).

3. Choose Multi Wave from the Shape Fast menu. 

The system displays the default Multi Wave effect on the incoming 
video.

4. Click the Swap Sources button in the Foregnd (Foreground) 
parameter category to display the effect on the outgoing video. 

Now click anywhere in the effect’s Timeline, and the system 
displays the effect on the outgoing video.

5. Click the first keyframe indicator.

6. In the Shape parameter category, set the Radius value to 0.

7. Click the last keyframe indicator.

8. In the Shape parameter category, set the Radius value to 55.

9. With the last keyframe still selected, set the Opac. slider in the 
Foregnd parameter category to 0.

10. Add a new keyframe approximately three-quarters of the way 
through the effect. 

This keyframe will have a predetermined radius value (calculated 
by the system to create a smooth splash between radius values 0 
and 55). You do not need to change this value.

11. For the keyframe you just added, set the Opac. slider to 100 in the 
Foregnd parameter category. 

12. Click the Play or Play Loop button to preview the effect.

The following table shows the nondefault keyframe values for this 
example.
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Try experimenting with the Highlight parameter for this effect. Open 
the Highlight parameter category, and adjust the Inty (intensity) value.

Turning a Splash into a Flat Image

The following techniques show two different ways to turn a splash 
into a flat image.

t Set the Radius value to 0. This setting conceals the ripples entirely. 
It allows you to create splash sequences simply by increasing the 
Radius.

t Bring Amplitude and Automatic Highlight intensity down to 0. 
Lowering the amplitude reduces the distortion. Reducing the 
highlight intensity to 0 eliminates highlights and shading. This 
allows you to:

- Bring up a full-sized splash from beneath the center of the 
picture by keeping the Radius constant and increasing the 
Amplitude and Highlight intensity settings.

- Create a splash that starts small, becomes a full-sized splash, 
and then changes to a flat picture. The following example 
shows how to do this.

Effect Parameter First Keyframe Second Keyframe Last Keyframe

Shape

Multi Wave Radius = 0 Let the system set 
the Radius.

Radius = 55

Foregnd

Full Key Opac = 100 Opac = 100 Opac = 100
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This example creates a splash that grows from the center of the screen. 
As the splash begins to cover the screen, the splash slowly fades away 
so that the final scene is completely flat. Fade the splash by lowering 
the Amplitude and Highlight intensity values to 0. The following 
illustrations show several stages of the effect.

To turn a splash into a flat image:

1. Apply the 3D Warp effect as a segment effect as shown in the 
following illustration.

2. Click the Effect Mode button to enter Effect mode. 

3. Choose Multi Wave from the Shape Fast menu.

4. Set Highlight parameter values for the first and last keyframes by 
using values from the following table.

Multi Wave Splash starts at center Splash at peak Splash slowly fades to flat
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5. Create a new keyframe in approximately the center of the effect’s 
position bar. This new keyframe is shown as the second keyframe 
in the following illustration.

The Avid system automatically calculates a radius size for this 
new keyframe in order to continue the smooth transition from 0 
radius to a radius of 50. 

6. Set the Shape and Highlight values for the second keyframe as 
shown in the above table.

7. Step through or play the effect.

Experiment with the X Pos and Y Pos Shape parameter values to 
reposition the splash on the screen. Also experiment with the Aspect 
and Angle parameters to stretch and rotate the splash.

Effect
Parameter First Keyframe Second Keyframe Last Keyframe

Shape
Multi Wave

Radius = 0

Freq = 70

Ampl = 36

Let the system set 
the Radius.

Freq = 70

Ampl = 36

Radius = 50

Freq = 0

Ampl = 0

Highlight Inty = 20 Inty = 20 Inty = 0

First keyframe Last keyframeSecond keyframe
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Creating a Cropped Foreground Effect

This example shows how to adjust 3D Warp parameters and apply 
them repeatedly as a template to create a consistent band of 
foreground segments — scaled and cropped with a soft border 
shadow — across a background.

Top video track (V2) Bottom video track (V1)

Settings for the 3D Warp effect are 
saved as a template and then 
applied to all segments on the top 
video track for consistency through-
out the dissolve sequence.
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To create a foreground band of footage:

1. Build the sequence with the background footage on the bottom 
track and the foreground footage on the top track. In this example, 
dissolves are added between a series of foreground segments.

2. Apply the 3D Warp effect to one segment of the top video track.

3. Enter Effect mode, and then click the segment to display the 
parameters in the Effect Editor.

4. Make sure both the starting and ending keyframes are selected; 
then adjust the effect parameters as shown in the following table.

Leave all other categories deselected.

Parameter Category Parameter Settings

Crop T (top): 600

L (left): –999

B (bottom): –600

R (right): 999

Scaling X: 110

Y: 100

Position Enable the category (leave parameter defaults).

Border Select a dark color for the border. For more 
information on color selection, see “Adjusting a 
Color Parameter” on page 125.

Width: 40

Soft: 100

H (hue): 0

S (saturation): 0

L (luminance): 255
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5. Save the parameters as a template by dragging the effect icon from 
the Effect Editor to a bin.

6. Apply the template from the bin to the remaining segments on the 
top track.

7. Click the Play Loop or Play button to preview the effect. The 
foreground segments play through smoothly with the same scale, 
border, and cropping effect against the background.

Using the Spline Parameters with 3D Effects

This example shows how to use the Spline parameters to create a 
smooth path for moving a 3D Warp effect.

The following illustrations show the motion path editor with the 
Spline parameter turned on and off. (The background image is black to 
make the motion paths more visible in this illustration.)

Motion path editor with
Spline turned off Spline turned on

Motion path editor with
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To use the Spline parameters:

1. Enter Effect mode and click the first keyframe indicator (on the left 
end of the effect’s position bar).

2. Click the Outline/Path button in the Effect Editor. 

A dot appears in the center of the image, and the arrow indicator 
appears to show the orientation of the image.

3. Click anywhere in the foreground video, and move the image to 
the bottom left corner of the Effect Preview monitor.

n Clicking and dragging moves a wire frame around the monitor. Press the Alt 
key (Windows) or Option key (Macintosh) and drag to move the actual effect 
object.

4. Click the last keyframe indicator, and move the image for that 
keyframe to the top right corner of the monitor. Notice that the 
two dots are connected by a straight line.

5. Add a keyframe approximately halfway through the effect’s 
position bar.

6. Move the image for the center keyframe to the top left corner of 
the monitor.

7. Play the effect. Notice that the image moves along straight lines.

8. Click the Enable button in the Spline parameter category. 

Notice that the straight lines connecting the dots turn into a 
smooth curve.

9. Play the effect again and notice the smooth movement.

Experiment with the XY Position and XZ Position buttons at any one 
of the keyframes. Also experiment with the Rotation buttons.

Enable button
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Corner Pinning an Image

Corner pinning is a way of precisely positioning a foreground image 
over an image in the background video track, with matching 
perspective.

This example shows the background and foreground videos used to 
create a segment transition using corner pinning. The segment starts 
with the foreground image “pinned” onto the video monitor in the 
scene; the image then moves off the TV and eventually fills the screen.

To corner pin an image:

1. Create a segment with two video tracks, placing the foreground 
video on the top track.

2. Apply the 3D Warp effect to the top track.

Foreground video corner pinned 
to background image

Foreground video moving off 
background image

Foreground video continuing to
move off background image

Background video Foreground video
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3. Enter Effect mode.

4. Position, scale, and rotate your image if necessary.

n For best results, make adjustments to the Position, Scale, and Rotate 
parameters before you use Corner Pin. This way, the center of the image for 
Corner Pin scale and rotation adjustments will be closer to the apparent 
center of the image, and you will find it easier to get the results you want.

5. Position the corners using one of the methods described in the 
following sections.

6. To review your edit, click the Play or Play Loop button.

n To return a corner to the default position, click the corresponding corner 
button in the parameter category, press the Alt key (Windows) or the Option 
key (Macintosh), and click the Enable button in the Corner Pin parameter 
category.

To use the Corner Pin button:

1. Click the Corner Pin button in the Effect Editor to activate the 
handles.

2. Click the handles and drag to manipulate the image.

3. Click the Corner Pin button a second time to turn off the handles.
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To use the Quick Pin feature:

1. Click the Corner Pin button in the Effect Editor to activate the 
handles.

2. Press and hold the Ctrl and Alt keys (Windows), or the Ctrl and 
Option keys (Macintosh). Position the cursor where you want the 
highlighted corner to be corner pinned, and click.

The next corner is highlighted. 

3. Continue using the Ctrl and Alt keys (Windows), or the Ctrl and 
Option keys (Macintosh), while clicking until the image is 
positioned where you want it.

The next corners continue to be highlighted in a clockwise rotation 
each time you click.

4. Click the Corner Pin button a second time to turn off the handles.

To use the parameter category:

1. Click the Enable button in the Corner Pin category.

2. Use the X and Y sliders in the Corner Pin parameter category to 
position the image.

The Corner Pin parameter category has a button for each corner, 
letting you pin one corner at a time.

Creating a Stamp

The Stamp category of the 3D Warp effect allows you to make certain 
effects — such as titles and Matte Key effects — remain on screen 
while other effects come and go, even though the effect segment itself 
has ended. For example, you can stamp a product or channel logo onto 
the lower corner to act as a type of watermark effect without adding 
additional layers onto the sequence.

In the example below, two effects (one Title effect and one imported 
Matte Key effect) are applied sequentially on the top track. Each one 
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has Stamp enabled on the last keyframe. Enabling Stamp lets each 
element remain in place as the next element appears on the screen. 

Both elements remain in place, and you could add additional stamps 
until you enable Clear to clear the Stamp buffer.

To create a stamp:

1. Create the image you want to use as a stamp.

For example, you can use the Title tool to create a title or you could 
import a PICT image.

2. Create a segment with at least two video tracks. 

If you want the stamp to be in the foreground, it has to be on the 
top track.

3. Add the track with your stamp image to the segment.

4. Enter Effect mode.

5. Click the 3D Promote button to turn on 3D effects.

6. Select the keyframe where you want the stamp to occur.

The first element zooms into position 
from full screen.

The first element is then “stamped” 
in place on the last keyframe.

The second element appears and is 
also stamped in place.
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If you do not want to use the first or last keyframe, add a keyframe 
where you want the stamp to occur.

7. Click the Enable button in the Stamp parameter category.

You can enable Stamp on more than one keyframe by repeating 
steps 6 and 7.

8. To review your edit, click the Play or Play Loop button.

To clear a stamp:

1. Select the keyframe where you want the stamp to be cleared.

2. Click the Clear button in the Stamp parameter category.

Everything in the Stamp buffer is cleared.

Using Axis for a Transition

The effect created in this example uses changes to axis and rotation to 
create a transition. If you move the axis in Z, the point of rotation 
moves off the object and creates a “barrel roll” effect as if the object is 
inside a rolling barrel. By breaking the move into two parts, you can 
add another shot on the reverse side of the image.

To use axis for a transition:

1. Create a two-track sequence.

2. Apply the 3D Warp effect to the segment on the second track. 

3. Make the effect at least 5 seconds long.

4. With both keyframes selected, set Z to –90 in the Axis parameter 
category.

5. Select the second keyframe and set Y to –180 in the Rotation 
parameter category.

6. Play the effect to see the simple YZ barrel roll.

7. Go back 3 seconds from the end of the effect and add a new 
keyframe.
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8. Copy the last keyframe values to the new keyframe.

9. Duplicate this new keyframe 1 second later by copying and 
pasting so that the last three keyframes are identical.

The frame stays at the half barrel roll position for 3 seconds.

10. Select the last keyframe and set Z to 180 in the Position parameter 
category.

This should bring the frame full screen for the new ending 
position.

11. Play the effect.

It should do a half barrel roll back, stay in position, and then move 
forward.

12. Find the point during the half barrel roll where the image is edge 
on to the viewer. 

The image should disappear and reappear with the back of the 
image showing.

13. Perform an add edit at this point. 

This divides the effect in two with the correct keyframes being 
sent to the correct parts of the clip.

14. Load the incoming video into the Source monitor, and mark it so 
that you can use it for the back of the image.

15. Step into the second part of the effect until all you see in the 
Timeline is the original video.

16. Mark the clip and replace it with the new shot.

17. Step out and play the effect.

Notice that the new incoming shot is reversed.

18. Step back in and apply a Flop to the incoming image.

19. Render the Flop.

20. Step out again and play the effect. 
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The incoming shot correctly transitions to full screen at the end of 
the effect.

About Chroma Keys

Like matte keys, chroma keys are used to replace an area of one shot 
with another shot. However, unlike matte keys, the area of 
replacement is determined by a single highly saturated color, usually a 
distinctive blue or green. The foreground object, such as a person, is 
shot in a studio in front of a screen of the selected color. Then the 
background is keyed out with a more desirable background, such as a 
weather map, an outdoor scene, or computer-generated animation. 

Chroma keys work better when you use component sources that have 
been digitized as a component signal. You can achieve this by using a 
component format, such as Betacam SP or D1. Proper lighting is also 
crucial to separating the foreground image from the chroma key color 
background.

To apply a Chroma Key effect:

1. Edit the foreground image onto track V2 and the background 
image onto track V1 in the Timeline.

2. Apply the 3D Warp effect to track V2.

3. Choose Chroma Key from the Fast menu in the Foregnd 
(Foreground) parameter category.

4. Click the Color Preview window, and press and hold the mouse.

5. When the eyedropper appears, drag it to the most representative 
area of color to be keyed and release the mouse.

n When choosing a color, stay away from corners of the frame or the area 
immediately around the foreground because these areas may contain subtle 
shades of gray.
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When you are finished, the system replaces the color with the 
video on track V1.

6. (Option) If your system includes the 3D Spill Suppression 
parameter category, use Spill Suppression if necessary to remove 
spill in the foreground image.

7. (Option) Use the sliders in the Foregnd (Foreground) parameter 
category to make refining adjustments to improve the look of the 
key.

Using Avid Xpress 3D Effects

The Effect Palette — on systems with 3D effects capability— contains 
an Xpress 3D Effect category.

The Xpress 3D effects have the following uses:

• Xpress 3D effects are completely compatible with Avid Xpress™ 
systems that are also equipped with the 3D Effects option. As a 
result, you can move sequences containing Xpress 3D effects 
between other Avid systems (Symphony™ or Media Composer) 
and Avid Xpress systems.
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c To maintain compatibility when transferring sequences from 
Symphony or Media Composer systems to Avid Xpress systems, use 
only Xpress 3D effects. Do not use the 3D Warp effect to create 3D 
effects.

• Xpress 3D effects provide a fast way to apply basic 3D effects to 
your sequence, without making custom adjustments using the 3D 
Warp effect. For example, the 3D Page Curl effect automatically 
creates a page curl effect when you apply it. 

n You can further adjust Xpress 3D effects in the Effect Editor; use the 3D 
Warp effect, however, when you need finer control of 3D effects parameters.
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CHAPTER 6

Creating Titles and 
Graphic Objects

The Title tool enables you to create titles that incorporate text, graphic 
objects, imported graphics, and video. This chapter explains how to 
create titles, including graphic objects. Throughout this chapter, the 
term “title” refers to both text and graphics.

• About Creating and Editing Titles

• Downstream Keying of Titles and Graphics

• Opening the Title Tool

• Understanding the Title Tool

• Setting Up the Drawing Environment

• Working with Text

• Creating Graphic Objects

• Creating Rolling Titles

• Selecting Colors and Setting Transparency

• Working with Shadows

• Manipulating Objects

• Saving Titles and Title Styles

• Creating and Using Title Templates
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• Working with Titles on Systems with 24p or 25p Support

• Saving and Recalling Title Styles

• Exporting a Title as a Graphics File

About Creating and Editing Titles

The following is an overview of the tasks you perform to create a title:

• Set up the drawing environment. After you open the Title tool, 
you can choose whether to display a color background or a frame 
of video from your sequence. You can also use safe colors or safe 
title and action guidelines or apply a grid for the placement of 
objects.

• Create a new title with the Title tool. You create the title by 
working with text and graphic objects and then applying and 
adjusting borders, colors, transparency, and shadows.

• Save the title and exit the Title tool. When you save a new title, 
you select a resolution that is compatible with your project and a 
target drive for the title media. You can also save just the styles for 
the title for future use. When you close the Title tool, the new title 
appears in the bin and in the Source monitor, ready for editing.

These basic procedures are described throughout this chapter. For 
information on editing a title into a sequence, see Chapter 7.

n If your system includes support for 24p or 25p projects, you have some 
additional options available to you when you are working with titles. For 
more information, see “Working with Titles on Systems with 24p or 25p 
Support” on page 323.
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Downstream Keying of Titles and Graphics

By default, the Avid system creates all titles using its downstream key 
(DSK) capabilities. Graphic elements imported with an alpha channel 
are also created as DSK clips. 

Downstream keying allows you to add uncompressed titles or 
graphics over multiple streams of compressed or uncompressed media 
and continue to play the sequence in real time. You can see the real 
benefits of downstream keying during editing of Title Effect clips into 
sequences.

n For information about editing with DSK titles, including descriptions of 
various restrictions and playback capabilities, see Chapter 7.

Opening the Title Tool

To open the Title tool:

1. In the Record monitor, move the position indicator to the video 
frame to be used as a reference. 

If you are not using video as the background, you can skip this 
step. For more information, see “Selecting a Background” on 
page 270.

2. Choose New Title from the Clip menu or Title Tool from the Tools 
menu.
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The Title tool opens. The Text tool is automatically selected, and 
the cursor becomes an I-beam, ready for entering text.

Understanding the Title Tool

The following illustration shows a title over a video background.

The Title tool has several major components: 

• A video background based on a sequence or a color background 
that you create.

• The title or graphic in the foreground that you create.

• The safe title and safe action area guidelines. For more 
information, see “Using Title and Action Guidelines” on 
page 269.

Toolbar

Safe action
area

Video
background

Title objects

Safe title
area
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• The toolbar at the bottom of the screen. For more information, see 
“Understanding the Toolbar” on page 264.

• In addition, there are title-related menu items on the File, Edit, 
Object, and Alignment menus. These menu items are described 
throughout this chapter.

Understanding the Toolbar

At the bottom of the Title tool are tools and pop-up menus you can use 
for creating and editing text and objects. They work much like similar 
tools in other draw and paint programs.

Table 6-1 briefly describes each section of the toolbar.

Drawing tools

Text formatting tools

Line attribute tools

Shadow tools

Background selec-
tion tools

Transparency 
Selection 
boxes

Color Selection 
boxes

Save Style 
Parameter menu

Video Placement tool
Text tool

Selection 
tool

Color and Transparency 
Blend tools

Styles menu
Rolling Title 
button

Templates tool

Table 6-1 Toolbar Elements

Tool Description

Selection tool Changes the cursor to an arrow and allows you to select text 
or objects for operations. See “Using the Selection Tool” on 
page 266.

Text tool Changes the cursor to an I-beam and allows you to enter text. 
See “Working with Text” on page 273.
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Video Placement 
tool

Changes the cursor to a hand and allows you to pan around 
the entire video clip within the Title tool.

Drawing tools Allow you to draw boxes, circles, ovals, and lines. See 
“Creating Graphic Objects” on page 284.

Styles menu Displays examples of the styles you defined and allows you 
to select one. See “Recalling a Title Style” on page 330.

Save Style 
Parameter menu

Displays examples of the styles you defined and allows you 
to select one. See “Saving a Title Style” on page 327.

Templates menu Allows you to create and recall title templates. See “Creating 
and Using Title Templates” on page 321.

Text formatting 
tools

Allow you to set various text attributes such as font, font 
size, kerning, and leading. See “Formatting the Text” on 
page 277.

Color Selection 
boxes

Allow you to change the color of text and objects. See 
“Selecting Colors and Setting Transparency” on page 296.

Transparency 
Level boxes

Allow you to change the transparency levels of text and 
objects. See “Adjusting the Transparency” on page 300.

Color and 
Transparency 
Blend tools

Allow you to create a blend between two colors or two 
transparency values. See “Blending Two Colors in an 
Object” on page 299.

Shadow tools Allow you to create drop shadows and depth shadows for 
text and objects and to preview the degree of softness set for 
shadows. See “Working with Shadows” on page 302.

Table 6-1 Toolbar Elements (Continued)

Tool Description
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Using the Selection Tool

The Selection tool is one of the most frequently used tools. You use the 
Selection tool when performing certain operations on objects you 
create, such as moving, formatting, resizing, or applying color.

To select an object:

t Click the Selection tool and click an object. 

Selection handles appear around the object.

Line attribute 
tools

Allow you to change the corners of boxes, line and border 
thickness, and arrowhead styles. See “Selecting Line 
Attributes” on page 286.

Rolling Title 
button

Allows you to create rolling titles. See “Creating Rolling 
Titles” on page 290.

Background 
selection tools

Allow you to switch between a video and opaque 
background and change the color of opaque backgrounds. 
See “Selecting a Background” on page 270.

Table 6-1 Toolbar Elements (Continued)

Tool Description

Selection tool

Selection handle 
for width
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n You can press the Alt key (Windows) or Option key (Macintosh), and click 
anywhere in the Title tool to switch between the Selection tool and the Text 
tool. You can also press and hold the Ctrl and Alt key (Windows), or the Ctrl 
and Option key (Macintosh), to display the Selection tool temporarily at any 
time.

To select multiple objects do one of the following:

t Shift+click with the Selection tool

t Click outside the objects and drag to surround the objects with 
a lasso

n After you use a tool in the toolbar, the system reverts to the Selection tool, and 
the cursor becomes an arrow. To prevent a tool from automatically reverting 
to the Selection tool, double-click the tool’s icon.

Setting Up the Drawing Environment

This section describes some aspects of the Title tool that you can use to 
set up your titling or drawing session.

n You can set or change these features at any time during your work on a title. 
These settings are stored with User settings and will appear each time a 
particular user opens the Title tool.

Installing Fonts

You can apply any font that is installed on the system when creating 
titles in the Title tool. When installing and using fonts, consider the 
following:

• If you want to apply a special font that is not currently on the 
system, you must install the font first before creating titles. 

• If you are bringing a project from another system, check to make 
sure you have installed any fonts used in titles contained in the 
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project. These fonts must match exactly (you cannot use variations 
of the font in the same font family). If your system does not 
recognize a font contained in a title, the Font Replacement dialog 
box appears to enable you to substitute an alternative font. For 
more information on font replacement, see the Avid Products 
Collaboration Guide.

• If you are bringing a project from one platform to another 
(Macintosh-based to Windows NT-based, or Windows NT-based 
to Macintosh-based), you might need to substitute a font from the 
new platform for an existing font in the project. Windows NT and 
Macintosh fonts sometimes differ even when they have the same 
name. If your system does not recognize a font contained in a title, 
the Font Replacement dialog box appears to enable you to 
substitute an alternative font. For more information on font 
replacement, see the Avid Products Collaboration Guide.

• If you intend to create titles with font sizes of 128 points or larger, 
use True Type® fonts. Some non-True Type fonts cannot display 
consistently at sizes of 128 points or higher.

n For more information on installing fonts, see your Windows NT system 
documentation or Macintosh system documentation.

Previewing Titles

Text and objects in titles are created anti-aliased with an 8-bit alpha 
channel. Anti-aliasing ensures that text, lines, and object edges appear 
smooth, regardless of size. You can preview a title to see the title 
drawn with anti-aliasing, just as it will be saved. 

To switch the display of anti-aliased titles on or off, choose Preview 
from the Object menu. A check mark indicates that Preview mode is 
enabled.

n Titles are always saved in anti-aliased format.
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The display behavior for title objects in Preview mode is as follows:

• You can alter the graphics characteristics of title objects (including 
colors, shadows, borders, and transparency) without losing the 
anti-aliased preview.

• You can select text objects and apply text styles from the Styles 
pop-up menu without losing the anti-aliased preview.

• When you click a text object for editing with the Text tool, the text 
is displayed without anti-aliasing. When you finish editing the 
text and click outside the object to deselect it, the anti-aliased 
preview is restored.

Using Title and Action Guidelines

By default, the system displays two outlined boxes in the Title tool to 
use as guidelines (see the illustration at the beginning of the section 
“Understanding the Title Tool” on page 263). The inner box is the safe 
title area. All text for television broadcast should remain within this 
inner box. The outer box is the safe action area for video display. These 
guidelines are self-adjusting for PAL and NTSC projects.

n You can customize the Effect Grid display. For more information, see 
“Working with the Effect Grid” on page 107.

To display the safe title area or safe action area guidelines:

t Choose Safe Title Area/Global Grid from the Object menu.

Using Safe Colors

If you plan to use your title for television broadcast, you can choose 
the Safe Colors command from the Object menu. This command 
displays only low saturation colors for use in text, objects, and 
background. Colors with low saturation look best when combined 
with video. By default, Safe Colors is turned on.
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To display only safe colors:

t Choose Safe Colors from the Object menu.

Selecting a Background 

Use the Video Background button to switch between a video 
background and an opaque color background.

Using a Video Background

If there is a sequence in the Record monitor, the Title tool opens with a 
video background. The location of the position indicator in the 
Timeline at the time you open the Title tool determines the initial 
video frame that displays. If there is no sequence in the Record 
monitor, the Title tool opens with no video showing (the background 
appears black).

The Video Background button is green when you are creating a title for 
display over a video background.

Use the background video frame as a reference. It does not become 
part of the title you create. You can edit the title anywhere else in the 
current sequence or in another sequence.

Updating the Video Background

You can update the video background at any time while creating titles 
within the Title tool.

Background Color window Video Background button
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To update the video background:

1. Click the Video Background (V) button in the toolbar to activate 
video background if you have not already done so.

2. Load the sequence into the Record monitor.

3. Move the position bar in the Timeline or in the monitor to display 
the new frame.

4. Click again in the Title tool to activate its window.

The background is updated to reflect the current contents of the 
Record monitor.

Creating a Color Background

To create a title that appears over an opaque color background:

1. Click the Video Background (V) button to switch off the video 
background if it was previously turned on.

2. Click and hold on the Background Color window.

The Title Tool Color Picker dialog box appears.

3. Use the Title Tool Color Picker dialog box, eyedropper, Windows 
Color dialog box, or Macintosh Color Picker to select a color. See 
“Selecting Colors and Setting Transparency” on page 296 for a 
description of how to use these tools. 

The default background color is black.

n When you create a title with a color background, it is opaque and it cannot be 
used to key over video. 

n You cannot create rolling titles with a color background. You can create a 
separate color background as a title and then edit the rolling title over it in the 
sequence.
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Displaying a Grid

You can display a grid to help you position text and objects. The 
visible grid does not appear when you save the title.

To display a grid:

t Choose Show Alignment Grid from the Alignment menu.

Snapping to a Grid

The snap grid is an invisible grid that helps position and connect 
objects. The snap grid has four lines for each line in the visible grid. 
Each square in the grid is subdivided by four invisible vertical and 
horizontal grid lines. Text and objects can snap to these lines.

To snap to a grid:

t Choose Align to Grid from the Alignment menu.

When you create or drag an object in the Title tool, the object snaps to 
the nearest grid line.

Bringing the Title Tool to the Foreground

If the Title tool becomes obscured by another window, you can instruct 
the Avid system to redisplay the tool. Choose Title Tool from the 
Windows menu or from the Tools menu.
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Using the 16:9 Display Format for Titles

For more information 
on HDTV and the 16:9 
option, see the editing 
guide for your system.

The Title tool supports the 16:9 aspect ratio for display of NTSC and 
PAL footage. The 16:9 option allows you to display the full-aspect ratio 
of wide-screen video used in the high-definition television (HDTV) 
format.

When you select the 16:9 option in the Composer settings, the Title tool 
increases its maximum horizontal size, and saved titles appear 
correctly in the Source and Record monitors set to 16:9.

n Because the 16:9 aspect ratio extends the horizontal dimensions of the footage, 
when you first open the Title tool in 16:9 mode you must use the Video 
Placement tool (the hand icon) to pan back and forth to view footage on the 
sides. Click the Maximize button in the upper-right corner of the Title tool to 
automatically resize the tool to fit the monitor.

Working with Text

By default, the Text tool is active when you open the Title tool, and you 
can begin entering text as soon as you click in the Title Tool window.

To use the Text tool at any other time, click the Text tool, click 
anywhere within the text object, and begin typing. An I-beam cursor 
indicates your position within the text. The Text tool remains selected 
until you select another tool.

n You can press the Alt key (Windows) or Option key (Macintosh) and click 
anywhere in the Title Tool window to switch between the Selection tool and 
the Text tool.

n For information on previewing smooth text, see “Previewing Titles” on 
page 268.

Text tool
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Creating Text

To create text:

1. Click the Text tool on the toolbar.

The cursor becomes an I-beam.

2. Click the position in the frame where you want to add text.

An insertion point appears.

3. Type the text. 

To insert a line return, press Enter (Windows) or Return 
(Macintosh).

n Text is word-wrapped automatically as you type. You can adjust the 
wrapping by changing the width of the text object. For more information, see 
“Resizing Text Objects” on page 275.

4. When you have finished typing, click the Selection tool on the 
toolbar to deselect the text object.

When you create text that is aligned on the left side using left 
justification (the default), you can eliminate the unused space on the 
right side of the newly created text object, especially if you want to use 
the Alignment menu commands.

To eliminate the space, click the middle selection handle on the right 
side of the text box and drag it to the left until it is closer to the text.

Copying and Pasting Text

You can copy and paste text into the Title tool directly from a word 
processing or text editing application.
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c There is a limit to the size of text objects you can create in the Title 
tool. Avoid pasting large blocks of text (numerous pages in a word 
processor) into the Title tool. Instead, consider pasting smaller 
blocks of text into separate text objects.

To copy and paste text into the Title tool:

1. Click the Text tool on the toolbar.

The cursor becomes an I-beam.

2. Click the position in the frame where you want to add text.

An insertion point appears.

3. Open the text file in a word processor or text editor.

4. Select the text in the word processor or text editor, and then choose 
Copy from the Edit menu or press Ctrl+C (Windows) or k+C 
(Macintosh).

5. Click the Title tool again to activate it. 

6. Press Ctrl+V (Windows) or k+V (Macintosh) to paste the text into 
place at the insertion point.

The pasted text takes on the attributes currently set in the Title 
Tool toolbar.

Resizing Text Objects

When you resize a text object, the text remains the same size but 
rewraps to fill the reshaped area.

To resize a text object:

1. Click the text object with the Selection tool.

2. Click one of the object selection handles for width and drag to 
resize.
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n You can resize only the width of a text object. The height of a text object is 
automatically determined by the number of words and the size of text.

Repositioning Text Objects

To reposition a text object:

1. Click the text object with the Selection tool.

2. Move the text by doing one of the following:

t Click in the middle of the object and drag it to a new position.

t Use the arrow keys to move the object one pixel at a time.

t Use commands on the Alignment menu to position the text. 
For more information, see “Aligning Objects” on page 311.

Editing a Text String

To edit an existing text string;

1. Click the Text tool, and click anywhere in the text. 

2. You can perform the following tasks:

• Use the arrow keys to move around within the text string.

• Type additional characters.

• Press Enter (Windows) or Return (Macintosh) to insert a line 
return.

• Drag to select characters.

• Use the Cut, Copy, and Paste commands from the Edit menu.

• Use the Delete key.

• Change the formatting of the selected text, as described in 
“Formatting the Text” on page 277.
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Formatting the Text

The text formatting tools control the appearance of text. You can click a 
text object with the Selection tool to format all the text within it, or you 
can use the Text tool to select a string of text within a text object to 
format individual characters or words.

You can modify the following text attributes for either a text object or a 
selected text string: 

• Current font

• Bold and italic

• Point size

• Kerning

• Leading

You can modify the following attributes for an entire text object only:

• Color (see “Adjusting the Color” on page 297)

• Transparency (see “Adjusting the Transparency” on page 300)

• Drop and depth shadows (see “Working with Shadows” on 
page 302)

• Outlined text (see “Selecting a Line or Border Width” on 
page 287)

• Justification (see “Justifying the Text” on page 280)

Text formatting tools
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While you type text, only the text color is apparent. Shadows, outlines, 
and other color attributes appear when you finish typing the text and 
click the Selection tool.

n If you want to create text elements in the title with different appearances, 
create a separate text object for each set of attributes.

Setting the Default Text Attributes

When you start the application and open the Title tool, the system uses 
default text attributes. You can change the defaults at any time. 
Changes you make to the default text attributes apply until you quit 
the application.

To change the default text attributes:

1. Click the Selection tool.

2. Click in the Title Tool window but do not select any text.

3. Change any of the text attributes.

Now whenever you start typing a new text string, the system uses 
your new defaults.

Selecting a Font

The Font Selection menu shows the current font for a text selection and 
allows you to change the font.

When you first open the Title tool, the font listed is the preferred 
system font. If an existing text object is selected, the Font Selection 
menu displays the font of the text object.
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The Font Selection menu displays all fonts currently installed on the 
system.

To change the font:

1. Click the Font Selection menu to display the pop-up menu. 

2. Select a font from the menu. 

The system displays the name in the Font Selection menu and uses 
this font for text until you change it during the editing session.

If a text object is selected, the Font Selection menu displays the font of 
the text object.

Changing the Point Size

The point size controls the size of the selected text. A point is a 
typographical unit of measure. There are 12 points to the pica and 
72 points to the inch. 

You can enter a point size either before or after you type text.

Font Selection menu

Point Size buttonPoint Size text box
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To change the point size, do one of the following:

t Click the Point Size button and choose a standard point size from 
the pop-up menu.

t Double-click in the text box and type a point size between 5 and 
999; then press Enter(Windows) or Return (Macintosh).

t Click in the text box and use the Up Arrow and Down Arrow keys 
to change the value incrementally.

Making Text Bold or Italic

The Bold and Italic buttons are located under the Point Size text box. 

In addition, the Object menu contains commands for bold and italic.

To change the text style, select the text you want to change and click 
the appropriate button, or select the appropriate command from the 
Object menu.

Justifying the Text

Below the Font Selection menu are the buttons for text justification. 
Text justification controls the alignment of text in an existing text object 
and also when you type text in a new text object.

Point Size
pop-up menu

Bold and Italic buttons
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Click the left text justification button to left justify the text. Click the 
center button to center the text. Click the right button to right justify 
the text. 

Kerning the Text

Kerning improves the appearance of titles by controlling the amount of 
space between characters. You can expand or condense the character 
spacing to make text more readable or to create special effects, such as 
dramatically expanded spacing in a title. 

The text kerning controls are located beneath the text justification 
buttons.

You can kern the text for an entire text object, or you can manually 
kern individual character pairs or character strings. For example, if 
you mix italic and plain versions of a font in a title, you might want to 
adjust the spacing between characters.

Text justification buttons

Kerning text box and Kerning selection button
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You can use the menu options to select predefined kerning options or 
specify your own custom kerning value. Positive numbers increase the 
spacing; negative numbers decrease the spacing. You can also use the 
arrow keys to make incremental adjustments.

n You can adjust kerning for individual characters or selected groups of 
characters using the arrow keys only.

n You can choose the kerning value before you type text.

Adjusting Kerning Manually

To adjust kerning manually with the arrow keys:

1. Click the Text tool on the toolbar.

2. Click between a character pair or select a group of characters to be 
kerned.

3. Press the Alt key (Windows) or Option key (Macintosh) and use 
the Left Arrow or Right Arrow key to increase or decrease the 
kerning.

Loose kerning

Normal kerning

Tight kerning
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Using the Predefined Kerning Sizes

To adjust kerning with the predefined sizes in the menu:

1. Select the text.

2. (Option) Click the Kerning selection button and choose 
Pair Kerning to eliminate excessive space between some character 
pairs. Note that pair kerning works only on fonts that support 
kerning tables (for example, Palatino).

3. Choose a kerning option from the Kerning pop-up menu:

t Loose adds space between letters.

t Normal leaves spacing unchanged.

t Tight closes up the spacing between letters.

Using the Kerning Text Box

To adjust kerning with the text box:

t Click in the Kerning text box and type a positive or negative 
numerical value. Values are a percentage of the point size.

t Click in the Kerning text box and use the Up Arrow and Down 
Arrow keys to change the value incrementally.

The system applies the kerning to the entire text object.

Adjusting Leading

Use leading to adjust the line spacing between lines in a title. Leading is 
measured in points, from baseline to baseline of the lines of text. The 
Title tool uses the leading that is built into the font as the default. 
Positive leading values add space; negative values decrease space. You 
might want to add leading for sans serif, tall, or boldface fonts, and for 
fonts with a strong vertical emphasis.
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To set leading:

1. Click in the Leading text box. 

2. Type a number to indicate the leading value you want.

The system adjusts leading immediately. 

Creating Graphic Objects

The drawing tools enable you to draw graphic objects such as squares, 
rectangles, circles, ovals, and lines. To use the drawing tools, select one 
of these shapes.

After creating graphic objects, you can change the following attributes:

• To round the corners of a box, adjust the width of lines and text 
borders, or add arrowheads to lines, see “Selecting Line 
Attributes” on page 286.

• To change or blend colors in a graphic object, see “Adjusting the 
Color” on page 297.

• To apply a drop or depth shadow, see “Working with Shadows” 
on page 302.

Leading text box

Drawing tools
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• To add transparency to an object or an object’s shadow, see 
“Adjusting the Transparency” on page 300.

n By default, when you use a drawing tool and deselect the created object, the 
cursor reverts to the Selection tool. To avoid this, double-click the drawing 
tool when you select it in the Title Tool toolbar.

Drawing a Square or Rectangle

To draw a square or a rectangle:

1. Click the Square and Rectangle tool on the toolbar.

The cursor becomes a crosshair pointer.

2. Click in the Title tool and drag to create an object.

n Pressing the Shift key while you drag constrains the Square or Rectangle tool 
to create a square.

Drawing a Circle or Oval

To draw a circle or an oval:

1. Click the Oval tool on the toolbar.

The cursor becomes a crosshair pointer.

2. Click in the Title tool and drag to create an object.

n Pressing the Shift key while you drag constrains the Oval tool to create a 
circle.

Rectangle 
drawn over 
video back-
ground
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Drawing a Line

To draw a line:

1. Click the Line tool (slanted line) on the toolbar.

The cursor becomes a crosshair pointer.

2. Click in the Title tool and drag to create a line.

n Pressing the Shift key while you drag constrains the Line tool to create a 
horizontal or vertical line.

Selecting Line Attributes

Use the line attribute tools to round the corners of a box, select the 
width of lines and borders, and add arrowheads to line endpoints.

You can also change the following drawing attributes:

• Color (see “Adjusting the Color” on page 297)

• Transparency (see “Adjusting the Transparency” on page 300)

• Drop and depth shadows (see “Working with Shadows” on 
page 302)

n If you do not select an object and you choose a line attribute, the system makes 
that the default for any new objects that you create.

Rounding Corners

To round box corners:

1. Select a box.

2. Click the Box Corner tool.

The Corner Selection pop-up menu appears.

Line attribute tools
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3. Choose a rounding option from the pop-up menu, or choose the 
custom radius option to open a dialog box and enter a custom 
radius.

4. If you choose the Custom Radius option, in the dialog box type a 
whole number (in pixels) to specify a custom corner radius and 
click OK. The maximum radius is 200.

Selecting a Line or Border Width

You can use the Border Width tool to change the width of lines created 
with the drawing tools or to apply a border outline to text or graphic 
objects.

To select a line or border width:

1. Select an object (such as a line, shape, or text object).

2. Click the Border Width tool.

The Border Width pop-up menu appears.

Custom Radius option
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3. Choose from the standard width selections or choose the Custom 
Width option to open a dialog box and enter a custom width.

4. If you choose the Custom Width option, in the dialog box type a 
whole number (in pixels) to specify a custom width. Use a width 
of 1 or greater for lines and 0 or greater for object outlines. The 
maximum width is 200.

If you selected a line for modification, the width of the line 
changes. If you selected an object for modification, the width of 
the outline changes.

Custom Width option

Remove border
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Adding Arrowheads

To add arrowheads to a line:

1. Select a line.

2. Click the Arrowhead tool. 

The Arrowhead Selection pop-up menu appears.

3. Choose an arrowhead style from the pop-up menu, or choose the 
Edit Arrowhead option as described in the following section.

Changing Arrowhead Size

To change the arrowhead size:

1. Select a line.

2. Click the Arrowhead tool.

3. Choose the Edit Arrowhead option from the pop-up menu.

The Arrowhead Size dialog box appears. 

Text with bor-
ders

Edit Arrowhead option

Remove arrowhead
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4. Click the handle on the arrowhead and drag it vertically or 
horizontally to resize and reshape it.

n The shape of the arrowhead is in scale with the line width.

5. Click OK. 

The system applies the arrowhead to the line.

Creating Rolling Titles

You can create text or graphics that roll up the screen. You create the 
title in the Title tool and refine the motion during editing.

Rolling titles scroll vertically, moving from top to bottom or bottom to 
top, as shown in the following example.

Handle
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n You cannot save a rolling title with a colored background even though you 
can set the Title tool to display a colored background while you create a rolling 
title. To place a rolling title over a colored background, you must export the 
background as a PICT file, reimport it (with Ignore Existing Alpha selected in 
the Import dialog box), edit it into your sequence, and then edit the rolling 
title onto a new layer above the background graphic.

Page Count Limits for Rolling Titles

Rolling titles form pages in the Title tool that are similar to the pages 
you create with a word processor. A page in a rolling title is a unit the 
size of a PAL or NTSC frame.

Table 6-2 shows the maximum number of pages you can create for 
rolling titles.

Rolling titles 
scroll from 
bottom to top 
by default.

Table 6-2 Title Object Size

Object Type Height Height

Graphic objects 17 pages NTSC 
14 pages PAL

8 K pixels

Text objects 67 pages NTSC 
57 pages PAL

32 K pixels
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Page limitations are based on the overall size of the text object. Typing 
more text, increasing the size of the font, or adjusting kerning and 
leading all affect the number of pages in the object.

• If you reach the end of the page limitation while you are typing 
text, the object stops getting bigger and text entry stops.

• If you attempt to make changes to the text formatting that cause 
the text to exceed the page limit, a message box appears, stating 
that the operation will exceed the limit. Click OK to abort the 
operation and keep the title within the limit.

Using Auto Size Mode

For more information 
on adding extra pages 
with Auto Size mode 
disabled, see “Adding 
Pages” on page 295.

Auto Size mode causes the Title tool to add or remove pages 
automatically as you add, delete, or reformat the text. You can disable 
Auto Size mode if you want to add extra pages before or after the text 
to make room for additional title elements, for example.

Auto Size mode is active by default in Rolling Title mode. To switch 
Auto Size mode off or on, choose Auto Size Mode from the Object 
menu. A check mark indicates that Auto Size mode is enabled.

Setting Up Text Formatting for Rolling Titles

Before creating a rolling title, consider setting up the text formatting 
defaults for such things as font, point size, leading, and kerning.

When you type the text for a rolling title, lines of text wrap 
appropriately within the safe title area, and the title scrolls down as 
you type, providing a realistic sense of positioning, word wrap, and 
page count limitations.

n To set up the defaults, see “Setting the Default Text Attributes” on 
page 278.
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Typing the Rolling Title Text

To type rolling title text:

1. Choose New Title from the Clip menu or Title Tool from the Tools 
menu. 

The Title tool opens.

2. Click the Text tool on the toolbar.

3. Click the Rolling Title (Roll) button to activate Rolling Title mode.

The button changes to green, and a page number display appears 
in the bottom right corner of the Title tool. 

n The Video Background button is automatically enabled (you cannot create 
rolling titles over a color background).

4. Type the title text. 

The text wraps automatically as you type.

5. When you are finished, click the Selection tool on the toolbar to 
select the new text object.

Resizing the Width of a Rolling Title

To resize a rolling title:

1. Click the title object with the Selection tool.

2. Click the object selection handle, and drag to resize the title until it 
appears as you want.

Rolling Title button
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n You can resize only the width of a text object. The height of a text object is 
automatically determined by the amount of text.

Scrolling Through a Title

When you create a rolling title, a scroll bar appears along the right side 
of the Title Tool window for moving vertically through the title.

Use standard techniques for scrolling, such as clicking the arrow icons, 
dragging the scroll box, or clicking in the scroll bar. You can also do the 
following:

• Press the Page Up or Page Down key on the keyboard to move 
through the title one page at a time.

• Press the Home or End key to go to the beginning or end of the 
title.

• Press the Up Arrow or Down Arrow key to move the cursor 
through the title one line at a time.

Going to a Page

When you first create a rolling title, a page number text box appears in 
the lower right corner of the Title tool. The page number text box 
reflects your current position in the title.

Page number text box
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To go to a different page:

1. Click in the page number text box.

2. Type a page number for a specific page, or use the Up Arrow and 
Down Arrow keys to cycle through the page numbers.

3. Press Enter (Windows) or Return (Macintosh).

Adding Pages

You can add pages to a rolling title to create space for adding new 
elements.

To add pages to a rolling title:

1. Choose Auto Size Mode from the Object menu to disable it (the 
check mark should no longer appear in the menu).

n The Add Page command is not available when Auto Size mode is enabled.

2. Choose Add Page from the Object menu to add a page. You can 
choose Add Page repeatedly to continue adding pages up to the 
maximum page count.

n For more information on maximum page counts, see “Page Count Limits 
for Rolling Titles” on page 291.

3. Select text or graphic objects within the title and position them 
within the range of available pages, or create new elements.

Deleting Additional Pages

You cannot select individual pages to delete during the creation of a 
rolling title. However, if you add pages to the title with Auto Size 
mode disabled, once you complete the title you can remove excess 
pages at the end of the title.
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To delete additional pages:

t Choose Auto Size Mode from the Object menu. 

The system removes excess pages at the end of the title.

Formatting Rolling Titles

You can modify the text attributes of a rolling title with the same 
methods used to format still text elements:

• For information on adjusting font, point size, style, justification, 
kerning, and leading, see “Formatting the Text” on page 277.

• To create outlines surrounding the text, see “Selecting a Line or 
Border Width” on page 287.

• For information on adjusting color and transparency, see 
“Selecting Colors and Setting Transparency” on page 296.

• To add a drop or depth shadow, see “Working with Shadows” on 
page 302.

Selecting Colors and Setting Transparency

You can select the color and transparency for text and graphic objects, 
their shadows and borders.

The following illustration shows the boxes associated with color and 
transparency.
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• The Color Selection boxes control fill (Fill), shadow (Shad), and 
border (Bord) color, respectively. 

• The Transparency Level boxes control fill, shadow, and border 
transparency, respectively. 

• The Color and Transparency Blend tools appear when you select a 
Fill or Border Color Selection box or Transparency Level box. 

If you select a Color Selection box, the top boxes show the two 
colors that are used to create the blend. The bottom box shows the 
blended color and allows you to control the direction of the blend 
or transparency.

If you select a Transparency Level box, the top boxes show the two 
transparency values that are used to create the blend. The bottom 
box allows you to control the direction of the transparency blend.

Adjusting the Color

You can select a color from the Title Tool Color Picker, use an 
eyedropper to select a color from any open application on your 
computer, or use the Windows Color dialog box or the Macintosh 
Color Picker to select a color. All these features are available through 
the Title Tool Color Picker.

Color and Transparency Blend tools

Transparency Level boxes

Color Selection boxes
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To select a color:

1. Select a text or graphic object. If you do not select an object, the 
color will be applied to the next object you create.

2. Click one of the Color Selection boxes on the toolbar: 

• Fill (Fill) applies the color to the selected object.

• Shadow (Shad) applies the color to the selected object’s 
shadow.

• Border (Bord) applies the color to the selected object’s outline 
or border.

3. The Title Tool Color Picker opens.

n You can drag the Color Picker from the toolbar to create a floating palette.

4. Choose a color:

t To choose from the Title Tool Color Picker, drag the cursor 
along the color selection bar to the color you want, and then 
move the cursor down into the shade selection palette to 
choose a shade. The color is applied when you release the 
mouse button.

t To use the eyedropper, drag the cursor to the eyedropper icon 
and release the mouse button. The cursor changes to the 
eyedropper. Click the color you want from anywhere in the 
window to apply the color to the selected object.

Color selection bar

Shade selection palette

Original Color window

New Color window

Grayscale
selection bar

Eyedropper

Click to open
the Windows Color dialog box 
or the Macintosh Color Picker.
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t To use the Windows Color dialog box or the Macintosh Color 
Picker, drag the cursor to the round button icon under the 
eyedropper, and release the mouse button. The Windows 
Color dialog box or the Macintosh Color Picker appears. For 
more information, see “Using the Windows Color Dialog 
Box” on page 125 or “Using the Macintosh Color Picker” on 
page 127.

t To choose a grayscale value, click in the grayscale selection 
bar.

Blending Two Colors in an Object

The Avid system lets you blend two colors in a text or graphic object or 
in a border. You can also specify the direction of the blend.

n You can blend the fill and border but you cannot blend a shadow.

To blend two colors:

1. Select text or another object.

2. Click the Color Selection box for either fill or border.

The Color Blend tools appear. 

3. Click one of the Color Blend Selection boxes, and choose a color 
using either the Title Tool Color Picker, the eyedropper, the 
Windows Color dialog box or the Macintosh Color Picker.

Color Selection boxes

Color Blend Selection boxes

Blend Direction box
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4. Click the other Color Blend Selection box, and choose the second 
color for your blend.

The Blend Direction box appears below the two Color Blend 
Selection boxes. This box displays the blend and allows you to 
specify the direction of the blend (for example, left to right).

5. Click the Blend Direction box and drag clockwise or 
counterclockwise to achieve the effect you want. 

As you rotate the pointer, the position of the two colors rotates. 
The change takes effect as soon as you release the mouse button.

Adjusting the Transparency

After you select a color, you can select the color transparency. To do so, 
click the appropriate Transparency Level box, depending on whether 
the transparency will apply to an object or will adjust a shadow or 
outline around the selected object.

The Transparency Level box displays the text “Hi” with a background 
that changes from black to white. A completely white background 
represents a fully transparent object or portion of an object. The 
following illustration shows an example.

Color blend tools 
apply a gradient 
blend to the 
selected object.
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In the pop-up control that appears, drag the slider until you attain the 
transparency you want, and then release the mouse button. The 
system immediately applies the transparency to your selection. 

n You might find it useful to turn off the shadow and shadow softness for an 
object while experimenting with transparency. Set the shadow value to 0 in 
the Shadow Depth text box and the softness value to 0 in the Shadow Softness 
dialog box, as described in “Working with Shadows” on page 302.

Blending Transparency of Fills and Borders

You can blend the transparency of fills and borders by using a 
technique similar to blending colors. Use the Transparency Blend 
Selection boxes to set the blend values. Use the Blend Direction box to 
set the direction of the blend.

Transparency Level boxes Transparency Blend 
Selection boxes

Blend Direction 
box

Transparency 
blend controls 
apply a gradient 
transparency to 
the selected 
object.
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n For more information on creating a blend, see “Blending Two Colors in an 
Object” on page 299.

Working with Shadows 

You can add a drop shadow or depth shadow to text and objects. A 
drop shadow is offset from the title itself, as though cast by a light 
source. A depth shadow extends from the edges of the title, as though 
the title were three-dimensional. The following illustration shows an 
example of drop and depth shadows.

You can select the color, width, direction, and transparency for the 
shadow. You can also soften (blur) shadows or create a glow effect 
behind title text. You can place the shadow anywhere within the title 
without restriction. The following illustration shows the tools used to 
create and modify shadows.

Text with 
drop shadow

Text with 
depth shadow
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Applying Shadows

To apply shadows to text or objects:

1. Select text or an object.

2. Click the Drop and Depth Shadow button to switch between a 
drop or depth shadow.

3. Adjust the depth or direction of the shadow as follows:

t Click the Shadow Depth and Direction button and drag the 
shadow displayed to any position.

t Press the Shift key; then click the shadow in the Shadow 
Depth and Direction button and drag to restrict shadow 
placement to 45-degree angles around the title.

t Press the Shift key and use the arrow keys to move the 
shadow to any position around the title.

t You can also type a value in the Shadow Depth text box to 
change the shadow depth by increments.

The Avid system automatically orients the shadow to the selected 
object. You can continue to follow these procedures to adjust the 
shadow until you achieve the effect you want.

Shadow Depth text box
Drop and Depth Shadow button

Shadow Depth and Direction buttonShadow Color and Transparency boxes
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Adjusting Shadow Color and Transparency

Use the procedures described in “Selecting Colors and Setting 
Transparency” on page 296 to apply color and transparency to 
shadows.

Adjusting Shadow Softness

You can set a value for the degree of softening or blurring that applies 
to the shadows you create in the Title tool. The value that you set 
applies immediately to any selected title. The value is also saved as the 
new default setting and applies to any new title objects you create in 
current and future Title tool sessions. To change the degree of 
softening that applies to objects in the Title tool, you must set a new 
value.

The following illustration shows a title shadow with a Shadow 
Softness setting of 15.

Setting Shadow Softness

To set a degree of softening or blurring for shadows:

1. Choose Soften Shadow from the Object menu.

The Shadow Softness dialog box appears.
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2. Type a number in the Shadow Softness text box to represent the 
degree of softening you want.

Shadow softness values must fall between 4 and 40. The higher the 
value, the more blurred the shadows will be. If you set the value to 
zero, shadows on title objects will have no softening (hard edges).

3. Click OK to close the Shadow Softness dialog box.

Adjusting Shadow Softness on the Fly

You can adjust the shadow softness value of a title object on-the-fly 
either by entering different values in the Shadow Softness text box or 
by using the Up Arrow and Down Arrow keys.

To adjust shadow softness on the fly by using the Shadow Softness 
text box:

1. Select one or more objects in the Title tool.

2. Choose Soften Shadow from the Object menu.

3. Type a number in the Shadow Softness text box to represent a 
degree of softening.

4. Click Apply.

The system applies the softness value to the selected title object.

5. Repeat steps 3 and 4 until you are satisfied with the effect.

6. Click OK.
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To adjust shadow softness on-the-fly using the Up Arrow and Down 
Arrow keys:

1. Select one or more objects in the Title tool.

2. While pressing and holding the Shift and Alt keys (Windows) or 
the Shift and Option keys (Macintosh), press the Up Arrow and 
Down Arrow keys to adjust the softness value incrementally until 
you are satisfied with the effect.

Each press of the Up Arrow key adds 1 to the shadow softness 
value. Each press of the Down Arrow key subtracts 1 from the 
shadow softness value.

Viewing Shadow Softness

The current degree of softness is always represented visually on the 
shadow display of the Shadow Depth and Direction button. The 
following illustration shows this representation for a shadow softness 
setting of 10.

To confirm the numerical value that is currently set for shadow 
softness, choose Soften Shadow from the Object menu and check the 
number in the text box.

Creating a Glow Effect 

If you create a title object with Shadow Softness set to a non-zero value 
and Shadow Depth set to zero in the Title tool, the object will appear to 
have a glow or halo around it. In the following illustration, Shadow 
Softness is set to 10.
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n To create titles that do not have either softened shadows or glows, you must 
set the Shadow Softness to zero.

Manipulating Objects

This section describes how to manipulate objects after you have 
created them. See “Using the Selection Tool” on page 266 for a 
description of how to select objects.

Basic Object Manipulation

You can use commands from the Edit menu to manipulate objects.

To manipulate objects:

1. Click an object — such as text, a square, a rectangle, a circle, or an 
oval — with the Selection tool.

2. Perform one of the following:

t Choose Cut from the Edit menu to cut an object and move it to 
the Clipboard.

t Choose Copy from the Edit menu to copy an object to the 
Clipboard.

t Choose Paste from the Edit menu to paste an object from the 
Clipboard.

t Choose Select All from the Edit menu to select all objects.
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t Choose Delete from the Edit menu to delete selected objects.

n You cannot delete locked objects. Unlock objects you want to delete.

t Choose Duplicate from the Edit menu to duplicate an object.

Layering Text and Objects

You can use commands on the upper portion of the Object menu to 
layer text and objects to create complex graphics. 

The last object created occupies the top layer, but you can move objects 
forward or backward within the screen area.

To adjust the layering of objects in a title:

1. Click an object with the Selection tool.

2. Choose one of the following commands from the Object menu:

t Bring To Front, to bring an object to the top layer.

t Send To Back, to send an object to the bottom layer.

t Bring Forward, to move an object forward one layer.

t Send Backward, to move an object back one layer.
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Grouping and Ungrouping Objects

After creating a number of text and graphic objects, you can use 
commands on the Object menu to group the objects and treat them as a 
single object. 

Combining the objects into a group means that actions, such as 
moving or applying color, affect all objects in the group.

To group objects:

1. Shift+click multiple objects with the Selection tool.

2. Choose Group from the Object menu.

The Avid system creates a grouped object from the individual 
objects. Changes to any individual object in the group affect all 
objects in the group.

To ungroup objects:

1. Click a grouped object with the Selection tool.

2. Choose UnGroup from the Object menu.

Everything in the group becomes an individual object that you can 
move or change independently.

Grouping commands
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Locking and Unlocking Objects

You can lock objects using commands on the Object menu so that 
changes to default settings, such as the font setting or object 
position, do not affect the locked objects. 

You may also want to lock objects so that you do not inadvertently 
change them while working on other objects. You can lock an 
individual object or multiple objects.

To lock objects:

1. Click an object with the Selection tool.

2. Choose Lock from the Object menu.

The Avid system locks the object. It cannot be changed until you 
unlock it. When selected, the object displays hollow selection 
handles to indicate that it is locked.

Locking commands

Hollow object 
selection handles
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To unlock objects:

1.  Click a locked object with the Selection tool.

2. Choose Unlock from the Object menu.

The Avid system unlocks the object. You can now change it.

Aligning Objects

You can use the Alignment menu commands to align text and objects 
to each other and to the frame. Aligning to the frame refers to the safe 
title area. For information about the safe title area, see “Saving Titles 
and Title Styles” on page 313.

To align objects to the frame:

1. Click an object with the Selection tool, or Shift+click multiple 
objects.

2. Choose a frame alignment direction from the upper portion of the 
Alignment menu.

The objects are aligned within the safe title area.

To align objects to each other:

1. Shift+click or lasso multiple objects with the Selection tool.

2. Choose an object alignment direction from the Alignment menu.

Frame alignment com-
mands
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n For information on aligning objects to a grid, see “Displaying a Grid” on 
page 272.

Distributing Objects

You can use Alignment menu commands to distribute text and 
graphic objects evenly across the safe title area. For information about 
the safe title area, see “Saving Titles and Title Styles” on page 313.

To distribute objects:

1. Shift+click at least three objects with the Selection tool.

2. Choose a distribute command from the Alignment menu:

t Distribute Left to Right, to distribute the objects evenly from 
left to right across the safe title area.

t Distribute Top to Bottom, to distribute the objects evenly from 
top to bottom across the safe title area.

t Distribute First to Last, to distribute the objects evenly 
between the position of the first object selected and the 
position of the last object selected. This option is especially 
useful for aligning objects diagonally or for roughly 
positioning a group of objects and then lining them up 
without spreading them out to the edges of the safe title area.

Align Objects 
commands
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Saving Titles and Title Styles

After creating a new title, there are three basic ways to save your work:

t Save the title and exit the Title tool.

t Save the title and continue creating additional titles.

t Save a title style that you can apply to additional titles you create.

You can also reopen in the Title tool a previously saved title and make 
further changes, as described in this section.

n After editing a title into a sequence and adjusting effect parameters, you can 
also save a Title Effect template that contains only the effect information 
(without title media) for applying to other previously created titles. For more 
information, see “Saving an Effect Template” on page 137.

c You should render all fast-saved titles and any unrendered rolling 
titles before exporting the sequence using OMF®.

Distribute
commands
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Matching Resolutions

When you save a new title, you must choose a resolution for the title 
that is compatible with the project, based on the following:

• The rules regarding different media resolution groups apply to 
titles. In other words, you cannot mix titles from one resolution 
group with media from another. For example, you cannot mix 
single-field titles with two-field media in a sequence. 

n For full information on mixing media resolutions in a project, see the 
appendix “Resolutions and Storage Requirements” in the Avid Media 
Composer and Film Composer Input and Output Guide.

• Your Avid system uses the resolution information to compute the 
dimensions of the title.

• Even though DSK titles are uncompressed, if you decide during 
editing that you need to render the title or disable the DSK 
capabilities to create a layered effect, the title renders with the 
resolution you select when you first save the title.

Saving a Title and Exiting the Title Tool

To save the title and exit the Title tool:

1. Choose Close from the File menu.

If the contents of the title have changed since the last time it was 
saved, a dialog box appears, asking if you want to save the 
existing title.
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2. Click Save. 

The Save Title dialog box appears.

3. Type a name to identify the title in the bin; then choose a bin, 
drive, and resolution from the pop-up menus.

n If you are saving a new title, the resolution you choose becomes the default for 
future new title saves.

n You must select a resolution that is compatible with the sequence. Titles will 
not play with incompatible media. For more information on resolution groups 
and compatibility, see the appendix “Resolutions and Storage Requirements” 
in the Avid Media Composer and Film Composer Input and Output Guide.

n You can also use the Media Creation tool to set the resolution and drives for 
titles. See the section on “Media Creation Settings” in the Avid Media 
Composer and Film Composer Input and Output Guide.

Multiformat 
check boxes 
(appear only 
on systems 
that support 
24p or 25p 
projects)
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4. Select or deselect Fast Save, depending on your needs. For more 
information, see “Using the Fast Save Option” on page 318.

5. (Option) If you are working on a system that supports 24p or 25p 
projects, select the title formats you want to save.

For more information, see “Working with Titles on Systems with 
24p or 25p Support” on page 323.

6. Click Save.

The Title tool closes, and the Avid system loads the new title into 
the Source monitor. A two-minute Title Effect clip that 
corresponds to the new title appears in the bin.

Saving Multiple Titles in a Session

To save multiple titles:

1. Choose Save Title from the File menu. 

The Save Title dialog box appears.
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2. Type a name to identify the title in the bin; then choose a bin, 
target drive, and resolution from the pop-up menus. 

n You must select a resolution that is compatible with the sequence. Titles will 
not play with incompatible media. For more information on resolution groups 
and compatibility, see the appendix “Resolutions and Storage Requirements” 
in the Avid Media Composer and Film Composer Input and Output Guide.

n You can also use the Media Creation tool to set the resolution and drives for 
titles. See the section on “Media Creation Settings” in the Avid Media 
Composer and Film Composer Input and Output Guide.

3. Select or deselect Fast Save, depending on your needs. For more 
information, see “Using the Fast Save Option” on page 318.

4. (Option) If you are working on a system that supports 24p or 25p 
projects, select the title formats you want to save.

Multiformat 
check boxes 
(appear only 
on systems 
that support 
24p or 25p 
projects)
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For more information, see “Working with Titles on Systems with 
24p or 25p Support” on page 323.

5. Click OK.

The new Title Effect clip appears in the bin.

6. Create another title.

7. Choose Save Title as from the File menu, and repeat steps 2 to 5 for 
each subsequent title that you create.

The Avid system loads titles into the Source monitor as they are 
saved, so the most recently saved title always appears in the 
Source monitor.

Using a Keyboard Shortcut to Save a Title (Windows Only)

You can use a keyboard shortcut that is equivalent to choosing “Save 
as” from the File menu of the Title tool. You can quickly save the latest 
version of your title without replacing the original. 

To save a title by using a keyboard shortcut:

1. Press Shift+Ctrl+S.

The Save Title dialog box appears.

2. Name the title.

3. Select a bin and an drive where you want to save the title.

4. Click Save.

Using the Fast Save Option

You can use the Fast Save option to work more quickly when creating 
and saving multiple titles in a Title tool session. 
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Fast Save skips the steps that create anti-aliased images from title 
objects. Instead, just the raw title objects (text and graphics) are saved 
in the bin, with the prefix “unrendered.” 

You can edit with the titles and then batch-render them at a more 
convenient time. Fast Save is ideal for working with multipage rolling 
titles with complex styles and shading.

For information on rendering Fast-saved titles, see “Creating Media 
for Unrendered Titles in a Bin” on page 359.

n Fast-saved titles appear as black in the monitors and are labeled as “media 
offline” during editing.

c Always render fast-saved titles before exporting a sequence using 
OMF and before creating an EDL from the sequence. In addition, 
render all rolling titles before you export a sequence as OMF.

Saving a Title with Fast Save

To use the Fast Save option, select Fast Save (unrendered) in the Bin 
Parameters dialog box when saving the title. For complete procedures 
for saving titles, see “Saving a Title and Exiting the Title Tool” on 
page 314 or “Saving Multiple Titles in a Session” on page 316.

n Fast Save remains in effect until you either deselect it, load a title that was 
saved without Fast Save selected, or exit the Title tool.

Viewing Fast-Saved Titles in a Bin

To quickly locate the unrendered fast-saved titles:

1. Open the bin containing the unrendered fast-saved titles.

2. Choose Select Unrendered Titles from the Bin menu.

The fast-saved titles are highlighted in the bin.
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Revising a Title in a Bin

If you want to revise a title that has not been edited into a sequence, 
you can reopen the title in the Title tool directly from the bin.

n For information on revising a title that has been edited into a sequence, see 
“Revising a Title in a Sequence” on page 352.

To revise a title in a bin:

1. Press the Ctrl key and double-click the Title Effect icon in the bin. 

The title opens in the Title tool.

n If the Title tool is already open, you can drag a Title Effect clip from the bin 
directly into the Title Tool window.

2. Edit the title using techniques described in Chapter 7.

3. Save the title using one of the following options:

t Save Title: To save the title with the same name and media 
parameters (bin, drive, and resolution), choose Save Title from 
the File menu.

The revised Title Effect clip replaces the previous clip in the 
bin. The clip also appears in the Source monitor. 

The Title tool remains open. You can continue creating 
additional titles, or choose Close from the File menu.

t Save Title as: To rename the title or change any of the media 
parameters (bin, drive, and resolution):

a. Choose Save Title as from the File menu.

The Save title dialog box appears.

b. Rename the title or choose other options from the Bin, Drive, 
and Resolution pop-up menus.

If you keep the same name for the title, the system retains the 
original Title Effect clip in the bin and creates a new clip with 



321

the same name plus a two-digit extension that adds 
incremental numbering for each revision.

c. Select or deselect Fast Save, depending on your needs. For 
more information, see “Using the Fast Save Option” on 
page 318.

d. (Option) If you are working on a system that supports 24p or 
25p projects, select the title formats you want to save.

For more information, see “Working with Titles on Systems 
with 24p or 25p Support” on page 323.

e. Click Save to save the title and exit the Title tool.

Creating and Using Title Templates

Title templates let you create a standard format for text and graphics 
that you use regularly. After you’ve set up your template, open the 
template, edit the text, and save the new title. The template prevents 
you from changing the position, colors, shadows, or graphics, which 
ensures consistency.

Creating Title Templates

To create a title template:

1. Open the Title tool by choosing New Title from the Clip menu or 
Title Tool from the Tools menu.

2. In the Title tool, create the text and graphic elements to include in 
the template.

3. Click the Templates button.

4. Choose Save Template from the pop-up menu.

The Save Template dialog box appears.

5. Type a name for the template.
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6. Click Save.

By default, the Avid system saves the template in the 
Title_Templates folder, but you can save it elsewhere if you prefer.

7. Close the Title tool and click Don’t Save in the dialog box. 

Using Title Templates

To use a title template:

1. Open the Title tool by choosing New Title from the Clip menu or 
Title Tool from the Tools menu.

2. Click the Templates button.

3. Choose Include Template from the pop-up menu.

The Open dialog box appears.

4. Select the template you want to use and click Open. 

The Title template opens.

5. Make any edits you want to the text.

6. Close the Title tool and click Save in the dialog box.

The Save Title dialog box appears.

7. Type a name for your title and click Save. 

The named title appears in the bin you specify. Now you can edit 
the title into the sequence. See Chapter 7, “Editing with Titles.”
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Working with Titles on Systems with 24p or 25p 
Support

If your system includes support for 24p or 25p projects, you can work 
with titles in multiple formats.

When you are working in a 24p or 25p project, you create titles in one 
of four formats:

• NTSC 4:3

• NTSC 16:9

• PAL 4:3

• PAL 16:9

Although you initially create a title in only one format (the native 
format in which you are editing when you create the title), you can 
save it in any of the four formats.

In a project other than a 24p or 25p project, you can create a title in one 
format and then save it in multiple aspect ratios. For example, in an 
NTSC video project, you might create a title at NTSC 4:3 and then save 
it in both the 4:3 and 16:9 aspect ratios.

The following sections explain how these multiformat options affect 
the creation and handling of titles.

n The Title tool uses your system’s DSK capabilities to apply the correct title to 
each output format for your project. Other imported titles and graphics 
cannot be saved in multiple formats and will be resized along with the video 
signal when you generate output in a format different from the native project 
format. This might affect the finished look of the title or graphic.

Multiformat titles must be real-time DSK. If your Avid system includes 
support for 24p or 25p projects, you can save titles in multiple formats 
(NTSC 4:3, PAL 4:3, NTSC 16:9, or PAL 16:9, depending on your source 
media). When you create a digital cut, you can choose the appropriate 
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format. This feature works only for real-time DSK titles. It does not 
work for rendered titles. Rendered titles will play in the original 
rendered format.

n If you need to render effects that play at the same time as the title, render all 
effects except the title. Alternatively, create a video mixdown of all tracks 
except the title. 

Creating Titles on Systems with 24p or 25p Support

When you create a title on a system that includes support for 24p or 
25p projects, you need to consider the different video formats and 
aspect ratios in which your project will be output. In particular, if you 
create a title in the 16:9 ratio, you need to use the grid to verify that the 
title will appear safely within the limits of the 4:3 viewing area. For 
more information on using the grid, see “Working with the Effect 
Grid” on page 107.

Saving Titles on Systems with 24p or 25p Support

When you save a title in a 24p or 25p project, the Save Title dialog box 
displays a check box for each of the four possible formats. 
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You can choose to save a title in any combination of the four formats, 
with the following restrictions:

• The format in which you created the title is selected by default and 
is always saved (even if you deselect the check box).

• If you choose to save the alternate video format and the alternate 
aspect ratio from that in which you created the title, the 
corresponding aspect ratio in the original video format is also 
saved. For example, if you create a title as NTSC 4:3 and choose to 
save it as PAL 16:9, the system will save three formats in total: 
NTSC 4:3, PAL 16:9, and NTSC 16:9.

n When you first save a title after starting the application, the system selects 
only the native format in the Save Title dialog box. Once you choose a 
combination of formats to save a title, that combination becomes the default 
when you reopen the Save Title dialog box while the application is running.

Title format 
options for 
systems with 
24p support
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n For more information on 24p or 25p titles, see “Working with Existing 
Multiformat Titles” on page 355 and “Re-creating Title Media on 
Systems with 24p or 25p Support” on page 361.

When you save a title in a project other than a 24p or 25p project, the 
Save Title dialog box displays a check box for each aspect ratio (4:3 and 
16:9) of the video format you are working in (NTSC or PAL). The check 
boxes for the other video format are dimmed and unavailable.

The aspect ratio in which you created the title is selected by default 
and is always saved. If you need a version of the title in the other 
aspect ratio, select the appropriate check box.

Saving and Recalling Title Styles

As you begin to work with a title, you may set up some basic title 
parameters you will use again for other titles. You can save the 
following style parameters in the form of a title style:

• Font, style, size, justification, kerning, and leading

• Fill color and transparency

• Shadow color, transparency, depth, direction, softness, and type

• Border color, transparency, and width

You can also assign a title style to one of the function keys on your 
keyboard. You can then recall that style simply by pressing the 
appropriate function key.

Table 6-3 shows the Title Style sheet options.

The following illustration shows the location of the two menus that 
allow you to choose and define title styles.
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Saving a Title Style

To save title parameters to a Style sheet:

1. Click the Selection tool so that the cursor becomes an arrow.

2. Select the object that you want to use as a basis for the title style.

3. Click the arrow next to the Styles button.

A menu appears that allows you to choose either an existing title 
style name or Save As.

4. Choose Save As.

The Title Style Sheet dialog box appears. The following illustration 
shows an example.

Save Style Parameter menuStyles menu
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5. Check the parameters that you want to include in the style. The 
Avid system uses the values from the currently selected object or 
from the current defaults if no object is selected.

6. (Option) Type a function key number in the Function Key text box 
to assign the style to a function key.

For example, typing 5 assigns the style to the F5 function key.

7. Type a name in the Style Sheet text box, and click Done when you 
are ready to exit the dialog box and save the values.

Style 
Name 
box
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Title Style Sheet Options

The Title Style Sheet dialog box allows you to create templates for the 
Title tool. Style sheets allow you to define and select basic text and 
drawing parameters that you can use with the Title tool.

Table 6-3 Title Style Sheet Options

Option Description

Check boxes Choose the current attributes of the object that you want to include in the 
style. You can modify the attributes that are associated with a saved title. Use 
the check boxes to specify the attributes to save.

Function key (Option) Designate a function key that you can use to apply the title style.

Style name This name appears in the Style list in the Title tool and in the Settings scroll 
list.

Refresh Appears after you change an item on the dialog box. Click to display the 
change in the sample window.

Select All
Select None

Allows you to select all or none of the check boxes.

Revert Returns the settings to those used when the style was last saved.

Done Closes the dialog box and saves your changes.

Close button The Close button in the upper right corner (Windows) or upper left corner 
(Macintosh) of the dialog box acts as a Cancel button. A dialog box appears 
asking whether you want to cancel or save your changes.

If you created a new style from within the Title tool, choosing Cancel means 
that the system will not create the new style.
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Recalling a Title Style

After you have saved your title style, you can recall the style and use 
the attributes as the defaults in subsequent Title tool sessions. You can 
recall a title style by using the Title Styles tear-off menu or, if you have 
assigned the style to a function key, by pressing the appropriate key.

To recall title style attributes by using the Title Styles tear-off menu:

1. Click the Styles button to display the Title Styles tear-off menu.

The menu contains a scaled visual representation of each style.

2. Drag the cursor to the chosen style and release the mouse button.

3. The style attributes appear in the Title Tool toolbar.

To recall a title style attribute by using a function key:

t Press the appropriate function key.

The style attributes appear in the Title Tool toolbar.

Arrows on the right 
and left allow you to 
scroll back and forth.
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Confirming Function Key Mapping of Title Styles

To verify which function key is assigned to a particular title style, do 
one of the following:

t Open the Title Style Sheet dialog box for the style from the Settings 
scroll list in the Project window, then check the function key 
number in the Function Key text box.

t In the Title tool, click the Styles button to display the Title Styles 
tear-off menu, then position the mouse pointer over the style.

The ToolTip that appears indicates the function key assignment 
along with the name of the style.

Applying Title Styles to Text Objects

To apply a title style directly to text objects:

1. Select one or more text objects.

2. Do one of the following:

t Click the Styles button to display the Title Styles tear-off 
menu, and then choose a title style.

t If the style is assigned to a function key, press the appropriate 
function key.
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Managing Title Styles

The Avid system lists the available title styles in the Project window. 
Click the Settings button in the Project window as shown in the 
following illustration.

To delete a style:

t Select the style in the Project window and press the Delete key or 
choose Delete from the Edit menu.

To copy a style:

t Select the style in the Project window and choose Duplicate from 
the Edit menu. 

To rename a style, do one of the following:

t Change the name in the Project window.

t Perform a Save As operation as described in “Working with 
Titles on Systems with 24p or 25p Support” on page 323 and 
change the name in the Style Sheet text box.

Sample 
title styles
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Exporting a Title as a Graphics File

To export a title as a PICT graphics file:

1. Choose Export Title from the File menu.

The Export Pict As dialog box appears.

Windows

Macintosh
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2. Select the location where you want to export the file, type a file 
name, and click Save.

Your Avid editing system saves the title.
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CHAPTER 7

Editing with Titles

Editing with titles involves placing Title Effect clips in a sequence and 
then adjusting parameters or revising the title in the Title tool. The 
following sections provide guidelines for editing with title media.

• About Editing with Titles

• Before You Begin

• Displaying Title Frames in the Bin

• Editing a Title into a Sequence

• Removing a Title

• Replacing a Title

• Fading a Title

• Adjusting Title Effect Parameters

• Revising a Title in a Sequence

• Working with Existing Multiformat Titles

• Replacing Fill Tracks

• Rendering Titles

• Re-creating Title Media

• Promoting a 2D Title to 3D

• Troubleshooting Titles
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About Editing with Titles

The following is an overview of the tasks you perform to edit a title 
into a sequence:

• Editing a Title into a Sequence. You can load a title into the 
Source monitor or drag the Title Effect icon from the bin to a 
segment in the Timeline. Title effects play in real time, using the 
Avid system’s downstream key (DSK) capabilities.

• Adjusting Title Effect Parameters. With a title edited into a 
sequence, you can use the Effect Editor to alter the appearance or 
position of the title. You can also open the title again in the Title 
tool at any time to revise the title elements. 

• Revising a Title in a Sequence. After editing the title and 
adjusting parameters, you can revise elements of the title in the 
Title tool or replace fill tracks to create various effects. 

These basic procedures are described throughout this chapter. For 
information on creating titles, see Chapter 6.

Before You Begin

The following sections provide guidelines for working effectively with 
DSK titles, non-DSK titles, and Title effect media.

Downstream Keying of Titles and Graphics

By default, the Avid system creates all titles using its DSK capabilities. 
Graphic elements imported with an alpha channel are also created as 
DSK clips. 
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Downstream keying allows you to add uncompressed titles or 
graphics over multiple streams of compressed or uncompressed media 
and continue to play the sequence in real time. The benefits of 
downstream keying include:

• High-quality images: Because the DSK title or graphic is 
uncompressed, the image retains its full quality.

• Real-time adjustment of keyframes and title parameters: When 
you adjust keyframes or effect parameters for the DSK Title effect, 
the title continues to play back in real time.

• Layering of titles over real-time or rendered effects: You can 
apply a DSK title over a rendered effect or a real-time effect such 
as a transition, and all effects continue to play back in real time.

• Smooth motion: Downstream keying uses subpixel placement for 
smooth motion in rolling titles. Subpixels are units smaller than 
pixels.

Restrictions of Downstream Key Titles

The following are a few restrictions to keep in mind with DSK titles:

• Rolling titles are always DSK titles unless you render them. You 
can convert a still DSK title to a non-DSK title. See “Converting 
Downstream Key Titles” on page 338.

• You can play in real time only one static DSK title or one rolling 
DSK title at a time.

• You can play in real time only one rolling DSK title and one static 
DSK title at a time in a nested effect. The DSK titles must be on the 
top layers of the nested tracks.

• Titles promoted to 3D are no longer DSK. Keep a copy of the 
original title if you want to continue using the DSK version. For 
more information, see “Promoting a 2D Title to 3D” on page 362.

• DSK titles become non-DSK titles when you replace the fill track. 
For more information, see “Replacing Fill Tracks” on page 355.
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• Rolling titles might jitter slightly at certain speeds. You can adjust 
the duration by a few frames to fix the problem.

• Rolling titles cannot play back at a rate greater than one page per 
second. This situation occurs when you edit a lengthy title roll into 
a short segment in the sequence.

If you experience a playback problem with a DSK title, do one or more 
of the following:

t Render the DSK or underlying effects. See “Rendering Titles” on 
page 356.

t Slow the roll by extending the duration of the clip. See “Trimming 
the Duration of Rolling Titles” on page 348.

t Separate DSK clips in the sequence.

t Store title and video media on separate drives, or use faster drives.

Converting Downstream Key Titles

All newly created titles and graphics imported with alpha channel are 
DSK clips by default. You can convert static DSK titles and graphics to 
non-DSK titles and Matte Key effects.

Titles converted to non-DSK are still real-time effects and will play 
back successfully in real time under most circumstances. For more 
information, see “Restrictions of Non-Downstream Key Titles” on 
page 340.

You might want to convert a DSK title to a non-DSK title in situations 
like the following:

• If you want to replace the fill track (the color fill) with a graphic or 
video.

• If you want to play two titles simultaneously. The top title can 
remain DSK, but the bottom title or titles must be non-DSK.
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• If you want to resize a 2D Title effect. Scale, Position, and Crop 
parameters are available only for non-DSK titles.

• If you want to play a title that causes a “DSK_image_too_large” 
error message. For more information, see “Troubleshooting 
Titles” on page 362.

c You cannot convert rolling titles to non-DSK. You can render them, 
as described in “Rendering Titles” on page 356.

To convert a DSK title to a non-DSK title:

1. Move the position indicator to the DSK title or graphic in the 
Timeline.

2. Click the Effect Mode button to open the Effect Editor.

3. Deselect the Downstream Key button.

The Downstream Key button changes from pink to gray, and the 
effect is now a non-DSK effect.

4. To re-enable the DSK capabilities, open the Effect Editor and click 
the Downstream Key button again.

c If you replace the fill track of a non-DSK title, you cannot restore the 
DSK capabilities.

In regard to the above caution, you can use the Undo command to 
remove the fill track (choose Undo from the Edit menu). However, 
once you save the title or reach the undo limit, you must edit in a copy 
of the title and start over again to restore the DSK capabilities.



340

Restrictions of Non-Downstream Key Titles

n DSK titles and non-DSK titles have different real-time playback capabilities 
during editing and adjustment of keyframe parameters. For more 
information, see “Playback Capabilities of Title Effects” on page 341.

Depending on the complexity of the title and the video it is keyed over, 
not all non-DSK titles can be played in real time. 

n If your system has the Uncompressed option, a non-DSK title keyed over 
uncompressed video will not play back in real time if the fill track has been 
replaced with a graphic or video.

When you attempt to play too complex a title, the following conditions 
might occur:

• Background video might jitter.

• Title might flash.

• Title might display a gray slide.

• Video might shift left or right.

• Video might display a gray slide.

• Video underrun error might occur.

• Audio underrun error might occur.

• Rolling title underrun error might occur.

If you encounter any of these conditions, try one or more of the 
following:

t Render the title or underlying effects.

t Simplify the title by removing text or drop shadows or by 
selecting different colors.

It is possible that a title with background video might be so complex 
that you can neither play it in real time nor render it.
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Playback Capabilities of Title Effects 

Playback Capabilities for Titles with One Video Stream

The following are the playback capabilities for Title effects when you 
are working with uncompressed media on a system with the 
single-stream uncompressed option.

About Title Effect Clips

When the Avid editing system saves a title, it creates a Title Effect clip 
and saves it in the selected bin. One media object, referred to as a 
precompute, has references to the RGB and alpha channel information. 
Every time you make a change, your Avid system creates two 
additional media files. The original media files are left unchanged.

n By default, the bin display does not show rendered effects. You can view 
rendered effects in the bin by choosing Set Bin Display from the Bin menu 
and selecting Rendered Effects and Show reference clips in the dialog box. 

Title Effect clipBin – Frame view Rendered effect (precompute)
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For more information, see “Managing Effect Media Files” on 
page 165.

Displaying Title Frames in the Bin

With your bin in Frame view, you can display a frame from the title 
itself rather than the Title Effect icon for the clip. This is especially 
useful if you have many titles in the bin and want a quick visual 
reference.

To display a frame from the title:

1. Select one or more Title Effect clips.

2. Press the Home key on the keyboard.

Rendered effect
(precompute)

Bin – Text view

Title Effect clip
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Editing a Title into a Sequence

After preparing the sequence with a second track for the title, there are 
three basic methods for editing the title into place:

• Edit the title into the sequence by using standard editing 
methods: Mark edit points in the sequence and in the title clip, 
and then splice or overwrite the title into place. See “Splicing or 
Overwriting a Title into a Sequence” on page 344.

• Drag a marked title clip directly into the sequence from a bin: 
Mark IN and OUT points in the title clip, and then drag the title 
directly into the sequence. See “Dragging a Marked Title into a 
Sequence” on page 346.

• Drag an unmarked title clip directly into the sequence from a 
bin: Drag the title clip directly from the bin to the location of the 
position indicator. See “Dragging an Unmarked Title into a 
Sequence” on page 347.

About Setting Marks in Rolling Titles

By default, a rolling title clip begins with the visible title just off screen. 
The clip ends just after the last element disappears off screen.

You can set IN and OUT points in the Source monitor to change the 
start and finish points; that is, you might want the title to begin with 
the screen full of text rather than start off screen. 

You can play and mark a title clip in the Source monitor by using 
standard procedures. For more information, see the Avid Editing Guide.

If you want to use the complete roll in the sequence, do not set marks. 
For information about adjusting the duration of the roll, see 
“Trimming the Duration of Rolling Titles” on page 348.
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Splicing or Overwriting a Title into a Sequence

To splice or overwrite a title into a sequence:

1. Load the sequence into the Record monitor.

2. (Option) Choose New Video Track from the Clip menu.

The system adds the next video track for the sequence to the 
Timeline. For example, if the sequence includes only V1, the 
system adds V2.

n Titles must be placed a track above the video that forms the background. If an 
upper track already exists with an open region for the title, you can skip 
step 2.

3. Double-click the Title Effect clip icon in the bin to load the title in 
the Source monitor.

4. Patch the title source to the video track in the sequence by clicking 
the Source Track button for track V1 in the Track Selector panel 
and dragging it to the Record Track button for track V2.

Title Effect clip icon
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n You can use any three-point editing method to edit a title into a sequence. The 
steps below are just one editing method. For other methods, see the Avid 
Editing Guide.

5. In the Source monitor, mark an IN point.

You should mark the IN point toward the middle of a still title clip 
so you can trim the title, if necessary. 

For rolling titles, set no marks and move the position indicator to 
the beginning of the clip if you want to use the full roll.

6. In the Record monitor, mark IN and OUT points.

7. Make sure all other Record Track buttons are deselected in the 
Track Selector panel.

8. Click either the Extract/Splice-in or the Lift/Overwrite button to 
edit the title into the sequence.

The Title Effect segment appears in the top video track.

Source Track button

Record Track button

Record Track monitor button

Lift/Overwrite buttonExtract/Splice-in button
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Dragging a Marked Title into a Sequence

To mark a portion of a title clip and then drag the marked clip 
directly into the Timeline:

1. Load the sequence into the Record monitor.

2. (Option) Choose New Video Track from the Clip menu.

The system adds the next video track for the sequence to the 
Timeline. For example, if the sequence includes only V1, the 
system adds V2.

n Titles must be placed a track above the video that forms the background. If an 
upper track already exists with an open region for the title, you can skip 
step 2.

3. Double-click the Title Effect clip icon in the bin to load the title into 
the Source monitor.

4. In the Source monitor, mark an IN point and an OUT point to 
establish the duration that you want for the title.

You should mark the IN point toward the middle of a still title clip 
so you can trim the title, if necessary. 

For rolling titles, set no marks and move the position indicator to 
the beginning of the clip if you want to use the full roll. The 
system uses the position indicator to determine the IN point on 
rolling titles.

5. Clear the Source monitor by choosing Clear Monitor from the Clip 
Name menu.

6. Click either the Extract/Splice-in or the Lift/Overwrite button, 
depending upon how you want to insert the Title effect.

7. Click the Title Effect icon in the bin, and drag it to the Timeline.

As you drag the Title effect in the Timeline, a white outline of the 
title clip indicates location in the sequence.
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8. When you find the right position for the title on the correct track, 
release the mouse button. 

The Title effect appears in place in the sequence.

Dragging an Unmarked Title into a Sequence

If you are not concerned about the OUT point for your title, or if you 
plan on trimming the Title effect later, you can quickly drag the 
unmarked Title effect directly into the Timeline.

To apply a Title effect to a sequence without adding marks:

1. Load the sequence into the Record monitor.

2. (Option) Choose New Video Track from the Clip menu.

The system adds the next video track for the sequence to the 
Timeline. For example, if the sequence includes only V1, the 
system adds V2.

n Titles must be placed a track above the video that forms the background. If an 
upper track already exists with an open region for the title, you can skip 
step 2.

3. Move the position indicator to the location where you want the 
Title effect to begin.

4. Click either the Extract/Splice-in button or the Lift/Overwrite 
button, depending upon how you want to insert the Title effect.

5. Click the Title Effect clip in the bin, and drag it to the Timeline.

As you drag the Title effect in the Timeline, a white outline of the 
title clip indicates location in the sequence.
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6. When you find the right position for the title on the correct track, 
release the mouse button.

The Title effect appears in place in the sequence.

Trimming the Duration of Rolling Titles

When you edit the title clip into a marked segment of a sequence, the 
clip plays back from beginning to end regardless of the duration of the 
segment. In other words, the entire roll shrinks to fit within the 
duration of the marked segment in the sequence.

Once the clip is edited into the sequence, you can trim the duration of 
the segment at any time, and the rolling title adjusts to fit. 

Unlike trimming other segments, trimming a rolling title does not 
remove any part of the title contents. As a result, the duration of the 
title determines how fast it plays. For example, the shorter you trim 
the title, the faster it rolls.

n Rolling titles might jitter slightly at certain speeds. You can trim the duration 
slightly to fix the problem.
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To trim the duration of a rolling title:

1. Enable the track containing the title and disable all other tracks by 
using the Track Selector panel.

2. Click the Trim Mode button to enter Trim mode.

3. Select either the head or the tail of the title segment for trimming.

4. Trim the title segment to the duration you want by using standard 
trim procedures.

The entire roll plays back within the new duration.

c If you trim your rolling title very short, it scrolls very fast and cannot 
display in real time; it must be rendered. The maximum speed it can 
scroll is one screen per second.

Removing a Title

To remove a title segment:

1. Move the position indicator to the segment containing the 
Title effect.

2. Select the track containing the Title effect and deselect all 
other tracks.

3. Click the Mark Clip button.

IN and OUT points appear surrounding the Title effect.

4. Click the Extract/Splice-In or Lift/Overwrite button to remove 
the segment.

n The Title effect remains in the bin. To remove the Title effect from the bin, 
select the effect in the bin and press the Delete key.
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Replacing a Title

To replace a title in a sequence:

1. Click the Lift/Overwrite button.

2. Click the title segment currently in the sequence to select it.

3. Click the Mark Clip button to mark an IN point at the beginning of 
the title segment and an OUT point at the end of the segment.

4. Drag the new Title Effect clip from the bin to the marked segment.

The new title replaces the old title.

Fading a Title

You can use the Fade Effect button to fade a title. A dialog box appears 
that allows you to enter the number of frames to fade up and fade 
down without opening the Effect Editor.

Rather than adding Dissolve effects that require rendering, you can 
use the Fade Effect button to quickly create keyframes in the title with 
the proper level settings for playback in real time. You can access the 
keyframes in the Effect Editor. For more information, see “Using the 
Fade Effect Button” on page 71.

Adjusting Title Effect Parameters

After editing a title into a sequence, you can open the Effect Editor and 
refine the title with keyframe control over effect parameters.
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To access the effect parameters for a Title effect:

1. Click the Effect Mode button.

The Effect Editor opens.

2. Click the Title Effect segment in the sequence to select it.

The Effect Editor displays the parameter controls.

Add Keyframe
button

Other Options button Title icon
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To work with the Title effect parameters:

t Adjust Title effect parameters by using basic techniques described 
in “Using the Effect Editor” on page 117.

n For information on specific Title effect parameters, see “2D Effects 
Parameters” on page 456.

t Use multiple keyframes to gradually change keyframeable 
parameters over time. For more information, see “Using 
Keyframes” on page 129.

t Save effect templates of Title effect parameter adjustments to a bin 
for use in other sequences or projects as described in “Using an 
Effect Template” on page 136.

n For DSK Title effects, you must convert the title to non-DSK in order to 
adjust the Scaling, Position, and Crop parameters. For more information on 
converting a DSK title, see “Converting Downstream Key Titles” on 
page 338.

Revising a Title in a Sequence

If you want to revise a title after you have edited it into a sequence, 
you must reopen the title in the Title tool directly from the sequence 
rather than revising the Title Effect clip in the bin.

To change a title in a sequence:

1. Click the Title Effect segment in the sequence to select it.

2. Click the Effect Mode button. 

The Effect Editor opens.
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3. Click the Other Options button in the Effect Editor.

The Title tool opens. 

4. Revise the title by using techniques described in Chapter 6.

5. Save the title by using one of the following procedures.

Use this procedure to save the title with the same name (numbered 
incrementally) and media parameters (bin, target drive, resolution, 
and formats).

To save the title with the same name and media parameters:

1. Choose Save Title from the File menu.

A message box appears.

2. Click Save.

The Title tool closes, and the revised Title Effect clip replaces the 
previous clip in the sequence, the bin, and the Source monitor.

Use this procedure to rename the title or change any of the media 
parameters (bin, target drive, resolution, and formats).

Other Options button
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To save the title with a new name or parameters:

1. Choose Save Title as from the File menu.

The Save Title dialog box appears.

2. Rename the title or choose other options from the Bin, Target 
Drive, and Resolution pop-up menus and the Title Formats area.

n You cannot select Fast Save when revising a title in a sequence.

3. (Option) If you are working on a system that supports 24p or 25p 
projects, select the title formats you want to save.

For more information, see “Working with Existing Multiformat 
Titles” on page 355.

4. Click OK to save the title and exit the Title tool.

The Title tool closes, and the revised Title Effect clip replaces the 
previous clip in the sequence. The new clip also appears in the 

Multiformat 
check boxes 
(appear only 
on systems 
that support 
24p or 25p 
projects)
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Source monitor, and in the bin with its new name. The previous 
Title Effect clip is preserved in the bin.

Working with Existing Multiformat Titles 

If your system includes support for 24p or 25p projects, the following 
restrictions apply when you move multiformat titles between projects 
or edit them into a sequence.

• You cannot move a title created in one video format into a project 
in the other video format. For example, you cannot create a title in 
an NTSC project and then edit it into a PAL project.

• If you need to revise a title that has been edited into a sequence, 
you must be working in the same aspect ratio in which the project 
was originally created. You cannot, for example, revise a title at 
16:9 if it was created at 4:3. If you are working in a different aspect 
ratio than that used to create the title, a message box alerts you to 
the problem and asks you to change the aspect ratio.

n When a title edited into a sequence is revised, the system selects all the 
formats that already exist in the title as the defaults. If you need to change the 
formats, choose Save Title as from the File menu. You can then create a new 
title with the formats you need, and the title will replace the previous version 
in the Timeline.

Replacing Fill Tracks

You can replace the fill track of Title effects with video or graphics. The 
moving video or graphic effect then appears inside the title itself, 
keyed over the background.
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All newly created titles and graphics imported with alpha channel are 
DSK clips by default. When you replace the fill track with a graphic or 
video, the title is converted automatically to a non-DSK title. 

c After replacing the fill track, you cannot restore the DSK 
capabilities of a title. Also, you cannot replace the fill track on a 
rolling title.

To replace the fill track:

1. Click the Step In button in the Timeline to step into the effect.

2. Load the video you would like to use as replacement filler into the 
Source monitor.

3. Drag the Source Track button in the Track Selector panel to the 
Record Track button for the fill track to patch the new source video 
to the title fill track.

4. Using standard editing methods, edit the video from the Source 
monitor onto the fill track.

A message box appears, warning you that the DSK capabilities of 
the title will be disabled.

5. Click OK to replace the fill track and convert the title to a non-DSK 
title; or, click Cancel to cancel the operation and retain the DSK 
capabilities of the title.

Rendering Titles

The following are a few situations in which you might want to 
render titles:

• If you want to layer DSK rolling titles in a sequence

• If you want to layer multiple effects, particularly more than one 
layer of DSK titles
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• If you want to place other effects over a DSK title

• If you encounter a message box with a message about audio or 
video underrun when playing a complex layered effect

For more information on rendering Title effects, see “Rendering 
Effects” on page 140.

Re-creating Title Media

You can use the Re-create Title Media command to:

• Regenerate title media that is offline

• Generate title media for unrendered (Fast Saved) titles in a bin

• Change the resolution of a title

• Generate multiple formats for titles, if your system includes 
support for 24p or 25p projects

If you have batch digitized a sequence at a resolution different from 
the resolution at which the sequence was originally created, for 
example, you can use this command to re-create the titles at the new 
resolution. This procedure is required when conforming an offline 
sequence with titles for online editing and output at uncompressed 
resolution.

You can re-create title media that is edited into a sequence in the 
Timeline, or you can create media for unrendered (Fast Saved) titles in 
a bin. For more information on Fast Save for titles, see “Using the Fast 
Save Option” on page 318.

c The Re-create Title Media command removes any nested edits made 
inside a title, replacing the edits with the new title’s graphic and 
alpha tracks.
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Re-creating Title Media from the Timeline

To re-create title media from the Timeline:

1. Load the sequence containing the titles into the Record monitor.

2. Mark IN and OUT points in the sequence surrounding all the titles 
that you want to re-create.

3. In the Track Selector panel, select the Record Track button for each 
track that contains titles you want to re-create.

4. Choose Re-create Title Media from the Clip menu.

The Re-create Title Media dialog box appears.

5. Choose a drive on which to store the re-created titles.

Multiformat 
check boxes 
(appear only 
on systems 
that support 
24p or 25p 
projects)
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6. Choose a resolution for the re-created titles.

n The default drive and resolution are defined in the Titles tab of the Media 
Creation Settings dialog box. For more information, see the chapter 
“Preparing to Digitize” in the input and ouput guide for your system.

7. (Option) If you are working on a system that supports 24p or 25p 
projects, select the title formats you want to create.

For more information, see “Re-creating Title Media on Systems 
with 24p or 25p Support” on page 361.

8. Click OK.

The Avid system recreates the title media file.

Creating Media for Unrendered Titles in a Bin

To create media for unrendered titles in a bin:

1. In the bin, select the titles for which you want to generate media.

To quickly select all the unrendered titles in the active bin, choose 
Select Unrendered Titles from the Bin menu.

2. Choose Create Unrendered Title Media from the Clip menu.

The Create Unrendered Title Media dialog box appears.
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3. Choose a drive on which to store the title media.

4. Choose a resolution for the title media that is compatible with the 
sequence, such as a two-field resolution for a sequence containing 
two-field media.

n The default resolution is the resolution specified at the time the titles were 
originally saved with the Fast Save option.

5. (Option) If you are working on a system that supports 24p or 25p 
projects, select the title formats you want to create.

For more information, see “Re-creating Title Media on Systems 
with 24p or 25p Support” on page 361.

6. Click OK.

The title media file is generated, and the title clip appears in the 
bin without the (unrendered) label in the name field.

Multiformat 
check boxes 
(appear only 
on systems 
that support 
24p or 25p 
projects)
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Re-creating Title Media on Systems with 24p or 25p Support

You can use the Re-create Title Media command to re-create title media 
with different formats just as you can use it to re-create title media at 
different resolutions. An efficient workflow for multiformat titles 
involves creating titles and saving them initially in the native format, 
and then generating any other necessary formats by using Re-create 
Title Media when editing is complete. The Re-create Title Media 
operation for multiformat titles is subject to the same kinds of 
restrictions as other editing and saving procedures:

• When you mark titles in a sequence and choose Re-create Title 
Media, the Re-create Title Media dialog box displays the same 
multiformat check boxes as the Save Title dialog box. You can 
create all the formats you need (with the same restrictions 
described in “Saving Titles on Systems with 24p or 25p Support” 
on page 324).

• You can re-create titles only when the aspect ratio in which you are 
working is the same as that used when the title was created.

• When you use Re-create Title Media to create new formats for a 
24p or 25p title, all formats are re-created. The system cannot add 
a format to an existing multiformat title file. Even if three of the 
four formats have been saved previously, the system will re-create 
all four formats when you add the fourth.

n When you first use the Re-create Title Media command to generate media for 
unrendered titles in a bin, the system selects the native format as the default. 
Once you choose a combination of formats in the Create Unrendered Title 
Media dialog box, that combination becomes the default when you reopen the 
Create Unrendered Title Media dialog box while the application is running.

n When you first use the Re-create Title Media command to regenerate titles in 
the Timeline, the system selects all four formats as the default. Once you 
choose a combination of formats in the Re-create Title Media dialog box, that 
combination becomes the default when you reopen the Re-create Title Media 
dialog box while the application is running.
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Promoting a 2D Title to 3D

If your system is equipped with 3D effect capabilities, you can 
promote a Title effect to 3D to create additional effects with the title. 
Title effects promoted to 3D are no longer DSK but remain real-time 
effects.

For more information, see “Promoting 2D Effects to 3D Effects” on 
page 225.

Troubleshooting Titles

This section describes several errors that might occur when working 
with Title effects and includes recommendations for resolving the 
problems.

Downstream Key Error Messages

When you edit with DSK titles or graphics, you might experience an 
underrun error message because the graphic key could not be loaded 
in time. 

Possible causes include the following:

• Insufficient drive speed

• Title rolling too fast

• Several DSK graphics too close together

Possible solutions include the following:

t Render the DSK clip and underlying video.

t Slow down the rolling title.
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t Store the DSK clip media on a drive other than the drive 
containing the underlying media.

t Add filler between sequential DSK clips.

t Use faster drives.

Wrong Title Format

If you see an image in a monitor that says Wrong Format, it means that 
the resolution of the Title effect is not compatible with the resolution of 
video clips used in the sequence. You will have to determine the 
resolution of the video clip. Then, you must regenerate the title at the 
same resolution as the video clip.

To determine the resolution of the current video clip:

1. Open the bin containing the sequence.

2. Choose Set Bin Display from the Bin menu.

3. Select the option “Show reference clips.”

The master clips used in the sequence appear in the bin.

4. Check the resolution for any of the master clips in the Video 
column when viewing the bin in Text view.

To correct a title’s resolution to match the resolution used in the video 
clips in the sequence, use the procedure described in “Re-creating 
Title Media” on page 357.
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CHAPTER 8

Intraframe Editing

This chapter describes the Intraframe Editing features available on 
some Avid systems. Intraframe editing refers to the ability to perform 
various paint or animated matte effect operations within an individual 
frame or series of frames in a clip. Intraframe editing frees you from 
having to export images from the Avid system, edit them in 
third-party applications, and import them back into the system. 
Intraframe editing also allows you to quickly remove scratches and 
flaws in your video material.

Intraframe editing is done with the Paint Effect and the AniMatte 
effect, or with the Scratch Removal effect in the specialized case of 
scratch removal. These effects share many of the same concepts, which 
are described in the following sections:

• About the Intraframe Effects

• Rendering Intraframe Effects

• Getting Started with the Paint and AniMatte Effects

• Using the Intraframe Drawing Tools

• Working with Vector-Based Objects

• Previsualization Marker Tool for Film Projects

• Manipulating Intraframe Objects

• Layering, Grouping, and Locking Intraframe Objects
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• Exporting a Matte PICT File

• Scratch Removal

• Common Intraframe Editing Techniques

About the Intraframe Effects

While many of the tools and parameters are the same for all the 
Intraframe effects, the result of applying each effect is different. 

The Paint Effect allows you to draw or paint and apply special effects 
within individual frames or across all the frames in a segment. The 
Paint Effect includes the following features:

• Customizable paint brushes with preset templates and parameters 
for adjustable softness and rotation

• Creation of vector-based objects that you can animate and edit

• A variety of paint modes including Erase, Clone, Colorize, 
Darken, Lighten, Blur, Unsharp Mask, Emboss, Scratch Removal 
and more

• Object selection with rescale, lock/unlock, and group/ungroup 
capabilities

• Z-rotation of painted objects

• Outline feathering with bias control

• Magic Mask™ for quick and easy colorization

The AniMatte effect allows you to generate custom matte effects that 
you can apply to a segment or transition in a sequence. The AniMatte 
effect includes the following features:

• Modes for keying in and keying out images

• Keyframeable animation of matte effects
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• Creation of mattes as vector-based objects that allow you to move, 
rescale, and reshape the mattes during a segment or transition

• Freehand painting ability to create organic matte wipes

• Magic Mask, brush shapes, Z-rotation, feathering, and more

• Export of mattes to create keys in third-party applications

• No additional hardware required

The Scratch Removal effect allows you to remove scratches or other 
flaws by replacing them with clean material from elsewhere in the 
same frame or from another nearby frame. The Scratch Removal effect 
includes the same tools for drawing objects and painting brush strokes 
found in the Paint Effect, together with specific controls for selecting 
clean replacement material. For more information, see “Scratch 
Removal” on page 423.

When you use the Intraframe Editing tools, the Avid system draws 
vector-based objects on the screen. Vector-based objects are composed 
of mathematically described lines and Bézier curves. You can edit the 
lines, curves, and other attributes of vector-based graphics with 
greater control and efficiency than you can with bitmapped objects, 
which are drawn on the screen as a pattern of dots, or pixels. For more 
information, see “Working with Vector-Based Objects” on page 393.

Additionally, any changes you make to an Intraframe effect is not 
limited to an individual frame. Instead, any object you paint and any 
changes you make to it appear for the duration of the entire segment 
or clip. In most cases, you can change the parameters of the effect 
between keyframes.

You can create multiple paint or matte shapes within a single effect. 
You can also add keyframes and apply effects separately to each of the 
shapes.
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Rendering Intraframe Effects

Intraframe effects are not real-time effects. While working in Effect 
mode, you can see the object as you step through each frame in the 
segment. To view the painted object in the Effect Preview monitor, 
choose Render-On-The-Fly from the Special menu. You also can use 
the Play Preview function to see an off-speed preview of a Paint Effect 
while you are working in Effect mode. For more information, see 
“Effect Editor Buttons” on page 119.

When you have finished painting or drawing a matte on a segment, 
you must render the effect to play it in real time. Regardless of how 
many objects you add to an individual segment, the Avid system plays 
back the effect as a single stream of video.

Rendering Paint Effects

Painted objects are rendered to the screen starting with the bottom 
layer (closest to the video background). Keep this concept in mind as 
you use different paint modes in combination and layer painted 
objects to generate new effects in a sequence. You also can combine the 
Paint Effect with the AniMatte effect to create custom effects.

Rendering AniMatte Effects

A multitrack AniMatte effect is rendered to the screen starting with the 
top video track (farthest from the video background and appearing 
closest to you in three-dimensional space). For example, if the video 
background is on track V1, and the AniMatte effect is applied to track 
V2, the system renders the effect starting with the image on track V2. 

However, if you draw multiple mattes in the same segment, these 
mattes are all objects that appear in the same foreground space; they 
interact with each other much like multiple painted objects do in the 
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same segment. For more information, see “Layering with the Paint 
Effect” on page 416.

Keep these concepts in mind as you use different key modes in 
combination and layer them to generate new effects in a sequence. You 
also can combine the AniMatte effect with the Paint Effect to create 
custom effects.

Getting Started with the Paint and AniMatte Effects

When you apply the Paint or AniMatte effect to a segment and enter 
Effect mode, the Effect Editor opens. The cursor is an arrow when you 
select tools and options from the Effect Editor. When you select a paint 
or editing tool and position the cursor over the Effect Preview monitor, 
the cursor becomes a crosshair. The crosshair indicates that you can 
begin to paint or draw a matte on the frame.

n After you use the Rectangle, Oval, Polygon, and Curve tools, your Avid 
editing system reverts to the Selection tool, and the cursor becomes an arrow. 
After you use the Brush tool, it remains the active tool, and the cursor 
remains a crosshair.

The painting and editing tools enable you to paint shapes or draw 
mattes, quick masks, and other vector-based objects on frames in a 
sequence. When you apply an Intraframe effect to a segment, the 
object or matte appears for the duration of the entire segment, not just 
for an individual frame.

Applying the Paint or AniMatte Effect to a Sequence

For information on 
creating keys and 
wipes, see Chapter 4.

You can apply an AniMatte effect to segments for multilayered effects 
or to transitions to create matte key wipes with your own custom 
shapes. A Paint Effect is a segment effect only; you cannot apply a 
Paint Effect to a transition in a sequence.
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The Paint Effect is located in the Image category in the Effect Palette. 
The AniMatte effect is in the Key category. 

To apply the Paint Effect or AniMatte effect to a sequence:

1. Load a sequence into the Record monitor.

2. Choose Effect Palette from the Tools menu.

3. Do one of the following:

t Click the Image category if you want to apply the Paint Effect.

t Click the Key category if you want to apply the AniMatte 
effect.

4. Click the Paint Effect icon or the AniMatte icon, drag it to a 
segment (or transition in the case of an AniMatte effect) in the 
sequence, and release the mouse button.

5. Click the Effect Mode button to enter Effect mode.

The Effect Editor opens with the default settings for the effect.

Using the Effect Editor with the Paint Effect

For more information on working with the Effect Editor, see “Using 
the Effect Editor” on page 117.

The following illustration identifies the different sections of the Effect 
Editor that are available when you apply a Paint Effect to a segment 
and enter Effect mode.



370

The following tables briefly describe the functions of the Effect Editor 
for the Paint Effect.

Painting and Editing tool

Bring Forward and Send
Backward buttons

Reshape tool

Z-Rotation tool

Selection tool

Reduce and Enlarge

Play Loop button

Dual Split button

Brush Shape

Brush Preview

buttons

Effect parameter

 

window

categories buttons

buttons

Previsualization Marker tool
(available in film projects)

Transition Effect Duration box

Transition Effect Alignment pop-up menu

Grid buttonOutline/Path button

Add Keyframe button

Play Preview button

Render Effect button
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The following buttons appear on the right side of the Effect Editor for 
the Paint Effect.

Tool Description

Effect parameter 
categories

Enable you to change the parameters of an effect.

Brush Preview window Displays the brush head with the parameters you have selected, such as color 
and shape. You also can use the window to reshape the brush head by 
dragging its control points.

Brush Shape buttons Change the shape of the brush.

Button Description

Play Loop button Plays back a transition or a segment effect in Effect mode.

Dual Split button Splits the screen in half to show the image with and without 
effects applied to it.

Reduce and Enlarge buttons Zoom in and out on objects.

Selection tool Selects an object so you can change its parameters, move it, or 
delete it. With the Shift key pressed, selects multiple objects. 

Z-Rotation tool Rotates an object around the Z axis.

Reshape tool Reshapes objects by manipulating anchor points at locations 
where new curves begin or straight lines intersect. Inserts 
additional control points.
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The following buttons and box appear at the bottom of the Effect 
Editor for the Paint Effect.

Bring Forward and 
Send Backward buttons

Bring a painted object one layer forward on the screen or send 
an object one layer backward on the screen. With the Alt key 
(Windows) or Option key (Macintosh) pressed, bring a painted 
object to the front or send an object to the back.

Painting and Editing tools Enable you to paint shapes or draw mattes on frames in a 
sequence with freehand capability or with preset shapes.

Previsualization Marker tool Available in film projects.

Button Description

Button Description

Add Keyframe button Adds a keyframe to an effect at the location of the position 
indicator in the effect’s Timeline.

Play Preview button Plays back a preview of an unrendered effect in the Effect 
Preview monitor.

Render Effect button Renders effects on selected tracks at the location of the 
position indicator in the effect’s Timeline.

Outline/Path button Displays wire-frame representations of the painted object. 
Illustrates the movement of an object from the first keyframe 
through the last keyframe.

Transition Effect Alignment 
pop-up menu

Enables you to choose whether a transition effect starts, ends, 
or is centered on a cut; not applicable to the Paint Effect.
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Using the Effect Editor with the AniMatte Effect

The following illustration shows the Effect Editor as it appears when 
you apply an AniMatte effect to a segment in a video project and enter 
Effect mode.

Transition Effect 
Duration box

Enables you to enter the length of a transition in seconds and 
frames; not applicable to the Paint Effect.

Button Description

Foreground category

Magic Mask category
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When you are working with the AniMatte effect, the categories that 
are available in the Effect Editor are the same as those for the Paint 
Effect with the following exceptions:

• The Swap Src option in the Foreground category enables you to 
swap the foreground and background video images for matte keys 
composed of multiple video tracks. When you are building a 
single-track wipe, the Swap Src button enables you to swap the 
incoming and outgoing segments in the sequence.

• With the AniMatte effect, you use Magic Mask to choose a key 
color when you create a matte. (With the Paint Effect, you use 
Magic Mask or the Color category to make color selections.)

Editing with Single-Field Step

To locate defects on individual fields of a frame for correction with the 
Paint and AniMatte effects, use the single-field step feature. For 
information on using single-field step, see “Using Single-Field Step” 
on page 117.

Using Effect Templates with the Intraframe Effects

As you can do with many other effects, you can save a template of a 
Paint or AniMatte effect and apply it to other video segments in a 
sequence at a later time. For more information on saving and applying 
an effect template, see “Using an Effect Template” on page 136.

Using the Intraframe Drawing Tools

The Intraframe effects include the following five drawing tools:

• Brush tool

• Rectangle tool
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• Oval tool

• Polygon tool

• Curve tool

You can use these tools for creating preset shapes or for creating 
freehand, vector-based objects and mattes with editable lines and 
Bézier curves. Additionally, the Selection tool enables you to select 
painted objects and mattes to move them, rescale them, and change 
their parameters.

Understanding Intraframe Modes

The Paint Effect includes a wide variety of modes that offer many 
creative and corrective possibilities. You use the modes to control the 
nature and appearance of the objects that you create with the drawing 
tools. Available modes include Solid (for traditional brush strokes), 
Erase, Clone, Colorize, Emboss, and more.

For example, if you create an oval shape with the Solid mode selected, 
a solid color oval appears in the frame. (The color is determined by the 
current selection in the Color parameter category.) If you create the 
same oval shape and select the Lighten mode, the oval will not be a 
solid color that masks part of the image beneath. Instead, it will define 
an area of the image that is lightened by an amount you specify.

The AniMatte effect provides two modes, Key In and Key Out. These 
modes enable you to key in or key out an image in a sequence.

n For a complete listing of the characteristics of each Paint Effect mode as well 
as the Key In and Key Out modes in the AniMatte effect, see “Mode” on 
page 460.
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Using an Optional Pen Tool

The Avid system supports the addition of a pen tool and graphics 
tablet for use with the Intraframe Editing option. For installation and 
configuration instructions, see the documentation that ships with your 
pen tool and tablet.

Using the Brush Tool
With the Brush tool, you can use the mouse or a pen tool with a tablet 
to paint objects or mattes with precision directly on the images in a 
sequence. You also can change and customize the brush shape, as well 
as determine the opacity of the paint or matte, adjust the outline 
feathering and softness values, and, for the Paint Effect, define the 
color.

When you paint an object in a sequence, you paint on the frame 
displayed in the Effect Preview monitor. The painted object is 
superimposed over the video background, appearing closer to you in 
three-dimensional space. Each object you paint creates a foreground 
layer that you can work with individually or group with other painted 
objects in the segment.

Choosing a Color

You can choose the color you want to paint with by using the 
eyedropper, the parameter sliders, the Windows Color dialog box or 
the Macintosh Color Picker. You can select the color before you begin 
painting or after you have painted an object.

Shortcut for Selecting a Color with the Brush Tool

When you use the Brush tool to paint an object, you can select a color 
quickly from a video segment as follows:

1. Click the Brush tool to make it the active paint tool.

2. Choose Solid from the Fast menu in the Mode category.

Video background

Paint
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3. Press and hold the Alt key (Windows) or Option key (Macintosh), 
and drag the cursor to the Effect Preview monitor.

The cursor becomes an eyedropper.

4. Position the eyedropper over the color you want to select and 
click it.

The color you picked becomes the new default color shown in the 
Color Preview window.

Painting with the Brush

To begin painting:

1. Apply the Paint Effect to a segment in the sequence as described in 
“Applying the Paint or AniMatte Effect to a Sequence” on 
page 368.

2. Click the Brush tool in the Effect Editor.

3. Select a paint mode or key mode and parameters in the 
Effect Editor.

4. Click one of the Brush Shape buttons in the Brush parameter 
category of the Effect Editor.

The default shape of the brush head changes to your selection. 

5. Position the cursor over the image in the Effect Preview monitor. 

Notice that the cursor becomes a crosshair.

Brush Shape but-
tons

Brush Shape but-
tons
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6. Press and hold the mouse button, and drag to paint freehand style 
on the video background.

7. Release the mouse button when you have finished painting the 
object.

Creating a Custom Brush Head from a Template

You can change the brush head to a custom shape by modifying the 
brush head in the Brush Preview window.

To create a custom brush head:

1. Click the Brush tool in the Effect Editor.

2. Click a brush shape that will provide the basis for your custom 
brush head.

The shape appears as the brush head in the Brush Preview 
window.

3. Click the brush head in the Brush Preview window.

Control points appear on the brush head where curves merge or 
straight lines intersect.

4. Click a control point, and drag it to change the shape of the brush 
head.

5. Repeat step 4with other anchor points as needed.
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n For brush shapes with rounded edges and curves, such as the oval, the ellipse, 
and the circle, clicking an anchor point creates direction bars and handles that 
enable you to edit the Bézier curve. For information on working with Bézier 
curves, see “Working with Vector-Based Objects” on page 393. You can 
use the direction bars and handles, and you can drag the object’s control 
points, but you cannot use the modifier key variations.

To rotate the brush head:

1. Click the Brush tool if the brush is not already active.

2. Click the button for the template as needed.

The shape appears in the Brush Preview window.

3. Do one of the following:

t Drag the Spin slider to the right (clockwise rotation) or to the 
left (counterclockwise rotation) to rotate the brush head to the 
desired position.

t Click the Spin slider, and use the keyboard to type a value 
from –360 to 360.

Saving a Brush Template

You can save a template of a custom brush to a bin so that you can 
reuse the parameters of the brush with an Intraframe effect.

To save the brush template:

1. Click the Brush Template icon in the Brush category, and drag it to 
a bin.
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A brush template appears in the bin, and the name of the template 
defaults to Brush.

2. Click the name of the template in the bin, type a unique name for 
the template, and press Enter.

3. To use the template later, click the template in the bin, drag it to 
the Brush Preview window, and release the mouse button.

4. The brush in the Brush Preview window assumes the same 
parameters as the brush template you saved to the bin.

Using Path to Create a Signature Effect

The Path parameter slider is useful for creating a “signature” effect 
with the Paint Effect, in which a signature gradually appears on the 
screen as if written with an invisible pen.

To create the signature effect:

1. Apply the Paint Effect to a segment.

2. Click the Brush tool in the Effect Editor.

3. Choose Solid from the Fast menu in the Mode category.

4. Press and hold the mouse button, and drag the cursor in the Effect 
Preview monitor to paint a signature or other string of text.

5. Release the mouse button when you are satisfied with the text.

6. Click the first keyframe in the segment to select it.

Brush Template icon
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7. Select the painted object if it is not selected already.

8. Click the Path slider, type 0, and press Enter (Windows) or Return 
(Macintosh).

9. Click the last keyframe in the segment to select it.

10. Click the Path slider, type 100, and press Enter (Windows) or 
Return (Macintosh).

n Alternatively, you can add keyframes at different locations in the effect’s 
Timeline and change the percentage of the Path parameter at each keyframe to 
modify how the effect appears over the course of the segment.

11. Render the Paint Effect to play it back in real time.

Using the Selection Tool

The Selection tool is one of the most frequently used tools. You use this 
tool to select a painted object or matte on the screen when you want to 
make changes to it. After you select an object, you can move it in the 
frame, rescale it, and change its parameters.

To select an object:

t Choose the Selection tool and click an object. 

Selection handles appear around the object. 

To select multiple objects do one of the following:

t Shift+click the additional objects with the Selection tool.

t Press and hold the mouse button and drag the cursor to draw a 
lasso around the objects.

When you select multiple objects, one set of selection handles appears 
around all the objects, which enables you to move, rescale, or 
otherwise change the parameters of all the selected objects 
simultaneously.
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When a segment contains multiple objects, you can change your 
selection from one object to another by clicking one of the following 
buttons: Fast Forward, Rewind, Go to Next, or Go to Previous. To use 
these buttons in Effect mode, you must map them to your keyboard. 
For more information on these buttons, see your Avid system’s quick 
reference card.

Creating Rectangular Shapes

With the Rectangle tool, you can paint rectangular shapes or mattes on 
images in a sequence. All the paint modes and parameters in the Effect 
Editor are accessible to the Rectangle tool with the exception of the 
Brush category.

To paint with the Rectangle tool:

1. Click the Rectangle tool in the Effect Editor.

2. Select a paint mode or key mode and parameters in the 
Effect Editor.

3. Position the cursor where you want to begin painting in the frame.

Multiple selected 
objects

Selection handles 
to control all 
selected objects 
simultaneously
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4. Press and hold the mouse button, and drag the cursor to create the 
rectangle.

n Press the Alt key (Windows) or Option key (Macintosh) and drag the mouse 
to constrain the shape to a square.

As you drag, you describe the diagonal of the rectangle. For 
example, if you drag to the right and in a downward fashion, the 
rectangle is anchored to its upper left corner.

5. Release the mouse button to complete the rectangle.

6. Adjust the object’s parameters if needed.

Creating Oval Shapes

With the Oval tool, you can paint oval shapes or mattes on images in a 
sequence. All the paint modes and parameters in the Effect Editor are 
accessible to the Oval tool with the exception of the Brush category.

To create oval shapes:

1. Click the Oval tool in the Effect Editor.

2. Select a paint mode or key mode and parameters in the 
Effect Editor.

3. Position the cursor where you want to begin painting in the frame.

Anchor Anchor
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4. Press and hold the mouse button and drag the cursor to create an 
oval.

n Press the Alt key (Windows) or Option key (Macintosh) and drag the mouse 
to constrain the shape to a circle.

As you drag, you describe the diameter of the oval. For example, if 
you drag to the right and in a downward fashion, the oval is 
anchored to its upper left corner.

5. Release the mouse button to complete the oval.

6. Adjust the object’s parameters if needed.

Drawing Polygons

With the Polygon tool, you can paint a variety of geometric objects and 
trace images in a frame. All the modes and parameters in the Effect 
Editor are accessible to the Polygon tool with the exception of the 
Brush category. You can use the Polygon tool to create objects and 
mattes composed of straight-line segments, curved segments, or a 
combination of both.

To take full advantage of the power of the Polygon tool, you should be 
familiar with the concepts behind vector-based graphics. If you are not 
familiar with these principles, see “Working with Vector-Based 
Objects” on page 393 for more information. 

Anchor Anchor
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It is helpful to visualize the shape and the position of the polygon 
within the frame before you begin painting. By visualizing the object 
first, you will gain more control over the objects’s attributes when you 
edit it later. 

The general workflow for working with the Polygon tool is:

1. Visualize the object you want to create.

2. Determine a location in the frame to begin painting and click that 
location to create the initial control point.

3. Click additional control points as you continue to define the shape 
of the object.

4. Double-click to create the final control point or click the initial 
control point to create the closed polygon.

n Try to create the object with as few control points as possible. Fewer control 
points will eliminate more work if you need to modify the object later.

Creating Polygons with Straight-Line Segments

To create a polygon with straight-line segments:

1. Click the Polygon tool in the Effect Editor.

2. Select a paint mode or key mode and parameters in the 
Effect Editor.

3. Click in the frame where you want to place the initial control 
point.

n The control points do not appear as tiny rectangles while you are painting the 
object.

4. Click in the frame where you want to place the next control point.
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A straight-line segment is drawn between the initial control point 
and the control point you just created.

n Segments appear as wire frames until you finish painting the object.

5. Click in the frame to create additional control points that further 
define the shape of the object.

A straight-line segment appears between each pair of adjacent 
control points.

6. When you are satisfied with the shape of the object, double-click 
in the frame to create the final control point or click the initial 
control point.

The object becomes a closed polygon.

Initial segment

Initial control point

Second control point
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7. Adjust the parameters of the polygon if needed.

Creating Polygons with Curved Segments

To create a polygon with curved segments:

1. Click the Polygon tool in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect 
Editor.

3. Click in the frame where you want to place the initial control 
point, and release the mouse button.

n The control points do not appear as tiny rectangles while you are painting the 
object.

4. Drag the cursor to the location where you want to place the next 
control point.

5. Click and hold the mouse button to begin creating the first curved 
segment.

Direction bars with handles appear as a tangent to the curved 
segment. The cursor “leads” the direction handle that you will use 
to determine the direction and height of the curve.
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6. Drag the cursor, which is attached to the direction handle, to 
adjust the direction and height of the curved segment.

7. Release the mouse button when you are satisfied with the height 
and angle of the curved segment.

8. Drag the cursor to the next location where you want to create a 
curved segment.

9. Repeat steps 3 to 8 to create additional curves if needed.

10. When you are satisfied with the shape of the object, double-click 
in the frame to create the final control point or click the initial 
control point. 

The object becomes a closed polygon.
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11. Adjust the parameters of the polygon if needed.

Creating a Straight Line Following a Curve

To create a straight line following a curved segment:

1. Create one or more curved segments as described in “Creating 
Polygons with Curved Segments” on page 387.

2. Drag the cursor to the location where you want to begin painting 
the straight line.

3. Click and then release the mouse button to create the control 
point.

4. Drag the cursor to the location where you want the straight-line 
segment to end.

5. Click and then release the mouse button to create the control 
point.
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6. Continue to create additional lines and curves.

7. When you are satisfied with the shape of the object, double-click 
in the frame to create the final control point or click the initial 
control point. 

The object becomes a closed polygon.

8. Adjust the parameters of the polygon if needed.
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Creating Curved Objects

With the Curve tool, you can trace curved objects with freehand 
capability. All the paint modes and parameters in the Effect Editor are 
accessible to the Curve tool with the exception of the Brush category.

To paint with the Curve tool:

1. Click the Curve tool in the Effect Editor.

2. Select a paint mode or key mode and parameters in the Effect 
Editor.

3. Position the cursor where you want to begin painting in the frame.

4. Press and hold the mouse button, and drag the cursor as you paint 
a freehand curved shape on the frame.

5. When you are satisfied with the shape of the object, release the 
mouse button to complete the curved object.

6. Adjust the object’s parameters if needed.

Changing the Parameters of a Painted Object

To change the parameters of an object you already have painted, click 
the object with the Selection tool and do one of the following:
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t To move the object, click anywhere within the outline and drag the 
object to a new location.

t To rescale the object, do one of the following:

t Click one of the selection handles and drag

t Press and hold the Alt key (Windows) or Option key 
(Macintosh) to rescale the object from its center

t To change the color, click the triangular opener next to the Color 
category and adjusting the Hue, Sat (saturation), and Lum 
(luminance) sliders.

t To add feathering to the object’s edges, click the triangular opener 
next to the Feathering category and adjusting the sliders.

Selection
handles
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t To delete the object, press the Delete key.

t To undelete the object, choose Undo from the Edit menu.

Working with Vector-Based Objects

Before you begin working with the paint and editing tools included in 
the Intraframe effects, you must understand the basics of working 
with vector-based objects and Bézier curves. The vector-based 
graphics technology of the Intraframe Editing option enables you to 
create and edit objects and mattes with a precision that you cannot 
achieve when you work with bitmapped objects. Vector-based objects 
are not subject to problems such as artifacting when you rescale them.

The Elements of Vector-Based Objects

The objects you paint, the matte keys you draw, and the brush 
templates that appear in the Brush Preview window include a control 
point at the midpoint of each line or curve, also known as a join. The 
portion of the line or curve on each side of the control point is called a 
segment. The control point controls the direction of each segment as it 
passes through the join. 

Join

Segment

Segment

Control point
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Control points for a painted object are visible when you select an 
object with the Selection tool and then click the Reshape tool. Also, 
when you click a brush template in the Effect Editor, the brush head 
displays visible control points in the Brush Preview window.

A painted object can include three types of joins that describe its 
shape: 

• Straight-edge join

• Smooth join

• Corner join

A control point associated with a smooth join or a corner join describes 
a Bézier curve. Clicking a control point makes it the active join. 
Tangents called direction bars appear on each side of the control point 
associated with a Bézier curve. At the end of each direction bar is a 
direction handle. Dragging a direction handle changes the way the 
segments pass through the control point to define the curve.

When you drag a direction handle, you change the height and angle of 
the curve. The curve responds as if you were gently tugging it like a 
piece of string. The segments remain anchored to the control points on 
either side of the active join.

Straight-edge join Smooth join Corner join

Control point

Anchor point

Direction bar
Direction handle

Active curve join

Anchor point



395

In contrast, straight-edge joins do not display direction bars and 
handles when you click them. 

To reshape an object composed of one or more straight edges:

t Select the object with the Selection tool, click the Reshape tool, and 
then drag one or more control points. For information on control 
points, see “Moving Control Points Manually” on page 406.

t Convert straight-edge joins to Bézier curves, and manipulate the 
curves as described in the following sections.

Getting Started with Bézier Curves

If you have never worked with Bézier curves, learning how to work 
with them requires a willingness to experiment. As you practice 
working with Bézier curves, you will gain greater control over painted 
objects and mattes, and the process will become more intuitive. The 
following sections describe how to paint a rectangular object with the 
Paint Effect and use the Reshape tool to convert corners into Bézier 
curves. You then will modify the curves to change the shape of the 
object. 

Transforming a Rectangle into a Circle 

To create a rectangle and transform it into a circle with Bézier curves:

1. Apply the Paint Effect to a segment in a sequence and enter Effect 
mode.

2. Click the Rectangle tool in the Effect Editor.

3. Choose Solid from the Fast menu in the Mode category.

4. Press and hold the mouse button, and drag in the Effect Preview 
monitor to paint a rectangular object. Do not worry about picking 
a color or other parameters for this exercise.
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5. Click the Selection tool and select the object you just painted.

6. Click the Reshape tool or double-click the object.

Notice that each corner of the rectangle displays a control point.

7. Alt+click (Windows) or Option+click (Macintosh) the control 
point at the top left corner of the rectangle.

Notice that the straight-edge join becomes a smooth join with 
direction bars and handles.

Control points
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8. Working in a counterclockwise direction, Alt+click (Windows) or 
Option+click (Macintosh) each control point until they have all 
been transformed into smooth joins.

The resulting shape is a circle. The control point at the top right of 
the circle is the active join and displays direction bars and handles.

Experimenting with Direction Handles

To experiment with the direction handles:

1. Click the bottom direction handle and drag away from the control 
point to increase the length of the direction bar.

Notice how the curve changes. Also, the direction bar and 
segment on the opposite side of the control point move in unison 
with the direction bar you are dragging. The control points 
adjacent to the active join serve as anchor points for the segments 
that compose the curve.
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2. Drag the direction handle toward the control point to shorten the 
direction bar.

Notice how the curve changes as you shorten the direction bar.

3. Shift+click the direction handle and drag it away from the control 
point.

Notice that the length of the direction bar on the opposite side of 
the control point does not change; this prevents the height of its 
associated segment from changing. However, the opposite 
direction bar does move in unison with the direction handle you 
are dragging, thereby changing the angle of the segment in 
unison.

Anchor point

Active join
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4. Shift+click the direction handle to revert the direction bars to their 
previous functionality.

5. Click the bottom direction handle, and drag it in a 
counterclockwise direction.

Notice how the curve changes as you drag the direction bar.

6. When you have finished experimenting, adjust the direction bar so 
that the object again resembles a circle.

Opposite segment
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Creating a Corner Join

The painting tools do not create corner joins by default; you can 
change an existing smooth join into a corner join as described in this 
section.

n If you want to transform a straight-edge join into a corner join, you must 
transform the straight-edge join into a smooth join first.

To transform a smooth join into a corner join:

1. Alt+click (Windows) or Option+click (Macintosh) the bottom 
direction handle.

Although you might not notice it immediately, the smooth join is 
transformed into a corner join.

2. Drag the direction handle away from the control point.

Notice how the active segment behaves as you lengthen the 
direction bar. The direction bar and segment on the opposite side 
of the control point do not move in unison with this direction 
handle. Also, notice that the active segment remains anchored to 
the adjacent control point.

3. Drag the direction handle in a counterclockwise direction.
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Notice how the segment changes as you drag the direction bar.

4. When you are finished experimenting, Alt+click (Windows) or 
Option+click (Macintosh) the direction handle.

The control point reverts to a smooth join.

Modifying Lines and Curves Summarized

Table 8-1 summarizes how you can modify lines and Bézier curves 
(smooth joins or corner joins) by using the mouse and the modifier 
keys on the keyboard.
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Table 8-1 Methods of Modifying Lines and Curves

Illustration Description Action

Smooth join: Drag one direction 
handle so that the direction bar on the 
opposite side of the control point 
moves and changes length in unison.

You do not have to press any of the 
modifier keys. Click one of the 
direction handles and drag it.

Smooth join: Drag one direction 
handle so that the direction bar on the 
opposite side of the control point 
moves in unison but does not change 
in length.

Shift+click a direction handle.

To change it back, Shift+click the 
direction handle.

Transform a straight-edge join into a 
smooth join.

Alt+click (Windows) or Option+click 
(Macintosh) the control point.

To change it back to a straight-edge 
join, Alt+click (Windows) or 
Option+click (Macintosh) the smooth 
join.

Direction handle

Direction bar

Active direction handle

Straight-edge join

Smooth join
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Painting a New Object with Bézier Curves

When you paint a freehand object to mask, colorize, or otherwise 
modify an image in a frame, you can achieve extraordinary precision 
when you know how to control Bézier curves. Being able to visualize 
curves and where you need to place their associated control points 
before you begin painting can make the process of tracing shapes 
easier. 

Transform a smooth join into a corner 
join.

Alt+click (Windows) or Option+click 
(Macintosh) one of the direction 
handles.

To change it back to a smooth join, 
Alt+click (Windows) or Option+click 
(Macintosh) the direction handle.

Corner join: Drag one direction handle 
so that the direction bar on the 
opposite side of the control point 
moves independently of the bar on the 
opposite side of the control point.

You do not have to press any of the 
modifier keys. Click one of the 
direction handles and drag it.

Table 8-1 Methods of Modifying Lines and Curves (Continued)

Illustration Description Action

Smooth join

Corner join

Active direction handle
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The following tools paint new objects composed of Bézier curves:

• Oval tool

• Polygon tool

• Curve tool

For information on how to use these tools to paint new objects with 
Bézier curves, see the description for each tool in “Layering with the 
Paint Effect” on page 416. Keep in mind that you are not limited to 
using these tools to create curved objects because you can transform 
the straight-edge joins in any painted object into Bézier curves as 
described in “Modifying Lines and Curves Summarized” on 
page 401.

Adding a Control Point

Placing more control points on an object enables the object to trace 
more detailed images. For example, if a segment of an object does not 
follow a curved section on a frame as well as you would like, and 
adjusting the control points and direction bars do not help, you can 
add a new control point.

To add a control point:

1. Click the object with the Selection tool. 

2. Click the Reshape tool or double-click the object.

3. Click the selected object where you want to add a new control 
point.

A new control point appears and is calculated so that the original 
object, as you drew it, does not change dramatically in shape. The 
new control point appears as part of the object for all keyframes in 
the segment. 

Any changes you make to a control point, such as moving it or 
changing the angle of the associated curve, affects the keyframes 
you have selected in the segment. If you change a control point at 
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a selected keyframe or add a keyframe to make changes, the 
changes are interpolated between the selected keyframe and 
adjacent keyframes.

Removing a Control Point

Avid recommends that you remove a control point if the object does 
not need the control point to adequately define its shape. It is better to 
have fewer control points and to manipulate the direction bars to gain 
the same effect because fewer control points mean less work if you 
need to modify an object later.

To remove a control point:

t Click the control point and press the Delete key. 

You also can Shift+click multiple control points and then delete them.

The Avid system attempts to reconstruct the object so that it does not 
change. The results you see might vary because of the internal 
mechanics and geometry of Bézier curve technology. However, adding 
and then removing the same control point should not dramatically 
change the curve of that section of an object.

Unnecessary number of 
control points to describe 
this curve

Minimum number of 
control points needed to 
describe this curve
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Moving to Adjacent Control Points

You can move from a control point to an adjacent control point 
without having to click the mouse. To use this feature, you must map 
the Fast Forward and Rewind buttons to your keyboard or a 
user-selectable button palette. 

n For more information on mapping buttons, see the Avid Media Composer 
and Film Composer Editing Guide.

To move to an adjacent control point:

1. Select a control point.

2. Move to an adjacent control point:

t Click the Fast Forward button to move in a clockwise fashion 
to the next control point.

t Click the Rewind button to move in a counterclockwise 
fashion to the next control point.

Moving Control Points Manually

You can move control points manually by simply clicking them and 
then dragging. You can move one control point at a time or several 
control points at once. Before you select control points for moving, first 
click an object with the Selection tool to display the control points.

To move control points manually:

t Single control points: Drag an individual control point to its new 
location. The control point’s direction bars do not change 
orientation.

t Multiple control points: Click one control point, and then 
Shift+click or lasso additional control points that you want to 
move. Drag one of the selected control points. All other selected 
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control points move in unison. To deselect the group, click any 
unselected control point.

t All control points: Press Ctrl+A (Windows) or k+A (Macintosh) 
to select all control points. Drag one of the selected control points. 
All other control points move in unison. To deselect the group, 
click outside the object to deselect it.

Moving Control Points and Objects in Small Increments

You can “nudge” selected control points or an entire object in 
one-pixel increments by using keys on the keyboard.

To move or “nudge” control points in one-pixel increments:

1. Click a control point to select it, or Shift+click additional control 
points to move them as a group.

2. Nudge the control point or points by using one of the following 
techniques:

t Press the Left Arrow key or the Trim Left key to nudge 
selected control points to the left.

t Press the Right Arrow key or the Trim Right key to nudge 
selected control points to the right.

t (Windows) Press the Alt key and the Left Arrow key or the 
Trim Left key to nudge selected control points up.

t (Macintosh) Press the Option key and the Left Arrow key or 
the Trim Left key to nudge selected control points up.

t (Windows) Press the Alt key and the Right Arrow key or the 
Trim Right key to nudge selected control points down.

t (Macintosh) Press the Option key and the Right Arrow key or 
the Trim Right key to nudge selected control points down.



408

c The Effect Preview monitor must be the active window for this 
feature to work. Additionally, if you have remapped the arrow keys 
on your keyboard, this feature might not function properly.

Previsualization Marker Tool for Film Projects

The Previsualization Marker tool enables you to place a marker in a 
segment to represent an effect that will be processed at an optical 
facility. This tool is applicable to 24-fps projects only and appears in 
the Effect Editor only when you are working in a film project with the 
Paint Effect.

When you create an optical list, each marker, along with its position in 
the segment on a keyframe-by-keyframe basis, appears as an optical 
event. The editor at the optical facility can refer to the event as a cue 
for creating a visual effect, such as a rotoscoped object.

n You generate optical lists with Avid FilmScribe. For general information on 
using Avid FilmScribe, see the Avid FilmScribe User’s Guide.

For example, the optical editor’s assignment is to create an airplane 
that flies through the scene. The editor can use keyframe information 
from the optical list to plot the exact path of the effect as it moves 
through the scene. The marker’s position at each keyframe is 
described with coordinates derived from the Effect Grid. Position is 
described in terms of compass coordinates and X, Y coordinates.

Additionally, you can add multiple markers to a single scene to 
represent different effects, and you can use a unique color for each 
marker. The resulting optical list will display each marker and its 
unique color values to enable the optical editor to distinguish each 
marker.
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Applying a Previsualization Marker Effect

To add a Previsualization Marker effect to a sequence:

1. Enable the Effect Grid and set the appropriate parameters for 
image scan size, aspect ratio, and film format.

2. Click the Previsualization Marker Tool button in the Effect Editor.

3. Adjust the sliders in the Color parameter category to determine 
the color of the marker.

4. Move the cursor to the location in the frame where you want to 
place the marker, and click the mouse.

A marker appears in the frame.

5. Use keyframes to move the marker throughout the segment.

6. To add more markers, repeat steps 2 to 5.

To delete a marker:

t Click the marker to highlight it, and then press the Delete key.

Creating a Cut List with Previsualization Marker Information

To include the Previsualization Marker coordinate information in a 
cut list:

1. In the Cut List tool within Avid FilmScribe, select Optical from the 
Lists pane.

2. Select the Key Frames check box in the Options pane for the 
optical list.

The following illustration shows the presentation of Previsualization 
Marker information in a cut list.
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Manipulating Intraframe Objects

The Intraframe effects include editing tools and additional parameters 
that enable you to perform the following operations:

• Move objects individually or in groups

• Reshape objects

• Rotate objects

• Scale objects

• Apply keyframed changes over time

Moving Intraframe Objects

The Selection tool also enables you to drag objects or mattes around 
the screen and in relation to the screen when you zoom out from a 
frame.

Grid informa-
tion

Keyframe number 
and reference 
numbers

Color and coordi-
nate information 
for two separate 
markers
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To move a painted object or matte:

1. Click the Selection tool in the Effect Editor.

2. Click the object you want to move.

The object outline becomes highlighted, and four selection points 
appear around the object.

3. Click the center of the object and drag it to a new location.

4. Release the mouse button when the object is positioned in the 
location you want.

Reshaping Intraframe Objects

The Reshape tool enables you to modify the shape of a painted object 
or matte on the screen by using several different techniques. These 
procedures require some familiarity with vector-based graphics. For 
more information, see “Working with Vector-Based Objects” on 
page 393.

n The shape of an intraframe object can be changed over time by using 
keyframes. For more information, see “Changing Intraframe Object 
Parameters over Time” on page 415.

To reshape an object:

1. Select an object or matte with the Selection tool.

2. Click the Reshape tool in the Effect Editor, or double-click the 
selected object.

The outline of the object becomes highlighted, and control points 
appear.
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n If you want to drag the control points only, Alt+click (Windows) or 
Option+click (Macintosh) the Reshape tool to hide the direction handles.

3. Edit the shape of the object or matte:

t Click one or more of the object’s control points and drag. For 
information on moving control points, see “Moving Control 
Points Manually” on page 406.

t Edit the object by manipulating the direction bars at one or 
more control points. For information on editing straight-line 
segments and curved segments, see “Modifying Lines and 
Curves Summarized” on page 401.

Reshaping Objects Created with the Curve Tool

The default behavior of control points in an object or matte created 
with the Curve tool differs slightly from those created with the 
Polygon tool. When you drag one of the direction handles, the 
direction bar on the opposite side of the control point moves in unison 
but the length does not change in unison. The dimensions of the 
curved segments on each side of the control point are not equal 
because the Curve tool creates curves with freehand capability, not 
with a mathematical formula that describes a Bézier curve in the way 
that the Polygon tool does.



413

You can transform the direction bars at a control point so that their 
lengths change in unison when you drag one of the direction handles. 
To do so, Shift+click one of the direction handles. For more 
information, see “Modifying Lines and Curves Summarized” on 
page 401.

Rotating Intraframe Objects Along the Z Axis

With the Z-Rotation tool, you can select an object or matte and rotate it 
around the Z axis (clockwise or counterclockwise direction). You also 
can change the rotation of an object over time by rotating the object on 
an individual keyframe basis.

n The rotation of an intraframe object can be changed over time using 
keyframes. For more information, see “Changing Intraframe Object 
Parameters over Time” on page 415.

To rotate an object or matte around the Z axis:

1. Click the Z-Rotation tool in the Effect Editor.

2. Click the object you want to rotate.

The object outline becomes highlighted, and a rotation handle 
appears within the object.

Center of 
rotation

Z-Rotation han-
dle
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The X on the rotation handle marks the default center of the Z axis 
for the object. You can click the X and drag it anywhere on the 
screen to change the center of the object’s rotation.

3. Click the rotation handle and drag the mouse to rotate the object in 
either a clockwise or a counterclockwise direction.

Scaling Intraframe Objects

You can rescale any object or matte that you create. Rescaling increases 
or decreases all dimensions of the object proportionately.

n The scale of an intraframe object can be changed over time using keyframes. 
For more information, see “Changing Intraframe Object Parameters over 
Time” on page 415.

To rescale an object or matte:

1. Click the Selection tool in the Effect Editor.

2. Click the object you want to rescale.

The object outline becomes highlighted, and four selection points 
appear around the object.

3. Rescale the object by using one of the following methods:

t Click any of the selection points and drag. 

Dragging toward the center of the object decreases the overall 
size, while dragging away from the center increases the 
overall size. When you drag a selection point, the object is 
anchored by the selection point that is diagonal to the one you 
are dragging.
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t Alt+click (Windows) or Option+click (Macintosh) any of the 
selection points and drag to rescale the object using the center 
of the object as the anchor.

Changing Intraframe Object Parameters over Time

You can animate an intraframe object by changing parameters on an 
individual keyframe basis. The following parameters are 
keyframeable:
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• Position of an object on screen (see “Moving Intraframe Objects” 
on page 410)

• Shape of an object (see “Reshaping Intraframe Objects” on 
page 411)

• Z-axis rotation of an object (see “Rotating Intraframe Objects 
Along the Z Axis” on page 413)

• Scale or relative size of an object (see “Scaling Intraframe 
Objects” on page 414)

• Feathering (see “Feathering” on page 470)

• Foreground level (see “Foreground” on page 489)

• Magic Mask (see “Magic Mask” on page 472)

For more information on using keyframes with parameters, see 
“Using Keyframes” on page 129.

Layering, Grouping, and Locking 
Intraframe Objects

The Intraframe effects include tools for navigating and adjusting 
layers of intraframe objects, grouping objects for performing 
operations on several objects at once, and locking objects to prevent 
further changes.

Layering with the Paint Effect

When you paint on a frame, the paint appears as an object in the 
foreground, seeming closer to you in three-dimensional space than the 
video frame. You can change the parameters of each painted object 
independently, including the object’s orientation in relation to another 
object. For example, if you have three painted objects, you can stack or 
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cascade them over each other to create three separate layers of objects 
in the foreground. 

All compositing of painted objects takes place in the foreground and is 
not destructive to the video background. Keep in mind that when you 
composite various Paint Effects on a frame, the Avid system renders 
the Paint Effects to the screen beginning with the bottom layer. 

Layering with the AniMatte Effect

Layering with the AniMatte effect works much as it does with the 
Paint effect, but the image that appears in the foreground is the video 
that you have chosen to key in or key out. Even though the Avid 
system renders matte keys starting with the highest track in a 
multilayer matte key, compositing of multiple AniMatte effects in the 
same segment occurs in the foreground and is not destructive to the 
video background.

Locating Layered Objects with the Outline/Path Button

You can use the Outline/Path button to locate an object or matte that 
might be obscured by others on the screen. The Outline/Path button 
creates a wire-frame representation of each object, which enables you 
to locate, select, and manipulate the object. Clicking the Outline/Path 
button switches the Path on or off.

To locate objects or mattes with the Path function:

1. Click the Outline/Path button in the Effect Editor.

Each object painted on the frame appears as a wire frame.

2. Select an object and change its location or parameters.

3. Click the Outline/Path button to return to default viewing mode.
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Bringing Objects and Mattes Forward by One Layer

You can use the Bring Forward function to bring a single object or 
matte forward by one layer (appearing closer to you in 
three-dimensional space). 

To bring an object or matte forward by one layer:

1. Select an object on the screen with the Selection tool. 

If the object is obscured by other objects, use the Outline/Path 
feature to locate it as described in “Locating Layered Objects with 
the Outline/Path Button” on page 417.

2. Click the Bring Forward button, or choose Bring Forward from the 
Object menu.

The object moves one layer forward in the foreground.

Sending Objects and Mattes Backward by One Layer

You can use the Send Backward function to send a single object or 
matte backward by one layer (appearing farther away from you in 
three-dimensional space). 

To send a painted object or matte backward by one layer:

1. Select an object on the screen with the Selection tool. 

If the object is obscured by other objects, use the Outline/Path 
feature to locate it as described in “Locating Layered Objects with 
the Outline/Path Button” on page 417.

2. Click the Send Backward button, or choose Send Backward from 
the Object menu.

The object moves one layer backward into the layers of objects that 
appear in the foreground.
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Bringing Objects and Mattes to the Front

You can use the Bring To Front function to bring a single object or 
matte to the front of the foreground layers (appearing closest to you in 
three-dimensional space).

To bring a painted object or matte to the front:

1. Select an object on the screen with the Selection tool. 

If the object is obscured by other objects, use the Outline/Path 
feature to locate it as described in “Locating Layered Objects with 
the Outline/Path Button” on page 417.

2. Alt+click (Windows) or Option+click (Macintosh) the Bring 
Forward button, or choose Bring To Front from the Object menu.

The object becomes the top layer in the foreground.

Sending Objects or Mattes to the Back

You can use the Send To Back function to send an object or matte to the 
bottom layer (appearing farthest away in three-dimensional space).

To send a painted object or matte to the back:

1. Select an object on the screen with the Selection tool. 

If the object is obscured by other objects, use the Outline/Path 
feature to locate it as described in “Locating Layered Objects with 
the Outline/Path Button” on page 417.

2. Alt+click (Windows) or Option+click (Macintosh) the Send 
Backward button, or choose Send to Back from the Object menu.

The object becomes the bottom layer in the layers of painted 
objects that make up the foreground.
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Grouping and Ungrouping Intraframe Objects

The Avid system enables you to group objects or mattes so that they 
behave as a single object. You then can move the new group and 
change its parameters as if it were a single object. If you want to 
separate the group and revert to working with the individual objects, 
you can do so by using the UnGroup function.

To group and ungroup painted objects or mattes:

1. Select an object on the screen with the Selection tool. 

If the object or matte is obscured by other objects, use the 
Outline/Path feature to locate it as described in “Locating 
Layered Objects with the Outline/Path Button” on page 417.

2. Shift+click any additional objects you want to include in the 
group.

3. Choose Group from the Object menu.

The objects become grouped together, and you can manipulate the 
group as if it were a single object.

4. To ungroup the objects, select the group and choose UnGroup 
from the Object menu.

n You also can group together groups of objects. If you then select the new 
group and choose UnGroup, all objects become ungrouped completely.

Locking and Unlocking Intraframe Objects

By using the lock feature, you can lock an object or a group in place on 
the screen. When you lock an object, the Avid system prevents you 
from moving the object accidentally while you add more effects and 
make additional edits to your sequence.
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To lock and unlock a painted object or matte:

1. Select an object or group on the screen with the Selection tool.

If the object is obscured by other objects, use the Outline/Path 
feature to locate it as described in “Locating Layered Objects with 
the Outline/Path Button” on page 417.

2. Choose Lock from the Object menu.

3. To unlock the object at any time, select the object and choose 
Unlock from the Object menu.

Exporting a Matte PICT File

You can create a matte with the AniMatte effect and export it from the 
Avid system as a high-contrast matte — without having to leave Effect 
mode. The exported image is a high-contrast 32-bit PICT file that 
includes an alpha channel.

You can use the exported PICT file in the following ways:

t Import the file back into the Avid system to create a real-time 
Matte Key clip that you can edit into a sequence. You can use this 
clip as a garbage matte, or, if your system has 3D effects 
capabilities, promote the clip to 3D.

t Open the file in a third-party graphics application, edit the file, 
and import the file back into the Avid system.

t Use the file as a graphic in an application other than your Avid 
system.

When you import the PICT file back into the Avid system, the system 
creates a Matte Key clip in the bin that you select. You can load the 
Matte Key clip into the Source monitor and edit it into a sequence as 
you can with any other imported matte key. The Matte Key clip 
appears as a high-contrast matte with transparent (black) and opaque 
(white) components. 
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n For more information on creating matte keys, see “Creating Key Effects” on 
page 173. For more information on editing a Matte Key clip into a sequence, 
see “Editing with Imported Matte Key Clips” on page 183.

When you open the high-contrast PICT file in a third-party application 
that supports alpha channels, select the file’s alpha channel to view the 
high-contrast components of the matte. However, if you open the 
PICT file in an application that does not support alpha channels, the 
image appears completely white.

To export a matte key created with the AniMatte effect:

1. Create a matte key using the AniMatte effect in Effect mode.

n To follow the remaining steps in this procedure, you must be working in Effect 
mode.

2. Move the position indicator in the Effect Preview monitor’s 
position bar to the frame you want to export.

3. Choose Export Matte PICT from the File menu.

A dialog box appears.

4. Choose the location where you want to save the PICT file, and 
then click Save.

The system saves the PICT file to the location you chose.

5. If necessary, open the PICT file in a third-party application and 
make changes to the file.

6. Select the bin into which you will import the PICT file, and choose 
Import from the File menu.

The Import file(s) into bin dialog box appears.

7. Click Options.

8. To use the existing alpha channel, deselect Ignore Existing Alpha. 

Depending on your needs, you might have to select Invert 
Existing Alpha; in a high-contrast matte key with an alpha channel 
on an Avid system, the white regions are opaque, and the black 
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regions are transparent. For more information on importing a 
matte key, see the chapter “Importing Files” in the Avid Media 
Composer and Film Composer Input and Output Guide.

9. When you have finished selecting the options you need, click OK.

10. Continue with the instructions in the chapter “Importing Files” in 
the Avid Media Composer and Film Composer Input and Output Guide 
to complete the import of the file into the bin.

The PICT file appears as a Matte Key effect clip in the bin you 
chose.

11. Click the Source/Record Mode button.

12. Load the Matte Key effect clip into the Source monitor.

The clip appears in the Source monitor as a black-and-white, 
high-contrast image.

13. Edit the matte key into the sequence as described in “Editing with 
Imported Matte Key Clips” on page 183.

Scratch Removal

Some Avid editing systems include tools for fixing flaws such as 
dropout in video frames or defects in film-originated footage. You can 
replace a flaw with clean material from the same frame or field or from 
other nearby frames or fields.

Understanding Scratch Removal Options

The basic workflow for removing a flaw involves the following main 
steps:

1. Isolate the flawed material in a new segment.

2. Apply an Intraframe effect.
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3. Use the Intraframe drawing tools and effect parameters to draw a 
shape that covers the flaw and fill the shape with clean 
replacement material.

4. (Option) If the flaw persists over several frames or fields, you 
might need to adjust the covering shape by using keyframes so 
that it continues to cover the flaw as the footage moves.

Before you correct a flaw, you should make some basic decisions about 
how you want to make the correction. The following sections provide 
an overview of the differences between correcting within the same 
frame or field and correcting using nearby frames or fields; they also 
provide guidance on deciding exactly what material you need to 
isolate when you make the correction.

Removing a Flaw Within a Frame

You can often remove a flaw by replacing it with a clean area from the 
same frame or field. For example, a flaw on a uniformly colored 
background such as sky can be replaced by copying another portion of 
the sky over the flaw.

The advantage of removing a flaw by using material from the same 
frame that contains the flaw is that you can see both the flaw and all 
the available clean material as you work. This can be helpful for 
certain kinds of footage, making it easy to choose the exact portion of 
the image that allows for the best replacement.

Removing a Flaw by Using Nearby Frames

You can correct flaws on a wider range of footage types by using 
replacement material from a nearby frame or field.

This method provides an alternative for dealing with uniform areas 
such as sky since you can replace a flaw with the same area from a 
nearby clean frame.
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Replacing with material from a nearby frame or field also allows you 
to correct flaws in more complex footage. For example, a flaw on an 
image such as a face might be very difficult to cover by using material 
from the same frame or field — there might be no other area of the face 
in that image that shows similar tones, textures, and highlights. In this 
situation, it is better to replace the flaw by copying the same part of the 
face from an earlier or later frame that does not contain the flaw.

When you replace a flaw by using material from a nearby frame, you 
cannot see the whole of the nearby frame as you work. Instead, you 
see the replacement area in the shape you draw to cover the flaw, and 
you adjust which portion of the nearby frame appears by using 
parameter sliders in the Effect Editor.

Selecting Material to Use When Correcting Flaws

When you isolate a flaw as a new segment in order to correct it, you 
must also include enough clean material to make the correction. The 
Intraframe tools you use for removing flaws cannot reference frames 
outside the segment that you isolate. 

In some cases, you can take all the clean material you need from the 
same frames that contain the flaw. In other situations, you need to 
include one or more completely clean frames along with the flawed 
frames in the segment you isolate.

For example, if a flaw persists across several frames in footage that 
includes no motion, the simplest way to correct the flaw is to include 
one clean frame before or after the flawed frames and use replacement 
material from the clean frame to cover the flaw in all the other frames. 
For more information on using replacement material from different 
points in your footage, see “Examples Of Scratch Removal Parameter 
Settings” on page 435.
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Isolating a Flaw

If you need to correct a flaw on a single frame, you can use the Scratch 
Removal button to quickly create a two-frame segment and apply the 
Scratch Removal effect. 

If a flaw persists over several frames, do one of the following:

t Use the Scratch Removal button to create a two-frame segment, 
and then trim the segment to extend it by using standard Trim 
mode methods.

t Insert add edits and apply a Scratch Removal effect manually.

n You cannot access frames outside the segment you have marked when you are 
working with the Scratch Removal tools. When you isolate a flaw, you must 
include in the segment both the flawed frames and sufficient clean material to 
correct the flaws successfully. For more information on the relationship 
between flaws and clean material, see “Understanding Scratch Removal 
Options” on page 423 and “Examples Of Scratch Removal Parameter 
Settings” on page 435.

Isolating a Flaw by Using the Scratch Removal Button

If the flaw you need to fix is on one frame, you can isolate the flaw on 
a new segment and apply the Scratch Removal effect simply by 
clicking the Scratch Removal button. The button creates a two-frame 
segment that isolates the flawed frame and the clean frame 
immediately before it, which you will use to make the correction.

n For information on finding flaws in 24p or 25p material, see “Detecting 
Video Dropout in 24p or 25p Material” on page 428.
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To isolate a flaw by using the Scratch Removal button:

1. Find the frame containing the flaw:

t Use the Step Forward or the Step Backward button to carefully 
cue the frame containing the flaw.

t (Option) Press and hold the Alt key while clicking the Step 
Forward or the Step Backward button to step through one field 
at a time.

2. Move the position indicator to the frame containing the flaw.

3. Make sure that the Record Track button for the track containing 
the flaw is the highest selected track button in the Track Selector 
panel.

4. Click the Scratch Removal button.

The system creates a two-frame segment ending at the frame 
marked by the position indicator and applies the Scratch Removal 
effect to that segment. If an effect is already present at that point in 
the sequence, the system auto-nests the Scratch Removal effect on 
top of the existing effect.

n The Scratch Removal button appears by default in the Tool palette. You can 
also map the Scratch Removal button from the Command palette to the 
keyboard or to the Composer window.

Add edits isolate the flawed material 
and create a new segment.

Scratch Removal effect 
applied to new segment
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Isolating a Flaw by Using Add Edits

If you need to remove a flaw that persists across more than two frames 
or that requires more than two frames for successful correction, you 
can isolate the flaw manually by using add edits.

n For information on finding flaws in 24p or 25p material, see “Detecting 
Video Dropout in 24p or 25p Material” on page 428.

To isolate a flaw by using add edits:

1. Find the series of frames or fields containing the flaw:

t Use the Step Forward or the Step Backward button to carefully 
cue the frames containing the flaws.

t (Option) If you are working with two-field media, press and 
hold the Alt key while clicking the Step Forward or the Step 
Backward button to step through one field at a time if 
necessary.

2. Isolate the flawed frames, together with sufficient clean material 
to make your correction, by placing add edits before and after the 
frames to create a new segment.

3. Apply one of the following effects to the segment:

t Paint Effect

t Scratch Removal effect

n You can use either the Paint Effect or the Scratch Removal effect. The 
difference is that the Scratch Removal effect provides only those effect 
parameters specific to fixing flaws, while the Paint Effect provides Scratch 
Removal as one of many available Paint modes.

Detecting Video Dropout in 24p or 25p Material

Because of the way your system handles the display of 24p or 25p 
material, you might not be able to see video dropout when you use the 
default Fast Frame Display mode.
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To ensure that you can see dropout when you are working with 24p or 
25p material, turn off Fast Frame Display mode by choosing Fast 
Frame Display from the Special menu. (When Fast Frame Display is 
deselected, there is no check mark beside it in the menu.) You can then 
see every line of the full 24p or 25p frame.

For more information on how your system displays 24p or 25p 
material, see the chapter “Film-to-Tape Transfer Methods” in the Avid 
Media Composer and Film Composer Input and Output Guide.

c When you turn off Fast Frame Display, you slow down the system’s 
display capabilities. If you turn off Fast Frame Display to check for 
flaws, you should turn it on again before you proceed with other 
editing operations.

Removing a Flaw by Using Intraframe Tools

Once you have isolated the flaw and have applied an Intraframe effect 
to it, you can remove the flaw by replacing it with a clean area of 
video. The best way to do this in most circumstances is to draw a 
shape that covers the flaw and fill the shape with replacement 
material. An alternative method is to draw a shape over your chosen 
replacement material and then drag the replacement over the flaw. 
This works well when you are taking replacement material from the 
same frame that contains the flaw.

Drawing a Shape over a Flaw

To remove a flaw by drawing a shape over it and filling the shape 
with replacement material:

1. Isolate the flaw and apply the Paint Effect or Scratch Removal 
effect by using the procedures described in “Isolating a Flaw” on 
page 426.

2. Enter Effect mode and select the segment if it is not already 
selected.
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3. (Option) If you are working with the Paint Effect, choose Scratch 
Removal from the Fast menu in the Mode category.

4. Click the triangular opener next to the Mode parameter category 
(Paint Effect) or the Scratch parameter category (Scratch Removal 
effect).

5. Select a shape tool or a brush from the Effect Editor.

6. Click the image and drag to create an object that covers the flaw.

n In most circumstances, you should make the object as small as possible while 
still covering the flaw completely.

7. Make sure that the Object Visible button is selected (pink) in the 
Mode parameter category (Paint Effect) or the Scratch parameter 
category (Scratch Removal effect) of the Effect Editor.

8. Use the Horizontal, Vertical, and Frame or Field sliders in the 
Effect Editor to select an area of replacement material to fill the 
object in the image and replace the flaw.

The replacement material appears in the object, replacing the flaw. 
For more information on using the Horizontal, Vertical, and Frame 
or Field parameter sliders, see “Using the Scratch Removal 
Positioning Parameters” on page 434.

9. (Option) Use the Feathering parameters to help blend the 
replacement material into the surrounding area.

Final effect:
Clean material from a nearby frame 
appears within the shape.

Original flaw:
Flaw seen with a shape drawn around it.
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10. Render the effect to play it back in real time.

If necessary, you can animate the shape that contains the replacement 
material by using keyframes to follow movement and changes in the 
frames of footage. For example, you can resize, reshape, and reposition 
the shape over time, or you can use the Object Visible button to control 
when the shape is visible. For more information, see “Animating the 
AniMatte Effect” on page 451 and “AniMatte and Paint Effects” on 
page 459.

n A standard Intraframe geometric shape such as an oval or a rectangle renders 
considerably faster than a series of brush strokes. In most cases of a single 
small flaw, a brush might be the easiest correction tool. If you need to correct 
several flaws that are close together, however, you will save rendering time if 
you can cover them with a single shape rather than use several different 
brush strokes.

Dragging Replacement Material over a Flaw

To remove a flaw by selecting replacement material and then dragging 
it over the flaw:

1. Isolate the flaw and apply the Paint Effect or Scratch Removal 
effect by using the procedures described in “Isolating a Flaw” on 
page 426.

2. Enter Effect mode and select the segment if it is not already 
selected.

3. (Option) If you are working with the Paint Effect, choose Scratch 
Removal from the Fast menu in the Mode category.

4. Click the triangular opener next to the Mode parameter category 
(Paint Effect) or the Scratch parameter category (Scratch Removal 
effect).

5. Select a shape tool or a brush from the Effect Editor.

6. Click a clean area of the image, and drag to create a selection that 
is appropriately sized for covering the flaw.
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n In most circumstances, you should make the object as small as possible while 
still covering the flaw completely.

7. Drag the replacement selection over the flaw.

8. (Option) Use the Feathering parameters to help blend the 
replacement material into the surrounding area.

9. Render the effect to play it back in real time.

If necessary, you can animate the selection by using keyframes to 
follow movement and changes in the frames of footage. For example, 
you can resize, reshape, and reposition the shape over time, or use the 
Object Visible button to control when the shape is visible. For more 
information, see “Animating the AniMatte Effect” on page 451 and 
“AniMatte and Paint Effects” on page 459.

Scratch Removal Using IN and OUT Points

You can use IN and OUT points to define multiple frames or fields of 
video that contain a scratch and then use the Scratch Removal button 
to quickly create a Scratch Removal effect that covers the scratched 
frames or fields together with the clean frame or field immediately 
before them. When you draw a shape to cover the scratch, the system 
will fill that shape with clean material in every frame or field of the 
effect.

Original flaw and selection Selection dragged over flaw Final effect
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This method is useful in any situation where a scratch is repeated 
across several frames or fields. In particular, it allows for quick 
correction of a scratched frame in film-originated material that has 
been duplicated by the pulldown process in telecine transfer to video.

To remove a scratch covering more than one frame or field:

1. Mark an IN point at the first scratched frame or field.

2. Mark an OUT point at the last scratched frame or field.

3. Move the position indicator to one of the following locations:

t Between the marked IN and OUT points

t On the frame or field immediately before the marked IN point

4. Click the Scratch Removal button.

The system applies a Scratch Removal effect that covers the 
scratched frames or fields and the clean frame or field 
immediately before them.

n The position indicator must be between the marked IN and OUT points or on 
the frame or field immediately before the marked IN point. If the position 
indicator is at any other location, the system creates the Scratch Removal 
effect at that location and ignores the marked IN and OUT points.

5. Select a shape tool or a brush from the Effect Editor.

6. Click the image and drag to create a shape that covers the scratch.

The system replaces the material in the shape with material from 
the clean frame or field. The same clean material covers the scratch 
on every scratched frame or field within the effect.

n The Scratch Removal positioning parameters are set by default to reference 
the part of the clean frame that corresponds to the shape you draw. In most 
cases, you do not need to make any adjustments to these parameters to cover 
the scratch successfully.

7. (Option) Use the Feathering parameters to help blend the 
replacement material into the surrounding area.
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8. Render the effect to play it back in real time.

In some unusual circumstances, you might need to animate the shape 
that contains the replacement material by using keyframes together 
with positioning adjustments to follow movement and changes. For 
example, if the image is changing rapidly from frame to frame and the 
scratch covers several frames, the clean material might not match the 
later scratched frames without repositioning. 

Using the Scratch Removal Positioning Parameters

The Hor (horizontal), Vert (vertical), and Frame or Field sliders in the 
Scratch Removal mode of the Paint Effect or in the Scratch category of 
the Scratch Removal effect allow you to control exactly which material 
you use from elsewhere in the same frame or in nearby frames to 
replace flawed material.

The Hor (horizontal) and Vert (vertical) sliders define the position of 
the replacement material relative to the shape you have drawn on the 
horizontal and vertical axes of the frame. 

The Frame or Field slider defines which nearby frame or field is being 
used as the source of the replacement material. Values represent an 
offset from the reference point defined in the Offset Fast menu. The 
default settings for Frame or Field offset are:

Frame/Field: 0

Offset: From Start

Offset Fast menu
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These settings correctly reference the clean frame or field whenever 
you apply the Scratch Removal effect using the Scratch Removal 
button. The settings reference the clean frame when you use the 
Scratch Removal button without marking IN and OUT points to 
remove a scratch on a single frame or field. They also reference the 
clean frame when you use the Scratch Removal button with IN and 
OUT points to remove a scratch or other flaw that repeats across more 
than one frame or field.

For more information on these parameters, see “Scratch” on page 509.

n You cannot access frames more than 5 frames (or fields more than 10 fields) 
from the zero point as defined by the Offset Fast menu, regardless of the 
length of the segment. 

n You cannot access frames or fields outside the segment that contains the effect. 
If you are positioned six fields from the end of the segment, and you set the 
Field slider to 10 and the Offset to Relative, you reference the last field of the 
segment (six fields ahead of your position).

Examples Of Scratch Removal Parameter Settings

The following examples illustrate several different settings for the 
Scratch Removal positioning parameters.
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Example 1: Replacement Material in the Same Frame

Parameter Settings
Vertical: –250
Horizontal: +250
Frame/Field: 0
Offset: Relative

In this example, the effect replaces the area of the rectangle covering 
the scratch with material from the area of the dotted rectangle in the 
same frame or field. Each frame or field in the segment will use 
replacement material from the same relative position in its own frame 
or field.

Rectangle covering scratch

Source of replacement 
material (in same frame)

250 pixels

250 pixels
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Example 2: Replacement Material from a Two-Frame Relative Offset

Parameter Settings
Vertical: 0
Horizontal: 0
Frame: +2 (Field: +4)
Offset: Relative

In this example, the area of the rectangle covering the scratch is 
replaced by the same coordinate area of the frame two frames (four 
fields) ahead. Each frame or field in the segment will use replacement 
material from two frames (four fields) ahead.

Rectangle covering 
scratch in frame n

Source of replacement material in 
frame n+2 — two frames (four 
fields) ahead
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Example 3: Replacement Material from a Single Clean Frame

Parameter Settings
Vertical: 0
Horizontal: 0
Frame/Field: 0
Offset: From Start

In this example, the area of the rectangle covering the scratch is 
replaced by the area of the dotted rectangle in the first frame of the 
segment. If the same parameter settings are used throughout the 
segment, then every frame in the segment will reference the first frame 
of the segment.

You can choose From Start or From End from the Offset Fast menu in 
this way to cover a flaw in several frames with clean material from a 
single frame. In this example, the flaw first appears in frame 2, and it is 
replaced in every frame in which it appears by clean material from 
frame 1.

Frame 1 of segment Frame 2 Frame 3 Frame 4

In every frame, the rectangle covering the scratch is replaced by the 
material from the dotted rectangle area in Frame 1.



439

Common Intraframe Editing Techniques

The following sequence contains examples of basic Intraframe editing 
techniques — from simple Paint Effects to animated matte keys. 

n You can double-click the following image to view the entire sequence in the 
PDF version of this guide, available on the Avid Media Composer and Film 
Composer Online Publications CD-ROM.

The Timeline for this sequence is shown in the following illustration. 
The callouts present several Intraframe editing examples and the 
sections that describe them.
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Colorizing with Magic Mask

Magic Mask is used for applying effects across a series of frames by 
using the chroma and luma values as the criteria for edge detection. 
While you can use Magic Mask in conjunction with any of the paint 
modes to generate custom effects, the primary benefit of this feature is 
localized colorization, which enables you to create garbage mattes and 
various chroma effects. For example, this can be used to change the 
color of a white shirt to another color without having to create a 
detailed matte.

In this example, the goal is to colorize the window area through which 
we see the athletes walking to the pool. The odd shapes in the window 
area would normally make this task extremely time consuming; but 
because the region is high contrast with a consistent off-white color, 
Magic Mask makes the job simple.

Custom-built wipe using the AniMatte effect:
See “Creating a Single-Layer Organic Matte Wipe” on 
page 452 .

Two-layer animated matte effects:
See “Creating Animated Matte Key Effects” 
on page 448 .

Magic Mask used to colorize a chosen 
region of the image: See “Colorizing with 
Magic Mask” on page 440 .

Intraframe Editing Examples

Blur effect applied to a traced area of the 
clip: See “Applying the Paint Effect to 
Regions of a Clip” on page 445 .
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To colorize the image:

1. Open the Effect Palette, and apply the Paint Effect from the Image 
category to the segment of footage in the sequence.

2. Enter Effect mode and select the segment if it is not already 
selected.

The Paint Effect parameters appear in the Effect Editor.

3. Choose Solid from the Fast menu in the Mode category for this 
example. In other applications of Magic Mask you might choose 
another mode such as Lighten, Darken, or Colorize.

4. Click the Rectangle tool (or another shape tool) in the Effect Editor, 
click in the Effect Preview monitor, and drag to draw a box 
surrounding the window region.
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5. Open the Color category, and, by using standard methods, choose 
a color to apply to the window region . For more information on 
choosing a color, see “Adjusting a Color Parameter” on page 125.

6. (Option) Click the Outline/Path button so you have an 
unobscured view of the object you want to colorize. Adjust the 
size and shape of the box as necessary.

7. Click the Enable button in the Magic Mask category. 

The Avid system activates the Magic Mask.

Select a color from the image with the 
eyedropper, click the Other Options 
button to use the Windows Color dia-
log box or the Macintosh Color Picker, 
or adjust the sliders to choose a color.

Enable button
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The default key color for Magic Mask might not match the color in 
your selection, so the color is not yet applied to the white area of 
the window.

8. Click in the Color Preview window of the Magic Mask category, 
drag the cursor to the off-whitearea of the window in the image, 
and release the mouse button.

The Avid system sets the Magic Mask key color to the color you 
selected, and applies the effect. 

9. Click the Outline/Path button to switch between viewing the 
image with or without the effect.

Effect applied before 
choosing Magic Mask 
key color: the color 
effect does not 
appear.
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10. Adjust the Magic Mask parameters, such as Gain and Soft 
(softness), to fine-tune the effect.

The Avid system applies the colorization effect to areas where the 
rectangle shape extends beyond the window area in the image. You 
can quickly convert the rectangle to a polygon and adjust its shape 
around the window.

To reshape the rectangle:

1. Click the rectangle to select it.

2. Double-click the rectangle to display its control points.

3. Drag the control points at the corners of the rectangle one at a time 
to surround the window area.

Effect applied with 
key color chosen from 
the image
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Applying the Paint Effect to Regions of a Clip

The Paint Effect includes a number of modes for applying special 
effects to traced regions of an image. This example describes the 
gradual application of the Blur mode to a region of the clip using 
keyframes. The effect gives the impression that the background is 
losing focus while the rest of the image is unaffected.

New shape restricts 
the Magic Mask effect 
to the window area.

Blur effect – before Blur effect – after
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To apply the blur:

1. Open the Effect Palette, and apply the Paint Effect from the Image 
category to the segment of footage in the sequence.

2. Enter Effect mode and select the segment if it is not already 
selected.

The Paint Effect parameters appear in the Effect Editor.

n The next task is to trace the background region around the woman in the 
foreground in order to apply the effect. Because the woman moves during the 
clip, you must animate the traced shape using keyframes.

3. Press the Home key to go to the beginning of the clip. Make sure 
both the first and last keyframes are selected.

4. Click the Reduce button in the Effect Editor to view the image in 
the Effect Preview monitor at 75 percent. (This makes it easier to 
include the outer edges of the footage in the traced area.)

5. Click the Curve tool.

6. Click on the image and drag to draw a matte with freehand 
capability. Trace an outline around the woman and surrounding 
the background.

7. When you are satisfied with the shape of the matte, release the 
mouse button.

Complex polygon 
shape traced 
around woman and 
background
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8. Click the last keyframe in the Effect Preview monitor to select it. 
Check the shape of the traced area around the woman, and adjust 
control points as necessary to make an accurate outline.

9. Before creating new keyframes to further animate the traced 
outline, apply the blur to the first and last keyframes to ensure a 
smooth effect across all keyframes:

a. Click the first keyframe in the Effect Preview monitor to select 
it.

b. Choose Blur from the Fast menu in the Mode category.

c. Drag the Hor (horizontal) and Vert (vertical) sliders all the 
way to 0.

d. Click the last keyframe in to select it.

e. Drag the Hor (horizontal) and Vert (vertical) sliders to 50.

The Blur mode effect is applied.
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10. Click elsewhere in the Effect Preview monitor’s position bar to 
check the traced outline. Make adjustments as necessary.

n As you adjust control points, the system automatically creates new 
keyframes.

11. (Option) To soften the edges of the blurred outline around the 
woman, adjust the Feathering parameters. For more information, 
see “Feathering” on page 470.

12. Render the effect to play it back in real time.

Creating Animated Matte Key Effects

When you apply the AniMatte effect and create a matte key, the shape 
and location of the matte remain fixed over the course of the segment. 
The parameters of the matte are the same at both the first and last 
keyframes in the segment.

When you have moving video, you must change the shape and 
location of the matte in order to follow the changes of the video over 
the course of the segment.
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Applying the Matte Key Effect

To apply a two-layer matte key:

1. For this two-layer effect, edit the image you want to use as the 
background onto one track and the image you want to use as the 
foreground onto the track above.

2. Open the Effect Palette.

3. Click the Key category.

4. Drag the AniMatte Effect icon from the Effect palette to the upper 
track in the Timeline.

Background image on lower layer

Foreground image on upper layer

Composite image

In this example, the matte shape is animated to 
follow the movement of the men in the foreground 
footage.

In this example, the 
background is on 
track V1 and the 
foreground is on 
track V2.
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5. Press the Home key to go to the beginning of the clip. Make sure 
both the first and last keyframes are selected.

6. Click the Reduce button in the Effect Editor to view the image in 
the Effect Preview monitor at 75 percent. (This makes it easier to 
include the outer edges of the footage in the traced area.)

7. Click the Curve tool.

8. Choose Key In from the Fast menu in the Mode category.

9. Click on the image and drag to draw a matte with freehand 
capability.

10. When you are satisfied with the shape of the matte, release the 
mouse button.

The area outside the border of the matte reveals the underlying 
image on the lower track (V1 in the example), and the area inside 
the border of the matte displays the image on the upper track (V2).

11. To check the traced outline, click the Swap Src (swap sources) 
button in the Foreground category.

In this example, a series of shapes are drawn to 
key out all areas of the foreground image.
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The foreground and background footage are reversed in the key. 
This allows you to easily spot areas where the outline encroaches 
on the foreground image.

12. Click the Swap Src button to restore your effect to a matte that 
keys in your selection.

Animating the AniMatte Effect

To animate a Matte Key effect:

1. Click the Step Forward button or the Step Backward button as 
many times as necessary to park on a frame in which the matte no 
longer provides a clean key due to the motion of the foreground or 
background image.

2. Adjust the matte outline as follows:

t Click the Reshape tool and drag control points to change the 
shape. You can also Shift+click multiple control points for 
repositioning as a group. For information, see “Removing a 
Control Point” on page 405.

In this example, swapping 
sources on one of the 
shapes reveals edges 
from the foreground 
image.
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t Edit the object by manipulating the direction bars at one or 
more control points. For information, see “Modifying Lines 
and Curves Summarized” on page 401.

t Click the Swap Src button if necessary to swap the view of the 
foreground and background images to examine edges.

t Reposition the matte if necessary by selecting the shape and 
dragging it with the Selection tool.

n As you adjust control points, the system automatically creates new 
keyframes.

3. Repeat the procedure as needed to create a matte that keys the 
images cleanly over the course of the segment.

4. (Option) To soften the edges of matte key, adjust the Feathering 
parameters. For more information, see “Feathering” on page 470.

5. Render the effect to play it back in real time.

Creating a Single-Layer Organic Matte Wipe

You can use the AniMatte effect to create a custom matte wipe. 
Additionally, you can create soft edges and other useful variations by 
adjusting the parameters of the AniMatte wipe. Multiple video tracks 
are not necessary. You apply the AniMatte effect to a transition on a 
single track of video and then draw the matte wipe as described in this 
section.
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To create an organic matte wipe:

1. Create a sequence that contains a transition (an incoming and an 
outgoing segment). 

2. Apply the AniMatte effect to a transition as described in 
“Applying the Paint or AniMatte Effect to a Sequence” on 
page 368.

3. Click the Effect Mode button to enter Effect mode.

4. Choose Key In from the Fast menu in the Mode category.

5. Click the Reduce button three times to reduce the image to 
25 percent of its normal viewing size.

6. Click the first keyframe in the Effect Preview monitor’s position 
bar.

The first keyframe is highlighted, and the last keyframe is 
deselected.

7. Click the Curve tool.

8. Press and hold the mouse button, and drag to draw a custom 
shape to the right of the image displayed in the Effect Preview 
monitor.

n Draw a matte that is at least as wide as the frame in the Effect Preview 
monitor.

Outgoing segment Incoming segment
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9. When you are satisfied with the shape of the object, release the 
mouse button to complete the matte wipe.

10. Click the last keyframe in the Effect Preview monitor’s position 
bar.

The Avid system highlights the last keyframe, and deselects the 
first keyframe.

11. Click the matte wipe within its borders and drag it so that it covers 
the frame in the Record monitor. Make sure to position the leading 
edge of the wipe so that it is beyond the left border of the frame.

12. Click the Enlarge button three times to restore the video image to 
100 percent.

13. Click in the middle of the Effect Preview monitor’s position bar to 
view the edge of the wipe.
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14. (Option) To soften the edges of the wipe, adjust the Feathering 
parameters. For more information, see “Feathering” on page 470.

15. Render the effect to play it back in real time.
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CHAPTER 9

2D Effects Reference

This chapter describes all 2D effects parameters and then summarizes 
all 2D effects in alphabetical order within each effect category. For 
information on effects editing, see Chapter 2, “Basics of Effects 
Editing.”

• 2D Effects Parameters

• 2D Effects

• Comparison of Similar Effects

2D Effects Parameters

This section provides a general description of all 2D parameters, in 
alphabetical order. Some parameters have corresponding 3D versions. 
The 3D versions are described in Chapter 10, “3D Effects Reference.”

Effect parameters are grouped in the following categories:

• Acceleration (see 3D version on page 640)

• Actions

• AniMatte and Paint Effects

• Aspect Ratios
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• Background (see 3D version on page 642)

• Blowup

• Border (see 3D version on page 643)

• Color Effect Parameters

• Crop (see 3D version on page 645)

• Downstream Key

• Foreground (see 3D version on page 649)

• Key Control Parameters (see 3D version on page 650)

• Matrix Parameters

• Motion Effect Parameters

• Position (see 3D version on page 658)

• Profile

• Scaling (see 3D version on page 661)

• Scratch

• Transition Parameters

For an explanation of how to change a parameter, see “Changing a 
Parameter” on page 123.

Global and Keyframeable Parameters

The effects parameters are divided into two logical groups:

• Global parameters: Changes apply to all keyframes. When you 
change a global parameter, the Avid system automatically sets the 
value for all keyframes in the effect.

• Keyframeable parameters: Changes can be applied to individual 
keyframes. You can use keyframe parameters to alter an effect 
over time.
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This distinction is noted throughout this section for each parameter.

Acceleration

Parameter type: Global

Acceleration adjusts the effect’s speed over time by having the effect 
ease in and ease out of every keyframe. This gives the effect a more 
natural appearance.

c Acceleration is not recommended for rolls or other DSK titles with 
vertical motion, due to anti-aliasing effects, which cause flicker.

The overall speed of an effect is determined by the duration of the 
effect, which is determined by the length of the clip in the sequence. 
If you want to slow down or speed up the movement of an effect, you 
will need to change the length of your effect or use add edits to limit 
the portion of the clip affected by the effect.

n If your system has the 3D Effects option, see the 3D version on page 640.

Actions

Parameter type: Global
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The Actions parameter allows you to control certain aspects of the Pan 
and Scan effect.

AniMatte and Paint Effects

Table 9-1 Actions Parameters

Parameter Description

Establish Origin Saves the current Scaling and Position values as a customized default setting. 
For more information, see “Setting an Origin in the Pan and Scan Effect” on 
page 199.

Subdivide Effect Divides a Pan and Scan effect into a series of segments based on the segment 
boundaries on the video tracks below the Pan and Scan track. For more 
information, see “Subdividing the Pan and Scan Effect” on page 200.

Reset to Origin Resets the Scaling and Position values to the current customized Origin 
values. If you have not established an origin, Reset to Origin resets the values 
to the default values for the current Target aspect ratio. For more information, 
see “Setting an Origin in the Pan and Scan Effect” on page 199.
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Most of the effect parameters used for Intraframe editing are available 
for both the AniMatte effect and the Paint Effect. The following 
sections describe the parameters that they have in common, while 
indicating those that function differently, depending upon whether 
you are using the AniMatte or Paint Effect.

n The Foreground and Acceleration parameters function similarly for 
Intraframe editing effects as they do for other effects. For more information, 
see “Foreground” on page 489 and “Acceleration” on page 458.

Mode

Parameter type: Global

Central to the Intraframe editing process, Mode parameters and 
options affect the overall nature of the Intraframe editing you perform 
using either the Paint Effect or the AniMatte effect. 

Table 9-2 Mode Parameters

Parameter Description

Fast menu The Fast menu provides different mode options for Intraframe editing with 
either the AniMatte effect or the Paint Effect:

- For AniMatte effect modes, see “AniMatte Modes” on page 462.

- For Paint Effect modes, see “Paint Effect Modes” on page 463.
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Opac. (opacity) Opacity, which appears in the Mode category for the Paint Effect only, refers 
to the transparency level of:

- A painted object created with the Paint Effect

- The image within the border of a matte or wipe created with the AniMatte 
effect

For the Paint Effect, a level of 0 makes a painted object completely 
transparent; a level of 50 makes an object 50 percent transparent; and a level 
of 100 makes an object opaque.

For the AniMatte effect, a level of 0 makes a keyed image completely 
transparent; a level of 50 makes a keyed image 50 percent transparent; and a 
level of 100 makes a keyed image opaque.

Object Visible The Object Visible button in the Mode parameter category enables you to add 
a keyframe to a segment or transition and have a painted object or matte 
suddenly “pop” onto the screen at the position marked by the keyframe. You 
must have at least three keyframes to create this effect. 

Hor (horizontal) The Hor slider is available for several of the Paint Effect modes. When used 
with the Clone and Scratch Removal modes, the Hor slider controls the 
horizontal position of the painted object in the frame relative to its original 
position. When used with the Mosaic, Blur, and Unsharp Mask modes, the 
Hor slider controls the extent of the tiling, blurring, or sharpening effect in the 
horizontal direction.

Vert (vertical) The Vert slider is available for several of the Paint Effect modes. When used 
with the Clone and Scratch Removal modes, the Vert slider controls the 
vertical position of the painted object in the frame relative to its original 
position. When used with the Mosaic, Blur, and Unsharp Mask modes, the 
Vert slider controls the extent of the tiling, blurring, or sharpening effect in the 
vertical direction.

Amt (amount) The Amt slider is available for the Darken and Lighten modes. Use the Amt 
slider to control the extent of the darkening or lightening effect.

Angle The Angle slider is available for the Gradient and Emboss modes. Use the 
Angle slider to control the direction of the gradient or the extrusion effect.

Table 9-2 Mode Parameters (Continued)

Parameter Description
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AniMatte Modes

Parameter type: Global

There are two basic modes for Intraframe editing with the AniMatte 
effect.

Frame/Field Controls which frame or field is used as the source for clean replacement 
material when you are working in Scratch Removal mode. For more 
information, see “Scratch” on page 509.

Offset Fast menu Defines the position from which the Frame or Field parameter is measured 
when you are working in Scratch Removal mode. For more information, see 
“Scratch” on page 509.

Table 9-2 Mode Parameters (Continued)

Parameter Description

Table 9-3 AniMatte Modes

Mode Description

Key In Displays the image on the higher track (foreground) within the matte 
selection while revealing the image on the lower track (background) outside 
the matte selection for two-track video effects; displays the incoming segment 
within the matte selection for single-track matte wipes.

Key Out Displays the image on the lower track (background) within the matte 
selection while revealing the image on the higher track (foreground) outside 
the matte selection for two-track video effects; displays the outgoing segment 
within the matte selection for single-track matte wipes.
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Paint Effect Modes

Parameter type: Global

The Paint Effect provides twenty-two modes that you can use to paint 
with a variety of styles. When you click a painting tool for the first 
time, the default setting is Solid mode, which enables you to paint an 
opaque object on the video background with a brush stroke.

Table 9-4 describes the Paint Effect modes and includes illustrations to 
help you understand how the modes alter the image.

n The illustrations show the same image in every case. This enables you to 
compare the different modes easily but does not necessarily illustrate the most 
common use of each mode.

Table 9-4 Paint Effect Modes

Mode Description Illustration

Solid Applies paint as a solid color superimposed 
on the video background.

The illustration shows Solid mode with 
Opacity set to 75%.
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Erase Removes paint from a frame. Can also be 
used to invert the key in an AniMatte effect.

The illustration shows a rectangular object in 
Erase mode that removes paint from the oval 
object beneath it.

Outline Creates an outline that is useful for tracing 
images in a frame.

Clone Duplicates an area from a frame and applies 
it to another area of the frame.

The illustration shows an oval object in Clone 
mode. The oval has been moved from higher 
in the image, taking an area of the upper part 
of the image with it.

Colorize Tints the selected area with the color 
currently selected in the Color parameter 
category.

Table 9-4 Paint Effect Modes (Continued)

Mode Description Illustration
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Hue Changes the hue in a selected area to the hue 
currently set with the Hue slider in the Color 
parameter category without affecting the 
saturation and luminance levels.

Saturation Changes the saturation in a selected area to 
the saturation level currently set with the Sat 
slider in the Color parameter category 
without affecting the luminance levels and 
the hue.

Luminance Changes the luminance in a selected area to 
the luminance level currently set with the 
Lum slider in the Color parameter category 
without affecting the saturation levels and 
hue.

Table 9-4 Paint Effect Modes (Continued)

Mode Description Illustration
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Darken Only Reduces the luminance levels in a selected 
area only if the result would be darker than 
the background color.

In the illustration, the light areas have been 
darkened in the selected oval while darker 
areas of the trees remain unaltered.

Lighten Only Increases the luminance levels in a selected 
area only if the result would be lighter than 
the background color.

The illustration shows the reverse of the 
effect seen for Darken Only. Dark areas in the 
selected oval have been lightened while light 
areas, mainly the dirt roads, remain 
unaltered.

Darken Reduces the luminance levels in a selected 
area by the amount specified by using the 
Amount slider.

In the illustration, luminance in the selected 
oval is reduced by 50.

Table 9-4 Paint Effect Modes (Continued)

Mode Description Illustration
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Lighten Increases the luminance levels in a selected 
area by the amount specified by using the 
Amount slider.

In the illustration, luminance in the selected 
oval is increased by 50.

Add Adds more of the color value currently 
selected in the Color parameter category to 
the colors in a selected area.

Subtract Removes the color value currently selected in 
the Color parameter category from the color 
in a selected area.

Table 9-4 Paint Effect Modes (Continued)

Mode Description Illustration
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Invert Inverts the RGB values of the colors in a 
selected area.

Mosaic Applies a tile effect to a selected area with 
horizontal and vertical controls. This is useful 
for distorting or disguising part of an image.

Blur Blurs a selected area with horizontal and 
vertical controls. This is useful for distorting 
or disguising part of an image.

Table 9-4 Paint Effect Modes (Continued)

Mode Description Illustration
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Median Takes the nine values surrounding each pixel, 
ranks them, and replaces the pixel with the 
value in the middle. This results in a slight 
softening effect. Median filters are often used 
to remove noise from an image.

Unsharp Mask Sharpens a selected area of an image to create 
more defined edges with horizontal and 
vertical controls.

Gradient Dissipates the paint in a gradient with 
controls to establish the direction of 
dissipation using the Angle slider. 100% of 
the currently selected color appears at one 
end of the gradient, 0% at the other end.

Table 9-4 Paint Effect Modes (Continued)

Mode Description Illustration
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Feathering

Parameter type: Keyframeable

Feathering adds soft edges to a painted object or a matte key. Adding a 
soft edge can make a composited object look more natural against the 
background.

Emboss Creates a three-dimensional extrusion effect 
in a selected area. You can adjust the 
direction of the extrusion with the Angle 
slider.

Scratch 
Removal

Replaces scratched or otherwise flawed areas 
of a frame with clean material from a nearby 
source.

For more information, see “Scratch 
Removal” on page 423.

Table 9-4 Paint Effect Modes (Continued)

Mode Description Illustration
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Table 9-5 Feathering Parameters

Parameter Description

Bias Increases control over the dissipation of pixels around the edges of a painted 
object or matte. Adjusting bias is especially effective when you trace an 
element on the screen with the Paint Effect.

A Bias setting of 0 feathers pixels starting at the outside edge; a setting of 50 
starts feathering at the center portion of the edge; and a setting of 100 starts 
feathering at the inner portion of the edge. The default setting for Bias is 50.

Hor (horizontal) and 
Vert (vertical)

Enables you to choose the dominant direction in which feathering of an object 
or matte appears. 

Increasing the horizontal parameter extends feathering in both the positive 
and negative directions along the X axis (right to left and left to right on the 
screen). The range is 0 to 255 pixels.

Increasing the vertical parameter extends feathering in both the positive and 
negative directions along the Y axis (upward and downward on the screen). 
The range is 0 to 255 pixels.

Fixed Aspect Gangs the Hor and Vert sliders together. When you drag one of the sliders, 
the other slider moves in unison with the first slider.

n When you enable the Fixed Aspect option, horizontal is the dominant value.

Anti-alias Decreases the jagged appearance of a selected Paint or AniMatte object’s 
edges. You can use anti-aliasing in combination with feathering to improve 
the appearance of an object around its edges.
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Magic Mask

Parameter type: Keyframeable

Magic Mask is used for applying effects across a series of frames by 
using the chroma and luma values as the criteria for edge detection. 
After you use Magic Mask to pick a color with the eyedropper for 
either an AniMatte or Paint Effect, you can adjust the Hue, Sat, and 
Lum sliders to fine-tune the color selection.

n When using the Paint Effect, keep in mind that the Hue, Sat, and Lum sliders 
in the Magic Mask parameter category enable you to refine the color you 
select from the video background. Use the sliders in the Color parameter 
category in conjunction with one of the Paint Effect modes to colorize your 
selection.
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Table 9-6 Magic Mask Parameters

Parameter Description

Hue Affects the tint of the color selection. The tint refers to the name commonly 
associated with a color, such as red, green, or blue. The slider values range 
from 0 to 255.

Sat (saturation) Affects the purity or intensity of the color selection. The color gray has no 
saturation at all; a fully saturated color produces the most intense 
representation of that color. The slider values range from 0 to 255.

Lum (luminance) Affects the brightness of the color selection. The color black has 0 brightness. 
The slider values range from 0 to 255.

Gain When you are using the AniMatte effect, Gain increases or decreases the effect 
of Magic Mask on pixels that are contiguous to your color selection within the 
borders of a matte key. Gain applies color correction to pixels that fall within 
the specified color range, or tolerance, of the color you pick with the 
eyedropper. The tolerance you adjust with the Gain slider is relative to the 
RGB values of the color you picked. 

When you are using the Paint Effect, Gain increases or decreases the range of 
pixels surrounding the color you pick that Magic Mask will enable you to 
modify in conjunction with your chosen paint mode. Gain includes or 
excludes pixels surrounding the color you pick that falls within a specified 
color range, or tolerance. The tolerance you adjust with the Gain slider is 
relative to the RGB values of the color you picked. 

Decreasing the Gain value lessens the color range and includes fewer pixels 
contiguous to the matte key or color selection. Increasing the gain expands 
the range and includes more pixels surrounding the matte key or color 
selection. 

Soft (softness) Increases or decreases the amount of softness applied to a color selection and 
contiguous pixels that fall within a specified tolerance. The tolerance you 
adjust with the Soft slider is relative to the RGB values of the color picked in 
the selection. The range is from 0 to 63.
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Brush

Parameter type: Global

The Brush parameters enable you to define the shape, size, and 
softness of the brush for creating brush strokes on an image. 
Additionally, you can customize the shape and rotate the head of the 
Brush tool to create a variety of new effects.

n The parameters in the Brush category apply only to the Brush tool.

Table 9-7 Brush Parameters

Parameter Description

Path Controls the percentage of paint or the matte that is visible from the initial 
point of pressure to the completion of the brush stroke. Path values range 
from 0 (no paint visible) to 100 (entire stroke visible). 

n Unlike other Paint Effect parameters, you can adjust Path only after you finish 
painting.

Soft (softness) Adjusts the softness of the brush head. Softness ranges from a value of 0 (hard 
center) to 100 (softest overall head).

Size Adjusts the size of the brush head. Size is measured in terms of pixel width. 
The widths range from 0 to 100 pixels.
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Aspect Ratios

Parameter type: Global

The Aspect Ratios parameter sets the Source and Target aspect ratios 
for a Pan and Scan or Reformat effect. For more information, see 
“Selecting the Source and Target Aspect Ratios” on page 192.

Shape buttons Clicking one of the Shape buttons changes the brush head to the new shape.

Spin Enables you to rotate the brush head 360 degrees in the clockwise and 
counterclockwise directions. The range of clockwise rotation is from 0 to –360 
degrees, and the range of counterclockwise rotation is from 0 to 360 degrees. 
The default position for the brush head in the Brush Preview window is 0.

Table 9-7 Brush Parameters (Continued)

Parameter Description

Table 9-8 Aspect Ratio Parameters

Parameter Description

Source Specifies the aspect ratio of the source media. Supported source aspect ratios 
are: 1.33 (4:3), 1.66, 1.78 (16:9), 1.85, 2.35, 15:9 anamorphic, and 16:9 
anamorphic.

Target Specifies the aspect ratio to which Pan and Scan will conform the media. 
Supported target aspect ratios are: 1.33 (4:3) and 16:9 anamorphic.
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Background

Parameter type: Global

The Background parameter sets the color for the background in effects 
that display a background. For example, the background parameters 
determine the color to be used in a Fade to Color, Fade from Color, or 
Dip to Color effect.

n If your system has the 3D Effects option, see the 3D version on page 642.

Table 9-9 Background Parameters

Parameter Description

Other Options button Opens the Windows Color dialog box or the Macintosh Color Picker for 
precise color selection. For more information, see “Using the Windows Color 
Dialog Box” on page 125 or “Using the Macintosh Color Picker” on 
page 127.

Hue Identifies the background color. The Hue parameter is measured as values on 
a color wheel ranging from 0 to 255. The start (0) and ending (255) values are 
both red.

Sat (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, 
where 0 is no chrominance and 255 is a fully saturated color.

Lum (luminance) Specifies the brightness of the color. Values range from 0 to 255, where 0 is 
black and 255 is full brightness or white.
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Blowup

Parameter type: Keyframeable

The Blowup effect uses the following parameters to set the effect’s 
position and size.

n The background color for the Blowup effect remains black unless you promote 
the effect to 3D and use the Background parameters to choose another color. 
For more information, see “Background Color” on page 642 and 
“Promoting 2D Effects to 3D Effects” on page 225.

Table 9-10 Blowup Parameters

Parameter Description

Field Controls the size of the image. A field of 0 leaves the image size unchanged, 
and a field of 10 increases the image to the maximum size.

X Pos (X position) Allows you to position the image horizontally on the screen. The X Position 
varies on a scale of West 20 to East 20, where 0 is unchanged. This matches the 
description in the cut list.

Y Pos (Y position) Allows you to position the image vertically on the screen. The Y Position 
varies on a scale of North 20 to South 20, where 0 is unchanged. This matches 
the description in the cut list.
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Border

Parameter type: Keyframeable

Many effects allow you to place a border on the inner or incoming 
picture in the effect. The Border parameters allow you to specify the 
color, softness, and width of the border. Some effects also include 
Blend Color parameters for blending border color.

n If your system has the 3D Effects option, see the 3D version on page 643.

Border with the Blend 
Color parameters

Border without the Blend 
Color parameters

Other 
Options 
button

Table 9-11 Border Parameters

Parameter Description

Other Options button Opens the Windows Color dialog box or the Macintosh Color Picker for 
precise color selection. For more information, see “Using the Windows Color 
Dialog Box” on page 125 or “Using the Macintosh Color Picker” on 
page 127.

Hue Identifies the border or blend color. The Hue parameter is measured as values 
on a color wheel ranging from 0 to 255. The start (0) and ending (255) values 
are both red.
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Color Effect Parameters

The Color Effect parameters allow you to perform color correction or 
create certain colorization effects such as posterization or solarization.

Luma Adjust

Parameter type: Keyframeable

Sat (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, 
where 0 is no chrominance and 255 is a fully saturated color.

Lum (luminance) Specifies the brightness of the color. Values range from 0 to 255, where 0 is 
black and 255 is full brightness or white.

Width Specifies the width of the border. Values range from 0 (no border) to 63 
(widest border).

Soft (softness) Blends the border with the background image, giving the border a soft 
appearance. Values range from 0 (no softness) to 63 (maximum softness).

Table 9-11 Border Parameters (Continued)

Parameter Description

Table 9-12 Luma Adjust Parameters

Parameter Description

Bright (brightness) Changes the brightness of the picture. The parameter ranges from –100 to 
+100, where a value of 0 indicates no change. A value of –100 darkens the 
image; a value of +100 brightens the image.



480

Brightness Example

Contrast Example

Cont (contrast) Controls the contrast of light and dark areas in the picture. Values range from 
–100 to +100, where a value of 0 indicates the image is unchanged. A negative 
value is less contrast; a positive value is more contrast.

Invert Invert reverses the image’s brightness, such that the brightest parts become 
the darkest and the darkest parts become the lightest.

Table 9-12 Luma Adjust Parameters (Continued)

Parameter Description

Brightness +50Brightness –50Original – Brightness 0

Contrast +50Contrast –50Original – Contrast 0
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Luma Range

Parameter type: Keyframeable

Luma Range parameters allow you to adjust the range of brightness 
from black to white.

Table 9-13 Luma Range Parameters

Parameter Description

Fast menu: 16 to 235 The default for video images.

Fast menu: 0 to 255 Allows you to map normal video to alpha ranges. This is useful if you have a 
high-contrast image that you want to expand to the full dynamic range. For 
example, use this value when you want to convert video to alpha for Matte 
Key effects.

n When you change the Luma Range to 0 to 255, the system attempts to go from 
0 to 255 but will be clipped by the Low Clip and High Clip values in the Luma 
Clip parameter category. If it is your intent to “open up” the image to the full 
dynamic range, you need to change the Low Clip and High Clip values to 0 
and 255, respectively.

W Point (white point) Allows you to set the white point in the image. All pixels with that value 
become white, and all pixels with higher values are also clipped to white. The 
default is 235 (the broadcast value for white).

Raising the black point and lowering the white point values increases the 
contrast by reducing the number of shades of gray in an image. The number 
of shades are reduced because you map some to extreme black and others to 
extreme white.
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B Point (black point) Allows you to set the black point in the image. All pixels with that value 
become black, and all pixels with lower values are also clipped to black. 

For example, you could use the eyedropper to select a shadow on the floor 
and change it from gray to black, clipping everything below that shade to 
black. The default is 16 (the broadcast value for black).

Raising the black point and lowering the white point values increases the 
contrast by reducing the number of shades of gray in an image. The number 
of shades are reduced because you map some to extreme black and others to 
extreme white.

n Black point control does not change the Black setup level. To adjust the Black 
setup level, use the Video Output tool.

Gamma Allows you to adjust the midtones in an image without affecting the extreme 
white or black values. Lowering the value darkens midtones and brings the 
image closer to black. Raising the value lightens the midtones and brings the 
image closer to white.

For example, a person shot in front of a window in daylight may be very 
dark, almost in silhouette. You can use gamma correction to increase the 
midtones without changing the blacks or whites. Values range from –100 to 
+100 with 0 being no change. 

The number of shades of gray in an image are determined by the W Point, B 
Point, and Luma Clip sliders. The Gamma point allows you to move the 
distribution of the shades closer to black or closer to white. Negative values 
move the distribution closer to black. Positive values move the distribution 
closer to white.

Table 9-13 Luma Range Parameters (Continued)

Parameter Description
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Luma Clip

Parameter type: Keyframeable

Luma Clip parameters allow you to determine the levels at which the 
system limits the brightness or darkness in the picture.

Table 9-14 Luma Clip Parameters

Parameter Description

High Provides a simple clip function for brightness values. When you specify a 
value for High, no pixel in the image can be brighter than that value. The 
default is 235 (the broadcast value for white).

Low Provides a simple clip function for darkness values. When you specify a 
value for Low, no pixel in the image can be darker than that value. The 
default is 16 (the broadcast value for black).

When preparing video for broadcast, normally you do not adjust these 
values. They allow you to adjust the brightness and contrast (using other 
controls in the Color Effect) while still maintaining legal broadcast values for 
black and white.
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Chroma Adjust

Parameter type: Keyframeable

Table 9-15 Chroma Adjust Parameters

Parameter Description

Hue Hue varies the tint of all colors in the image. The Hue parameter is measured 
as degrees on a color wheel from –180 to +180, where 0 does not change the 
hue. Changing the value of the Hue causes all colors in the image to rotate 
around the color spectrum. For example, a Hue setting of –20 causes skin 
tones to look more red, while a Hue setting of +20 causes skin tones to look 
more green.

Sat (saturation) Saturation varies the amount of all colors in the image. The Saturation 
parameter has a value of –100 to +100. Zero is the default. A value of –100 
displays as gray tones. Positive values display all colors with more 
saturation.

Invert Invert reverses the colors in both Hue and Saturation such that all colors 
display as their complement.
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Color Style

Parameter type: Keyframeable

Posterization Example

Table 9-16 Color Style Parameters

Parameter Description

Post (posterization) Posterization allows you to limit the number of colors in the image by 
controlling the number of luminance steps that are displayed. This gives the 
image a graphic appearance. The range of values is 0 to 25, where 0 displays 
all colors and 25 displays the least number of colors.

Solar (solarization) Solarization allows you to make the lightest points in the image dark to 
achieve a partial inversion of the luminance. Values above the threshold set 
for the parameter will be inverted. Solarization can have a value of 0 to 255, 
where 0 is normal luminance and 255 inverts all luminance values in the 
picture. Values of 0 to 127 display the lightest points in the image as dark. 
Values of 128 to 255 display both the lightest points as dark and the darkest 
points as light, which gives the appearance of a film negative.

Posterization 20Posterization 10Original image
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Solarization Example

Color Gain

Parameter type: Keyframeable

The Color Gain parameters allow individual control of the Color Gain 
for each of the three color components: red, green, and blue. 

Solarization 200Solarization 100Original image

Table 9-17 Color Gain Parameters

Parameter Description

Red Changes the amount of red in the whole image. The parameter value is a 
percentage of the range from 0 to 200, where a value of 100 indicates that the 
color is unchanged.

Green Changes the amount of green in the whole image. The parameter value is a 
percentage of the range from 0 to 200, where a value of 100 indicates that the 
color is unchanged.

Blue Changes the amount of blue in the whole image. The parameter value is a 
percentage of the range from 0 to 200, where a value of 100 indicates that the 
color is unchanged.
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Crop

Parameter type: Keyframeable

The Crop parameters remove video from the top, bottom, left, and 
right edges of the video.

n Cropping is not available for DSK titles. To crop a Title effect, deselect the 
Downstream Key button in the Effect Editor.

Table 9-18 Crop Parameters

Parameter Description

T (top) Removes video from the top of the inner or incoming video. Values range 
from 0 to 999; 0 is the top of the screen, 500 is the middle of the screen, and 
999 is the bottom of the screen.

B (bottom) Removes video from the bottom of the inner or incoming video. Values range 
from –999 to 0; 0 is the bottom of the screen, –500 is the middle of the screen, 
and –999 is the top of the screen.

L (left) Removes video from the left side of the inner or incoming video. Values range 
from 0 to 999; 0 is the left side, 500 is the middle, and 999 is the right side.

R (right) Removes video from the right side of the inner or incoming video. Values 
range from –999 to 0; 0 is the right side, –500 is the middle, and –999 is the left 
side.
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n If your system has the 3D Effects option, see the 3D version on page 640.

Downstream Key

Parameter type: Global

Downstream keying allows you to add uncompressed titles or 
graphics over multiple streams of compressed or uncompressed media 
and continue to play the sequence in real time. By default, all titles are 
created using the Avid system’s downstream key (DSK) capabilities. 
Graphic elements imported with an alpha channel are also created as 
DSK clips. 

You can convert static DSK titles and graphics to non-DSK titles and 
Matte Key effects by clicking the button in the Downstream Key 
category in the Effect Editor. For more information, see “Converting 
Downstream Key Titles” on page 338.

c If you replace the fill track of a non-DSK title, you cannot restore the 
DSK capabilities.
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Foreground

Parameter type: Keyframeable

The Foreground parameters are used, together with keyframes, to set 
the relative amount of the effect to be displayed over time. The 
additional options included with the Level slider vary, depending on 
the type of effect.

Additional options vary, depending 
upon the type of effect.

Table 9-19 Foreground Parameters

Parameter Description

Level Controls the opacity of the foreground image. A Level of 0 is 0 percent 
opacity (the foreground is transparent), a Level of 50 is 50 percent opacity, 
and a Level of 100 is 100 percent opacity (no transparency).

Swap Sources This option applies to key effects (such as Chroma Key or Luma Key), 3D 
effects, and the PIP (Picture-in-Picture) effect only.

Click Swap Sources to swap the image source for the foreground and 
background layers of the effect.

Reverse Animation This option is available for all effects except the Paint Effect and the AniMatte 
effect.

Click the Reverse Animation button to cause the entire effect to be reversed, 
including the direction of movement as well as the incoming and outgoing 
sources. 

This maintains the shot continuity while reversing the movement. For 
example, instead of the outgoing shot peeling off from the top left corner, the 
incoming shot peels on from the bottom right corner. This option effectively 
creates a mirror image of the sequence of keyframes for the effect as they 
appear in the Effect Preview monitor’s position bar.



490

Grid

Parameter type: Global

The Grid parameters are used to define the Effect Grid associated with 
an effect. Grid parameters set in the Effect Editor override settings in 

Invert Key This option applies to key effects only (such as Chroma Key or Luma Key). 
Select Invert Key to reverse the key.

In the case of a Chroma Key effect (2D or 3D), inverting the key displays the 
key color regions while showing the background image source through the 
foreground image area.

In the case of a Luma Key effect (2D or 3D), inverting the key displays the 
background image source through the darker areas rather than the lighter 
areas of the foreground image source.

In the case of a Matte Key effect, inverting the key effectively reverses the 
black and white areas of the alpha channel so that foreground and 
background are reversed.

Show Alpha This option applies to key effects only (such as Chroma Key or Luma Key).

Displays the grayscale alpha channel used to apply the key effect to the 
foreground and background source. This allows you to examine problem 
areas of the key while making adjustments.

Table 9-19 Foreground Parameters (Continued)

Parameter Description



491

the Grid Settings dialog box for that effect only. Table 9-20 describes 
the Grid parameters.

Table 9-20 Grid Parameters

Parameter Description

Other Options button Opens the Grid Settings dialog box.

Grid Type Fast menu Use this menu to select a grid type. For video projects, use the Square grid 
type. The Academy grid includes a safety margin on the left that is used for 
adding the optical soundtrack.

Enable button Turns the local Grid effect on or off. If you disable the local Grid effect, the 
system uses the global settings defined in the Grid Settings dialog box.

Fields This option determines the number of tick marks along the grid axes as well 
as the number of visible grid points. Values range from 8 to 32. The default 
value is 12.

Sub This option determines the snap-to-grid feature between visible grid points. 
The value determines how many jumps are in between each visible point. 
Values range from 0 to 10. A value of 1 snaps only to visible points. A value of 
2 splits provides 1/2 field jumps. A value of 4 (the default value) provides 
1/4 field jumps, and so on. A value of 0 turns off the snap-to-grid feature.

Source Scan Size For film projects, where an optical house scans film for the addition of visual 
effects. Values range from 720 to 9999 for Horizontal and from 243 to 9999 for 
Vertical. The default values are 720 x 486 pixels.

Source Grid Offset The Hor (horizontal) and Vert (vertical) sliders move the grid on the image. 
The Inset slider shrinks the grid proportionally. Values are set to 
approximately 15% of the current values in the Source Scan Size sliders. 
These values are intended mainly for film projects.

Transfer Fast menu Enables you to specify how the film was transferred to video as follows:

Full Aperture: Transferred everything that is visible in the frame

Academy: Did not transfer the sound track area that appears on the left-hand 
side of the film
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Key Control Parameters

Key control parameters appear only in the Chroma Key, Luma Key, 
and RGB Keyer effects. These parameters control the key color and 
allow you to fine-tune the edges of key effects and the appearance of 
the foreground elements.

n If your system has the 3D Effects option, see the 3D version on page 650.

n For information on the workflow for applying key effects, see “Creating Key 
Effects” on page 173.

Key

Chroma Key and Luma Key Effects

Parameter type: Global

Use the Key parameters to select the primary key color to be replaced 
by video.

Table 9-21 Key Parameters

Parameter Description

Other Options button Opens the Windows Color dialog box or the Macintosh Color Picker for 
precise color selection. For more information, see “Using the Windows Color 
Dialog Box” on page 125 or “Using the Macintosh Color Picker” on 
page 127.
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Secondary Key

Chroma Key Effect Only

Parameter type: Global

Use the Secondary Key parameters in the Chroma Key effect to key 
out a second background color. For example, the floor in a bluescreen 
or greenscreen shot might be a slightly different shade than the 

Hue Identifies the key color. The Hue parameter is measured as values on a color 
wheel ranging from 0 to 255. The start (0) and ending (255) values are both 
red.

Sat (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, 
where 0 is no chrominance and 255 is a fully saturated color.

Lum (luminance) Specifies the brightness of the color. Values range from 0 to 255, where 0 is 
black and 255 is full brightness or white.

Gain Specifies how much of the foreground and the background video will be 
displayed. Values range from 0 to 63. A Gain of 0 shows only the foreground. 
A Gain of 63 replaces all the foreground video with the background video.

Soft (softness) Determines how the bordering colors along the edge of the key are processed 
in the effect. Colors that border the luminance or chroma specified for the key 
are displayed as a blend of the foreground and the background video. The 
higher the Softness value, the more of the background video will be blended 
in the border colors. Use the Soft slider to improve the appearance of the 
edges of the keyed areas.

Table 9-21 Key Parameters (Continued)

Parameter Description
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background. You can choose the floor color as your secondary color 
and key it out. If the Chroma Key effect is normally a real-time effect 
on your system, enabling the Secondary Key parameter will make the 
effect non-real-time.

See Table 9-21 on page 492 for a description of each parameter.

Spill Suppression

Chroma Key Effect Only

Parameter type: Global

The Spill Suppression key neutralizes the selected color for the 
Chroma Key effect without affecting the luminance. The Avid system 
changes the spill color to a grayscale, allowing it to blend more easily 
with the foreground image. If the Chroma Key effect is normally a 
real-time effect on your system, enabling the Spill Suppression 
parameter will make the effect non-real-time.

Use the Spill Suppression key color to fix the following problems:

t Remove background color spill from the foreground image. Color 
spill occurs when the background color is present in the 
foreground image due to backdrop reflection.

t If the foreground object retains an outline of the chroma key color, 
you can use Spill Suppression to reduce the color effect in the 
outline.

See Table 9-21 on page 492 for a description of each parameter.
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Key Color

RGB Keyer Only

Parameter type: Global

Use the Key Color parameters in the RGB Keyer effect to select a color 
for the chroma key.

Chroma Key

RGB Keyer Only

Parameter type: Global

Table 9-22 Key Color Parameters

Parameter Description

H (hue) Specifies the hue or tint measured as values on a color wheel ranging from 0 
to 255. The start (0) and ending (255) values are both red.

S (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, 
where 0 is no chrominance and 255 is a fully saturated color.

V (value) Specifies the value of the color.
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Use the Chroma Key parameters in the RGB Keyer effect to fine-tune 
the key effect.

Matte Control

RGB Keyer Only

Parameter type: Global

Use Matte Control in the RGB Keyer effect to fine-tune the edges of the 
matte used in the chroma key.

Table 9-23 Chroma Key Parameters

Parameter Description

Gain Adjusts the threshold of the key, with a range from 0 to 100.

Soft (softness) Softens the edge of the key, with a range from 0 to 100.

Show Alpha Displays the grayscale alpha channel used to apply the key effect to the 
foreground and background sources. Viewing the alpha channel directly 
allows you to examine problem areas of the key while making adjustments.

Spill Suppresses the spill from the key color onto foreground objects that often 
occurs due to color reflection in the scene. The range is from 0 to 100.

Level Controls transparency of the foreground elements against the key 
background. 

Reverse Inverts the key.
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Color Correction 

RGB Keyer Only

Parameter type: Global

Use the Color Correction parameters in the RGB Keyer effect for 
post-key color correction of the foreground elements in the Chroma 
Key effect. Because the foreground and background elements are often 
shot at different times and locations, post-key color correction is 
especially useful for maintaining the key while matching the visual 
characteristics of the foreground to the background.

Table 9-24 Matte Controls

Parameter Description

Blur Blurs the matte for the key using a box filter. The range is from 0 to 100, in 
which 0 indicates a blurring of 0 pixels and 100 indicates a blurring of 10 
pixels.

Erode Used with blur, decreases or “erodes” the outer edges of the blurred matte 
key.

Table 9-25 Color Correction Parameters

Parameter Description

Hue Specifies the hue or tint of the foreground elements. The Hue parameter is 
measured as values on a color wheel ranging from 0 to 255. The start (0) and 
ending (255) values are both red.
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Matrix Parameters

Parameter type: Global

Matrix effects use a grid to define the position or progress of the effect 
over time, for example in a Matrix wipe. The Matrix parameters define 
the grid to be used in the effect.

Other Options

The Other Options button in the Matrix effects opens the Matrix 
effect’s dialog box shown below. 

Sat (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, 
where 0 is no chrominance and 255 is a fully saturated color.

Bright (brightness) Specifies the brightness level. Values range from 0 to 255, where 0 is black and 
255 is full brightness or white.

Cont (contrast) Controls the contrast of light and dark areas in the picture. Values range from 
–100 to +100, where a value of 0 indicates the image is unchanged. A negative 
value is less contrast; a positive value is more contrast.

Table 9-25 Color Correction Parameters (Continued)

Parameter Description
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You can select a standard grid or enter a custom number of rows and 
columns. The minimum number of rows and columns is 2 x 2.

Columns

Number of columns in the effect.

Rows

Number of rows in the effect.

Motion Effect Parameters

Motion effect parameters apply to Freeze Frame, Variable Speed, and 
Strobe Motion effects. For information about applying and editing 
various motion effects, see “Creating Motion Effects” on page 82.

Freeze Frame Parameters

Parameter type: Global

You access Freeze Frame parameters by choosing Freeze Frame from 
the Clip menu.

Columns Rows

Graphical
representation
of the grid
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Duration

Custom duration

Table 9-26 Freeze Frame Menu Commands

Command Description

Duration (in seconds) Specifies the length of the Freeze Frame clip that will be created in the Source 
monitor. You can either select a duration from the Freeze Frame pop-up menu 
or select Other to enter a custom duration.

Other Opens a dialog box that allows you to specify a custom duration for the 
Freeze Frame clip.

Two Field Freeze 
Frames submenu

Options below determine how the effect media is created and displayed 
when working in two-field resolutions (for example, 20:1, 3:1, 2:1, or 
uncompressed).
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Variable Speed and Strobe Motion Parameters

Parameter type: Global

You access Variable Speed and Strobe Motion parameters by clicking 
the Motion Effect button in the Tool palette to open the Motion Effect 
dialog box.

Using Duplicated 
Field

A single field is displayed in the effect. This option reduces the vertical 
resolution of the image by one-half, resulting in a lower-quality image.

Using Both Fields Both fields are used to create the effect. This option is especially useful when 
there is motion in the footage.

Using 
Interpolated Field

A second field is created for the effect by combining scan line pairs from the 
first field in the original media. This might result in a slightly softer look to 
the freeze frame.

Table 9-26 Freeze Frame Menu Commands (Continued)

Command Description
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Variable Speed 
effect 
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Table 9-27 Variable Speed and Strobe Motion 
Options

Category

DescriptionOption

Variable Speed

Duration The duration of the effect in frames. Doubling the number of frames causes 
the frame rate to be half the current rate.

Rate The rate of speed in frames per second (fps) at which the video will be 
played. Normal speed is 30 fps for NTSC video, 25 fps for PAL video.

% speed The percent of speed at which the video will be played. Normal speed is 
100%.

Fit To Fill Sets the Variable Speed parameters, so the duration of the motion effect will 
match the IN to OUT duration marked in the sequence.

Strobe Motion

Update every __ 
frames

Specifies the update rate in frames for the Strobe Motion effect. For example, 
entering a rate of 5 causes every fifth frame to be displayed in the Strobe 
Motion effect.

Render 2-Field Motion Effect Using:

Duplicated Field A single field is displayed in the effect. For two-field media, this reduces the 
information stored by half because it drops one field of the image, resulting 
in a lower quality image. For single-field media, this is usually the best choice 
because of its speed (the other options do not improve effect quality for 
single-field media). 

The effects render in the shortest amount of time using this option.
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Both Fields Both fields are displayed in the effect. For example, the first two frames of a 
half-speed (50%) slow motion effect repeat the original Frame 1 (both fields) 
twice. This option is good for shots without inter-field motion and still shots. 
With footage that includes inter-field motion, this method might result in 
minor shifting or bumping of the image because it disturbs the original order 
of fields: a Field 1 will appear both before and after the corresponding Field 2. 

The effect renders relatively quickly. For best results, you should use evenly 
divisible frame rates with this option.

Interpolated Field A second field is created for the effect by combining scan line pairs from the 
first field in the original media. This option calculates the motion effect at the 
field level rather than the frame level. Because the system considers all fields 
and does not disturb the original order of fields, the smoothest effect results. 
This method is best for video-originated material or film-originated material 
transferred at 24 fps. 

The time needed to render effects created using this option is longer than for 
effects created using either Duplicated Field or Both Fields, but similar to the 
time needed for VTR-Style.

VTR-Style The Avid system creates a second field for the effect by shifting selected 
video fields of the original media by a full scan line. This option also creates 
the motion effect at the field level rather than the frame level, but because 
pixels are not filtered, the final image is sharper than that created by the 
Interpolated Field option. The image might display some slight jitter at 
certain speeds. This technique is similar to that used by high-quality 
professional video decks when playing footage at less than normal speed.

The time needed to render effects created using this option is longer than for 
effects created using either Duplicated Field or Both Fields, but similar to the 
time needed for Interpolated Field.

Table 9-27 Variable Speed and Strobe Motion 
Options (Continued)

Category

DescriptionOption
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n If a Strobe Motion effect becomes unrendered because it has been trimmed to a 
longer duration, the effect will not play and must be rendered again.

n To indicate reverse motion at full play rate, slow or fast, enter a negative play 
rate or a percent.

Paint Effect Parameters

See “AniMatte and Paint Effects” on page 459.

Position

Parameter type: Keyframeable

Position parameters set horizontal and vertical position.

Ignore Render 
Setting

If a specific motion effect type is set in the Motion Effects Render Using 
option of the active Render setting, the system automatically selects that 
motion effect type, makes all other motion effect type options unavailable, 
and displays the Ignore Render Setting checkbox. Click the Ignore Render 
Setting checkbox to temporarily override the active Render setting and make 
all four motion effect type available.

Table 9-27 Variable Speed and Strobe Motion 
Options (Continued)

Category

DescriptionOption
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n Position is not available for DSK titles. To reposition a Title effect, deselect the 
Downstream Key button in the Effect Editor.

n If your system has the 3D Effects option, see the 3D version on page 658.

Scroll Position V

Parameter type: Keyframeable

Rolling titles have an additional position parameter labeled Scroll 
Position V (vertical).

Use this parameter to move the rolling title up or down in the frame. 
The number range refers to the position of the roll relative to its overall 
length, where 0 represents the point at which the top of the roll is 
aligned with the top of the screen. The highest negative number (the 
slider at its leftmost position) places the top of the roll off the bottom of 
the screen. The highest positive number (the slider at its rightmost 
position) places the bottom of the roll off the top of the screen. 

Click Reverse to reverse the direction of the roll.

Table 9-28 Position Parameters

Parameter Description

H Pos 
(horizontal position)

Moves the video from side to side. Values range from –999 to 999. Negative 
values move the image to the left. Positive values move the image to the right.

V Pos (vertical 
position)

Moves the video up and down. Values range from –999 to 999. Negative 
values move the image to the top. Positive values move the image to the 
bottom.
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c If you select all keyframes when changing the scroll position on a 
rolling title, all keyframes will be set to that position and the title 
will no longer move. Make sure you select the appropriate 
keyframes.

Profile

Parameter type: Keyframeable

The Profile window in the Effect Editor is a graphical representation of 
the foreground level and acceleration applied to effect keyframes:

• Foreground level affects the opacity of the effect. The greater the 
opacity, the closer to the top of the Profile graph the keyframe 
appears. For more information, see the following section, 
“Adjusting Foreground Level in the Profile Window.”

• Acceleration affects the rate of movement into and out of 
keyframes. The greater the acceleration, the more rounded the 
lines appear in the Profile window. You can adjust Acceleration 
with the Acceleration slider only. For more information, see 
“Acceleration” on page 458.

Adjusting Foreground Level in the Profile Window

Foreground level controls the opacity of a 3D effect layer. You can 
adjust levels for various keyframes directly in the Profile window. This 
is the same as using the Level slider in the Foreground parameter 
category, as described in “Foreground” on page 489. Adjustments you 
make with the Level slider are also represented in the Profile graph.

100% level (foreground opaque)

0% level (foreground transparent)

Straight lines indicate no acceleration. 
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To adjust foreground level within the Profile window:

1. Select the appropriate keyframe in the effect’s position bar.

2. Click the round white keyframe indicator that appears on the 
Profile graph, and drag it up or down to increase or decrease the 
opacity of the foreground image.

Scaling

Parameter type: Keyframeable

Scaling involves resizing the effect by adjusting height and width.

n Scaling is not available for DSK titles. To scale a Title effect, deselect the 
Downstream Key button in the Effect Editor.

Table 9-29 Scaling Parameters

Parameter Description

Wid (width) Controls the width of the image when the Fixed Aspect parameter is 
disabled. Stretches or compresses along the X axis (horizontally). Values 
range from 0 to 400, where 100 indicates 100 percent scaling (normal size).

Hgt (height) Controls the height of the image when the Fixed Aspect parameter is 
disabled. Stretches or compresses along the Y axis (vertically). Values range 
from 0 to 400, where 100 indicates 100 percent scaling (normal size).

Fixed Aspect Determines which position and size parameters are displayed. When the 
Fixed Aspect parameter is enabled, the aspect ratio of the picture cannot be 
changed. The Wid and Hgt sliders are ganged and move together.
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Scratch

Parameter type: Keyframeable

The Scratch parameters control the position and appearance of 
replacement material that you use to cover scratches and other flaws.

Table 9-30 Scratch Parameters

Parameter Description

Opac. (opacity) The Opac. slider controls the opacity of the replacement material used in a 
Scratch Removal effect. A value of 0 represents complete transparency. A 
value of 100 represents complete opacity.

Object Visible The Object Visible button enables you to add a keyframe to a Scratch 
Removal effect and have replacement material suddenly “pop” onto the 
screen at the position marked by the keyframe. You must have at least three 
keyframes to create this effect. 

Hor (horizontal) Defines the position of the replacement material relative to the shape you 
have drawn on the horizontal axis of the frame. Negative values indicate the 
number of pixels the replacement material is to the left of the shape, positive 
values the number of pixels to the right. The default value is 0.

Vert (vertical) Defines the position of the replacement material relative to the shape you 
have drawn on the vertical axis of the frame. Negative values indicate the 
number of pixels the replacement material is above the shape, positive values 
the number of pixels below. The default value is 0.
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Frame/Field Defines which nearby frame or field is being used as the source of the 
replacement material. Values represent an offset from the reference point 
defined in the Offset Fast menu.

A value of 0 indicates the frame or field that is the reference point; a positive 
value indicates a later frame or field than the reference point; a negative value 
indicates an earlier frame or field than the reference point. The default value 
of –1 provides an instant correction when you are working with the normal 
two-frame effect created by the Scratch Removal button.

When you are working with single-field or 24p or 25p material, the slider is 
Frame and is calibrated from –5 to +5, with each increment representing one 
frame. When you are working with two-field material, the slider is Field and 
is calibrated from –10 to +10, with each increment representing one field.

Offset Fast menu The Offset Fast menu defines the reference or zero point for the Frame or 
Field slider. The following three choices are available on the Offset Fast 
menu.

Relative — The Frame or Field slider is set relative to the frame containing 
the shape that covers the flaw.

From Start — The Frame or Field slider is set relative to the first frame of the 
segment. 

From End — The Frame or Field slider is set relative to the last frame of the 
segment.

Table 9-30 Scratch Parameters (Continued)

Parameter Description
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Transition Parameters

Parameter type: Global

The Transition parameters appear at the bottom of the Effect Editor.

Transition Effect Alignment

The Transition Effect Alignment parameters specify the start of the 
transition effect relative to the cut point in the sequence. 

To set the alignment for a transition effect:

t Click the button to the left of the Transition Effect Duration box, 
and select a position from the Transition Effect Alignment pop-up 
menu:

t Ending at Cut — The transition effect will start a number of 
frames before the cut defined by the duration, such that the 
effect completes at the cut point in the video.

t Centered on Cut — The transition will be centered on the cut 
so that half the effect will occur before the cut point and half 
will occur after the cut point in the sequence.

t Starting at Cut — The transition effect will start immediately 
after the last frame of the outgoing video is displayed.

t Custom Start — Allows you to specify the number of frames 
before and after the cut to be included in the effect.

Click the Transition Effect Align-
ment button to select a position 
from the pop-up menu.

Transition effect alignment
pop-up menu

Transition effect duration box
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Transition Effect Duration

The Transition Effect Duration box specifies the length of time that the 
effect will span the transition. The duration of a segment effect is 
determined by the length of the segment. The Transition Effect 
Duration format that is displayed (for example, 1:00 is 1 second and 0 
frames) is determined by the Transition Effect Duration setting you 
selected at the top of the Effect Preview window.

n For more information about using transition effects, see “Working with 
Transition Effects” on page 72.

Plug-in Effect Parameters

If you install third-party AVX (Avid Visual Extensions) plug-in effects, 
these effects usually come with their own documentation. For 
information on installing and using third-party plug-in effects, see 
“Using Third-Party Plug-in Effects” on page 46.
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2D Effects

This section summarizes each 2D effect in alphabetical order within 
each effect category listed below. Parameters for each effect are listed 
here and described in “2D Effects Parameters” on page 456.

• Blend Effects

• Box Wipes

• Conceal Effects

• Edge Wipes

• Film Effects

• Image Effects

• Key Effects

• L-Conceal Effects

• Matrix Wipes

• Motion Effects

• Peel Effects

• Push Effects

• Reformat Effects

• Sawtooth Wipes

• Shape Wipes

• Spin Effects

• Squeeze Effects

• Title Effects
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Blend Effects

Blend effects are general two-channel effects. They include:

• Blend: Dip to Color

• Blend: Dissolve

• Blend: Fade from Color

• Blend: Fade to Color

• Blend: Picture-in-Picture

• Blend: Superimpose

Blend: Dip to Color

 

Outgoing footage Incoming footageMiddle of effect

Effect Icon

Apply to Transitions

Parameters Profile – foreground level

Foreground – level, reverse animation

Background – hue, saturation, luminance

Acceleration

Transition Parameters – transition effect alignment and duration

Description Fades from the outgoing video to black, white, or any color and then fades up to 
the incoming video. Color is specified using the Lum, Chroma, and Sat sliders.
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Blend: Dissolve

Outgoing footage Incoming footageMiddle of effect

Effect Icon

Apply to Transitions

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Blends images from the outgoing video with the incoming video over time.
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Blend: Fade from Color

Incoming footageMiddle of effectBeginning color

Effect Icon

Apply to Transitions

Parameters Profile – foreground level

Foreground – level, reverse animation

Background – hue, saturation, luminance

Acceleration

Transition Parameters – transition effect alignment and duration

Description Fades from any color to incoming video.
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Blend: Fade to Color

Middle of effect Final colorOutgoing footage

Effect Icon

Apply to Transitions

Parameters Profile – foreground level

Foreground – level, reverse animation

Background – hue, saturation, luminance

Acceleration

Transition Parameters – transition effect alignment and duration

Description Fades from the outgoing video to any color.
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Blend: Picture-in-Picture

Bottom track PIP as a segment effect Top track

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Background – hue, saturation, luminance

Acceleration

Transition Parameters – transition effect alignment and duration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Description Creates a picture within a picture. Video from the higher layer, where the effect is 
applied, is displayed inside the video on the lower layer. When used on a 
transition, the incoming video appears inside outgoing video.
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Blend: Superimpose

Superimpose effectBottom track Top track

Effect Icon

Apply to Multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Description Blends the image from the upper video track (where the effect is applied) with the 
image from the lower video track over time. Level set at 100 percent shows only 
the video image from the upper track where the effect is applied. Level set at 0 
percent shows only the video image from the lower video track.
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Box Wipes

Box Wipes reveal one video channel on top of another video channel, 
using predefined growing rectangular shapes. They include:

• Box Wipe: Bottom Box

• Box Wipe: Bottom Left to Top Right

• Box Wipe: Bottom Right to Top Left

• Box Wipe: Left Box

• Box Wipe: Right Box

• Box Wipe: Top Box

• Box Wipe: Top Left to Bottom Right

• Box Wipe: Top Right to Bottom Left

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 634.
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Box Wipe: Bottom Box

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the bottom edge of the screen and 
wipes out the outgoing video as the box expands to fill screen.
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Box Wipe: Bottom Left to Top Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the bottom left corner of the screen and wipes 
out the outgoing video as the box expands to fill the screen.
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Box Wipe: Bottom Right to Top Left 

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the bottom right corner of the screen and wipes 
out the outgoing video as the box expands to fill the screen.
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Box Wipe: Left Box

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the left edge of the screen and 
wipes out the outgoing video as the box expands to fill the screen.
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Box Wipe: Right Box  

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the right edge of the screen and 
wipes out the outgoing video as the box expands to fill the screen.
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Box Wipe: Top Box

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the center of the top edge of the screen and 
wipes out the outgoing video as the box expands to fill the screen.
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Box Wipe: Top Left to Bottom Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the top left corner of the screen and wipes out 
the outgoing video as the box expands to fill the screen.
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Box Wipe: Top Right to Bottom Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a box in the top right corner of the screen and wipes out 
the outgoing video as the box expands to fill the screen.
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Conceal Effects

Conceal effects overlap one video channel over another video channel 
using a predefined path. They include:

• Conceal: Bottom Left to Top Right

• Conceal: Bottom Right to Top Left

• Conceal: Bottom to Top

• Conceal: Left to Right

• Conceal: Right to Left

• Conceal: Top Left to Bottom Right

• Conceal: Top Right to Bottom Left

• Conceal: Top to Bottom

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 634.
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Conceal: Bottom Left to Top Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the bottom left to the top 
right of the screen.



531

Conceal: Bottom Right to Top Left

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the bottom right to the 
top left of the screen.
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Conceal: Bottom to Top

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the bottom to the top of 
the screen.
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Conceal: Left to Right

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the left edge to the right 
edge of the screen.
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Conceal: Right to Left

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the right edge to the left 
edge of the screen.
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Conceal: Top Left to Bottom Right

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the top left to the bottom 
right of the screen.
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Conceal: Top Right to Bottom Left

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the top right to the 
bottom left of the screen.
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Conceal: Top to Bottom

Effect Icon

Apply to Transitions, single-layer and multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides on top of the outgoing video from the top to the bottom of 
the screen.
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Edge Wipes

Edge Wipes reveal one video channel on top of another video channel 
by wiping an edge across the screen. They include:

• Edge Wipe: Horizontal

• Edge Wipe: Horizontal Open

• Edge Wipe: Lower Left Diagonal

• Edge Wipe: Lower Right Diagonal

• Edge Wipe: Upper Left Diagonal

• Edge Wipe: Upper Right Diagonal

• Edge Wipe: Vertical Open

• Edge Wipe: Vertical
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Edge Wipe: Horizontal

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins at the left edge of the screen and moves to the right edge, 
wiping out the outgoing video.
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Edge Wipe: Horizontal Open

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a vertical band in the center of the screen. This band 
expands to the left and right edges of the screen, wiping out the outgoing video.
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Edge Wipe: Lower Left Diagonal

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the bottom left corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the bottom left corner to the top 
right corner of the screen.
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Edge Wipe: Lower Right Diagonal

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the bottom right corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the bottom right corner to the top 
left corner of the screen.
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Edge Wipe: Upper Left Diagonal

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the top left corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the top left corner to the bottom 
right corner of the screen.
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Edge Wipe: Upper Right Diagonal

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins in the top right corner of the screen and wipes out the 
outgoing video as a diagonal line moves from the top right corner to the bottom 
left corner of the screen.



545

Edge Wipe: Vertical Open

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a horizontal band in the center of the screen. This band 
expands up and down to fill the screen.
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Edge Wipe: Vertical

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins at the top edge of the screen and expands downward to 
fill the screen.
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Film Effects

Film effects, which are an available option on some systems, emulate 
many of the effects an optical house can produce. They include:

• Film: 1.66 Mask

• Film: 1.85 Mask

• Film: Anamorphic Mask

• Film: 16:9 Mask

• Film: Blowup

• Film: Film Dissolve

• Film: Film Fade

• Film: Mask



548

Film: 1.66 Mask

Mask effect example (1:1.85 Mask)Original image

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 1.66 times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.
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Film: 1.85 Mask

Film: Anamorphic Mask

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 1.85 times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 2.35 times wider than it is tall. The area surrounding the 
rectangle is masked by a black background.
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Film: 16:9 Mask

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a centered rectangle. The 
centered rectangle is 16 units wide by 9 units high. The area surrounding the 
rectangle is masked by a black background.
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Film: Blowup

Original image Blowup effect

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Blowup – field, X position, Y position

Description Blowup modifies the size and portion of the picture that is displayed.
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Film: Film Dissolve

Outgoing video Middle of effect Incoming video

Effect Icon

Apply to Transitions

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Blends the outgoing frame to the incoming frame over time. The Level parameter 
has been preset according to Kodak™ specifications. Avid does not recommend 
adjusting the Level parameter on this effect.

The Level set at 0% shows all of the outgoing frame. The Level set at 100% shows 
all of the incoming frame. 

This dissolve has preset parameters that emulate film’s response to light when 
dissolving to another (nonblack) picture.
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Film: Film Fade

Film: Mask

Effect Icon

Apply to Transitions

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Description Blends the outgoing pictures to the incoming pictures over time. The Level 
parameter has been preset according to Kodak specifications. Avid does not 
recommend adjusting the Level parameter on this effect. 

The Level set at 0% shows all of the outgoing frame. The Level set at 100% shows 
all of the incoming frame.

This dissolve has preset parameters that emulate film’s response to black material. 
Use this effect for fade ins and fade outs.

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a rectangle defined by the 
Scaling, Fixed Aspect, and Position parameters of the effect.

The area surrounding this rectangle is masked by the effect’s background color.
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Image Effects

Image effects are general effects that apply to a single stream of video 
or (in the case of Scratch Removal and Submaster) that modify all the 
layers of video beneath them. They include:

• Image: Color Effect

• Image: Flip

• Image: Flip-Flop

• Image: Flop

• Image: Mask

• Image: Paint Effect

• Image: Resize

• Image: Scratch Removal

Image: Color Effect

Effect Icon

Apply to Single-layer segments

Parameters Luma Adjust – brightness, contrast, invert

Luma Range – white point, black point, and gamma

Luma Clip – high and low

Chroma Adjust – hue, saturation, invert

Color Style – posterization and solarization

Color Gain – red, green, blue

Description The Color Effect modifies the luminance, chroma, style (posterized or solarized), 
and color gain of the segment. For examples of the Color Effect, see “Color Effect 
Parameters” on page 479.
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Image: Flip

Original image Flip effect applied

Effect Icon

Apply to Single-layer segments

Parameters None

Description Video image is flipped vertically.
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Image: Flip-Flop

Original image Flip-flop effect applied

Effect Icon

Apply to Single-layer segments

Parameters None

Description Video image is flipped both horizontally and vertically.
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Image: Flop

Image: Mask

Original image Flop effect applied

Effect Icon

Apply to Single-layer segments

Parameters None

Description Video image is flipped horizontally, which reverses the camera angle.

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Description Masks out any area of the image that is not inside a rectangle defined by the 
Scaling, Fixed Aspect, and Position parameters of the effect. The area surrounding 
the rectangle is masked by the effect’s background color.
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Image: Paint Effect

Effect Icon

Apply to Single-layer or multilayer segments

Parameters Acceleration

Mode

Feathering

Magic Mask

Brush

Description Enhances the creative and corrective powers of the Avid system by allowing you 
to create vector-based objects that you can animate and edit with customizable 
paint brushes on one frame or a series of frames. For examples of the Paint Effect, 
see “Common Intraframe Editing Techniques” on page 439.
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Image: Resize

Original image Resize effect – reduced image Resize effect – enlarged image

Effect Icon

Apply to Single-layer segments

Parameters Background – hue, saturation, luminance

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Description Resize modifies the size and position of the video. The background color displays 
where no video is present. Use the H Pos, V Pos, and Size sliders to specify the 
size and position of the video. Use the Crop parameters to remove the edges of 
the picture.
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Image: Scratch Removal

Effect Icon

Apply to Single-layer segments

Parameters Acceleration

Scratch

Feathering

Brush

Description Allows you to remove scratches and other flaws by drawing an object to cover the 
scratch and filling the object with clean replacement material. For examples of the 
Scratch Removal effect, see “Scratch Removal” on page 423.
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Image: Submaster

n The Submaster effect does not render each track separately; you cannot play 
each track separately after rendering.

Effect Icon

Apply to The top video track under which are the video tracks that will be included in the 
Submaster effect.

Parameters None

Description When rendered, the Submaster effect creates a single media file for all the video 
on the layers below the Submaster effect. This allows you to group several effects 
that reside on different video layers and render them as one effect; this is quicker 
than rendering each effect separately.
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Key Effects

Key effects combine two streams of video using components from one 
of the streams. They include:

• Key: AniMatte

• Key: Chroma Key

• Key: Luma Key

• Key: Matte Key

• Key: RGB Keyer (AVX Plug-in Effect)

Key: AniMatte

Effect Icon

Apply to Transitions, multilayer segments

Parameters Acceleration

Foreground – level, reverse animation, swap sources

Mode

Feathering

Magic Mask

Brush

Description Enables you to generate custom matte effects that you can apply to a segment or 
transition in a sequence. You can use a variety of brushes and painting tools to 
create matte effects that you can animate. For examples of the Animatte Effect, see 
“Common Intraframe Editing Techniques” on page 439.
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Key: Chroma Key

Background – video layer 1 Key image – video layer 2 Chroma Key effect

Effect Icon

Apply to Transitions, multilayer segments

Parameters Key – hue, saturation, luminance, gain, softness

Secondary Key – hue, saturation, luminance, gain, softness

Spill Suppression – hue, saturation, luminance, gain, softness

Profile – foreground level

Foreground – level, swap sources, reverse animation, invert, show alpha

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Transition Parameters – transition effect alignment and duration

Description Replaces one part of the video image with another video image based on color. 
The key color in the video on the higher track is replaced with the video from the 
lower track number. Chroma Key is used most frequently with a foreground 
image shot in front of a highly saturated color screen.
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Key: Luma Key

Key image Background image Luma Key effect

Effect Icon

Apply to Transitions, multilayer segments

Parameters Key – hue, saturation, luminance, gain, softness

Profile – foreground level

Foreground – level, swap sources, reverse animation, invert, show alpha

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Transition Parameters – transition effect alignment and duration

Description Replaces one part of the video image with another video image based on 
luminance.
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Key: Matte Key

Matte Key effect

Video layer 3 – high-contrast matte image

Video layer 1 – backgroundVideo layer 2 – foreground

Effect Icon

Apply to Multilayer segments

Parameters Profile – foreground level

Foreground – level, swap sources, reverse animation, invert, show alpha

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Transition Parameters – transition effect alignment and duration

Downstream Key (for graphics files imported with alpha channel)

Description A three-layer track effect. The bottom layer is the background image, the middle 
layer is the foreground image, and the top layer contains the grayscale matte or 
alpha channel. 
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Key: RGB Keyer (AVX Plug-in Effect)

Background – video layer 1 Key image – video layer 2 Chroma Key effect

Effect Icon

Apply to Multilayer segments

Parameters Key Color – hue, saturation, value

Chroma Key – gain, softness, show alpha, spill suppression, level, reverse

Matte Control – blur, erode

Color Correction – hue, saturation, brightness, contrast

Description Replaces one part of the video image with another video image based on color. 
The key color in the video on the higher track is replaced with the video from the 
lower track number. You can also perform post-key color correction with the RGB 
Keyer effect.
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L-Conceal Effects

L-Conceal effects overlap one video channel over another using a 
predefined L-shaped path. They include:

• L-Conceal: Bottom Left

• L-Conceal: Bottom Right

• L-Conceal: Top Left

• L-Conceal: Top Right
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L-Conceal: Bottom Left

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides up the left half of the screen from bottom to top and then 
fills the screen from left to right.
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L-Conceal: Bottom Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides up the right half of the screen from bottom to top and then 
fills the screen from right to left.
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L-Conceal: Top Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides down the left half of the screen from top to bottom and 
then fills the screen from left to right.
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L-Conceal: Top Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video slides down the right half of the screen from top to bottom and 
then fills the screen from right to left.
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Matrix Wipes

Matrix wipes reveal one video channel on top of another video 
channel, using blocks or bands that appear in a predefined position or 
path. They include:

• Matrix Wipe: Grid

• Matrix Wipe: One-Way Row

• Matrix Wipe: Speckle

• Matrix Wipe: Spiral

• Matrix Wipe: Zig-Zag
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Matrix Wipe: Grid

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix columns and rows

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as blocks in a grid pattern that wipe out the outgoing 
video as the blocks expand to fill the screen. Change the size of the grid by 
clicking the Other Options button.
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Matrix Wipe: One-Way Row

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix columns and rows

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a block in the top left corner of the screen that wipes out 
the outgoing video as the band expands horizontally across the screen from left to 
right. When the first horizontal band reaches the right edge of the screen, a second 
band appears on the left edge of the screen, just below the first band, and repeats 
the process until the incoming video has wiped out all the outgoing video.
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Matrix Wipe: Speckle

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix columns and rows

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video appears in a random series of blocks that wipe out the outgoing 
video until the blocks have filled the screen.
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Matrix Wipe: Spiral

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix columns and rows

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video spirals over and wipes out the outgoing video using blocks of 
screen space, starting in the bottom left corner of the screen, spiraling inward in a 
counterclockwise movement.
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Matrix Wipe: Zig-Zag

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix columns and rows

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a single block in the top left corner of the screen that 
wipes out the outgoing video as the band expands horizontally across the screen 
from left to right. When the first horizontal band reaches the right edge of the 
screen, a second band appears and expands horizontally across the screen from 
right to left. Succeeding bands repeat the process until the wipe is completed.
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Motion Effects

A motion effect is applied to a clip in the Source monitor and controls 
the rate at which the video channel is played. Motion effects include:

• Freeze Frame

• Variable Speed

• Strobe Motion

n When you use motion effects to slow down a clip, the effect is real-time. When 
you use motion effects to speed up a clip, the effect is non-real-time and must 
be rendered before it can be played.

Motion Effect: Freeze Frame

Motion Effect: Variable Speed and Strobe Motion

Apply to Current frame in the Source monitor

Parameters Motion Effect Parameters – duration and two-field media

Description This effect repeats the current frame in the Source monitor for the 
specified duration.

Apply to The clip marked by the IN and OUT points in the Source monitor

Parameters Motion Effect Parameters – variable speed, strobe motion, two-field media

Description Variable Speed creates slow motion, fast motion, or reverse motion. Strobe 
Motion creates a stuttering effect. The Strobe Motion effect can be used in 
combination with the Variable Speed effect.
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Peel Effects

Peel effects treat one video channel as though it were a sheet of paper 
being peeled from the other video channel. They include:

• Peel: Bottom Left Corner

• Peel: Bottom Right Corner

• Peel: Bottom to Top

• Peel: Left to Right

• Peel: Right to Left

• Peel: Top Left Corner

• Peel: Top Right Corner

• Peel: Top to Bottom
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Peel: Bottom Left Corner

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from incoming video from the bottom left corner to the 
top right corner of the screen.
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Peel: Bottom Right Corner

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from incoming video from the bottom right corner to the 
top left corner of the screen.
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Peel: Bottom to Top

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from incoming video from the bottom edge to the top 
edge of the screen.
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Peel: Left to Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from incoming video from the left edge to the right edge 
of the screen.
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Peel: Right to Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from incoming video from the right edge to the left edge 
of the screen.
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Peel: Top Left Corner

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from incoming video from the top left corner to the 
bottom right corner of the screen.
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Peel: Top Right Corner

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is peeled from incoming video from the top right corner to the 
bottom left corner of the screen.
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Peel: Top to Bottom

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video is peeled from outgoing video from the top to the bottom of the 
screen.
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Push Effects

Push effects move one video channel to fill the screen while the other 
video channel is pushed out of the screen. They include:

• Push: Bottom Left to Top Right

• Push: Bottom Right to Top Left

• Push: Bottom to Top

• Push: Left to Right

• Push: Right to Left

• Push: Top Left to Bottom Right

• Push: Top Right to Bottom Left

• Push: Top to Bottom

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 634.



589

Push: Bottom Left to Top Right

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the bottom left corner to the top 
right corner of the screen. Border is on incoming video.
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Push: Bottom Right to Top Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the bottom right corner to the top 
left corner of the screen. Border is on incoming video.
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Push: Bottom to Top

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the bottom to the top of the 
screen. Border is on incoming video.
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Push: Left to Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the left edge to the right edge of 
the screen. Border is on incoming video.
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Push: Right to Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the right edge to the left edge of 
the screen. Border is on incoming video.
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Push: Top Left to Bottom Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the top left corner to the bottom 
right corner of screen. Border is on incoming video.
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Push: Top Right to Bottom Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the top right corner to the 
bottom left corner of the screen. Border is on incoming video.
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Push: Top to Bottom

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video pushes out outgoing video from the top to the bottom of the 
screen. Border is on incoming video.
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Reformat Effects

Reformat effects allow you to reformat media to different aspect ratios, 
for example when you need to reformat a film aspect ratio for 
television programming. 16:9 Letterbox, 14:9 Letterbox, and 4:3 
Sidebar resize the media to conform to the aspect ratio you select. Pan 
and Scan allows you to select a portion of the media to reformat.

• Reformat: 16:9 Letterbox

• Reformat: 14:9 Letterbox

• Reformat: 4:3 Sidebar

• Reformat: Pan and Scan

Reformat: 16:9 Letterbox

Original footage After 16:9 Letterbox effect applied

Effect Icon

Apply to Multilayer or single-layer segments.

Parameters Background

Position – horizontal position

Acceleration

Description Reformats media to 16:9 Letterbox aspect ratio by distorting the media. See 
“Understanding the Pan and Scan Effect” on page 188.
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Reformat: 14:9 Letterbox

Reformat: 4:3 Sidebar

Effect Icon

Apply to Multilayer or single-layer segments.

Parameters Background

Position – horizontal position

Acceleration

Description Reformats media to 14:9 Letterbox aspect ratio by distorting the media. See 
“Understanding the Pan and Scan Effect” on page 188.

Effect Icon

Apply to Multilayer or single-layer segments.

Parameters Background

Position – horizontal position

Acceleration

Description Reformats media to 4:3 Sidebar aspect ratio by distorting the media. See 
“Understanding the Pan and Scan Effect” on page 188.
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Reformat: Pan and Scan

Sawtooth Wipes

Sawtooth wipes create a transition between shots using a jagged edge 
like the teeth of a saw. They include:

• Sawtooth Wipe: Horizontal Sawtooth

• Sawtooth Wipe: Horizontal Open Sawtooth

• Sawtooth Wipe: Vertical Open Sawtooth

• Sawtooth Wipe: Vertical Sawtooth

Effect Icon

Apply to Multilayer segments, or single-layer segments in certain circumstances. For more 
information, see “Combining the Pan and Scan Effect with Transition Effects” 
on page 205.

Parameters Aspect Ratios – source, target

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Acceleration

Actions – establish origin, subdivide effect, reset to origin

Grid

Description Allows you to reformat media to different aspect ratios, for example when you 
need to reformat a film aspect ratio for television programming. For examples of 
the Pan and Scan effect, see “Using the Reformat Effects and the 
Pan and Scan Effect” on page 187.
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Sawtooth Wipe: Horizontal Sawtooth

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Other Options – matrix columns and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video appears with a sawtooth on the left edge of the screen. The 
sawtooth edge moves to the right edge of the screen, revealing the incoming 
video.
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Sawtooth Wipe: Horizontal Open Sawtooth

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Other Options – matrix columns and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a vertical sawtooth in the center of the screen. The 
sawtooth then expands outward to the left and right edges of the screen to display 
the incoming video in the center while covering the outgoing video.
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Sawtooth Wipe: Vertical Open Sawtooth

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Other Options – matrix columns and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a horizontal sawtooth in the center of the screen. The 
sawtooth expands up and down, revealing the incoming video.
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Sawtooth Wipe: Vertical Sawtooth

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Other Options – matrix columns and rows

Acceleration

Transition Parameters – transition effect alignment and duration

Description The sawtooth edge moves from the top of the screen down, covering the outgoing 
video and displaying the incoming video above the sawtooth.
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Shape Wipes

Shape Wipes reveal one video channel on top of another video 
channel, using a growing or moving geometric shape. They include:

• Shape Wipe: 4 Corners

• Shape Wipe: Center Box

• Shape Wipe: Circle

• Shape Wipe: Clock

• Shape Wipe: Diamond

• Shape Wipe: Ellipse

• Shape Wipe: Horizontal Bands

• Shape Wipe: Horizontal Blinds

• Shape Wipe: Vertical Blinds
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Shape Wipe: 4 Corners

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as blocks in four corners of the screen and wipes out the 
outgoing video as the blocks expand to fill the screen.
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Shape Wipe: Center Box

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small box in the center of the screen and wipes out the 
outgoing video as it expands to fill the screen.
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Shape Wipe: Circle

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small circle in the center of the screen and wipes out 
the outgoing video as it expands to fill the screen.
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Shape Wipe: Clock

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and durations

Description Incoming video appears as a vertical line from the center of the screen to the top 
edge. The incoming video replaces the outgoing video in a clockwise motion as if 
it were the hand on a clock.
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Shape Wipe: Diamond

Effect Icon

Apply to Transitions, multilayer segments

Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small diamond in the center of the screen and wipes 
out the outgoing video as it expands to fill the screen.
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Shape Wipe: Ellipse

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, and softness

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as a small ellipse in the center of the screen and wipes out 
the outgoing video as it expands to fill the screen.
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Shape Wipe: Horizontal Bands

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix rows and columns

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Reversible Yes

Description Horizontal bands expand toward the center of the screen to reveal incoming video 
between alternate shrinking bands of outgoing video.
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Shape Wipe: Horizontal Blinds

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix rows and columns

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as horizontal bands on the screen that wipe out the 
outgoing video as the incoming bands expand vertically to fill the screen. 
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Shape Wipe: Vertical Blinds

Spin Effects

Spin effects rotate one or more video channels. They include:

• Spin: X Spin

• Spin: Y Spin

• Spin: Z Spin

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Other Options – matrix rows and columns

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video begins as vertical bands on the screen that wipe out the outgoing 
video as the incoming bands expand horizontally to fill the screen. 
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Spin: X Spin

Outgoing footage

Middle of effect

Incoming footage

Effect Icon

Apply to Transitions

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is squeezed until it appears as a vertical line. The incoming video 
then expands from that vertical line until it fills the screen. Border appears only 
on the incoming video.
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Spin: Y Spin

Middle of effect

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Outgoing video is squeezed until it appears as a horizontal line. The incoming 
video then expands from that horizontal line until it fills the screen.
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Spin: Z Spin

Incoming footageOutgoing footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description The incoming video begins as a dot in the center of the screen and then enlarges 
to full screen while rotating counterclockwise one full revolution, covering the 
outgoing video.
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Squeeze Effects

Squeeze effects expand a video channel from a single point or line 
until it fills the screen, obscuring the second video channel. They 
include:

• Squeeze: Bottom Centered

• Squeeze: Bottom Left

• Squeeze: Bottom Right

• Squeeze: Bottom to Top

• Squeeze: Centered Zoom

• Squeeze: Horizontal Centered

• Squeeze: Left Centered

• Squeeze: Left to Right

• Squeeze: Right Centered

• Squeeze: Right to Left

• Squeeze: Top Centered

• Squeeze: Top Left

• Squeeze: Top Right

• Squeeze: Top to Bottom

• Squeeze: Vertical Centered

n For examples of similar effects, see “Comparison of Similar Effects” on 
page 634.
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Squeeze: Bottom Centered

Outgoing footage Middle of effect Incoming footage

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center bottom of the screen and expanding to fill the screen.
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Squeeze: Bottom Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Reversible Yes

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
bottom left corner of the screen and expanding to fill the screen.
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Squeeze: Bottom Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
bottom right corner of the screen and expanding to fill the screen.
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Squeeze: Bottom to Top

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at the bottom of the 
screen and filling to the top of the screen.
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Squeeze: Centered Zoom

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Description Incoming video starts as a rectangle in the center of the screen and zooms to fill 
the screen.
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Squeeze: Horizontal Centered

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video starts as a vertical band squeezed in the center of the screen and 
expands horizontally to fill the screen.
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Squeeze: Left Centered

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center left edge of the screen and expanding to fill the screen.



625

Squeeze: Left to Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at the left edge of the 
screen and filling to the right edge of the screen.
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Squeeze: Right Centered

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center right edge of the screen and expanding to fill the screen.
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Squeeze: Right to Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at right edge of the 
screen and filling to the left edge of screen.
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Squeeze: Top Centered

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
center top edge of the screen and expanding to fill the screen.
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Squeeze: Top Left

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
top left corner of the screen and expanding to fill the screen.
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Squeeze: Top Right

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning as a rectangle in the 
top right corner of the screen and expanding to fill the screen.



631

Squeeze: Top to Bottom

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video squeezes over the outgoing video, beginning at the top edge of 
the screen and filling to the bottom edge of the screen.
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Squeeze: Vertical Centered

Effect Icon

Apply to Transitions, multilayer segments

Parameters Border – hue, saturation, luminance, width, softness

Blend Color – hue, saturation, luminance

Profile – foreground level

Foreground – level, reverse animation

Acceleration

Transition Parameters – transition effect alignment and duration

Description Incoming video starts as a horizontal band squeezed in the center of the screen 
and expands vertically to fill the screen.
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Title Effects

Effect Category Title effects (Title, Rolling Title)

Effect Icons

Apply to Multilayer segments

Title Parameters Profile – foreground level

Foreground – level, reverse animation

Acceleration

Scroll Position V (rolling titles only)

Downstream Key

Disabling Downstream Key enables the following additional parameters:

Scaling – height, width, fixed aspect

Position – horizontal position, vertical position

Crop – top, bottom, left, right

Rolling Title 
Parameters

Foreground – level, reverse animation

Acceleration

Scroll Position V

Reverse

Description Title effects are created in the Title tool and can incorporate text, graphic objects, 
imported graphics, and video. Similar to Matte Key effects, Title effects are placed 
on segments in one video layer and then keyed over background video on the 
underlying video layers.

Title Rolling Title
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Comparison of Similar Effects

There are four effect categories that have a similar result: Box Wipe, 
Conceal, Push, and Squeeze. Examples of these effects are shown here 
to assist you in using these effects.

Box Wipe — 
Top Left to 
Bottom Right

Conceal — 
Top Left to 
Bottom Right

Push — Top 
Left to Bottom 
Right

Squeeze — 
Top Left
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CHAPTER 10

3D Effects Reference

This chapter provides reference information on parameters and effect 
shape options that appear in the Effect Editor when you apply the 
3D Warp effect to a transition or segment. For information on applying 
and editing 3D effects, see Chapter 5, “Working with 3D Effects.”

• 3D Effects Parameters

• 3D Shape Effects
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3D Effects Parameters

This section provides a general description of all 3D parameters, in 
alphabetical order. Each effect includes a subset of these parameters. 
Some parameters have corresponding 2D versions, described in 
Chapter 9.

This section also covers the following topics:

• Global Versus Keyframeable Parameters

• The Hierarchy of Parameters

n Some parameters are not available on all systems.
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Effects parameters are grouped in the following categories:

• Acceleration (see 2D version on page 458)

• Axis

• Background Color (see 2D version on page 476)

• Border (see 2D version on page 478)

• Corner Pin

• Crop (see 2D version on page 487)

• Defocus

• Erode/Expand

• Foreground (see 2D version on page 489)

• Highlight

• Perspective

• Position (see 2D version on page 505)

• Profile

• Rotation

• Scaling (see 2D version on page 508)

• Shadow

• Shape

• Skew

• Spill Suppression

• Spline

• Stamp

• Target

• Trail

n For an explanation of how to change a parameter, see “Changing a 
Parameter” on page 123.
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Global Versus Keyframeable Parameters

Parameters for 3D effects are divided into two logical groups:

• Global parameters cannot change between keyframes. When you 
change one of these parameters, your Avid system automatically 
sets the value for all keyframes.

• Keyframeable parameters are adjustable on an individual 
keyframe basis, so that the parameters can change over time. 

The type of parameter is indicated throughout this section.

The Hierarchy of Parameters

Your Avid system processes 3D effects parameters in a specific order. 
Knowing the order will help you understand why something looks a 
particular way or why an object behaves the way it does on a motion 
path.

The hierarchy of 3D effects parameters, and the relationships between 
them, are as follows:

• Parameters that are lower in the hierarchy, like Crop, are not 
affected by parameters that are higher in the hierarchy, such as 
Rotation. In an effect that has both rotation and cropping, for 

Lower

HigherTarget 

Perspective

Position 

Rotation

Axis

Scaling

Crop
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example, the same four edges are always cropped the same way 
no matter what angle you have chosen for the rotation.

• Parameters that are higher in the hierarchy will always take into 
account the parameters lower in the hierarchy when processing. 
For example, before an object is rotated, your Avid system looks to 
see where the object is positioned in the frame to display the 
correct 3D point of view with the new angle.

• You always end up with the same effect no matter the order in 
which you change parameters. However, building an effect from 
the bottom of the hierarchy up will be easier to control. If you 
rotate an object, for example, and then move the axis (a lower 
parameter), your object may jump off the screen. It would be 
better to move the axis first, and then rotate the object.

• Parameters operate as 2D, 3D, and post-transformation. All these 
choices affect the 3D path of the object differently. 
Two-dimensional (2D) parameters, such as Scaling, are lowest in 
the hierarchy and do not affect the path through space. 
Three-dimensional (3D) parameters, such as Position, directly 
affect the shape of the motion path. Post-transformation 
parameters, such as Target, move the entire path.
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Acceleration

Parameter type: Global

Acceleration changes the speed of movement into and out of 
keyframes. This is also known as ease in and ease out. Zero on the slider 
is no acceleration; 100 is full acceleration.

n Acceleration applies to every keyframe in the same way. The last time you 
change this parameter determines the acceleration for all keyframes in the 
effect.

You can apply acceleration to a number of 3D effects parameters. For 
example, you can use keyframes and acceleration to smooth the 
motion of a rotating Picture-in-Picture effect. 

Acceleration affects the following 3D effects parameters:

• Shape (X and Y position)

• Position (if Spline is disabled)

• Scaling

• Rotation

• Axis

• Target

• Perspective

• Skew

• Crop

• Shadow (X and Y position)
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Axis

Parameter type: Keyframeable

Use Axis to move the center of rotation relative to the image. There is 
no fixed rotation axis with an image. The axis is independent of the 
image and is movable. For example, the rotation axis can be placed in 
the center of the image, on the edge, or off the picture.

To move the center of rotation off the image, you might find it useful 
to zoom out and activate the wire-frame handles. For more 
information, see “Effect Editor Buttons” on page 119.

Axis button

Table 10-1 Axis Parameters

Parameter Description

X Moves the center of rotation along the X axis (right or left). Values range from 
–999 to +999, where 0 is the center of the X axis.

Y Moves the center of rotation along the Y axis (up or down). Values range from 
–999 to +999, where 0 is the center of the Y axis.

Z Moves the center of rotation along the Z axis. Values can range from –999 to 
+999, where 0 is the center of the Z axis. Positive values are closer and negative 
values are farther away. Adjusting the Z value moves the center of rotation off 
the plane of the video screen.
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Background Color

Parameter type: Keyframeable

Use Backgnd (background) Color to replace the bottom video track 
with a background color.

Use the eyedropper to select a color from the video in a monitor, or use 
the following color parameters. For a description of how to use the 
eyedropper, see “Using the Eyedropper” on page 125.

n You can achieve interesting effects on a two-track sequence by using a 
background color for the bottom track and using a Luma Key effect on the top 
track.

Move the mouse to the Color Preview 
window to activate the eyedropper.

Table 10-2 Background Color Parameters

Parameter Description

H (hue) Specifies the hue or shade of the color. Values range from 0 to 255.

S (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, where 0 
is no chrominance and 255 is a fully saturated color.

L (luminance) Specifies the brightness of the color. Values range from 0 to 255, where 0 is black 
and 255 is full brightness.
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Border

Parameter type: Keyframeable

Use Border to place a border around the image. Use the Fast Menu 
button to select the border style.

The default border color is black for Plain borders and shades of gray 
for other border types.

n You can blend the foreground video with the background video if you turn on 
Border, use a zero width, and adjust the Soft parameter.

n For information about the 2D version of this effect, see “2D Effects 
Parameters” on page 456.

Move the mouse to the Color Preview 
window to activate the eyedropper.

Table 10-3 Border Parameters

Parameter Description

Width Changes the width of the border. Values range from 0 (no border) to 100, where 50 
is the default.

Soft (softness) Changes the softness. Values range from 0 (hard edge) to 255 (a very soft edge), 
where 0 is the default. Border softness blends the border with the background 
image, giving the border a soft appearance.

Use the eyedropper to select a color from the video in the Record monitor, or use the following color 
parameters. For a description of how to use the eyedropper, see “Using the Eyedropper” on page 125.

H (hue) Specifies the hue or shade of the color. Values range from 0 to 255.
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n You cannot change the border type and border color between keyframes.

Corner Pin

Parameter type: Keyframeable

Corner pinning is a way of positioning a 3D effect in a foreground 
video track over an object in a background video track. For example, 
you might want to have the foreground video appear to be playing on 
a TV set in the background video.

S (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, where 0 
is no chrominance and 255 is a fully saturated color.

L (luminance) Specifies the brightness of the color. Values range from 0 to 255, where 0 is black 
and 255 is full brightness.

Table 10-3 Border Parameters (Continued)

Parameter Description

Table 10-4 Corner Pin Parameters

Parameter Description

Corner Selection Selects which corner the X and Y parameters apply to.
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Crop

Parameter type: Keyframeable

At the bottom of the effects parameters hierarchy is Crop. It always 
crops the same four edges of the object no matter what orientation the 
object has. Cropping works only in 2D space so that 3D parameters 
such as Rotation and Position, which are higher in the hierarchy, take 
effect later in the processing. You don’t need to adjust cropping before 
the other parameters, but it is difficult to crop edges if they are rotated 
to the vanishing point. Use Crop to trim an image’s top, bottom, left, 
and right edges.

n For information about the 2D version of this effect, see “2D Effects 
Parameters” on page 456.

X Pins the image along the X axis. Values range from –999 to +999, where 0 is 
the default.

Y Pins the image along the Y axis. Values range from –999 to +999, where 0 is 
the default.

Follow Crop Lets you pin the corners of a cropped image rather than pinning the corners 
of the whole frame.

Table 10-4 Corner Pin Parameters (Continued)

Parameter Description

Crop button



646

n You can apply the FG Only, Key Only, FG and Key, or KeyBlur on any Avid 
system, but if your system does not support the feature, there will be no effect 
on the image. When you move the project to a system that does support the 
feature, the system will make the image adjustments you specified.

Defocus

Parameter type: Keyframeable

Table 10-5 Crop Parameters

Parameter Description

T (top) Crops the top edge of the image. Values range from –999 (bottom) to 999 
(top). The values –999 to 999 are relative to the edges of the image. Zero is the 
center of the image.

B (bottom) Crops the bottom edge of the image. Values range from –999 (bottom) to 999 
(top).

L (left) Crops the left edge of the image. Values range from –999 (left) to 999 (right).

R (right) Crops the right edge of the image. Values range from –999 (left) to 999 (right).

Menu options in Key effects Menu options in non-Key effects
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Defocus gives you the ability to blur the image or blur individual 
layers of a matte effect with the Internal, FG Only, Key Only, or FG and 
Key options.

You can use Defocus to create an effect in which the incoming media 
“fades in” to focus. 

The KeyBlur option uses alpha channel values as a template for 
blurring the foreground image. When you select this option, Defocus 
blurs the foreground in proportion to the opacity of the matte. You 
might use this effect to selectively blur part of a foreground image, 
such as a face, by creating a moving matte for the area of the image 
you want to appear blurred. You would use the Offset parameter to 
control how much of a blur Defocus applies to the face. Alternatively, 
you could use a KeyBlur matte to create a soft-focus area around a 
foreground subject.

n
When you enable Defocus, the default option is Internal and default values are 
10 for Horz (horizontal) and Vert (vertical). This produces a slight softening 
effect.

Table 10-6 Defocus Options

Option Parameter Description

Internal Blurs the image. Available on all systems.

Horz 
(horizontal)

Increases or decreases horizontal blur.

Values range from 0 to 15, where 0 represents no change. Defaults to 10.

Vert (vertical) Increases or decreases vertical blur.

Values range from 0 to 15, where 0 represents no change. Defaults to 10.

FG (Foreground) Only
Key Only
FG (Foreground) and Key

Blurs the selected component of a Matte Key effect.
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Erode/Expand

Parameter type: Global

Use Erode/Expand to control the blending of the edges on 3D Warp 
effects. 

Horz 
(horizontal)

Increases or decreases horizontal blur of the selected component(s).

Values range from 0 to 255, where 0 represents no change. Defaults to 0.

Vert (vertical) Increases or decreases vertical blur of the selected component(s).

Values range from 0 to 255, where 0 represents no change. Defaults to 0.

KeyBlur Blurs the foreground in proportion to the opacity of the matte. Black 
matte values cause no blurring; white matte values cause maximum 
blurring.

Offset Increases or decreases across the whole image the relative amount of 
blurring that Defocus applies as a result of the KeyBlur option.

Values range from –100 to 100, representing a percentage of maximum 
blur (100) or minimum blur (–100). At 0, Defocus makes no further 
adjustment to the foreground after it applies the KeyBlur option.

Table 10-6 Defocus Options (Continued)

Option Parameter Description
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Foreground

Parameter type: Global

The Foregnd (foreground) Fast menu has three options: Full Key, 
Luma Key, and Chroma Key. Each of the three keys has different 
values you can adjust. When you enable a key, its value options are 
automatically revealed. The values are described in the following 
sections.

Table 10-7 Erode/Expand Parameters

Parameter Description

Filter Specifies how many pixels on each side of the edge will be smoothed. Values 
range from 1 (1 pixel on each side) to 7 (7 pixels on each side).

Center Controls the amount of erosion or expansion applied to the edges. Erosion 
shrinks the edges, and expansion enlarges the edges. Values range from 0 to 
255, where 0 is maximum erosion and 255 is maximum expansion. 

Sof (softness) Controls the slope of the edges. Values range from 0 to 255, where 0 is a 
vertical slope (no softness) and 255 is the maximum slope (maximum 
softness).
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Full Key

Parameter type: Keyframeable

Full Key is the default for all 3D effects. Use Full Key to:

t Create dissolves using the Opac. (opacity) slider

t Switch an effect from one video track or segment to another by 
using the Swap Sources button

n You cannot rotate the key independently of the image.

Table 10-8 Foreground: Full Key Parameters

Parameter Description

Opac. (opacity) Modifies the transparency of the foreground image. Values range from 0 
(transparent) to 100 (opaque). You can also use the Opac. (opacity) slider to 
adjust the foreground opacity. See “Adjusting Foreground Level in the 
Profile Window” on page 659.

Invert Inverts the key. This setting is most noticeable for effects that scale the 
foreground video, such as a Picture-in-Picture effect. The bottom track shows 
through the Picture-in-Picture effect key unscaled. The area outside the 
Picture-in-Picture effect key is black.

Swap Sources Switches the foreground and background sources for the effect.

Reverse Animation Causes the entire effect to be reversed, including the direction of movement 
as well as the incoming and outgoing sources.
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Luma Key

Parameter type: Keyframeable

Use Luma Key to replace portions of the foreground video with the 
background video based on brightness or luminance. The Luma Key 
sliders allow you to select a brightness value or a range of brightness 
values in the foreground video. The Avid system replaces the 
corresponding portions of the foreground video with background 
video.

n For information about the 2D version of this effect, see “2D Effects 
Parameters” on page 456.

Show Alpha Displays the grayscale alpha channel used to apply the key effect to the 
foreground and the background source. This allows you to examine problem 
areas of the key while making adjustments.

Table 10-8 Foreground: Full Key Parameters (Continued)

Parameter Description

Table 10-9 Foreground: Luma Key Parameters

Parameter Description

Opac. (opacity) Adjusts the transparency of the foreground image from 0 (transparent) to 100 
(opaque).
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Thresh (threshold) Identifies either the brightness threshold for the foreground image or the 
center of the luma range.

Soft (luma softness) Allows you to soften the edge of the cutoff line. Pixel values slightly above or 
below the threshold are included, depending on the softness value.

Lum Range 
(luminance range)

Turns the Range slider on and off. The Luma Range parameter is not available 
on all systems.

Range When Lum Range is not active, the Thresh value is a cutoff point. All 
brightness values above the Thresh value are displayed (you see the 
foreground). Values below the Thresh value are not displayed (you see the 
background). 

When Lum Range is active, Thresh becomes the median point of the range. 
This allows you to leave in a specific range of brightness values.

The Luma Range parameter is not available on all systems.

Invert Inverts the key. Portions of the foreground that were visible are now invisible 
and vice versa.

Swap Sources Switches the foreground and background sources for the effect.

Reverse Animation Causes the entire effect to be reversed, including the direction of movement 
as well as the incoming and outgoing sources.

Show Alpha Displays the grayscale alpha channel used to apply the key effect to the 
foreground and the background source. This allows you to examine problem 
areas of the key while making adjustments.

Table 10-9 Foreground: Luma Key Parameters (Continued)

Parameter Description
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Chroma Key

Parameter type: Global

Use Chroma Key to replace one part of the video image with another 
video image based on color. The key color in the video on the higher 
track is replaced with the video from the lower track.

Chroma keys are often used with a foreground image shot in front of a 
highly saturated color screen.

n For information about the 2D version of this effect, see “2D Effects 
Parameters” on page 456.

Move the mouse to the Color Preview 
window to activate the eyedropper.

Table 10-10 Foreground: Chroma Key Parameters

Parameter Description

Opac. (opacity) Adjusts the transparency of the foreground image from 0 (transparent) to 100 
(opaque).

Hue Identifies the color. The hue color is replaced with video from the lower track. 
Either use the slider to select the hue, or use the eyedropper with the Color 
Preview window. When you use the eyedropper, the Avid system uses the 
hue only from the selected color. It ignores the saturation and luma values.
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H Tol. 
(hue tolerance)

Controls how many similar shades of the hue will be replaced by the 
background (the bottom video track). Use this when the ranges of luminance 
and saturation of the chroma key color are too wide.

H Soft 
(hue softness)

Allows you to soften edges that are too aliased or sharp.

S Low 
(low saturation)

Allows you to remove low saturation colors by raising the lower limit. For 
example, sometimes portions of clothing or faces may contain subtle 
variations of a hue. To keep these portions of the image visible, you can try 
adjusting the S Low value.

S High 
(high saturation)

Allows you to remove high saturation colors by moving the upper limit 
down. For typical chroma keys with high saturation colors, you usually leave 
this value at the default of 255.

Invert Inverts the key. Portions of the foreground that were visible are now invisible 
and vice versa.

Swap Sources Switches the background and foreground source footage.

Reverse Animation Causes the entire effect to be reversed, including the direction of movement 
as well as the incoming and outgoing sources.

Show Alpha Displays the grayscale alpha channel used to apply the key effect to the 
foreground and the background source. This allows you to examine problem 
areas of the key while making adjustments.

The following parameters, available on some systems, are used only for special applications. These 
parameters actually create a mask rather than a key. They determine a range of values to retain rather 
than define a range of values to key out.

L Tol. 
(luminance tolerance)

Specifies a tolerance level — retain everything below the level.

L Soft 
(luminance softness)

Softens the key created by L Tol.

Table 10-10 Foreground: Chroma Key Parameters (Continued)

Parameter Description
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Using the Chroma Key Sliders

The most common procedure for using Chroma Key sliders is:

1. Use the eyedropper to select a hue. 

For best results, pick a color that is well within the field of color.

2. Adjust H Tol. (hue tolerance) to replace the hue with the 
background.

3. If low-saturation grays are keyed out (for example, portions of 
faces or clothing), try adjusting S Low (low saturation) to put them 
back into the foreground.

4. Use L Soft (luminance softness) to fine-tune the edges of the key.

You usually keep the S High, L Tol., and L Soft at their default settings.

n You can use the Spill Suppression parameter to correct spill for a 
Chroma Key.

Highlight

Parameter type: Keyframeable

Lum Range option 
and Range slider

Allow you to retain values within a certain luminance range.

Table 10-10 Foreground: Chroma Key Parameters (Continued)

Parameter Description



656

The Highlight parameters allow you to:

t Enable automatic highlighting for shapes and adjust the intensity 
of automatic highlighting

t Adjust the highlights for manual highlighting and Rev (reverse) 
manual highlighting

You can use manual highlights even when a shape is not active. The 
default manual highlight creates a blurred disk in the center of the 
image.

Table 10-11 Highlight Parameters

Parameter Description

Soft (softness) Controls the softness of the highlight’s edge. Softness values range from 0 
(hard edge) to 100 (a very soft edge), where 50 is the default softness.

Inty (intensity) Controls the brightness of the highlight. Values range from 0 to 100, where 50 
is the default intensity.

Rad (radius) Controls the size of the highlight. Values range from 0 to 100, where 50 is the 
default radius.

Angle Rotates the highlight. This has an effect only when the aspect ratio is not 0. 
Values range from –180 degrees to +180 degrees, where 0 is the default angle.

Aspct (aspect ratio) Changes the shape of the highlight from a perfect circle (0) to an oval or a 
band. Values range from –100 to +100, where 0 is the default. The –100 band is 
at right angles to the +100 band.

X Moves the center of the highlight from left to right. Values range from –999 to 
+999, where 0 is the default. Positive values move the highlight to the right.

Y Moves the center of the highlight from top to bottom. Values range from –999 
to +999, where 0 is the default. Positive values move the highlight up.
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Perspective

Parameter type: Keyframeable

Use Perspective to move the perspective point (where parallel lines 
appear to converge) along the screen’s X, Y, and Z axes. This changes 
the way the image is visually projected onto the video screen.

Table 10-12 Perspective Parameters

Parameter Description

X Moves the projected screen image farther to the left or right. Values range 
from –999 to +999, where 0 is the default.

Y Allows you to view the image from a higher or lower angle. Values range 
from –999 to +999, where 0 is the default.

Z Moves the perspective point closer to and farther from the observer. 
Perspective increases as the point moves inward and decreases as the point 
moves outward from the screen. Moving the perspective point in Z changes 
the amount of foreshortening on an image that is rotated around the X or Y 
axis.
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Position

Parameter type: Keyframeable

Use Position to move an image in 3D space.

n For information about the 2D version of this effect, see “2D Effects 
Parameters” on page 456.

n For an illustration of the XYZ coordinate system, see “The 3D Coordinate 
System” on page 228.

Table 10-13 Position Parameters

Parameter Description

X Moves the image along the screen’s X axis (horizontally). Values range from 
–3000 to +3000, where 0 is the zero-point of the X axis. Negative values move 
the image to the left and positive values move the image to the right.

Y Moves the image along the screen’s Y axis (vertically). Values range from 
–3000 to +3000, where 0 is the zero-point of the Y axis. Negative values move 
the image down and positive values move the image up.

Z Moves the image closer to or farther from the observer along the Z axis. 
Values range from -3000 to +3000, where zero is the zero-point of the Z axis. 
Negative values move the image away from the observer and positive values 
move the image toward the observer.
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Profile

Parameter type: Keyframeable

Profile is available on all effects that have the Foreground (level) 
parameter. The Profile window in the Effect Editor is a graphical 
representation of the foreground level and acceleration applied to 
effect keyframes:

• Foreground level affects the opacity of the effect. The greater the 
opacity, the closer to the top of the Profile graph the keyframe 
appears. For more information, see the following section.

• Acceleration affects the rate of movement into and out of 
keyframes. The greater the acceleration, the more rounded the 
lines appear in the Profile window. You can adjust Acceleration 
with the Acceleration slider only. For more information, see 
“Acceleration” on page 640.

Adjusting Foreground Level in the Profile Window

Foreground level controls the opacity of a 3D effect layer. You can 
adjust levels for various keyframes directly in the Profile window. This 
is the same as using the Opac. slider in the Foregnd (foreground) 
parameter category.

To adjust foreground level within the Profile window:

1. Select the appropriate keyframe in the effect’s Timeline.

100% level (foreground opaque)

0% level (foreground transparent)

Straight lines indicate no acceleration. 
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2. Click the round white keyframe indicator that appears on the 
Profile graph, and drag it up or down to increase or decrease the 
opacity of the foreground image.

Rotation

Parameter type: Keyframeable

Use Rotation to rotate the image around the X, Y, or Z axis.

A value of 720 degrees allows you to spin the image more than once 
between two keyframes. For an explanation of rotation angles, see 
“Rotation Axes” on page 229.

Rotate buttons Z

X

Y

Table 10-14 Rotation Parameters

Parameter Description

Z Rotates the image around the Z axis (clockwise or counterclockwise). Values 
range from –720 to +720, where 0 is the default.

X Rotates the image around the X axis. Values range from –720 to +720, where 0 
is the default.

Y Rotates the image around the Y axis. Values range from –720 to +720, where 0 
is the default.
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Scaling

Parameter type: Keyframeable

The Scaling parameters allow you to adjust the size of the image or 
effect.

n For information about the 2D version of this effect, see “2D Effects 
Parameters” on page 456.

Shadow

Parameter type: Keyframeable

Scale button

Table 10-15 Scaling Parameters

Parameter Description

X Stretches or compresses along the X axis (horizontally). Values range from 0 
to 400, where 100 indicates 100 percent scaling (normal size).

Y Stretches or compresses along the Y axis (vertically). Values range from 0 to 
400, where 100 indicates 100 percent scaling (normal size).

Fixed Aspect When enabled, Fixed Aspect locks the aspect ratio of the image so you cannot 
move the X and Y sliders independently. The X and Y sliders are ganged and 
move together to maintain the selected aspect ratio.
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Use Shadow to place a shadow beneath an image, to adjust its offset, 
and to adjust its transparency.

n Shadow, Trail, and Stamp (described in “Trail” on page 671) are mutually 
exclusive. This means that you can have only one enabled at a time.

Shape

Parameter type: Global

There are five basic types of 3D shape effects, each with its own 
parameter categories. For more information, see “3D Shape Effects” 
on page 672.

Skew

Parameter type: Keyframeable

Table 10-16 Shadow Parameters

Parameter Description

Opac. 
(opacity)

Changes the shadow’s opacity from fully transparent (0) to fully opaque 
(100), where 50 is the default.

X Changes the shadow’s left/right offset. Values range from –100 to +100, 
where 50 is the default.

Y Changes the shadow’s top/bottom offset. Values range from –100 to 0, where 
–50 is the default.
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Use Skew to move or tilt an image in the X or Y direction.

Spill Suppression

Parameter type: Keyframeable

Use real-time Spill Suppression to replace one color with another color. 
You can use real-time Spill Suppression in conjunction with the 
chroma key to correct spill. You can also use real-time Spill 
Suppression for spot color correction.

Table 10-17 Skew Parameters

Parameter Description

X Skews the image along the X axis. The orientation of the top and bottom 
edges remains fixed, while the left and right edges are tilted along the X axis 
into a parallelogram. Values range from –999 to +999, where 0 represents no 
change.

Y Skews the image along the Y axis. The orientation of the left and right edges 
remains fixed, while the top and bottom edges are tilted along the Y axis into 
a parallelogram. Values range from –999 to +999, where 0 represents no 
change.

Color to replace

Replacement color
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Table 10-18 Spill Suppression Parameters

Parameter Description

H (hue) Specifies the hue or shade of the color. Hue refers to the name commonly 
associated with a color, such as red, green, or blue. Values range from 0 to 
255.

S (saturation) Specifies the purity or intensity of the color. A fully saturated color produces 
the most intense representation of that color. Values range from 0 to 255, 
where 0 is no chrominance and 255 is a fully saturated color.

L (luminance) Specifies the brightness of the color. Values range from 0 to 255, where 0 is 
black and 255 is full brightness.

Use Key Color Uses the chroma key color as the color to be replaced.The color indicator box 
will show gray rather than the key color itself when this option is enabled.

Gain Spill Suppression affects contiguous pixels that fall within the specified color 
range, or tolerance, of the color you pick with the eyedropper or color sliders. 
You adjust the tolerance with the Gain slider. Values range from 0 to 63.

Decreasing the Gain decreases the color range and includes fewer pixels 
contiguous to the color selection. Increasing the Gain expands the range and 
includes more pixels surrounding the color selection.

Soft (softness) Determines how colors contiguous to the selected color are processed in the 
effect. Colors that border the selected color are displayed as a blend of the 
original color and the replacement color. The higher the softness value, the 
more of the replacement color is blended with the original color. Use the Soft 
slider to improve the appearance of the edges of the keyed areas. Values 
range from 0 to 63.
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Spline

Parameter type: Global

Spline is the parameter that smooths the position changes between 
keyframes. It helps to reproduce the natural motion path of an object 
through 3D space. Without spline, moving objects follow the most 
direct path between keyframed positions, resulting in a “mechanical” 
feel.

Sometimes you want objects to settle gently into place at each 
keyframe and other times you may want objects to move in a 
swooping arc, connecting the keyframes. Spline helps to achieve both. 
It looks ahead and takes into account the motion approaching a 
keyframe and the motion immediately after a keyframe and averages 
the changes for the smoothest possible transition. Spline is often 
helpful for putting the finishing touches on a move.

n When you are working with Spline, it is a good idea to click the Outline/Path 
button in the Effect Editor to displays the wire-frame line that represents the 
path between keyframes.

Outline/Path button

Table 10-19 Spline Parameters 

Parameter Description

Tension (Tens.) Tension controls how sharply the curve bends at a keyframe. The default or 0 
setting is the average of the changes before and after the keyframe. 
Decreasing it to –100 doubles the amount of bending from the original 0 
position and creates more slack in the curve. Increasing it to 100 tightens the 
curve and makes the change in direction more severe. 
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Tension (Tens.)

The following is a graphical representation of the effects of adjusting 
the Tens. (tension) slider.

Continuity (Cont.)

The following is a graphical representation of the effects of adjusting 
the Cont. (continuity) slider.

Continuity (Cont.) Continuity controls the amount of direction change between the incoming 
motion and outgoing motion around the keyframe. Usually the motion 
should be as smooth as possible, reducing sharp, unnatural corners (the 
default setting of 0). However, when you want to simulate bouncing or 
punching, you must turn the Continuity down (–100) to make the quick, hard 
direction changes more obvious. Turning it up to 100 forces the motion to 
begin going in the opposite direction at the previous keyframe, changing to 
the new direction for the outgoing motion.

Bias Bias assigns a different weight to either the incoming or the outgoing motion. 
Set at 0, it averages both incoming and outgoing motion. When set to –100, it 
“undershoots” the keyframe; at 100 it “overshoots” the keyframe. This causes 
the curve to occur either before or after the keyframe it passes through.

Table 10-19 Spline Parameters  (Continued)

Parameter Description

Tens.
Cont.
Bias

100
0
0

Tens.
Cont.
Bias

–100
0
0

Tens.
Cont.
Bias

0
0
0
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Difference Between Tension and Continuity

There appears to be no difference between the motion path of an object 
with maximum Tension and an object with minimum Continuity. The 
motion dynamics of the two moves, however, are quite different. Even 
though both motion paths have severe direction changes, Tension 
causes the object to start slowly, speed up, slow down, and pause at 
the keyframe, and then speed up and slow down again at the next 
keyframe. This is referred to as an ease in/ease out motion.

Tens.
Cont.
Bias

0
–100

0

Tens.
Cont.
Bias

0
100

0

Tens.
Cont.
Bias

0
0
0

Tens.
Cont.
Bias

0
–100

0

Tens.
Cont.
Bias

100
0
0

Continuity Tension
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Bias

The following is a graphical representation of the effects of adjusting 
the Bias slider.

Adding a New Point to a Spline Curve

Mathematically speaking, when you add a point to a spline curve, the 
curve changes shape, even if the new point is on the curve. Sometimes 
you will want to add a new point on the curve to change the path. 
However, sometimes you may simply want to add a new keyframe to 
change a parameter such as Rotation or Scaling without affecting the 
curve. In order to account for both cases, the Avid system uses the 
following rule: 

Once you move one of the points, the Avid system incorporates all the 
existing keyframes into the curve. You can move any of the points to 
readjust the curve. 

If you add a keyframe when using the Spline category, the system 
displays the new point on the curve. However, it does not recalculate 
the curve until you use one of the Position parameters to move one of 
the points.
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Stamp

Parameter type: Keyframeable

Stamp lets you imprint a video or graphic element into an 
independent Stamp buffer that allows the image to remain on screen 
after the effect’s segment has ended. For example, you can “stamp” 
multiple elements of video, text, and graphics over a background 
image to create effects that would otherwise require rendering or 
additional real-time streams of video. For more information, see 
“Creating a Stamp” on page 253.

Three of the most common uses for Stamp are:

• Real-time title builds: You reveal multiple text, graphic, and 
video elements and stamp them over or under the foreground 
image when they come to rest. Once the image is stamped, you 
can add additional layers. 

• Downstream key: You add an image that stays in place. For 
example, you could create a logo that you want to just stay on the 
screen.

Table 10-20 Stamp Parameters

Parameter Description

Opac. (opacity) Changes the stamp’s opacity from fully transparent (0) to fully opaque (100), 
where 100 is the default.

Foregnd. On Top 
(foreground on top)

Switches the image in the Stamp buffer to the background; without Foregnd. 
On Top enabled, the Stamp buffer is always in the foreground.

Clear Lets you clear the stamp buffer of everything in it.



670

• Video montage: You bring in a variety of video images, where 
each one stays in place as you continue to add new ones.

n You cannot render Stamp effects; they are real-time effects. Also, the Stamp, 
Shadow, and Trail parameters are mutually exclusive. This means that you 
can only have only one enabled at a time.

Target

Parameter type: Keyframeable

Use Target to change the X Y positioning and the sizing and to 
maintain the current perspective.

Target is a post-transformation parameter. In other words, it is at the 
top of the hierarchy and affects objects after all the other parameters 
have affected it. If an object has been rotated and has perspective 
added to it, Target moves the object without changing the relationship 
of the other parameters. Think of it as moving the entire 3D world 
where point of view does not change.

Target can be used in many cases as a global parameter. If you have 
already created an effect and want the whole effect to move higher 
across the frame or to appear inside another frame, such as a television 
on a set, Target is the way to move it. It is also good for offsetting 
another track slightly if you want to use a black graphics image as a 
drop shadow.
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Trail

Parameter type: Keyframeable

Use Trail to add a trail to an effect as it moves across the screen.

Table 10-21 Target Parameters

Parameter Description

X Moves the image along the screen’s X axis (horizontally). Values range from 
–999 to +999, where 0 is the default.

Y Moves the image along the screen’s Y axis (vertically). Values range from –999 
to +999, where 0 is the default.

Size Scales the image and maintains the aspect ratio. Values range from 0 to 400, 
where 100 is the default scale of 100 percent.

Table 10-22 Trail Parameters

Parameter Description

Decay Changes the rate of the trail’s decay, or dissipation, during the DVE’s motion. 
Adjustment ranges from a quick decay (close to 0) to a slower decay (close to 
100), where 75 is the default.

Use Sparkle Instructs the Avid system to paint a trail with sparkles. When Use Sparkle is 
not selected, the Avid system paints a trail using the image itself.
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n You do not see the trail when you step through the effect because it is a 
cumulative effect. Also, you cannot render a Trail effect.

3D Shape Effects

3D shape effects allow you to map the foreground video channel to 
various geometric shapes. You do this by selecting a shape from the 
Fast menu in the Shape parameter category. The following illustration 
shows the Shape menu and the five main categories of shapes.

Each shape effect displays a set of parameters that are specific to that 
shape in the Shape category. In addition, you can use any of the other 
3D effects parameters, such as Border, Scaling, Position, and Trail.

Page turns:
Page Turn
Page Curl
Page Fold

Splashes:
Single Wave
MultiWave

Ball Offset shapes:
Slats
Arrow
One Burst
Center Burst
Sawtooth
Sine Wave
Bumps

Scaling shapes:
Hour Glass
Bow Tie
Octagon
Hexagon
Rain Drop
Hour Glass 2
Hex Med
Hex Wide
Circle
Ellipse
Goblet
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Page Turns

A page turn effect treats the foreground video channel as though it 
were a sheet of paper being turned over or rolled up to reveal another 
page beneath. You can see the video on either side when you rotate the 
image or curl the edges. The portion of the image that folds over or 
rolls up is referred to as the flap.

Page Turn Parameters

This section describes parameters that are common to all three page 
turn effects. The following illustration shows the Shape parameter 
category with Page Turn selected.

n To soften the edges of a page turn effect, enable the Border parameter and 
adjust the Soft slider. You can soften a border of zero width.

Page Curl

Top

Flap
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The following parameters are common to all page turn effects.

Vary the Curl value from 0 to 100 with default radius to take the page 
from a flat, centered image to one that is completely off the screen.

In addition, there are three Fast menus: No Split, Tuck Over, and Auto 
Highlight. These Fast menu values are described in “Using the Page 
Turn Fast Menus” on page 675.

The following table describes the three Page Turn shapes that are 
accessible from the Fast menu in the Shape parameter category.

Table 10-23 Page Turn Parameters

Parameter Description

Curl Controls the distance the page rolls up. It specifies how far the rolling up has 
progressed. Values range from 0 to 100, where 0 represents no rollup.

Radius Controls the tightness of the curl or fold. Values range from 0 to 100, where 15 
is the default.

Angle Controls the direction of the curl or fold. Values range from –180 degrees to 
+180 degrees, where 45 degrees is the default.

Effect Description

Page Turn Creates the illusion of the top image rolling up into a 
scroll. This effect has one highlight.

Page Curl Page Curl is the same as Page Turn except that there 
are two highlights. One highlight is slightly wider and 
more intense than the other.

Page Fold Creates an illusion similar to turning a page in a book. 
The top image curls over and then becomes flat.
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Using the Page Turn Fast Menus

The following sections describe how you can use the Shape category 
Fast menus along with the Page Turn shape effect parameters to 
achieve various effects.

Adjusting Page Fold Angle Values

The following illustration shows how the Avid system interprets 
several angle values for the Page Fold with the default No Split option. 
Experiment with incremental angle values. Also experiment with 
changing angle values at different keyframes.

While you are experimenting with angle and offset values, it is useful 
to scale down the top video layer. This allows you to see the full effect 
as the video peels off the screen. For example, scaling 75 percent in 
both X and Y axes displays the page fold as a Picture-in-Picture effect.

–45 degrees +45 degrees +135 degrees –135 degrees

–90 degrees 0 degrees
+180 degrees
–180 degrees +90 degrees

Page Fold Angles
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Splitting a Page Turn or Page Fold Effect

You can access the splitting options through the No Split Fast menu in 
the Shape parameter category. A split gives the illusion of cutting the 
top image with a pair of scissors and folding or scrolling the resulting 
pieces. The following table describes the splitting options.

No Split Fast menu

Table 10-24 Page Turn Splitting Options

Option Description

No Split Folds or scrolls a single corner or edge, depending on the angle. This is the 
default option.

Horizontal Split Cuts the image in half horizontally. The two images are tied together so that 
they appear to scroll or fold in unison. The image separates from left to right.

Rev Horizontal Split 
(reverse horizontal 
split) 

Similar to Horizontal Split except that the image folds or scrolls from opposite 
sides at the same time.

Vertical Split Cuts the image in half vertically. The two images are tied together so that they 
appear to scroll or fold in unison. The image separates from top to bottom.

Rev Vertical Split 
(reverse vertical 
split)

Similar to Vertical Split except that the image folds or scrolls from opposite 
sides at the same time.

Quad Split Divides the image into four equal parts. Results depend on the starting and 
ending angle values (specify the starting and ending angles on different 
keyframes). For example, for a starting and ending angle of 135 degrees, the 
split begins in the center and the four inside corners roll outward.
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The following illustrations show how the Horizontal Split and 
Rev Horizontal Split options interpret angles.

Doubled Split Displays two scrolls of live video on the screen at the same time. Both scrolls 
roll off the video underneath.

Table 10-24 Page Turn Splitting Options (Continued)

Option Description
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Page Fold
Horizontal Split

Page Fold
Rev Horizontal Split

–45 degrees

+45 degrees

–135 degrees

+135 degrees
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Page Fold
Horizontal Split 
(continued)

Page Fold
Rev Horizontal Split 
(continued)

–90 degrees
(same for both)

+90 degrees
(same for both)

–180 degrees
+180 degrees

0 degrees



680

Manipulating the Flap and Bottom of a Page Fold

You can access the tuck and flap options through the Tuck Over Fast 
menu in the Shape parameter category. The following table describes 
the tuck and flap options.

Use Show Top Only and Show Bottom Only when you want to control 
the image in the flap or top. These are commonly used with two video 
channels. One channel shows the top and the other shows the bottom 
(the flap).

Top

Bottom (flap)

Tuck Over Fast menu

Table 10-25 Page Turn Tuck and Flap Options

Option Description

Tuck Over Folds the flap over the top. This is the default 
option.

Tuck Under Folds the flap under the top.

Show Top Only Shows the top without the flap.

Show Bottom Only Shows the flap (bottom) without the top.



681

For example, if you want an opaque top and a partially transparent 
flap, set a transparency value for the video channel containing Show 
Bottom Only. Use the Opac. slider in the Foregnd parameter category 
to adjust transparency. Note that in this example you would have to 
render one of these effects to see the result.

Show Top Only and Show Bottom Only are also useful when you want 
to apply an effect such as Defocus on just the flap or the top.

Highlight Options

You can access the highlight options through the Auto Highlight Fast 
menu in the Shape parameter category. The following table describes 
the highlight options.

Auto Highlight Fast menu

Table 10-26 Page Turn Highlight Options

Option Description

Auto Highlight Lets the Avid system control the highlighting. You need to enable 
highlighting in the Highlight parameter category in order for highlights to 
appear. You can also vary the intensity of the highlight in the parameter 
category. The Avid system takes care of the positioning automatically. 
Applies to all shapes except for the Ball shape.

Manual Highlight Lets you use the Highlight parameter category to control the highlighting. In 
this case, you need to set the angle, aspect ratio, radius, and so forth. Applies 
to all shapes, including the Ball shape.

Use the Highlight parameters (located near the bottom of the 3D Warp 
parameter list) to control manual highlighting. See “Highlight” on page 655.
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Splashes

Splashes create a wave effect as if you dropped a stone into still water. 
There are two choices on the Shape Fast menu:

• Single Wave creates a splash with one wave, as if you dropped a 
pebble into a very still pool.

• Multi Wave creates a splash with many waves or ripples, as if you 
dropped a stone into a pond.

Rev Manual 
Highlight 

Reverses the effect of manual highlighting you set up. Applies to all shapes, 
including the Ball shape.

Table 10-26 Page Turn Highlight Options (Continued)

Option Description

Multi Wave splash
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Splash Parameters

The following Shape parameters apply to splashes.

Table 10-27 Splash Effect Parameters

Parameter Description

Radius Controls the size of the waves and, therefore, the movement of the waves 
through the video. Values range from 0 to 100.

Freq 
(frequency)

For Multi Wave effects, controls the width and number of waves present at any 
given time. Increase the frequency to make the waves smaller and increase 
their number. Decrease the frequency to create fewer, wider waves. For Single 
Wave effects, determines the width of the single wave. Frequency values range 
from 0 to 100.

Ampl 
(amplitude)

Controls the depth of the troughs of the ripples and the height of the crests of 
the waves. You can think of this as the depth to which the image is distorted to 
produce the splash. Values range from 0 to 100. 

X Pos Moves the splash to the right or left. The values range from –999 to +999, 
where 0 is the center of the image. Values increase to the right and decrease to 
the left.

Y Pos Moves the splash up or down. Values range from –999 to +999, where 0 is the 
center of the image. Values increase as you go down and decrease as you go 
up.

Aspct 
(aspect ratio)

Distorts the shape from a circle to variations on an oval shape. Values range 
from –100 to +100, where 0 is a circle.

Angle Rotates the splash. This parameter has a visible effect only when the aspect 
ratio is other than 0. Values range from –180 to +180.
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Limitations to Splash Effects

The following limitations apply to Splash effects:

• You cannot apply the Z perspective to a Splash effect.

• The X and Y direct manipulation handles do not work for a Splash 
effect. Use the Rotation (X, Y, Z) sliders in the Rotation parameter 
category instead.

For a visual explanation of this limitation, see “Limitations to Ball 
Shapes” on page 685.

Ball

Use Manual Highlight 
to apply highlights to a 
Ball shape.

The Ball shape lets you treat the video as a rubbery, rectangular sheet 
stretched around a sphere. If the radius of the sphere is very large, the 
corners of the sheet curve along the surface like a rubber patch on a 
ball. If the radius is small, the corners disappear, wrapping completely 
around the sphere’s surface.

Ball effect with highlight 
and shadow
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Ball Effect Parameters

The following parameters apply to the Ball effect.

Limitations to Ball Shapes

The following limitations apply to Ball shapes:

• You cannot apply the Z perspective to a Ball.

• The X and Y direct manipulation handles do not work for a Ball. 
Use the Rotation sliders in the Rotation parameter category 
instead.

Table 10-28 Ball Effect Parameters

Parameter Description

Radius Changes the size of the ball. Values range from 0 to 100.

Curve Gives the ball a 3D effect. A value of 0 looks like a flat circle (and can be used 
as a Circle Wipe). Higher values give more depth to the ball’s shape. Values 
range from 0 to 100.

X Pos 
(X position)

Moves the shape to the right or left in relation to the image. The values range 
from –999 to +999, where 0 is the center of the image. Values increase to the 
right and decrease to the left.

Y Pos 
(Y position)

Moves the shape up or down in relation to the image. Values range from –999 
to +999, where 0 is the center of the image. Values increase as you go down 
and decrease as you go up.

Aspct 
(aspect ratio)

Changes the shape from perfectly round to a distorted shape. Values range 
from –100 to +100, where 0 is a circle.

Angle Rotates the axis of the shape. This effect is visible only when the aspect ratio is 
not zero. Values range from –180 to +180.
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n Once you rotate a Radial effect in X or Y using the sliders, no direct 
manipulation other than XY position will work. To regain access to the direct 
manipulation Z handle, reset the X and Y Rotation sliders to 0.

Offset Shapes

Offset shapes are separate portions of a live video image moving at the 
same time, in different directions, and at varying speeds.

Offset shapes are shown below. You can access the Offset shapes 
through the Fast menu in the Shape parameter category. 

Rotate around Z Axis Rotate around X Axis Rotate around Y Axis

Direct manipulation in Z 
works for Radial shapes.

Direct manipulation in X and Y does not work for 
Radial shapes. Use the Rotation sliders instead.

Slats Arrow One Burst Center Burst Sawtooth Sine Wave

Bumps
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Offset Shape Parameters

The following Shape parameters are common to all Offset shape 
effects.

n When experimenting with these shapes, start with a Frequency value of 1 and 
an Amplitude of 0. This makes it easier to see how changes in these values 
affect the image.

Table 10-29 Offset Shape Parameters

Parameters Description

Ampl (amplitude) Controls the distance the shape moves. For transition effects, increase the 
amplitude to take the effect off the screen.

Angle Changes the line along which the video pieces move. Values can range from 
–180 to +180. Use 0 for horizontal and 90 for vertical.

Freq (frequency) Controls how many copies of the offset shape appear on the screen.

Offset Repositions the shape on the image.

Sk Amp (skew 
amplitude)

Weaves the image through the slats. Think of this as weaving a “video cloth” 
through a loom.

Sk Angl (skew angle) Rotates the image through the slats.
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Slats

Slats split the image into alternating bands of video that enter the 
screen from opposite directions. Change the Amplitude to make the 
slats move in opposite directions.

Arrow

You can think of 3D Arrow as a specialized form of Slats. Each arrow 
contains seven rectangles that enter the screen at slightly different 
speeds from the same direction. The difference in speed creates the 
arrow shape. Use Frequency to change the number of arrows that 
appear on the screen at any given time. See “Offset Shapes” on 
page 686 for a description of the other sliders.
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One Burst

This is a burst in one direction. The Avid system separates the image 
into many straws, each with a height of one line. All straws move in 
the same direction but at different (random) speeds. Use Amplitude to 
increase the speed.

Center Burst

This is similar to One Burst except that the burst begins in the center of 
the image and the straws move in opposite directions rather than in 
one direction. Use Amplitude to increase the speed. See “Offset 
Shapes” on page 686 for a description of the other sliders.
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Sine Wave

This effect applies the image to a general sine curve, as seen on a 
mathematical graph. The video is twisted into a sine wave as it enters 
or leaves the screen. You can also think of it as a progression of 
connected waves. Amplitude stretches or compacts the waves. 
Frequency increases the number of waves.

Sawtooth

This is similar to a Sawtooth Wipe effect except that you have more 
control over the shape. Alternating slats of video turn and slide 
against each other to fill the screen or turn and slide away to reveal 
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incoming video. Amplitude changes the tilt of the slats. Frequency 
changes the size and number of the slats. Higher values increase the 
number of slats.

Bumps

The video in this effect billows out from fixed horizontal lines, like a 
sail or a sheet of fabric tacked to the horizontal beams of a fence.

• Amplitude stretches or compacts the bumps. Think of this as 
making the wind blow harder against the video fabric.

• Frequency increases the number of bumps (puts more beams on 
the fence).

• Change the Angle to change the line along which the video pieces 
move.

Scaling Shapes

The following illustration shows the Scaling shapes. They are called 
Scaling shapes because they give the illusion of the video “pouring” 
from one portion of the shape to the other. The image is scaled as it 
pours through a narrower or wider portion of the shape.

You can access the Scaling shapes through the Fast menu in the Shape 
parameter category.
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Scaling Shape Parameters

The following Shape parameters are common to all Scaling shapes.

n The interactive scaling feature is very useful when working with these effects.

Scaling shapes scroll down over the image as you increase the Offset 
value. The following illustrations show examples of Scaling shapes 
and the values used to obtain the image shown. 

Hour Glass Bow Tie Octagon Hexagon Rain Drop

Hour Glass 2 Hex Med Hex Wide Circle Ellipse Goblet

Table 10-30 Scaling Shape Parameters

Parameter Description

Ampl (amplitude) Controls the width of the shape. Negative values flip the image within the 
shape. Values range from –100 to +100.

Freq (frequency) Controls how many copies of the shape appear on the screen. Values range 
from –100 to +100.

Offset Moves the shape along the image from bottom to top. As one shape moves 
down, another shape “pulls down” from above. For an example, see the 
following illustrations. Values range from –100 to +100.

Skew Moves the shape and the image together to the left or right. Values range 
from –999 to +999, where 0 is the center of the display area.
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Hour Glass

The following illustration shows the values used to obtain the image 
shown. 

Bow Tie

The following illustration shows the values used to obtain the image 
shown. 
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Octagon

The following illustration shows the values used to obtain the image 
shown. 

Hexagon

The following illustration shows the values used to obtain the image 
shown. 
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Rain Drop

The following illustration shows the values used to obtain the image 
shown. 

Hour Glass 2

The following illustration shows the values used to obtain the image 
shown. 
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Hex Medium

The following illustration shows the values used to obtain the image 
shown. 

Hex Wide

The following illustration shows the values used to obtain the image 
shown. 
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Circle

The following illustration shows the values used to obtain the image 
shown. 

Ellipse

The following illustration shows the values used to obtain the image 
shown. 
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Goblet

The following illustration shows the values used to obtain the image 
shown. 

Avid Xpress 3D Effects

The Effect Palette — on systems equipped with the 3D Effects option 
— contains an Xpress 3D Effect category.

The Xpress 3D effects are completely compatible with Avid Xpress 
systems that are also equipped with the 3D Effects option. As a result, 
you can move sequences containing Xpress 3D effects between Avid 
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Media Composer or Film Composersystems, and Avid Xpress 
systems.

c To maintain compatibility when transferring sequences between 
Avid Media Composer or Film Composer systems and Avid Xpress 
systems, use only Xpress 3D effects (do not use the 3D Warp effect to 
create 3D effects).

The Xpress 3D effects include:

• 3D Arrow

• 3D Ball

• 3D Bumps

• 3D Center Burst

• 3D Multi Wave

• 3D PIP

• 3D Page Curl

• 3D Page Fold

• 3D Quad Split

• 3D Sine Wave

• 3D Slats

Xpress 3D Effects Parameters

Xpress 3D effects use a subset of the parameters that are available for 
the 3D Warp effect. For more information about a specific parameter 
that appears in the Effect Editor for an Xpress 3D effect, see “3D 
Effects Parameters” on page 636.
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Numerics
1:1 video

See Uncompressed video
1:1.66 Mask effect 548
1:1.85 Mask effect 549
14:9 Letterbox effect 598
16:9 display

in the Title tool 273
16:9 Letterbox effect 597
16:9 Mask effect 550
24p editing projects

finding flaws from telecine transfer 428
24p or 25p editing projects

with multiformat titles 323
24p or 25p titles 323
2D effects 456
3D effects 221
3D Page Fold effect 674
3D Promote button (Effect Editor) 121
3D titles

promoting from 2D 362
3D Warp effect 223
4 Corners Shape Wipe effect 605
4:3 Sidebar effect 598

A
Acceleration parameter (2D) 458
Acceleration parameter (3D) 640
Actions parameters (2D) 459
Add Dissolve button 74
Add Edit function

with Submaster effects 214
Add Keyframe button (Effect Editor) 120
Add Page command (Object menu) 295
Adding

highlights (3D) 656
pages in Title tool 295
spline points 668

Adjusting
Pan and Scan effect 204
shadow softness 304

Align to Frame commands (Alignment menu) 
311

Alignment
of title text 280
of titles 311

Alpha channel
in 3D Matte Key effect 225
in Matte Key effects 183
title creation with 268

Anamorphic Mask effect 549

Index

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 
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AniMatte effect
animating 448
applying 368
described 365, 562
exporting as PICT file 421
matte wipe example 452
modes 375
parameters for 373, 460
position information for 114
rendering 367
using Magic Mask 440

Anti-aliased elements in title 268
Applying

Dissolve effects 72
Pan and Scan effect 191
Submaster effect 214
title styles 331

Arrow effect (3D) 688
Arrowheads in titles 289
Aspect ratio

See also Fixed Aspect parameter
adjusting with Pan and Scan effect 188
fixed aspect 508
image size 670
selecting within Pan and Scan effect 192

Aspect Ratio parameters (2D) 475
Assigning multiple tracks in AVX plug-ins 53
AudioSuite plug-ins

described 47
Auto Size Mode command (Object menu) 292
Avid MediaManager 165
Avid Unity workgroup environment 165
Avid Visual Extensions (AVX)

defined 46
AVX (Avid Visual Extensions)

defined 46
AVX plug-ins

assigning multiple tracks in 53
blank icons in Timeline 57
described 47
installing 49

interfaces and parameters for 54
locating AVX_Plug-Ins folder

Macintosh 50
Windows 51

memory usage 47, 57
messages in Console 57
missing effect categories 57
missing icons 56
plug icon 46
problems with rendering 57
resetting parameters to default values 233
RGB Keyer 173
troubleshooting 56
upgrading 52
vendors 46
Web site for 46

Axes in rotation (3D) 229
Axis as a transition (3D) 255
Axis parameters (3D) 641

B
Background color

selecting 270
Background Color parameters (3D) 642
Background parameters (2D) 476
Ball effects (3D) 684
Bézier curves

described 393
manipulating 395

Bias setting for Spline 666
Big Effect mode 103
Bins

effect templates in 44, 137
revising titles in 320
titles in 341
viewing Fast saved titles in 319

Blend effects
3D Warp 223
Dip to Color 514
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Dissolve 515
Fade from Color 516
Fade to Color 517
Picture-in-Picture 518
Superimpose 519

Blowup effect
described 551
position information for 115

Blowup parameters (2D) 477
Blue dot 42
Blur mode

Paint Effect example 446
Bolding title text 280
Border parameters (2D) 478
Border parameters (3D) 643
Bottom Box Wipe effect 521
Bottom Centered Squeeze effect 618
Bottom Left Corner Peel effect 580
Bottom Left L-Conceal effect 568
Bottom Left Squeeze effect 619
Bottom Left to Top Right Box Wipe effect 522
Bottom Left to Top Right Conceal effect 530
Bottom Left to Top Right Push effect 589
Bottom Right Corner Peel effect 581
Bottom Right L-Conceal effect 569
Bottom Right Squeeze effect 620
Bottom Right to Top Left Box Wipe effect 523
Bottom Right to Top Left Conceal effect 531
Bottom Right to Top Left Push effect 590
Bottom to Top Conceal effect 532
Bottom to Top Peel effect 582
Bottom to Top Push effect 591
Bottom to Top Squeeze effect 621
Bow Tie effect (3D) 693
Box Wipe effects

Bottom Box 521
Bottom Left to Top Right 522
Bottom Right to Top Left 523
Left Box 524
Right Box 525
Top Box 526

Top Left to Bottom Right 527
Top Right to Bottom Left 528

Brightness (luminance)
defined 476

Bring Forward button (Effect Editor) 418, 419
Bring Forward command (Object menu) 308, 

418
Bring to Front command (Object menu) 308, 

419
Brush parameters (2D) 474
Brush tool

creating a custom shape for 378
painting with 376
saving a template 379

Bumps effect (3D) 691
Buttons

3D Promote (Effect Editor) 121
Add Dissolve 74
Add Keyframe (Effect Editor) 120
Bring Forward (Effect Editor) 418, 419
Collapse 216
Dual Split (Effect Editor) 120
Effect Mode 101
Enlarge (Effect Editor) 120
Extract/Splice-in 71
Fade Effect 71, 350
Grid 106, 112
in Effect Editor 119
Lift/Overwrite 71
mapping in Effect mode 104
Match Frame 92
Motion Effect 92, 96
Other Options (Effect Editor) 119
Outline/Path (Effect Editor) 120
Play (Effect Editor) 120
Play Loop (Effect Editor) 120
Play Preview (Effect Editor) 120
Reduce (Effect Editor) 120
Remove Effect 69
Render Effect (Effect Editor) 120
Rolling Title (Roll) (Title tool) 293
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Scratch Removal 426
Send Backward (Effect Editor) 418, 419
Step Backward One Field 117
Step Forward One Field 117
Step In (Timeline) 208
Step Out (Timeline) 208
Timeline View Name (Timeline) 58
Transition Effect Alignment 74
Video Background (Title tool) 270

C
Center Box Shape Wipe effect 606
Center Burst effect (3D) 689
Centered on Cut option

described 511
using 74

Centered Zoom Squeeze effect 622
Changing perspective (3D) 657
Chroma Adjust parameters (2D) 484
Chroma Key

2D parameters for 496
Chroma Key effect

3D parameters for 653
creating 176
creating 3D version 257
described 563
post-key color correction for 178

Chrominance with Color Effect 484
Circle effect (3D) 697
Circle Shape Wipe

as constraining effect in nest 207
Circle Shape Wipe effect

described 607
Clearing a stamp 255
Client monitor

setting up 195
Clock Shape Wipe effect 608
Collapse button 216
Collapsing layers 216

Color
background 270
blending in titles 299
changing parameter settings 125
for Paint Effect 376
safe limits for titles 269
selecting for titles 296

Color coding for effects 32, 42
Color Correction parameters (2D) 497
Color Effect

described 554
parameters for 479
preparing high-contrast image with 182

Color Gain parameters (2D) 486
Color Style parameters (2D) 485
Command palette

mapping buttons from 104
Commands

See Menu commands
Comparison of 2D effects 634
Conceal effects

Bottom Left to Top Right 530
Bottom Right to Top Left 531
Bottom to Top 532
L-Conceal 567
Left to Right 533
Right to Left 534
Top Left to Bottom Right 535
Top Right to Bottom Left 536
Top to Bottom 537

Console
AVX plug-in messages in 57
Disable3D and Enable3D commands 222

Continuity
versus Tension in motion path 667
with Spline 666

Control points in Intraframe objects
adding 404
deleting 405
described 394
moving 406
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removing 405
selecting 406

Controlling image sharpness (3D) 647
Coordinate system for 3D effects 228
Coordinates

displaying in monitors 112
displaying position 113

Copy command
for graphic objects 307
for title elements (Edit menu) 274

Copy command for title elements (Edit menu) 
307

Corner Pin parameter (3D) 644
Corner pinning an image 251
Creating

keyframes 130
multiformat titles 324
nested effects 209

Creating 3D effects
Corner Pin 251
cropped foreground 247
Page Curl transition 238
Quad Split Page Turn 240
Stamp 254
with Axis as a transition 255

Crop parameters (2D) 487
Crop parameters (3D) 645
Cropped foreground effect

3D example 247
Curve tool for Intraframe editing 391
Custom Start option

See also Transition effects
described 511
using 74

Cut command for title elements (Edit menu) 
307

Cut list
position information in 114
with Previsualization Marker tool 

information 409

D
Defocus parameters (3D) 647
Deleting

effect media files 165, 170
motion effect media 170

Diamond Shape Wipe effect 609
Digidesign AudioSuite plug-ins 47
Dip to Color effect

described 514
Disable3D command (Console) 222
Dissolve effects

Add Dissolve button 74
applying 72
Blend 515
creating splash as 242
duration of 73
Film 552

Dissolve Icons command (Timeline Fast menu) 
58

Distribute Objects commands (Alignment 
menu) 312

Distributing titles 312
Downstream key (DSK)

defined 32
Downstream Key parameter (2D) 488
Drawing environment

preparation in Title tool 267
Drawing tools (Title tool)

Arrowhead tool 289
Border Width tool 287
Box Corner tool 286
circles and ovals 285
lines 286
squares and rectangles 285

Drop shadow
3D effects 662

DSK (downstream key)
defined 32
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DSK (downstream key) titles and graphics
converting to non-DSK 338
described 262, 337
limitations with 337
parameter control for 488
playback capabilities 341

Dual Split button (Effect Editor) 120
Dupe Detection command (Timeline Fast menu) 

153
Duplicate command for title elements (Edit 

menu) 307

E
Edge Wipes

Horizontal 539
Horizontal Open 540
Lower Left Diagonal 541
Lower Right Diagonal 542
Upper Left Diagonal 543
Upper Right Diagonal 544
Vertical 546
Vertical Open 545

Edit decision list (EDL)
using 213
with Submaster effects 213

Editing
Submaster effects 213, 214
titles into sequence 343
with imported matte keys 183
with titles 336

EDL (edit decision list)
with Submaster effects 213

Effect categories
Blend 514
Box Wipe 520
Conceal 530
Edge Wipe 538
Film 547
Image 554

Key 562
L-Conceal 567
listed 39, 513
Matrix Wipe 572
Peel 579
Push 588
Sawtooth Wipes 599
Shape Wipe 604
Spin 613
Squeeze 617

Effect Editor
buttons in 119
color parameters in 125
for adjusting titles 351
for Intraframe editing 369
keyframes in 121
Other Options button in 119
parameter sliders in 119
triangular opener in 119

Effect Grid
customizing for a single effect 114
described 107
displaying in Effect mode 112
setting options for 108
using with Pan and Scan effect 197

Effect Icons command (Timeline Fast menu) 58
Effect media files

deleting 170
revealing 166
viewing and deleting 165

Effect mode
enabling Big Effect mode 103
entering 101
mapping buttons in 104

Effect Mode button 101
Effect Palette

about 39
display of plug-ins in 46
displaying 40
Dissolve effects in 73
effect categories in 39
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resizing 41
using 39

Effect parameters
2D versions 456
3D versions 637
accessing with Other Options button 124
adjusting 123
displaying 117
for transitions 511
making slider adjustments 124

Effect Preview monitor
described 102
displaying safe title/action area in 105
grid display in 107
moving enlarged image in 121
tracking information in 105
with Big Effect mode 103
zooming in 233

Effect template
applying 138
defined 136
displaying in bin 44
for 3D effects 233
for Intraframe effects 374
saving 137
viewing 44

Effects
See also Effects (3D)
2D, promoting to 3D 225
applying Intraframe 368
applying one 64
applying to multiple segments 67
applying to multiple transitions 66
applying to multiple transitions using Add 

Dissolve button 78
changing position in 116
color coding for 42, 43
creation tools for 31
deleting a single effect 69
deleting multiple effects 70
motion, creating 82

Pan and Scan 187, 188
playback with uncompressed video 35
Reformat category 187
rendering at position 147
rendering between IN and OUT points 148
rendering one 145
replacing existing 129
size of source media 81
Submaster 213
templates for 44
types of 29
using Color to prepare high-contrast image 

182
using wire frames with 134
wire-frame preview of 140

Effects (2D)
parameters for 456
types 456

Effects (3D)
adjustment handles 234
applying 223
applying 3D Warp 223
compatibility between Avid systems 258, 

698
coordinate system for 228
creating a transition using Axis 255
creating Chroma Key 257
creating Corner Pin 251
creating cropped foreground 247
creating Page Curl 238
creating Quad Split Page Turn 240
creating Splash 242, 245
creating Stamp 254
custom effects 674
keys 460, 497, 562, 564, 565, 566, 650, 653
matte key 225
motion path in 235
overview 220
parameter adjustments 231
parameters described 637
promoting from 2D 225
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resetting parameters to default 233
Shapes 672
templates for 233
turning on and off 221
using Spline parameter 249
Xpress 3D category 258

Ellipse effect (3D) 697
Ellipse Shape Wipe effect 610
Enable3D command (Console) 222
Ending at Cut option

in Transition effect 511
using 74

Enlarge button (Effect Editor) 120, 133
Enlarged image

moving in Effect Preview monitor 121
Entering

Effect mode 101
Erode/Expand parameters (3D) 648
ExpertRender

considerations when using 158
described 154
examples 159
modifying results of 156
rendering with 154

ExpertRender commands (Clip menu) 155
Export Title command (File menu) 333
Exporting

AniMatte effect as a PICT file 421
titles as graphics files 333

Extract/Splice-in button 71
Eyedropper

adjusting a color with 297
choosing a color with 376
using 125

F
Fade Effect button

described 71
for fading titles 350

Fade for film 553
Fade from Color effect 516
Fade to Color effect 517
Fading effects 71
Fast Frame Display command (Special menu) 

429
Fast motion effect

compared to other motion effects 578
creating 92
described 578
reversing 94

Fast rolling title playback issues 349
Fast Save option for titles

described 318
saving with 319

Fast Save titles
viewing in bin 319

Feathering for Intraframe effects 392
Feathering parameters (2D) 470
Field parameter for Blowup effects 477
Film Dissolve effect 552
Film effects

1:1.66 Mask 548
1:1.85 Mask 549
16:9 Mask 550
Anamorphic Mask 549
Blowup 551
Dissolve 552
Fade 553
Mask 553

Film Fade effect 553
Film Mask effect 553
Film projects

obtaining position information in 114
Fixed Aspect parameter

in 2D Scaling parameters 508, 661
in 3D Target parameters 670

Flaws 424
Flip effect 555
Flip-Flop effect 556
Flop effect 557
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Fonts
choosing 278
compatibility between systems 267
installing 267
setting point size 279
substituting 268

Foreground keys (3D)
Chroma 653
Full 650
Luma 651

Foreground parameters (2D) 489
Foreground parameters (3D) 649
Formatting title text 277
Four Corners Shape Wipe effect 605
Freeze Frame command (Clip menu) 89
Freeze Frame effect

See also Motion effects
creating 89
described 578
parameters for 499

Freezing a rolling clip 91
Full key on 3D effects 650
Function keys

using with title styles 328

G
Gain

with color effect 486
Gain with key effects 493
Global versus keyframeable parameters 457
Glow effect on titles 306
Goblet effect (3D) 698
Graphics

converting DSK to Matte Key effect 338
Graphics in titles

displaying grid for 272
drawing 284

Green dot 42

Grid
effect grid 107
for title alignment 272
options 110
parameters in Effect Editor 114
Safe Action setting 111
Safe Title setting 111
snapping to in Title tool 272

Grid button
for Safe Title/Safe Action 106
in Effect mode 112

Grid Matrix Wipe effect 573
Group command (Object menu) 309, 420
Grouping and ungrouping

Intraframe objects 420
titles 309

H
Halo effect with titles 306
Handles for adjusting 3D effects 234
HDTV aspect ratio

in the Title tool 273
Height parameter (2D) 661
Hex Medium effect (3D) 696
Hex Wide effect (3D) 696
Hexagon effect (3D) 694
High-contrast images 182
Highlight parameters (3D) 656
Hollow drag handles for locked objects 310
Horizontal Bands Shape Wipe effect 611
Horizontal Blinds Shape Wipe effect 612
Horizontal Centered Squeeze effect 623
Horizontal Edge Wipe effect 539
Horizontal effects

defined 30
Horizontal Open Edge Wipe effect 540
Horizontal Open Sawtooth Wipe effect 601
Horizontal Sawtooth Wipe effect 600
Hour Glass 2 effect (3D) 695
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Hour Glass effect (3D) 693
Hue

defined 476

I
Icons

Timeline display of 58
Title effect 336

Image effects
Color 554
Flip 555
Flip-Flop 556
Flop 557
Mask 557
Paint 558
Pan and Scan 599
Resize 559
Scratch Removal 560
Submaster 561

Imported master clips
editing with 186

Installing
AVX plug-ins 49

Insufficient Source message 81, 236
Interfaces for AVX plug-ins 54
Interrupting

Render On-the-Fly 37
rendering of effects 151

Intraframe editing
Brush tool 376
changing effect parameters 392
creating polygon shapes 385
Curve tool 391
customizing Brush shape 378
described 365
drawing tools 374
examples of 439
modes described 375
Oval tool 383

Polygon tool 384
Previsualization Marker tool 408
Rectangle tool 382
rendering during 367
saving a brush template 379
single-field step with 374
summary of line and curve modification 401
using control points 404
using keyframes 415
using pen tool for 376
using Selection tool 381
with Magic Mask 440

Intraframe objects
grouping and ungrouping 420
layering 416
locking and unlocking 420
moving 410
reshaping 411
rotating along Z axis 413
scaling 414

Invert Key option 490
Inverting color effects 480
Inverting keys

Chroma 654
Full 650
Luma 652

Isolating flaws for removal 426
Italic text in titles 280

J
Justification of title text 280

K
Kerning of title text 281
Key Color parameter (2D) 495
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Key effects
3D matte keys 225
AniMatte 562
Chroma 563
Chroma (3D) 653
creating Chroma 176
creating Luma 178
creating Matte 179
described 173
Full 650
Luma 564, 651
Matte 183, 565
RGB Keyer 566

Key parameters (2D) 492
Keyboard shortcuts

saving titles with 318, 318
Keyframes

3D parameters with 638
copying and pasting 132
creating 130
defined 129
deleting 133
for adjusting titles 352
moving or changing 131
selecting 130
with Intraframe effects 415

L
Layering

Intraframe objects 416
titles 308

Layers 172
L-Conceal effects 567

Bottom Left 568
Bottom Right 569
Top Left 570
Top Right 571

Leading for title text 283
Left Box Wipe effect 524

Left Centered Squeeze effect 624
Left to Right Conceal effect 533
Left to Right Peel effect 583
Left to Right Push effect 592
Left to Right Squeeze effect 625
letterboxing 187
Lift/Overwrite button 71
Limitations

for DSK titles and graphics 337
for non-DSK titles 340
for playing fast rolling titles 349
to size of rolling titles 291

Lines
attribute options 286
in titles 286

Locating AVX_Plug-Ins folder
Macintosh 50
Windows 51

Lock command (Object menu) 310, 421
Locked objects

hollow handles indicating 310
Locking and unlocking

Intraframe objects 420
titles 310

Lossless images 32, 262
Lower Left Diagonal Edge Wipe effect 541
Lower Right Diagonal Edge Wipe effect 542
Luma Adjust parameters (2D) 479
Luma Clip parameters (2D) 483
Luma Key effect

creating 178
described 564
with 3D effects 651

Luma Range parameters (2D) 481
Luminance

defined 476
of color effect 479
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M
Macintosh Color Picker 127, 297
Magic Mask 440
Magic Mask parameters (2D) 472
Magnified image

moving in Effect Preview monitor 121
Marks

setting in rolling titles 343
Mask effect 557
Match Frame button 92
Matching resolutions with titles 314
Matrix parameters (2D) 498
Matrix Wipes

Grid 573
One-Way Row 574
Speckle 575
Spiral 576
Zig-Zag 577

Matte Control parameters (2D) 496
Matte Key effect

3D version 225
creating 179
described 565
editing with 183
in nested layers 211
preparing high-contrast image for 182

Matte key effect
applying 449

Media
deleting 170

Media files
insufficient source material 81
managing

procedure 166
Memory usage

AVX plug-ins 47
Menu commands

Add Page (Object menu) 295
Align Objects (Alignment menu) 311
Align to Frame (Alignment menu) 311

Auto Size Mode (Object menu) 292
Bring Forward (Object menu) 308, 418
Bring to Front (Object menu) 308
Bring to Front (Object menu)) 419
Copy (Edit menu) 307
Cut (Edit menu) 307
Dissolve Icons (Timeline Fast menu) 58
Distribute Objects (Alignment menu) 312
Dupe Detection (Timeline Fast menu) 153
Duplicate (Edit menu) 307
Effect Icons (Timeline Fast menu) 58
ExpertRender (Clip menu) 155
Export Title (File menu) 333
Fast Frame Display (Special menu) 429
Freeze Frame (Clip menu) 89
Group (Object menu) 309, 420
Lock (Object menu) 310, 421
New Title (Clip menu) 262
Paste (Edit menu) 307
Preview (Object menu) 268
Re-create Title Media (Clip menu) 358
Render On-The-Fly (Special menu) 36
Render Ranges (Timeline Fast menu) 152
Reveal File (File menu) 168
Safe Colors (Object menu) 269
Safe Title Area/Global Grid (Object menu) 

269
Send Backward (Object menu) 308, 418
Send to Back (Object menu) 308, 419
Set Bin Display (Bin menu) 167, 341
Show Alignment Grid (Alignment menu) 

272
Snap to Grid (Alignment menu) 272
Soften Shadow (Object menu) 304
UnGroup (Object menu) 309, 420
Unlock (Object menu) 311, 421

Mode parameters (2D) 460
Modes

for Intraframe editing 375
Modifying

results of ExpertRender 156
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Monitors
setting up for Pan and Scan effect 195

Motion Effect button 92, 96
Motion Effect media

deleting 170
revealing 166

Motion effects
creating a freeze frame 89
creating strobe motion 96
creating variable speed 92
defined 29, 82
fast motion 578
Freeze Frame 578
freezing a rolling clip 91
parameters for 499, 578
playback capabilities for 83
rendering existing 84
rendering requirements for 83
slow motion 578
Strobe Motion 578
Variable Speed 578

Motion path 133
Motion path editor 235
Moving perspective point (3D) 657
Multi Wave splashes (3D) 682
Multiformat titles

creating 324
described 323
editing into sequences 355
moving between projects 355
re-creating 361
saving 324
with Pan and Scan effect 190

Multilayer effects
3D Matte Key 225
defined 29
deleting 70
described 29
overlapping of 36
Picture-in-Picture 518
Submaster 561

N
Nested effects

creating 209
defined 206
expanding in Timeline 209
stepping in and out 208
video layers in 206
with matte key 211
with the Submaster effect 213

New Title command (Clip menu) 262
Non-DSK titles

limitations with 340
Non-real-time effects

overlapping with real-time effects 36
rendering 36, 140

NTSC frame and safe title/action guidelines 
269

O
Octagon effect (3D) 694
Offset shapes (3D)

Arrow 688
Bumps 691
Center Burst 689
described 686
One Burst 689
Sawtooth 690
Sine Wave 690
Slats 688

One Burst effect (3D) 689
One-Way Row Matrix Wipe effect 574
Optical list

position information in 114
with Previsualization Marker tool 

information 409
Orange dot 32
Origin

setting in Pan and Scan effect 199
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Other Options button (Effect Editor) 119
Outline/Path button (Effect Editor) 120
Output formats

for Pan and Scan effect 190
Oval Tool for Intraframe editing 383
Overlapping effects 36

P
Page Curls (3D) as transition 238
Page number display in Title tool 295
Page Turns (3D) 673

creating quad split 240
Paint Effect

applying 368
choosing color 376
creating signature effect 380
described 365, 558
example of Blur mode 446
modes 375, 463
painting with Brush tool 377
parameters for 369, 460
position information for 114
rendering 367
using Magic Mask 440

PAL frame and safe title/action guidelines 269
Pan and Scan effect

adjusting 204
applying 191
combining with transition effects 205
described 188, 599
Grid parameter category in 114
output formats for 190
placing on video track 206
positioning the Pan and Scan track 190
selecting aspect ratios in 192
setting an origin in 199
setting up monitors for 195
subdividing 200
using Effect Grid with 197

using multiformat titles with 190
viewing media in 196
wire frame display in 202

Pan and Scan effects 187
Parameters (2D)

Acceleration 458
Actions 459
AniMatte effect 373, 460
Aspect Ratio 475
Background 476
Blowup 477
Border 478
Brush for Paint and AniMatte effects 474
Chroma Adjust 484
Chroma Key 496
Color Correction 497
Color Effect 479
Color Gain 486
Color Style 485
Crop 487
described 456
Downstream Key 488
Feathering for Paint and AniMatte effects 

470
Foreground 489
Key 492
Key Color 495
listed 456
Luma Adjust 479
Luma Clip 483
Luma Range 481
Magic Mask for Paint and AniMatte effects 

472
Matrix 498
Matte Control 496
Mode for Paint and AniMatte effects 460
Motion effect 499
Paint Effect 369, 460
Position 505
Profile 507
Scaling 508
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Scratch 509
Scroll Position V 506
Secondary Key 493
Spill Suppression 494
Transition 73, 511

Parameters (3D)
Acceleration 640
Axis 641
Background Color 642
Border 643
Corner Pin 644
Crop 645
Defocus 647
described 636
Erode/Expand 648
Foreground 649
Highlight 656
keyframe 638
listed 636
Perspective 657
Position 658
Profile 659
Rotation 660
Scaling 661
Shadow 662
Skew 663
Spill Suppression 663
Spline 665
Stamp 669
Target 670
Trail 671

Parameters for AVX plug-ins 54
Partial render

described 150
example 150

Paste command
for title elements (Edit menu) 274

Paste command for title elements (Edit menu) 
307

Path
for Intraframe editing effects 474
in effect motion 235

Peel effects
Bottom Left Corner 580
Bottom Right Corner 581
Bottom to Top 582
Left to Right 583
Right to Left 584
Top Left Corner 585
Top Right Corner 586
Top to Bottom 587

Pen tool for intraframe editing 376
Perspective parameters (3D) 657
Photoshop-compatible plug-ins 47
Picture-in-Picture effect

described 518
foreground image movement 133

Pinning corners (3D) 644
Play button (Effect Editor)

described 120
Play Loop button (Effect Editor)

described 120
Play Preview button (Effect Editor) 120
Playback capabilities

of real-time effects 33
Playback of effects

basic playback 139
in a loop 140
in a wire-frame preview 140
in Effect mode 139
real-time effect renderings 43
Submaster restriction 561

Plug-in effects
AVX (Avid Visual Extensions) 46
Digidesign AudioSuite

using 46
Polygon shape creation 385
Polygon tool for Intraframe editing 384
Position coordinates

displaying 113
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Position display for two-field media 105
Position information

for Blowup effect 115
for Paint and AniMatte effects 114
obtaining in a film project 114

Position parameters (2D) 505
Position parameters (3D) 658
Posterization

constrained by nested Circle Shape Wipe 
207

of Color Effect 485
Post-key color correction 178
Preview command (Object menu) 268
Previewing anti-aliased titles 268
Previsualization Marker tool

described 408
using 409
with cut list 409

Profile parameter (2D) 507
Profile parameter (3D) 659
Project window

managing title styles in 332
Projects

moving from Macintosh to Windows NT 
268

moving from Windows NT to Macintosh 
268

Push effects
Bottom Left to Top Right 589
Bottom Right to Top Left 590
Bottom to Top 591
Left to Right 592
Right to Left 593
Top Left to Bottom Right 594
Top Right to Bottom Left 595
Top to Bottom 596

Q
Quad Split Page Turn (3D) 240

R
R button for Rolling Title mode 293
Radial shapes

Ball 684
Splashes

Raindrop effect (3D) 695
Real-time effects

color coding for 32, 42
combined with rendered effects 140
defined 32
limitations for 36
playback capabilities of 33
playback with two streams of video 33
rendering of 140

Recalling title styles 330
Re-create Title Media command (Clip menu) 

358
Re-creating

multiformat titles 361
titles 357

Rectangle tool for Intraframe editing 382
Reduce button (Effect Editor) 120, 133
Reformat effects

14:9 Letterbox 598
16:9 Letterbox 597
4:3 Sidebar 598
Pan and Scan 599

Reformat effects category 187
Remove Effect button 69
Removing

titles from a sequence 349
Render Effect button (Effect Editor) 120
Render On-the-Fly

interrupting 37
Render On-The-Fly command (Special menu) 

36
Render Ranges command (Timeline Fast menu) 

152
Render settings

creating and using 142
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Rendered effects
color coding for 43
combining with real-time effects 337
Submaster icon color code 214
viewing in bins 341

Rendering
a single effect 145
AniMatte effect 367
AVX plug-ins 57
combining real-time and non-real-time 

effects 36
displaying render ranges 152
during Intraframe editing 367
effects 140
effects at position 147
effects between IN and OUT points 148
ExpertRender examples 159
interrupting 151
multiple effects with Submaster 214
Paint Effect 367
saving partially completed renders 150
Submaster restriction 561
titles 356
using ExpertRender 154

Replacing
existing effects 129
title fill tracks 356
titles in a sequence 350

Reshape tool for Intraframe effects 411
Resize effect 559
Resizing

Effect Palette 41
Resolution

compatibility in titles 314
Reveal File command (File menu) 168
Revealing effect media files 166
Revealing motion effect media 166
Reverse Animation option 489

Reversing
fast motion effects 94
motion effects 505
slow motion effects 94

Revising titles in a sequence 352
RGB Keyer

applying 176
described 173
post-key color correction 178

RGB Keyer effect 566
Right Box Wipe effect 525
Right Centered Squeeze effect 626
Right to Left Conceal effect 534
Right to Left Peel effect 584
Right to Left Push effect 593
Right to Left Squeeze effect 627
Rolling Title (Roll) button (Title tool) 293
Rolling titles

adding pages to 295
defined 290
deleting pages 295
page numbers for 295
parameter for 506
resizing 293
scrolling through 294
setting marks in 343
size limits 291
text formatting for 292
trimming 348
typing text 293
working with colored backgrounds 291

Rotation axes (3D) 229
Rotation buttons 660
Rotation parameters (3D) 660

S
Safe Action option (Grid settings) 111
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Safe Colors command (Object menu) 269
Safe Title Area/Global Grid command (Object 

menu) 269
Safe Title option (Grid settings) 111
Safe title/action area

displaying 105
for aligning objects 311
in Title tool 269

Saturation
defined 476
of colors in titles 269

Saving
multiformat titles 324
partially completed renders 150
title styles 327
titles 314
titles with a keyboard shortcut 318
titles with Fast Save option 319
titles, overview of 313

Sawtooth effects (3D) 690
Sawtooth Wipes

Horizontal 600
Horizontal Open 601
Vertical 603
Vertical Open 602

Scaling Intraframe objects 414
Scaling parameters (2D) 508
Scaling parameters (3D) 661
Scaling shapes (3D)

Bow Tie 693
Circle 697
defined 691
Ellipse 697
Goblet 698
Hex Medium 696
Hex Wide 696
Hexagon 694
Hour Glass 693
Hour Glass 2 695
Octagon effect 694
Raindrop 695

Scratch parameters (2D) 509
Scratch removal

finding flaws from telecine transfer 428
isolating flaws 426
parameter setting examples 435
removing flaws 429
selecting clean material 425
using effect parameters 434
using nearby frame or field 424
within single frame or field 424
workflow for 423

Scratch Removal button 426
Scratch Removal effect

described 366
summarized 560

Scroll Position V parameter (2D) 506
Secondary Key parameters (2D) 493
Segment effects

14:9 Letterbox 598
16:9 Letterbox 597
4:3 Sidebar 598
AniMatte 562
Blowup 551
Chroma Key 563
Chroma Key (3D) 653
Chroma Key editing 173
Color Effect 554
defined 29
deleting 69, 70
fading 71
Film masks 547
Flip 555
Flip-Flop 556
Flop 557
Luma Key 178, 564, 651
Mask 557
Matte Key 565
Paint 558
Pan and Scan 599
Picture-in-Picture 518
Resize 559
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RGB Keyer 566
Scratch Removal 560
Submaster 213, 561
Superimpose 519

Selecting
keyframes 130

Selection tool
defined 266
for grouping objects 309
for ungrouping objects 309
text options for titles 278
viewing attributes with 278
with Intraframe editing 381

Send Backward button (Effect Editor) 418, 419
Send Backward command (Object menu) 308, 

418
Send to Back command (Object menu) 308, 419
Sequences

title editing in 343
Set Bin Display command (Bin menu) 167, 341
Settings

Grid 110
Render 142
Title Styles 332

Shadow parameters (3D) 662
Shadow softness

adjusting 304
viewing current setting 306

Shadows for titles 302
Shape Wipes

4 Corners 605
Center Box 606
Circle 607
Clock 608
Diamond 609
Ellipse 610
Horizontal Bands 611
Horizontal Blinds 612
Vertical Blinds 613

Shapes (3D)
about 672
Ball 684
Offset 686
Page Turns 673
Scaling 691
Splashes 682

Sharpness of focus (3D) 647
Short clips

using Submaster effect with 215
Shortcuts

saving titles with keyboard 318
Show Alignment Grid command (Alignment 

menu) 272
Show Alpha option 490
Sine Wave effect (3D) 690
Single Wave splashes (3D) 682
Single-field step 117, 374
Single-layer effects

defined 29
Single-stream option

playback capabilities with 35
title playback with 341

Size of effect
adjusting 670
fixed aspect 671
foreground image 134
source media 81

Skew parameters (3D) 663
Slats effect (3D) 688
Sliders

adjusting effect parameter 124
Slow motion effect

creating 92
described 578
reversing 94

Smoothing a path (3D) 665
Snap to Grid command (Alignment menu) 272
Soft shadows

adding to titles 304
Soften Shadow command (Object menu) 304
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Softness parameter for borders 479
Solarization of color effect 485
Speckle Matrix Wipe effect 575
Speed of an effect and video underruns 36
Spill Suppression parameters (2D) 494
Spill Suppression parameters (3D) 663
Spin effects

X Spin 614
Y Spin 615
Z Spin 616

Spiral Matrix Wipe effect 576
Splashes (3D)

creating dissolve 242
described 682
making into flat images 245

Spline parameters (3D)
adding a point 668
Bias setting 666
Continuity setting 666
defined 665
Tension setting 665
using 249

Squeeze effects
Bottom Centered 618
Bottom Left 619
Bottom Right 620
Bottom to Top 621
Centered Zoom 622
Horizontal Centered 623
Left Centered 624
Left to Right 625
Right Centered 626
Right to Left 627
Top Centered 628
Top Left 629
Top Right 630
Top to Bottom 631
Vertical Centered 632

Stamp (3D)
clearing 255
creating 254

Stamp parameters (3D) 669
Starting at Cut option

described 511
using 74

Step Backward One Field button 117
Step Forward One Field button 117
Step In button (Timeline) 208
Step Out button (Timeline) 208
Stepping

through two-field media 117
Strobe Motion effect

creating 96
parameters for 501

Subdividing the Pan and Scan effect 200
Submaster effect

applying 214
collapsing layers into 216
described 561
editing 213
using with EDLs 213
using with short clips 215

Substituting fonts 268
Superimpose effect 519
Swap Sources option 489
Swapping effect tracks 650

T
Target parameters (3D) 670
Template (effect) 44
Templates

for titles 321
Tension

setting for Spline 665
versus Continuity in motion path 667

Text for titles
editing 276
formatting 277
justifying 280
kerning 281
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leading 283
repositioning 276
resizing 275

Tilt parameter (3D) 663
Timeline

color coding of real-time effects 42
dragging titles into 346
expanding nested effects in 209
real-time effects in 214
real-time effects, color coding 32
segment deletions in 69
showing effect icons in 58

Timeline View Name button (Timeline) 58
Title

saving with a keyboard shortcut 318
Title Effect clips

described 341
Title effects

defined 29
Title styles

applying 331
defined 326
managing in Project window 332
recalling 330
saving 327
using function keys with 328

Title templates
creating and using 321

Title tool
16:9 display option 273
Auto Size mode 292
background options 270
blending colors in 299
blending transparency in 301
choosing fonts in 278
Color Picker 297
described 263
drawing graphics in 284
opening 262
overview 261
pasting text into 274

preparing drawing environment 267
safe title/action area display in 269
setting color in 296
setting point size in 279
setting transparency in 296
toolbar overview 264
updating video background in 270
working with shadows in 302

Titles
adding shadows to 302
adjusting in Effect Editor 351
adjusting using keyframes 352
aligning 311
applying styles 331
bold text in 280
color of background 270
compatible resolutions with 314
complexity and playback 340
converting DSK to non-DSK 338
creating color background for 271
creating media for unrendered 359
creating multiformat 324
creating text 274
distributing 312
dragging into Timeline 346
editing into a sequence 343
effect clips described 341
effect icons 336
effects summarized 633
exporting as a graphics file 333
fading 350
fast saving 318
glow effect with 306
grouping and ungrouping 309
italic text in 280
kerning of text in 281
layering of 308
layering with other effects 337
locking and unlocking 310
managing fonts for 267
managing styles in Project window 332
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multiformat 323, 355
on systems with 24p or 25p support 323
overview of creation 261
overview of saving 313
playback capabilities 341
previewing 268
promoting to 3D 362
recalling styles 330
re-creating 357
re-creating multiformat 361
removing from a sequence 349
rendering 356
replacing fill tracks 356
replacing in a sequence 350
revising in a sequence 352
revising in bin 320
saving 314
saving multiformat 324
saving styles 327
saving with keyboard shortcut 318
soft shadows with 304
splicing into a sequence 344
templates for 321
troubleshooting 362
unrendered 318
viewing Fast saved in bin 319
viewing Title effects 44

Toolbar in Title tool 264
Top Box Wipe effect 526
Top Centered Squeeze effect 628
Top Left Corner Peel effect 585
Top Left L-Conceal effect 570
Top Left Squeeze effect 629
Top Left to Bottom Right Box Wipe effect 527
Top Left to Bottom Right Conceal effect 535
Top Left to Bottom Right Push effect 594
Top Right Corner Peel effect 586
Top Right L-Conceal effect 571
Top Right Squeeze effect 630
Top Right to Bottom Left Box Wipe effect 528
Top Right to Bottom Left Conceal effect 536

Top Right to Bottom Left Push effect 595
Top to Bottom Conceal effect 537
Top to Bottom Peel effect 587
Top to Bottom Push effect 596
Top to Bottom Squeeze effect 631
Tracking information

in Effect Preview monitor 105
Tracks of video

as background in Title tool 270
foreground (3D) keys on 655
gain levels 493
in nested effects 206
swapping background and foreground (3D) 

237
swapping effects on (3D) 650

Trail parameters (3D) 671
Transition Effect Alignment button 74
Transition effects

alignment 511
AniMatte 562
available with Add Dissolve button 74
Blends 514
Box Wipes 520
Chroma Key 563
Conceals 530
defined 29
deleting 69
deleting multiple 70
dissolves 72
Edge Wipes 538
Fades 516
Film Dissolve 552
Film Fade 553
L-Conceal 567
Luma Key 564
Matrix Wipes 572
Peels 579
Pushes 588
Sawtooth Wipes 599
Shape Wipes 604
Spins 613
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Squeezes 617
trimming 81
using Axis for 255
with Page Curl (3D) 238
with Pan and Scan effect 205

Transition parameters (2D) 511
Transparency

blending in titles 301
setting for titles 296

Transparency (Foreground parameter) 489
Triangular opener in Effect Editor 119
Trimming

rolling titles 348
transitions in Trim mode 81

Troubleshooting
AVX plug-ins 56
titles 362

True Type fonts 268
Turning 3D on and off 221
Two-field media

position display for 105
Types of effects 456

U
Uncompressed (DSK) titles

described 337
Uncompressed video

playback capabilities with 35
title playback with 341

UnGroup command (Object menu) 309, 420
Unlock command (Object menu) 311, 421
Unrendered titles

creating media for 359
saving 318

Update rate of Strobe effect 503
Upgrading AVX plug-ins 52
Upper Left Diagonal Edge Wipe effect 543
Upper Right Diagonal Edge Wipe effect 544

V
Variable Speed motion effect

described 578
parameters for 501

Vector-based objects
creating 395
described 393

Vertical Blinds Shape Wipe effect 613
Vertical Centered Squeeze effect 632
Vertical Edge Wipe effect 546
Vertical effects

defined 30
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